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Welcome to MicroEJ developer documentation. Browse the following chapters to familiarize yourself with MicroEJ
Technology and understand the principles of app and platform development with MicroEJ.

The Glossary chapter describes MicroEJ terminology.
The Overview chapter introduces MicroEJ products and technology.
The Application Developer Guide presents Java applications development and debugging tools.

The Platform Developer Guide teaches you how to integrate a C Board Support as well as simulation config-
urations.

The Kernel Developer Guide introduces you to advanced concepts, such as partial updates and dynamic app
life cycle workflows.

The Tutorials chapter covers a variety of topics related to developing with the MicroEJ ecosystem.
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CHAPTER

ONE

MICROEJ GLOSSARY

This glossary defines the technical terms upon which the MicroEJ Virtual Execution Environment is built.

Add-On Library A MicroEJ Add-On Libraryis a pure managed code (Java) library. It runs over one or more MicroEJ
Foundation Libraries.

Application A MicroEJ Application is a software program that runs on a Powered by MicroEJ device.

Standalone Application MicroEJ Standalone Application is a MicroEJ Application that is directly
linked to the C code to produce a MicroEJ Mono-Sandbox Firmware. It is edited using MicroEJ
SDK.

Sandboxed Application A MicroEJ Sandboxed Application is a MicroEJ Application that can run
over a MicroEJ Multi-Sandbox Firmware. It can be linked either statically or dynamically.

System Application A MicroEJ System Application is a MicroEJ Sandboxed Application that is
statically linked to a MicroEJ Multi-Sandbox Firmware, as it is part of the initial image and
cannot be removed.

Kernel Application AMicroEJ Kernel Application is a MicroEJ Standalone Application that imple-
ments the ability to be extended to produce a MicroEJ Multi-Sandbox Firmware.

Architecture A MicroEJ Architecture is a software package that includes the MicroEJ Core Engine port to a target
instruction set and a C compiler, core MicroEJ Foundation Libraries (EDC, [BON], [SN/], [KF]) and the MicroEJ
Simulator. MicroEJ Architectures are distributed either as evaluation or production version.

Core Engine MicroEJ Core Engine is a scalable runtime for resource-constrained embedded devices running on
32-bit microcontrollers or microprocessors. MicroEJ Core Engine allows devices to run multiple and mixed
Java and C software applications.

Firmware A MicroEJ Firmware is the result of the binary link of a MicroEJ Standalone Application with a MicroEJ
Platform. The firmware is a binary program that can be programmed into the flash memory of a device.

Mono-Sandbox Firmware A MicroEJ Mono-Sandbox Firmware is a MicroEJ Firmware thatimple-
ments an unmodifiable set of functions. (previously MicroEJ Single-app Firmware)

Multi-Sandbox Firmware A MicroEJ Multi-Sandbox Firmware is a MicroEJ Firmware that imple-
ments the ability to be extended, by exposing a set of APIs and a memory space to link MicroEJ
Sandboxed Applications. (previously MicroEJ Multi-app Firmware)

Foundation Library AMicroEJ Foundation Libraryisa library that provides core or hardware-dependent function-
alities. A Foundation Library combines managed code (Java) and low-level APIs (C) implemented by one or
more Abstraction Layers through a native interface (SN/).

Mock A MicroEJ Mock is a mockup of a Board Support Package capability that mimics an hardware functionality
for the MicroEJ Simulator.



https://developer.microej.com/microej-vee-virtual-execution-environment
https://en.wikipedia.org/wiki/Managed_code
https://en.wikipedia.org/wiki/Managed_code

MicroEJ Documentation, Revision 4€20bb27

Module Manager MicroEJ Module Manager downloads, installs and controls the consistency of all the dependen-
cies and versions required to build and publish a MicroEJ asset. It is based on Semantic Versioning specifi-
cation.

Platform A MicroEJ Platform integrates a MicroEJ Architecture, one or more Foundation Libraries with their re-
spective Abstraction Layers and the board support package (BSP) for the target Device. It also includes asso-
ciated MicroEJ Mocks for the MicroEJ Simulator.

SDK MicroEJ SDK allows MicroEJ Firmware developers to build a MicroEJ-ready device, by integrating a MicroEJ
Architecture with both Java and C software on their device.

Simulator MicroEJ Simulator allows running MicroEJ Applications on a target hardware simulator on the devel-
oper’s desktop computer. The MicroEJ Simulator runs one or more MicrokEJ mock that mimics the hardware
functionality. It enables developers to develop their MicroEJ Applications without the need of hardware.

Studio MicroEJ Studio allows application developers to write a MicroEJ Sandboxed Application, run it on a Virtual
Device, deploy it on a MicroEJ-ready device, and publish it to a MicroEJ Forge instance.

Virtual Device A MicroEJ Virtual Device is a software package that includes the simulation part of a MicroEJ
Firmware: runtime, libraries and application(s). It can be run on any PC without the need of MicroEJ Stu-
dio. In case a MicroEJ Multi-Sandbox Firmware, it is also used for testing a MicroEJ Sandboxed Application
in MicroEJ Studio.
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CHAPTER

TWO

OVERVIEW

2.1 MicroEJ Editions

2.1.1 Introduction
MicroEJ offers a comprehensive toolset to build the embedded software of a device. The toolset covers two levels
in device software development:

+ MicroEJ SDK for device firmware development

+ MicroEJ Studio for application development

The firmware will generally be produced by the device OEM, it includes all device drivers and a specific set of Mi-
croEJ functionalities useful for application developers targeting this device.

QA Platform Firmware @ Application | ;1 ulator
Sources

Sources
MICROEJ. 5DK MICROEJ Studic
Firmware Developer Host Application Developer Host
Import Build
Virtual
Device
Build
I
Target Local Deploy
- MICROEJ
- irmware | ——— APPLICATION
Build Flash — (7) —
L7 Install N Publish

MICROEJ.Forge

Fig. 1: MicroEJ Development Tools Overview

Using the MicroEJ SDK tool, a firmware developer will produce two versions of the MicroEJ binary, each one able
to run applications created with the MicroEJ Studio tool:

+ A MicroEJ Firmware binary to be flashed on OEM devices;
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« AVirtual Device which will be used as a device simulator by application developers.
Using the MicroEJ Studio tool, an application developer will be able to:

« Import Virtual Devices matching his target hardware in order to develop and test applications on the Simu-
lator;

« Deploy the application locally on an hardware device equipped with the MicroEJ Firmware;

« Package and publish the application on a MicroEJ Forge Instance, enabling remote end users to install it on
their devices. For more information about MicroEJ Forge, please consult https://www.microej.com/product/
forge.

2.1.2 Determine the MicroEJ Studio/SDK Version

In MicroEJ Studio/SDK, go to Help > About MicroEJ SDK menu.
In case of MicroEJ SDK 4.1 .x, the MicroEJ SDK version is directly displayed, suchas 4.1.5:

A About MicroEl® SDK

MicroEl® SDE

Version 4.1.5

Copyright ©2016-2018 1527 5.4, All Rights Reserved.

Use of this program is subject to Microk) License Agreement.

MicroE)® SDK is built on Eclipse, licensed under the terms of the Commen Public
License (CPL).

MicroEl® 50K and the MicreEl) logos are tradernarks of MicroE) 5.4,

CSEHOFPFS I EBwEDF

3 . .
@ Installation Details

In case of MicroEJ SDK 5. x , the value displayed is the MicroEJ SDK distribution, suchas 19.05 or 20.07:

2.1. MicroEJ Editions 5
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= About MicroEl

Copyright ©2018-2020 Microb) Corp. All Rights Reserved.

Use of this program is subject to MicroE) License Agreement.

MicroE)® SDK is built on Eclipse, licensed under the terms of the Common
r Public License (CPL).

MicroEl® 5DK and the MicrokE) logos are trademarks of MicroB) Corp.

CSEOFPF O JE WS

® Installation Details

To retrieve the MicroEJ SDK version that is currently installed in this distribution, proceed with the following steps:
o Clickonthe Installation Details button,
o Clickonthe Installed Software tab,

+ Retrieve the version of entry named MicroEJ SDK (or MicroEJ Studio).

K Installation Details

Installed Software |nstallation History Features Plug-ins Coenfiguration

Name Version Id Provider
@= C/C++ Development Tools SDK 9.4.3.201802261533  org.eclipse.cdt.sdk.feature.group Eclipse COT
[k C/C++ GCC Cross Compiler Support 9.4.3.201802261533  org.eclipse.cdt.build.crossgec.feature.group  Eclipse COT
[ C/C++ GDB Hardware Debugging 9.4.3.201802261533  org.eclipse.cdt.debug.gdbjtag.feature.gro... Eclipse COT
[{f- Eclipse Checkstyle Plug-in 6.8.0.201507251301  net.sf.eclipsecs.feature.group http:/Yeclipse-cs.sfu
@ Eclipse Runner Feature 1.34 com.eclipserunnerfeature feature.group Eclipse Runner Tean
@: Eclipse SDK 4.7.3.M20180330-06... org.eclipse.sdk.ide Eclipse.org
@: Eclipse XML Editors and Tools 3.9.2,:201803221834  erg.eclipse.wstxml_uifeaturefeature.group Eclipse Web Tools P
@: Git integration for Eclipse 4.9.2.201712130930-r  org.eclipse.egit.feature.group Eclipse EGit
@: JAutodoc 1.13.0 net.sf,jautodec.feature feature.group Martin Kesting
(= Markdown Editor 0.2.3 markdown.editor.feature.feature.group Winterwell
i i Joldeded?00728-1506  com.is2t.microej.mpp-feature feature.gro...  MicroEl
5.2.0 com.is2t.microej.sdk.feature.feature.group  MicroEJ
- LLUZ0I00728-1306  com.is2t.microgj.mpp.product.feature.fea.. MicroE)
@ Mylyn WikiText 3.0.792001711172000  erg.eclipse.mylynwikitext_featurefeature.... Eclipse Mylyn
@: PMD Plug-in 4.0.5720141105-1906  net.sourceforge.pmd.eclipsefeature.group PMD Project
@: Sonarlint for Eclipse 4.0.0.201810170711  org.sonarlint.eclipse featurefeature.group  SonarSource

2.1. MicroEJ Editions 6
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2.2 Licenses

2.2.1 Overview

MicroEJ Architectures are distributed in two different versions:

« Evaluation Architectures, associated with a software license key. Can be downloaded at https://repository.
microej.com/architectures/.

+ Production Architectures, associated with an hardware license key stored on a USB dongle. Can be requested
to MicroEJ support team support@microej.com.

Licenses list is available in MicroEJ SDK preferences dialog pagein Window > Preferences > MicroEJ :

= Preferences l (S S

type filter text MicroEJ =T - -

Checkstyle -
Copyright

> Data Management MicroEl repository
Easyant4Eclipse

: Help

> IceTea

> Install/Update
Instant Messaging

> Ivy

> Java

4 MicroE)
Architectures

Naming Convention
Platforms

General settings for MicroE) development:

CAP\runtime-New_configuration'repo Browse... ] I Refresh

Licenses

m

License Id Edition License Tags Expiration Date Packs Add...

. xFRYs-32Msn-Y3MAS-RBK4s | STD  IS2TJSFSC ' 2020-12-31 P

Platforms in workspace

[ Restore Defaultsl [ Apply ]

Updates

@ [ ok [ canca |

Fig. 2: MicroEJ Licenses View

2.2.2 License Manager

The license manager is provided with MicroEJ Architectures and this then integrated to Platforms, consequently:

« Evaluation licenses will be shown only if at least one Evaluation Architecture or Platform built from an Eval-
uation Architecture has been imported in MicroEJ SDK.

« Production licenses will be shown only if at least one Production Architecture or Platform built from a Pro-
duction Architecture has been imported in MicroEJ SDK.

See sections MicroEJ Architecture Import and Download and Install a MicroEJ Platform for more information.

2.2.3 Evaluation Licenses

This section should be considered when using Evaluation Architectures, which use software license keys.

Get your Machine UID

To activate an Evaluation Architecture, a machine UID needs to be provided to the key server.

2.2. Licenses 7
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This information is available from the preferences page:
« Goto Window > Preferences > MicroEJ ,
« Select either Architectures or Platforms ,

« Click on one of the available Architectures or Platforms,

+ Pressthe GetUID button to get the machine UID.

Note: To access this Get UID option, at least one Evaluation Architecture must have been imported before (see
License Manager).

Copy the UID. It will be needed when requesting a license.

& UID successfully generated Iﬁ

'0' Your UID was successfully generated.

Your UID is:  |A856470297673E28

Fig. 3: Machine UID for Evaluation License

Request your Activation Key

« Go to https://license.microej.com.
« Clickon Create a new account link.

« Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and login with your new account.

 Clickon Activate a License .
« Set Product P/N: to 9PEVNLDBU6IJ.
« Set UID: tothe UID you copied before.

« Clickon Activate .

+ The license is being activated. You should receive your activation by email in less than 5 minutes. If not,
please contact support@microej.com.

« Once received by email, save the attached zip file that contains your activation key.

Install the License Key

« Go back to MicroEJ SDK.

« Selectthe Window > Preferences > MicroEJ menu.

2.2. Licenses 8
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+ Press Add... .

« Browse the previously downloaded activation key archive file.

« Press OK. A new license is successfully installed.

+ Go to Architectures sub-menu and check that all Architectures are now activated (green check).
« Your MicroEJ SDK is successfully activated.

If an error message appears, the license key could not be installed. (see section Troubleshooting). A license key can
be removed from key-store by selecting it and by clickingon Remove button.

Troubleshooting
Consider this section when an error message appears while adding the Evaluation license key. Before contacting
MicroEJ support, please check the following conditions:

+ Key is corrupted (wrong copy/paste, missing characters or extra characters)

+ Key has not been generated for the installed environment

+ Key has not been generated with the machine UID

« Machine UID has changed since submitting license request and no longer matches license key

+ Keyhasnotbeen generated for one of the installed Architectures (no license manager able to load this license)

= Invalid activation key I&

| The key could not be installed in this environment. Possible reasons are:

Sl® - keyis corrupted,

- key is valid but does not match any available license manager(s). (Works for an
other edition),

- key has not been generated for this machine,

- old key version,

Fig. 4: Invalid License Key Error Message

2.2.4 Production Licenses

This section should be considered when using Production Architectures, which use hardware license keys stored
on an USB dongle.

Note: If your USB dongle has been provided to you by your sales representative and you don’t have received an
activation certificate by email, it may be a pre-activated dongle. Then you can skip the activation steps and directly
jump to Check Activation on MicroEJ SDK section.

2.2. Licenses 9
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Request your Activation Key

+ Goto license.microej.com.
+ Clickon Create a new account link.

« Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and login with your new account.

« Clickon Activate a License .

« Set Product P/N: to The P/N on the activation certificate.

Enter your UID: serial number printed on the USB dongle label (8 alphanumeric char.).

« Clickon Activate and check confirmation message.

+ Click on Confirm your registration .

Enter the Registration Code provided on the activation certificate.

Clickon Submit .

« Your Activation Key will be sent to you by email as soon as it is available (12 business hours max.).

Note: You can check the My Products page to verify your product registration status, the Activation Key avail-
ability and to download the Activation Key when available.

Once the Activation Key is available, download and save the Activation Key ZIP file to a local directory.

Activate your USB Dongle

This section contains instructions that will allow to flash your USB dongle with the proper activation key.
You shall ensure that the following prerequisites are met :
+ The USB dongle is plugged and recognized by your operating system (see Troubleshooting section)
« No more than one USB dongle is plugged to the computer while running the update tool

+ The update tool is not launched from a Network drive or from a USB key

The activation key you downloaded is the one for the dongle UID on the sticker attached to the dongle (each
activation key is tied to the unique hardware ID of the dongle).

You can then proceed to the USB dongle update:
« Unzipthe Activation Key file to a local directory
« Enter the directory just created by your ZIP extraction tool.

+ Launch the executable program.

+ Clickonthe Update button (no password needed)

2.2. Licenses 10
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(=] Update Tool

k.eylcharacter zting]

Ky

Fig. 5: Dongle Update Tool

« On success, an Update successfully message shall appear. On failure, an Error key or no proper
rockey message may appear.

update_E24C0785 i

ﬂ Update successfully

OK

Fig. 6: Successful dongle update

Check Activation on MicroEJ SDK

Note: Production licenses will be shown only if at least one Production Architecture has been imported before (see
License Manager).

+ Go back to MicroEJ SDK,

« Goto Window > Preferences > MicroEJ ,

« Goto Architectures or Platforms sub-menuand checkthatall Production Architectures or Platforms are
now activated (green check).

2.2. Licenses 1
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type filter text Platforms =T -
EasyantdEclipse " Add or remove platforms,
> Help
. lceTea Platforms, Virtual Devices and Architectures:
> Install/Update . Mame Version  Lic... Select All
:”“a”tmessag'”g [ FRDM-KL46Z Jakarta Kickstart 135 Decelect Al
> vy
. Java ugQ me_ L‘\rchitect:.'re:CMD
4 MicroEl [14F STM Hardware Part Number: Jakarta Import...
. [1€¥F STM: Compilation Toolchain: CMO_ARMCC
Architectures []€F sTM: Name: KickStart Uninstall
MNaming Conventior )43 sTm: Provider: [S2T
oy, Version: 1.3.5 Get UID
Platforms in worksp g 1 Core Engine Architecture: 14
Undates [C14¥ STM: Usage Level:Fer ]
P 143 STM: Technology Version: 1.6
> Mylyn []£3 vicr License Tag{[52TJaF5C
Planning []¢) vicp Build Labek: 207503071047
» Plug-in Development Path: .microgfrepositorieshFull\1.64sd002
Fig. 7: Platform License Status OK
Troubleshooting

This section contains instructions to check that your USB dongle is correctly recognized by your operating system.

GNU/Linux Troubleshooting
For GNU/Linux Users (Ubuntu at least), by default, the dongle access has not been granted to the user, you have to
modify udev rules. Please create a /etc/udev/rules.d/91-usbdongle.rules file with the following contents:

ACTION!="add", GOTO="usbdongle_end”
SUBSYSTEM=="usb", GOTO="usbdongle_start”
SUBSYSTEMS=="usb", GOTO="usbdongle_start"”
GOTO="usbdongle_end"
LABEL="usbdongle_start”
ATTRS{idVendor}=="096e" , ATTRS{idProduct}=="0006" , MODE="0666"
LABEL="usbdongle_end"
Then, restart udev: /etc/init.d/udev restart

You can check that the device is recognized by running the 1susb command. The output of the command should
contain a line similar to the one below for each dongle : Bus 002 Device 003: ID 096e:0006 Feitian
Technologies, Inc.

Windows Troubleshooting

For Windows users, each dongle shall be recognized with the following hardware ID :

HID\VID_0Q96E&PID_0006&REV_0109

On Windows 8.1, go to Device Manager > Human Interface Devices and check amongthe USB Input Device
entries that the Details > Hardware Ids property match the ID mentioned before.

2.2. Licenses 12
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VirtualBox Troubleshooting

In a VirtualBox virtual machine, USB drives must be enabled to be recognized correctly. So make sure to enable the
USB dongle by clicking on it in the VirtualBox menu Devices > USB.

In order to make this setting persistent, go to Devices > USB > USB Settings... and add the USB donglein the
USB Devices Filters list.

2.3 MicroEJ Runtime

2.3.1 Language

MicroEJ is compatible with the Java language version 7.

Java source code is compiled by the Java compiler' into the binary format specified in the JVM specification’. This
binary code needs to be linked before execution: .class files and some other application-related files (see MicroEJ
Classpath) are compiled to produce the final application that the MicroEJ Runtime can execute.

MicroEJ complies with the deterministic class initialization (<clinit>) order specified in /[BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

2.3.2 Scheduler
The MicroEJ Architecture features a green thread platform that can interact with the C world [SNI]. The (green)
thread policy is as follows:

+ preemptive for different priorities,

« round-robin for same priorities,

« “priority inheritance protocol” when priority inversion occurs.’

MicroEJ stacks (associated with the threads) automatically adapt their sizes according to the thread requirements:
Once the thread has finished, its associated stack is reclaimed, freeing the corresponding RAM memory.

2.3.3 Garbage Collector
The MicroEJ Architecture includes a state-of-the-art memory management system, the Garbage Collector (GC).
It manages a bounded piece of RAM memory, devoted to the Java world. The GC automatically frees dead Java

objects, and defragments the memory in order to optimize RAM usage. This is done transparently while the MicroEJ
Applications keep running.

2.3.4 Foundation Libraries

Embedded Device Configuration (EDC)

The Embedded Device Configuration specification defines the minimal standard runtime environment for embed-
ded devices. It defines all default API packages:

! The JDT compiler from the Eclipse IDE.
2 Tim Lindholm & Frank Yellin, The Java™ Virtual Machine Specification, Second Edition, 1999
3 This protocol raises the priority of a thread (that is holding a resource needed by a higher priority task) to the priority of that task.

2.3. MicroEJ Runtime 13
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* java.io

+ java.lang

+ java.lang.annotation
« java.lang.ref

« java.lang.reflect

« java.util

Beyond Profile (BON)

[BON] defines a suitable and flexible way to fully control both memory usage and start-up sequences on devices
with limited memory resources. It does so within the boundaries of Java semantics. More precisely, it allows:

« Controlling the initialization sequence in a deterministic way.

« Defining persistent, immutable, read-only objects (that may be placed into non-volatile memory areas), and
which do not require copies to be made in RAM to be manipulated.

« Defining immortal, read-write objects that are always alive.

« Defining and accessing compile-time constants.

2.4 MicroEJ Libraries

A MicroEJ Foundation Library is a MicroEJ Core library that provides core runtime APIs or hardware-dependent
functionality. A Foundation library is divided into an APl and an implementation. A Foundation library APl is com-
posed of a name and a 2 digits version (e.g. EDC-1.3) and follows the semantic versioning (http://semver.org)
specification. A Foundation Library API only contains prototypes without code. Foundation Library implementa-
tions are provided by MicroEJ Platforms. From a MicroEJ Classpath, Foundation Library APIs dependencies are
automatically mapped to the associated implementations provided by the Platform or the Virtual Device on which
the application is being executed.

A MicroEJ Add-On Library is a MicroEJ library that is implemented on top of MicroEJ Foundation Libraries (100%
full Java code). A MicroEJ Add-On Library is distributed in a single JAR file, with a 3 digits version and provides its
associated source code.

Foundation and Add-On Libraries are added to MicroEJ Classpath by the application developer as module depen-
dencies (see MicroEJ Module Manager).

YOUR APPLICATION

ADD-ON LIBRARIES

FOUNDATION LIBRARIES

EDC BON MicroUl NET SSL FS ECOM

JAVA CODE

Fig. 8: MicroEJ Foundation Libraries and Add-On Libraries

MicroEJ Corp. provides a large number of libraries through the MicroEJ Central Repository. To consult its libraries
APIs documentation, please visit https://developer.microej.com/microej-apis/.

2.4. MicroEJ Libraries 14
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2.5 MicroEJ Central Repository

The MicroEJ Central Repository is the binary repository maintained by MicroEJ Corp. It contains Foundation Library
APIs and numerous Add-On Libraries. Foundation Libraries APIs are distributed under the organization ej.api and
com.microej.api . All other artifacts are Add-On Libraries.

By default, MicroEJ SDK s configured to connect online MicroEJ Central Repository. The MicroEJ Central Repository
can be downloaded locally for offline use. Please follow the steps described at https://developer.microej.com/
central-repository/.

To consult its libraries APls documentation, please visit https://developer.microej.com/microej-apis/.

2.6 Embedded Specification Requests

MicroEJ implements the following ESR Consortium specifications:

[BON] | http://e-s-r.net/download/specification/ESR-SPE-0001-BON-1.2-F.pdf

[SNI] http://e-s-r.net/download/specification/ESR-SPE-0012-SNI_GT-1.2-H.pdf
[SP] http://e-s-r.net/download/specification/ESR-SPE-0014-SP-2.0-A.pdf ]
[MUI] | http://e-s-r.net/download/specification/ESR-SPE-0002-MICROUI-2.0-B.pdf
[KF] http://e-s-r.net/download/specification/ESR-SPE-0020-KF-1.4-F.pdf

2.7 MicroEJ Firmware

2.7.1 Bootable Binary with Core Services
A MicroEJ Firmware is a binary software program that can be programmed into the flash memory of a device. A
MicroEJ Firmware includes an instance of a MicroEJ runtime linked to:

+ underlying native libraries and BSP + RTOS,

« MicroEJ libraries and application code (C and Java code).

2.5. MicroEJ Central Repository 15
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YOUR APPLICATION
Ll
8 ADD-ON LIBRARIES
Q
%: FOUNDATION LIBRARIES
:
Low Level API
W Sl ( Abstraction Layer ) ( ) ( ) ( )
© T
E —
=
_g\ ( ) Driver I Driver I Driver m Driver I Driver I Driver l Driver ]
RTOS

CPU FPU Ethernet Wi-Fi/BLE/... Mass Storage Serial Memory Periph ...

YOUR HARDWARE

Fig. 9: MicroEJ Firmware Architecture

2.7.2 Specification

The set of libraries included in the firmware and its dimensioning limitations (maximum number of simulta-
neous threads, open connections, ...) are firmware specific. Please refer to https://developer.microej.com/5/
getting-started-studio.html for evaluation firmware release notes.

2.8 Introducing MicroEJ SDK

MicroEJ SDK provides tools based on Eclipse to develop software applications for MicroEJ-ready devices. MicroEJ
SDK allows application developers to write MicroEJ Applications and run them on a virtual (simulated) or real de-
vice.

This document is a step-by-step introduction to application development with MicroEJ SDK. The purpose of
MicroEJ SDK is to develop for targeted MCU/MPU computers (loT, wearable, etc.) and it is therefore a cross-
development tool.

Unlike standard low-level cross-development tools, MicroEJ SDK offers unique services like hardware simulation
and local deployment to the target hardware.

Application development is based on the following elements:

+ MicroEJ SDK, the integrated development environment for writing applications. It is based on Eclipse and is
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (see MicroEJ Module Manager). The current distribution of MicroEJ SDK ( 19.05 ) is built on top of
Eclipse Oxygen (https://www.eclipse.org/oxygen/).

+ MicroEJ Platform, a software package including the resources and tools required for building and testing an
application for a specific MicroEJ-ready device. MicroEJ Platforms are imported into MicroEJ SDK within a
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local folder called MicroEJ Platforms repository. Once a MicroEJ Platform is imported, an application can be
launched and tested on Simulator. It also provides a means to locally deploy the application on a MicroEJ-
ready device.

+ MicroEJ-ready device, an hardware device that will be programmed with a MicroEJ Firmware. A MicroEJ
Firmware is a binary instance of MicroEJ runtime for a target hardware board.

Starting from scratch, the steps to go through the whole process are detailed in the following sections of this chapter

« Download and install a MicroEJ Platform
« Build and run your first application on Simulator

« Build and run your first application on target hardware

2.9 Introducing MicroEJ Studio and Virtual Devices

MicroEJ Studio provides tools based on Eclipse to develop software applications for MicroEJ-ready devices. Mi-
croEJ Studio allows application developers to write MicroEJ Applications, run them on a virtual (simulated) or real
device, and publish them to a MicroEJ Forge instance.

This document is an introduction to application development with MicroEJ Studio. The purpose of MicroEJ Studio
is to develop for targeted MCU/MPU computers (loT, wearable, etc.) and it is therefore a cross-development tool.

Unlike standard low-level cross-development tools, MicroEJ Studio offers unique services like hardware simula-
tion, deployment to the target hardware and final publication to a MicroEJ Forge instance.

Application development is based on the following elements:

+ MicroEJ Studio, the integrated development environment for writing applications. It is based on Eclipse and
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (see MicroEJ Module Manager). The current distribution of MicroEJ Studio (19.05) is built on top of
Eclipse Oxygen (https://www.eclipse.org/oxygen/).

+ MicroEJ Virtual Device, a software package including the resources and tools required for building and test-
ing an application for a specific MicroEJ-ready device. A Virtual Device will simulate all capabilities of the
corresponding hardware board:

Computation and Memory,

Communication channels (e.g. Network, USB ...),

Display,

User interaction.

Virtual Devices are imported into MicroEJ Studio within a local folder called MicroEJ Repository. Once a Vir-
tual Device is imported, an application can be launched and tested on Simulator. It also provides a mean to
locally deploy the application on a MicroEJ-ready device.

+ MicroEJ-ready device, a hardware device that has been previously programmed with a MicroEJ Firmware. A
MicroEJ Firmware is a binary instance of MicroEJ runtime for a target hardware board. MicroEJ-ready devices
are built using MicroEJ SDK. MicroEJ Virtual Devices and MicroEJ Firmwares share the same version (there is
a1:1 mapping).

The following figure gives an overview of MicroEJ Studio possibilities:
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Fig. 10: MicroEJ Application Development Overview

2.10 Perform Online Getting Started

MicroEJ Studio Getting Started is available on https://developer.microej.com/5/getting-started-studio.html.
Starting from scratch, the steps to go through the whole process are:
1. Setup a board and test a MicroEJ Firmware:
« Select between one of the available boards;
« Download and install a MicroEJ Firmware on the target hardware;
« Deploy and run a MicroEJ demo on board.
2. Setup and learn to use development tools:
» Download and install MicroEJ Studio;
« Download and install the corresponding Virtual Device for the target hardware;
« Download, build and run your first application on Simulator;

« Build and run your first application on target hardware.

The following figure gives an overview of the MicroEJ software components required for both host computer and

target hardware:

2.10. Perform Online Getting Started
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Fig. 11: MicroEJ Studio Development Imported Elements

2.11 GitHub Repositories

Alarge number of examples, libraries, demos and tools are shared on MicroEJ GitHub account: https://github.com/
MicroEJ.

Most of these GitHub repositories contain projects ready to be imported in MicroEJ SDK. This section explains the
steps to import them in MicroEJ SDK, using the MWT Examples repository.

Note: MicroEJ SDK Distribution includes the Eclipse plugin for Git.

First, from the GitHub page, copy the repository URI (HTTP address) from the dedicated field in the right menu
(highlighted in red):
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O Why GitHub? ~~ Team Enterprise Explore Marketplace Pricing Sign in ‘ Sign up |
& MicroE) / ExampleJava-MWT ®Watch | 2 TrStar | 1 Yok 0
<> Code Issues Pull requests Actions Projects Security Insights

$ master - P 1branch  © 2 tags Go to file About

These projects provide examples
Q privron Merge branch ‘develop’ into ‘master’ .. BJ Clone @ for MWT

HTTPS  GitHub CLI
: - e e (FF [ Readme
com.microej.example.mwt.basic ix api minor version @ignc https://github.con/MicroEl/Exanplela | 7]
com.microej.example.mwtbutt..  Fix api minor version @ignc  Use Git or checkout with SVN using the web URL. BB View license
com.microej.example.mwt.hello...  Fix api minor version @ignc
Et] Open with GitHub Desktop
. Releases
com.microej.example.mwt.mvc Fix api minor version @ignc
: - o - X B D load ZIP @ 2 tags
com.microej.example.mwtslidi..  Fix api minor version @igne & ownloa
[ .gh-copyright.template Move mwt example from foundation libraries @ignore_branc... 3 years ago
N e AT e A 1 e e o e e . Packages

In MicroEJ SDK, to clone and import the project from the remote Git repository into the MicroEJ workspace, select
File > Import > Git > Projectsfrom Git wizard.
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® |mport

Select

Import one or more projects from a Git Repository. Iﬁ

Select an import wizard:

type filter text

= General

= C/C++

= CV5
v = Git

S0 Projects from Git

= Install
= MicroEl
= Plug-in Development
[= Run/Debug
= Tasks
= Teamn
= XML

® < Back Finish Cancel

Click Next , select CloneURI ,click Next and paste the remote repository address in the URI field. For
this repository, the address is https://github.com/MicroEJ/ExampleJava-MWT.git. If the HTTP address is a valid
repository, the other fields are filed automatically.
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® |mport Projects from Git
Source Git Repository GIT
Enter the location of the source repository. :_‘:n‘
Location
URJ: ?| https:.-"fgithul:l.cum.-"MicrDElexampI&lava-M‘."H"T.giﬂ | Lacal File...
Host: | github.com |
Repository path: | /Microbl/Examplelava-MWT.git |
Connection
Protocol: | https
Authentication
User | |
Password: | |
[ ]5tore in Secure Store
® = Back Finish Cancel

Click Next , selectthe master branch, click Next and acceptthe proposed Local Destination by clicking Next

once again.

2.11. GitHub Repositories
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® |mport Projects from Git

Local Destination

GIT

Configure the local storage location for Examplelava-MWT. E‘
Destination

Directory: | IC:\Users\user\git\Examplelava-MWT | Browse
Initial branch: K master v

[]Clene submodules

Configuration

Remote name: | crigin

® < Back Finish Cancel

Click Next once more and finally Finish . The Package Explorer view now contains the imported projects.

£ Package Explorer &2 ‘Eg Type Hierarchy % ™

w '[c‘.gl- com.microgj.example.mwt.basic [Examplelava-MWT master]
& src/main/java
B\ Module Dependencies module.ivy [*]
[ src
[%} CHANGELOG.md
5 LICEMSE.txt
ke moduleivy
[#} README.md
'[c".gl- com.microgj.example.mwt.button [Examplelava-MWT master]
'_,fé com.microg).example.rmwt.helloworld [Examplelava-MWT master]
'[;_—'é com.microgj.example.mwt.mve [Examplelava-MWT master]

1—.;‘- com.microg).example.mwt.slidingwidget [Examplelava-MWT master]
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If you want to import projects from another (GitHub) repository, you simply have to do the same procedure using

the Git URL of the desired repository.

2.12 System Requirements

MicroEJ SDK and MicroEJ Studio

+ Intel x64 PC with minimum :
- Dual-core Core i5 processor
- 4GB RAM
- 2GB Disk

« Operating Systems :

Windows 10, Windows 8.1 or Windows 8

Linux distributions (tested on Ubuntu 16.04, 18.04 and 20.04)

Mac OS X (tested on version 10.13 High Sierra, 10.14 Mojave)

« Java:

JRE or JDK 8 (OpenJDK or Oracle JDK)

2.12. System Requirements
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CHAPTER

THREE

APPLICATION DEVELOPER GUIDE

3.1 Introduction

The following sections of this document shall prove useful as a reference when developing applications for MicroEJ.
They cover concepts essential to MicroEJ Applications design.

In addition to these sections, by going to https://developer.microej.com/, you can access a number of helpful re-
sources such as:

« Libraries from the MicroEJ Central Repository (https://developer.microej.com/central-repository/);
« Application Examples as source code from MicroEJ Github Repositories (https://github.com/MicroEJ);
« Documentation (HOWTOs, Reference Manuals, APIs javadoc...).

MicroEJ Applications are developed as standard Java applications on Eclipse JDT, using Foundation Libraries. Mi-
croEJ SDK allows you to run / debug / deploy MicroEJ Applications on a MicroEJ Platform.

Two kinds of applications can be developed on MicroEJ: MicroEJ Standalone Applications and MicroEJ Sanboxed
Applications.

A MicroEJ Standalone Application is a MicroEJ Application that is directly linked to the C code to produce a Mi-
croEJ Firmware. Such application must define a main entry point, i.e. a class containing a public static void
main(String[]) method. MicroEJ Standalone Applications are developed using MicroEJ SDK.

A MicroEJ Sandboxed Application is a MicroEJ Application that can run over a Multi-Sandbox Firmware. It can be
linked either statically or dynamically. If it is statically linked, it is then called a System Application as it is part of
the initial image and cannot be removed. MicroEJ Sandboxed Applications are developed using MicroEJ Studio.

3.2 Local Workspaces and Repositories

When starting MicroEJ SDK, it prompts you to select the last used workspace or a default workspace on the first
run. A workspace is a main folder where to find a set of projects containing MicroEJ source code.

When loading a new workspace, MicroEJ SDK prompts for the location of the MicroEJ repository, where the Mi-
croEJ Architectures, Platforms or Virtual Devices will be imported. By default, MicroEJ SDK suggests to point to
the default MicroEJ repository on your operating system, located at ${user.home}/.microej/repositories/
[version]. You can select an alternative location. Another common practice is to define a local repository relative
to the workspace, so that the workspace is self-contained, without external file system links and can be shared
within a zip file.
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3.3 Standalone Application

3.3.1 Download and Install a MicroEJ Platform

MicroEJ SDK being a cross development tool, it does not build software targeted to your host desktop platform.
In order to run MicroEJ Applications, a target hardware is required. Several commercial targets boards from main
MCU/MPU chip manufacturers can be prepared to run MicrokJ Applications, you can also run your applications
without one of these boards with the help of a MicroEJ Simulator.

A MicroEJ Platform is a software package including the resources and tools required for building and testing an
application for a specific MicroEJ-ready device. MicroEJ Platforms are available at https://developer.microej.com/
5/getting-started-sdk.html.

After downloading the MicroEJ Platform, launch MicroEJ SDK on your desktop to start the process of Platform in-
stallation :

« Open the Platform view in MicroEJ SDK, select Window > Preferences > MicroEJ > Platforms . The
view should be empty on a fresh install of the tool

O Preferences = n
type filter text Platforms = v -
 General . Add or remove platforms.
. Ant
. CfC++ Platforms, Virtual Devices and Architectures:
Checkstyle Name WVersion Lic... Select All
EasyantdEclipse
- Help Deselect All
- Install/Update
Import...
. |W
- Java Uninstall
4 Microb)

Architectures Get UID
Maming Convention

Platforms in workspace
Updates

- Mylyn

- Plug-in Development

- PMD

@
Fig. 1: MicroEJ Platform Import

« Press Import... button.

» Choose SelectFile... andusethe Browse option to navigate tothe .jpf file containing your MicroEJ
Platform, then read and accept the license agreement to proceed.

3.3. Standalone Application 26


https://developer.microej.com/5/getting-started-sdk.html
https://developer.microej.com/5/getting-started-sdk.html

MicroEJ Documentation, Revision 4€20bb27

- oS

('} Import Platforms, Virtual Devices and Architectures

Import Platforms, ¥irtual Devices and Architectures

Select a directory/file to search for available platforms, virtual devices and architectures.

(") Select directory: Browse...
(®) Select file: Ch\Usersh, MicroEJPlatform jpof Browse...
Platforms, Yirtual Devices and Architectures:
Mame Yersion Select All
L} MicroE Platform 2.1.1 Deselect Al

MICROE) LICEMSE AGREEMENT

PREAMELE

THIS SOFTWARE LICEMNSE AGREEMENT (THE « AGREEMENT ») APPLIES TO PRODUCTS LICEMSE
On purchase of any Licensed Product from 52T or an 52T Partner or an [52T Distributor, the relz
THE LICEMSEE, AS A USER OF THE LICEMSED PRODUCTS REFERRED TO ABOVE AND OM THE REI

1 DEFIMITIONS

€ >

[+]1 agree and accept the above terms and conditions and | want to install the copyrighted Software

Fig. 2: MicroEJ Platform Selection

+ The MicroEJ Platform should now appear in the Platforms view, with a green valid mark.

3.3. Standalone Application
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O

ty

Preferences = n

rpe filter text Platforms =1 v w

» General ~
» Ant
s CfC++ Platforms, Virtual Devices and Architectures:

Checkstyle MName Version  Lic.. Select All

EasyantdEclipse ;
211 >
. Help L} MicroEJ Piatform o Deselect Al

+ Install/Update
> Iy

. Java

Add or remove platforms.

Import...

Uninstall

4 Microk)

<

Architectures Get UID
Maming Conventicon
Platforms in workspace
Updates

» Mylyn

» Plug-in Development

> PMD

noom Restare Defaults Apply

3.3

Fig. 3: MicroEJ Platform List

.2 Build and Run an Application

Create a MicroEJ Standalone Application

« Create a project in your workspace. Select File > New > MicroEJ Standalone Application Project .

File | Edit Source Refactor Mavigate Search Project Run  Window Help
Mew Alt+Shift+N » | (22 MicroE) Standalone Application Project -
Open File... \g MicroE) Standalone Example Project
Close Ctrl+W ‘3 e
Close Al CtrlShift+ W R
£ MicroE) Sandboxed Application Project
Sav |+ 5
Save Ctrl+5 |=<3 T
Save As
FE¥  MirrnFl Eant
Fig. 4: New MicroEJ Standalone Application Project
« Fillin the application template fields, the Project name field will automatically duplicate in the following
fields. Click on Finish . A template project is automatically created and ready to use, this project already
contains all folders wherein developers need to put content:
- src/main/java: Folder for future sources
- src/main/resources : Folder for future resources (images, fonts etc.)
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- META-INF : Sandboxed Application configuration and resources

- module.ivy: lvyinput file, dependencies description for the current project

+ Rightclickonthesourcefolder src/main/java andselect New > Package . Giveaname: com.mycompany
. Clickon Finish .

0 Mew Java Package - 0 n
Java Package

Create a new Java package.

Creates folders corresponding to packages.

Source folder: | MyTest/src Browse...

Mame: COM.Mmycompany

[ | Create package-info.java

Fig. 5: New Package

+ The package com.mycompany is available under src/main/java folder. Right click on this package and
select New > Class . Give a name: Test and check the box public static void main(String[]

args) . Clickon Finish .
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0 Mew Java Class - B n

Jawva Class —=
Create a8 new Java class, @

Source folder: MyTest/src Browse...

Package: COM.mMycompany Browse...

[ Enclosing type: Browse...

Mame: Test

Modifiers: (@) public () package private protected

[ ]abstract [ ]final ctatic

Superclass: java.lang.Object Browse...

Interfaces: Add...
Bemowve

Which method stubs would you like to create?
[#]ipublic static void main(String[] args);

[ ] Constructors from superclass
Inherited abstract methods
Do you want to add comments? (Configure templates and default value here

|:| Generate comments

Fig. 6: New Class

+ The new class has been created with an empty main() method. Fill the method body with the following
lines:

System.out.println("hello world!");
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by module.ivy [J] Testjava &3

package com.mycompany;

public class Test {

-
“

public =s=tatic void main(String([] args)
System.out.println("hello world!"™});

Fig. 7: MicroEJ Application Content
The test application is now ready to be executed. See next sections.

Run on the Simulator

{

To run the sample project on Simulator, select it in the left panel then right-click and select Run > Runas >

MicroEJ Application .

3.3. Standalone Application
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package com.mycompany;

4 Go Into public class Test {

Open in New Window public static void main

Open Type Hierarchy F4 System.out.println/

Show In Alt+Shift+W »

0

=
= {2 | Copy Ctrl+C
¥ | BS

w —

Copy Qualified Mame
[ Paste Ctrl+V
. Delete Delete

Build Path »
Source Alt+Shift+5 ¥
Refactor Alt+Shift+T »

Import...
Export...

EE

wit  Refresh F5
Close Project
Close Unrelated Projects

Assign Warking Sets..,

Run As »
Debug As *
Profile As »
Validate

@ Ruild with Faswlnt

1 lava Applet Alt+5hift+X, A
2 Java Application Alt+Shift+X, J
3 Microk) Application Alt+Shift+X, M

MM A

Run Cenfigurations..,

"

Fig. 8: MicroEJ Development Tools Overview

MicroEJ SDK console will display Launch steps messages.

=============== [ Initialization Stage ) =
=== eI Launchj_ng on Simulator ] ===============

SUCCESS

Run on the Hardware Device

Compile an application, connect the hardware device and deploy on it is hardware dependant. These steps are
described in dedicated documentation available inside the MicroEJ Platform. This documentation is accessible
from the MicroEJ Resources Center view.

Note: MicroEJ Resources Center view may have been closed. Click on Help > MicroEJ Resources Center to
reopen it.
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Open the menu Manual and select the documentation [hardware device] MicroEJ Platform, where
[hardware device] is the name of the hardware device. This documentation features a guide to run a built-in
application on MicroEJ Simulator and on hardware device.

MicroE) Resource Center 23
type filter text
. &2 Javadoc

6 Manual

[l Hardware Device MicroE] Platform

Fig. 9: MicroEJ Platform Guide

3.3.3 Build Output Files
When building a MicroEJ Application, multiple files are generated next to the ELF file. These files are generated in a
folder which is named like the main type and which is located in the output folder specified in the run configuration.

The following image shows an example of output folder:

v [ com.microg).demo.widget.common.Mavigation
= bon
[= cC
[ externalResources
= fonts
= heapDump
= Images
= logs
= platform
= resourceBuffer
w [—- soar
=| com.microgj.demowidget.common.Mavigation.clinitrap
com.micreel.demo.widget.common.MNavigation.o
Ei com.micreel.demo.widget.common.Mavigation.s3infos
|X| com.microg.demowidget.commen.Mavigation.xml
L] sni_intern.h
[ SOAR.map

SOAR.o

Fig. 10: Build Output Files
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The SOAR Map File

The SOAR.map file lists every embedded symbol of the application (section, Java class or method, etc.) and its size
in ROM or RAM. This file can be opened using the Memory Map Analyzer.

The embedded symbols are grouped into multiple categories. For example, the Object class and its methods are
grouped inthe LibFoundationEDC category. For each symbol or each category, you can see its size in ROM ( Image
Size)and RAM (Runtime Size).

The SOAR groups all the Java strings in the same section, which appearsinthe ApplicationStrings category. The
same appliesto the staticfields (Statics category), thetypes (Types category), and the class names (ClassNames
category).

The SOAR Information File

The soar/<main class>.xml file can be opened using any XML editor.
This file contains the list of the following embedded elements:

« method (in selected_methods tag)

« resource (in selected_resources tag)

« system property (in java_properties tag)

« string (in selected_internStrings tag)

« type (in selected_types tag)

« immutable (in selected_immutables tag)

3.3.4 MicroEJ Launch

The MicroEJ launch configuration sets up the MicroEJ Applications environment (main class, resources, target plat-
form, and platform-specific options), and then launches a MicroEJ launch script for execution.

Execution is done on either the MicroEJ Platform or the MicroEJ Simulator. The launch operation is platform-
specific. It may depend on external tools that the platform requires (such as target memory programming). Refer
to the platform-specific documentation for more information about available launch settings.

Main Tab

The Main tab allows you to setin order:
1. The main project of the application.
2. The main class of the application containing the main method.

3. Types required in your application that are not statically embedded from the main class entry point. Most
required types are those that may be loaded dynamically by the application, using the Class.forName()
method.

4. Binary resources that need to be embedded by the application. These are usually loaded by the application
using the Class.getResourceAsStream() method.

5. Immutable objects’ description files. See the [BON 1.2] ESR documentation for use of immutable objects.
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0 Run Configurations n
Create. manage. and run configurations ;—I
- —*|,
= x| H 5 Name: | HelloWerld
type filter text 3] Main s Execution| 8§ Configuration | g, JRE E Source | [[] Commen
E C/C++ Application Praject ~
Ju JUnit
BI;I La::'1ch Group MyHelloWorld5ample Browse...
4 [7] MicroE) Application Main type, Required types
31 HelloWarld
& MicroE Tool com.is2t.examples.edc.helle. HelloWorld Select Main type...
Add types...
Extra types...
Remove
Resources
Add...
Remove
Immutables v
Revert Apply

Filter matched 6 of 11 items

Fig. 11: MicroEJ Launch Application Main Tab

Execution Tab

The next tab is the Execution tab. Here the target needs to be selected. Choose between execution on a MicroEJ
Platform or on a MicroEJ Simulator. Each of them may provide multiple launch settings. This page also allows you
to keep generated, intermediate files and to print verbose options (advanced debug purpose options).
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G— Run Cenfigurations

Create, manage, and run configurations

)

CEX B3P~

type filter text

] C/C++ Application
Ju JUnit

Name: | Widget Demo (SIM)

3] Main | = Execution

A Configuratioﬂ B JRE} E_/ Source\l i=| Qommoﬂ

Target

Platfarm: | STM32F746G-DISCO SingleApp Production [K1AU3] (4.0.0-RC202007301413) | Browse...
L Launch Group
w [T MicroE) Application Execution
& W!dget Demo (EMB) (®) Execute on Simulator () Execute on Device
[3] Widget Demo (SIM])
» g MicroE! Tool Core Engine Mode: MDefanl ~
Settings: | Default ~ | Seftings: | Build & Deploy w
The Application is simulated
Cptions
Output folder: | S{project_loc:com.microej.demouwidget} Browse...
Clean intermediate files [ Verbose
Opticns Files
Y project_loc:com.microe].demo.widget}/build/commeoen.properties Add...
Y project_loc:com.microgj.demo.widgetl/build/sim/sim.properties
Remove
Up
Down
Revert Appl
Filter matched 8 of 21 items = e
@

Configuration Tab

Fig. 12: MicroEJ Launch Application Execution Tab

The next tabis the Configuration tab. Thistab contains all platform-specific options.

3.3. Standalone Application
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ﬂ Run Configurations n

Create. manage. and run configurations -
w,

S X B2 Name: | HelloWorld

type filter text 37 Main | s Execution | ifif Configuration g, JRE E Source | [[] Commen
[E] C/C++ Application 4 Debug
Ju JUnit Code Coverage
[ Launch Group Heap Dumper
4 [7] MicroE) Application 1Dwe
Logs
@ MicroE) Tool 4 Simulator
Com Port
F5
HAL
4 Target
Memory

Specify debug options

4 Libraries
EDC
Shielded Plug
. ECOM
FS
> Microll
Met
MNLS
S5L

. . Revert Apply
Filter matched 6 of 11 items

Fig. 13: Configuration Tab

JRE Tab

The next tabisthe JRE tab. Thistab allows you to configure the Java Runtime Environment used for running the
underlying launch script. It does not configure the MicroEJ Application execution. The VM Arguments text field
allows you to set vm-specific options, which are typically used to increase memory spaces:

« To modify heap space to 1024MB, set the -Xmx1024M option.

« To modify string space (also called PermGen space) to 256MB, set the -XX:PermSize=256M
-XX:MaxPermSize=256M options.

« To set thread stack space to 512MB, set the -Xss512M option.

Other Tabs

The next tabs ( Source and Common tabs) are the default Eclipse launch tabs. Refer to Eclipse help for more
details on how to use these launch tabs.
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3.3.5 Application Options
Introduction
To run a MicroEJ Standalone Application on a MicroEJ Platform, a set of options must be defined. Options can be
of different types:
« Memory Allocation options (e.g set the Java Heap size). These options are usually called link-time options.
« Simulator & Debug options (e.g. enable periodic Java Heap dump).
+ Deployment options (e.g. copy microejapp.o to a suitable BSP location).
« Foundation Library specific options (e.g. embed UTF-8 encoding).

The following section describes options provided by MicroEJ Architecture. Please consult the appropriate MicroEJ
Pack documentation for options related to other Foundation Libraries (MicroUl, NET, SSL, FS, ...) integrated to the
Platform.

Notice that some options may not be available, in the following cases:

« Option is specific to the MicroEJ Core Engine capability (tiny/single/multi) which is integrated in the targeted
Platform.

+ Option is specific to the target (MicroEJ Core Engine on Device or Simulator).

« Option has been introduced in a newer version of the MicroEJ Architecture which is integrated in the targeted
Platform.

+ Options related to Board Support Package (BSP) connection.

Defining an Option

A MicroEJ Standalone Application option can be defined either from a launcher or from a properties file. It is also
possible to use both together. Each MicroEJ Architecture and MicroEJ Pack option comes with a default value,
which is used if the option has not been set by the user.

Using a Launcher

To set an option in a launcher, perform the following steps:

1. In MicroEJ Studio/SDK, select Run > Run Configurations... ,
2. Select the launcher of the application under MicroEJ Application or create a new one,

3. Select the Configuration tab,

4. Find the desired option and set it to the desired value.

It is recommended to index the launcher configuration to your version control system. To export launcher options
to the filesystem, perform the following steps:

1. Selectthe Common tab,
2. Selectthe Shared file: option and browse the desired export folder,

3. Pressthe Apply button. Afile named [launcher_configuration_name].launch is generated in the ex-
port folder.
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Using a Properties File

Options can be also be defined in properties files.

When a MicroEJ Standalone Application is built using the firmware-singleapp skeleton, options are loaded from
properties files located in the build folder at the root of the project.

The properties files are loaded in the following order:

1. Every file matching build/sim/x.properties, for Simulator options only (Virtual Device build). These files
are optional.

2. Every file matching build/emb/x.properties, for Device options only (Firmware build). These files are
optional.

3. Everyfile matching build/*.properties, bothfor Simulatorand Device options. At least one fileis required.
Usually, the build folder contains a single file named common.properties.

In case an option is defined in multiple properties files, the option of the first loaded file is taken into account and
the same option defined in the other files is ignored (a loaded option cannot be overridden).

The figure below shows the expected tree of the build folder:

v [ build
v [ emb
=| emb.properties
W [ sim
=| sim.properties
5 common.properties

Fig. 14: Build Options Folder

Itis recommended to index the properties files to your version control system.

To set an option in a properties file, open the file in a text editor and add a line to set the desired option to the
desired value. For example: soar.generate.classnames=false.

To use the options declared in properties files in a launcher, perform the following steps:
1. In MicroEJ Studio/SDK, select Run > Run Configurations... ,
2. Select the launcher of the application,
3. Selectthe Execution tab,
4. Under Option Files , pressthe Add... button,

5. Browse the sim.properties file for Simulator or the emb.properties file for Device (if any) and press
Open button,

6. Add the common.properties file and pressthe Open button.

Note: An option setin a properties file can not be modified in the Configuration tab. Options are loaded in the
order the properties files are added (you can use Up and Down buttons to change thefile order). In Configuration
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tab, hovering the pointer over an option field will show the location of the properties file that defines the option.

Generating a Properties File

In order to export options defined ina . launch file to a properties file, perform the following steps:

1. Selectthe [launcher_configuration_name].launch file,

2. Select File > Export > MicroEJ > Launcher as Properties File ,
3. Browse the desired output .properties file,
4. Pressthe Finish button.

Category: Runtime

w Device T
es
v CoreEngine P
Kernel [JEmbed all type names
Watchdog
Deploy
v Feature [] Execute assertions on Simulator
Dynamic Download
~ Libraries [] Execute assertions on Device
v ECOM
Comm Connection
EDC [ Enable execution traces
External Resources Loader
Shielded Plug [ start execution traces automatically

Assertions

Trace

~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Types
Option(checkbox): Embed all type names

Option Name: soar.generate.classnames
Default value: true
Description:

Embed the name of all types. When this option is disabled, only names of declared required types are embedded.
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Group: Assertions
Option(checkbox): Execute assertions on Simulator

Option Name: core.assertions.sim.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Option(checkbox): Execute assertions on Device

Option Name: core.assertions.emb.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Group: Trace
Option(checkbox): Enable execution traces

Option Name: core.trace.enabled

Default value: false

Option(checkbox): Start execution traces automatically

Option Name: core.trace.autostart

Default value: false
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Category: Memory

w Device Heaps

v CoreEngine L
Kernel Java heap size (in bytes) | |
Watchdog
Deploy
w Feature

Immortal heap size (in bytes) | |

Dynamic Download Threads

w Libraries Number of threads | |
v ECOM
Comm Connection Number of blocks in pool | |

EDC
External Resources Loader Block size (in bytes) | |
Shielded Plug

w Runtime Maximum size of thread stack (in blocks) | |
Memory

Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heaps
Option(text): Java heap size (in bytes)

Option Name: core.memory. javaheap.size
Default value: 65536

Description:

Specifies the Java heap size in bytes.

A Java heap contains live Java objects. An OutOfMemory error can occur if the heap is too small.

Option(text): Immortal heap size (in bytes)

Option Name: core.memory.immortal.size
Default value: 4096

Description:

Specifies the Immortal heap size in bytes.

The Immortal heap contains allocated Immortal objects. An OutOfMemory error can occur if the heap is too small.

Group: Threads

Description:
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This group allows the configuration of application and library thread(s). A thread needs a stack to run. This stack
is allocated from a pool and this pool contains several blocks. Each block has the same size. At thread startup the
thread uses only one block for its stack. When the first block is full it uses another block. The maximum number of
blocks per thread must be specified. When the maximum number of blocks for a thread is reached or when there
is no free block in the pool, a StackOverflow error is thrown. When a thread terminates all associated blocks are
freed. These blocks can then be used by other threads.

Option(text): Number of threads

Option Name: core.memory.threads.size
Default value: 5
Description:

Specifies the number of threads the application will be able to use at the same time.

Option(text): Number of blocks in pool

Option Name: core.memory.threads.pool.size
Default value: 15
Description:

Specifies the number of blocks in the stacks pool.

Option(text): Block size (in bytes)

Option Name: core.memory.thread.block.size
Default value: 512
Description:

Specifies the thread stack block size (in bytes).

Option(text): Maximum size of thread stack (in blocks)

Option Name: core.memory.thread.max.size
Default value: 4
Description:

Specifies the maximum number of blocks a thread can use. If a thread requires more blocks a StackOverflow error
will occur.
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Category: Simulator

~ Device Options
v CoreEngine

Kernel [[]Use target characteristics

Watchdog Slowing factor (0 means disabled): | 0
Deploy
v Feature . HIL Connectien
Dynamic Download
w Libraries [ Specify a port
w ECOM
Comm Connection 8001
EDC
External Resources Loader HIL connection timeout: | 10 |
Shielded Plug
~ Runtime Shielded Plug server configuration
. Memory Server socket port: | 10082 |
w Simulator

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Options

Description:

This group specifies options for MicroEJ Simulator.

Option(checkbox): Use target characteristics

Option Name: s3.board.compliant
Default value: false
Description:

When selected, this option forces the MicroEJ Simulator to use the MicroEJ Platform exact characteristics. It sets
the MicroEJ Simulator scheduling policy according to the MicroEJ Platform one. It forces resources to be explicitly
specified. It enables log trace and gives information about the RAM memory size the MicroEJ Platform uses.

Option(text): Slowing factor (0 means disabled)

Option Name: s3.slow
Default value: 0
Description:

Format: Positive integer

This option allows the MicroEJ Simulator to be slowed down in order to match the MicroEJ Platform execution
speed. The greater the slowing factor, the slower the MicroEJ Simulator runs.
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Group: HIL Connection

Description:

This group enables the control of HIL (Hardware In the Loop) connection parameters (connection between MicroEJ
Simulator and the Mocks).

Option(checkbox): Specify a port

Option Name: s3.hil.use.port
Default value: false
Description:

When selected allows the use of a specific HIL connection port, otherwise a random free port is used.

Option(text): HIL connection port

Option Name: s3.hil.port
Default value: 8001
Description:

Format: Positive integer
Values: [1024-65535]

It specifies the port used by the MicroEJ Simulator to accept HIL connections.

Option(text): HIL connection timeout

Option Name: s3.hil.timeout
Default value: 10

Description:

Format: Positive integer

It specifies the time the MicroEJ Simulator should wait before failing when it invokes native methods.

Group: Shielded Plug server configuration

Description:

This group allows configuration of the Shielded Plug database.

Option(text): Server socket port

Option Name: sp.server.port
Default value: 10082

Description:
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Set the Shielded Plug server socket port.

Category: Code Coverage

~ Device Code Coverage
w CoreEngine
Kernel
Watchdog
Deploy
w Feature

[ Activate code coverage analysis

Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Code Coverage

Description:

This group is used to set parameters of the code coverage analysis tool.

Option(checkbox): Activate code coverage analysis

Option Name: s3.cc.activated
Default value: false
Description:

When selected it enables the code coverage analysis by the MicroEJ Simulator. Resulting files are output in the cc
directory inside the output directory.

Option(text): Saving coverage information period (in sec.)

Option Name: s3.cc.thread.period
Default value: 15
Description:

It specifies the period between the generation of .cc files.
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Category: Debug

v Device Remote Debug
v CoreEngine
Kernel Debug port: | 12000
Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Remote Debug
Option(text): Debug port

Option Name: debug.port
Default value: 12000
Description:

Configures the JDWP debug port.
Format: Positive integer

Values: [1024-65535]
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Category: Heap Dumper

~ Device Heap Inspection

v CoreEngine i
Kernel [] Activate heap dumper
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heap Inspection

Description:

This group is used to specify heap inspection properties.

Option(checkbox): Activate heap dumper

Option Name: s3.inspect.heap
Default value: false

Description:

When selected, this option enables a dump of the heap each time the System.gc() method is called by the MicroEJ

Application.
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Category: Logs

w Device

Logs
v CoreEngine L
system thread maonitoring
Kernel 2
Watchdog memory schedule monitors
Deploy
w Feature 2

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Logs

Description:

This group defines parameters for MicroEJ Simulator log activity. Note that logs can only be generated if the
Simulator > Use target characteristics optionis selected.

Some logs are sent when the platform executes some specific action (such as start thread, start GC, etc), other logs
are sent periodically (according to defined log level and the log periodicity).

Option(checkbox): system

Option Name: console.logs.level.low

Default value: false

Description:

When selected, System logs are sent when the platform executes the following actions:
start and terminate a thread

start and terminate a GC

exit

Option(checkbox): thread

Option Name: console.logs.level.thread
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Default value: false
Description:

When selected, thread information is sent periodically. It gives information about alive threads (status, memory
allocation, stack size).

Option(checkbox): monitoring

Option Name: console.logs.level .monitoring
Default value: false
Description:

When selected, thread monitoring logs are sent periodically. It gives information about time execution of threads.

Option(checkbox): memory

Option Name: console.logs.level .memory
Default value: false
Description:

When selected, memory allocation logs are sent periodically. This level allows to supervise memory allocation.

Option(checkbox): schedule

Option Name: console.logs.level.schedule
Default value: false
Description:

When selected, a log is sent when the platform schedules a thread.

Option(checkbox): monitors

Option Name: console.logs.level .monitors
Default value: false
Description:

When selected, monitors information is sent periodically. This level permits tracing of all thread state by tracing
monitor operations.

Option(text): period (in sec.)

Option Name: console.logs.period
Default value: 2
Description:

Format: Positive integer
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Values: [0-60]

Defines the periodicity of periodical logs.

Category: Device

w Device Device Architecture
w CoreEngine
Kernel
Watchdog
Deploy

[] Use a custom device architecture

~ Feature
Device Uni D
Dynamic Download evice Lnique

w Libraries [ Use a custom device unique ID
w ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Device Architecture

Option(checkbox): Use a custom device architecture

Option Name: s3.mock.device.architecture.option.use

Default value: false

Option(text): Architecture Name

Option Name: s3.mock.device.architecture.option

Default value: (empty)

Group: Device Unique ID

Option(checkbox): Use a custom device unique ID

Option Name: s3.mock.device.id.option.use

Default value: false
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Option(text): Unique ID (hexadecimal value)

Option Name: s3.mock.device.id.option

Default value: (empty)

Category: Com Port

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs
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Category: Libraries

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: EDC

w Device Java System.out

v Cor;:rr;gewlne [ Use a custom Java output stream
Watchdog
Deploy
w Feature

Runti ti
Dynamic Download B

~ Libraries Embed UTF-8 enceding
v ECOM .
Comm Connection []Enable SecurityManager checks
EDC
External Resources Loader
Shielded Plug

~ Runtime
Memary

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Java System.out
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Option(checkbox): Use a custom Java output stream

Option Name: core.outputstream.disable.uart

Default value: false

Description:

Select this option to specify another Java System.out print stream.

If selected, the default Java output stream is not used by the Java application. the JPF will not use the default Java
output stream at startup.

Option(text): Class

Option Name: core.outputstream.class

Default value: (empty)

Description:

Format: Java class like packageA.packageB.className
Defines the Java class used to manage System.out.

At startup the JPF will try to load this class using the Class.forName() method. If the given class is not available,
the JPF will use the default Java output stream as usual. The specified class must be available in the application
classpath.

Group: Runtime options

Description:

Specifies the additional classes to embed at runtime.

Option(checkbox): Embed UTF-8 encoding

Option Name: cldc.encoding.utf8.included
Default value: true
Description:

Embed UTF-8 encoding.

Option(checkbox): Enable SecurityManager checks

Option Name: com.microej.library.edc.securitymanager.enabled
Default value: false
Description:

Enable the security manager runtime checks.
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Category: Shielded Plug

v Device Shielded Plug configuration
v CoreEngine
Kernel Database definition: Browse...
Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Shielded Plug configuration

Description:

Choose the database XML definition.

Option(browse): Database definition

Option Name: sp.database.definition
Default value: (empty)
Description:

Choose the database XML definition.
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Category: ECOM

w Device Device Management

v CoreEngine ] ) -
Kernel [ Enable registration event notifications
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Device Management
Option(checkbox): Enable registration event notifications

Option Name: com.is2t.ecom.eventpump.enabled
Default value: false
Description:

Enables notification of listeners when devices are registered or unregistered. When a device is registered or un-
registered, a new ej.ecom.io.RegistrationEvent isadded to an event queue. Then events are processed by a
dedicated thread that notifies registered listeners.

Option(text): Registration events queue size

Option Name: com.is2t.ecom.eventpump.size
Default value: 5
Description:

Specifies the size (in number of events) of the registration events queue.
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Category: Comm Connection

w Device Comm Connection Options

w CoreEngine

Kernel []Enable comm connections

Watchdog
Deploy Device Management

v Feature Enable dynamic comm ports registration
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Comm Connection Options

Description:

This group allows comm connections to be enabled and application-platform mappings set.

Option(checkbox): Enable comm connections

Option Name: use.comm.connection
Default value: false
Description:

When checked application is able to open a CommConnection.

Group: Device Management
Option(checkbox): Enable dynamic comm ports registration

Option Name: com.is2t.ecom.comm.registryPump.enabled
Default value: false
Description:

Enables registration (or unregistration) of ports dynamically added (or removed) by the platform. A dedicated
thread listens for ports dynamically added (or removed) by the platform and adds (or removes) their CommPort
representation to the ECOM DeviceManager .
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Category: External Resources Loader

<

Device External Resources Loader

v CoreEngine

Kernel Folder where are stored the resources which will be pregrammed outside CPU address
space range (storage media like SD card, serial NOR flash, EEPROM).
Watchdog The resources which will be linked into the CPU address space range (internal
Deploy device memeories, external parallel memories) must be listed in the Resources box
w Feature of Main tab.

Dynamic Download

~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime

Browse...

Memory

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: External Resources Loader

Description:

This group allows to specify the external resources input folder. The content of this folder will be copied in an
application output folder and used by SOAR and the Simulator. If empty, the default location will be [output
folder]/externalResources, where [output folder] is the location defined in Execution tab.

Option(browse):

Option Name: ej.externalResources.input.dir
Default value: (empty)
Description:

Browse to specify the external resources folder..
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Category: Device

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: Core Engine

v Device
v CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memary
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Memory

Specify target options

Memory

Maximum number of monitors per thread

Maximum number of frames dumped on OutOfMemoryError
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Option(text):

Option Name: core.memory.thread.max.nb.monitors
Default value: 8
Description:

Specifies the maximum number of monitors a thread can own at the same time.

Option(text):

Option Name: core.memory.oome.nb.frames
Default value: 5
Description:

Specifies the maximum number of stack frames that can be dumped to the standard output when Core Engine
throws an OutOfMemoryError.

Category: Kernel

Device

<

[] Check APIs allowed by Kernel
v CoreEngine

Kernel Threads
Watchdog
Deploy
~ Feature

Maximum number of threads per Feature | |

Installed Features
Dynamic Download

w Libraries Maximum number of installed Features | |
v ECOM
Comm Connection Code Size (in bytes) | |
EDC
External Resources Loader Runtime Size (in bytes) | |
Shielded Plug
~ Runtime

Memary

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Check APIs allowed by Kernel

Option Name: apis.check.enable

Default value: true
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Group: Threads
Option(text):

Option Name: core.memory.feature.max.threads
Default value: 5
Description:

Specifies the maximum number of threads a Feature is allowed to use at the same time.

Group: Installed Features
Option(text):

Option Name: core.memory.installed.features.max
Default value: 0
Description:

Specifies the maximum number of installed Features that can be added to this Kernel.

Option(text):

Option Name: core.memory.installed.features.text.size
Default value: ©
Description:

Specifies the size in bytes reserved for installed Features code.

Option(text):

Option Name: core.memory.installed.features.bss.size
Default value: ©
Description:

Specifies the size in bytes reserved for installed Features runtime memory.
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Category: Watchdog

v Device
+ CoreEngine [ Enable watchdog support

Kernel Watchdog
Watchdog Mazximum number of active watchdogs
Deploy

w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Enable watchdog support

Option Name: enable.watchdog. support

Default value: true

Group: Watchdog
Option(text):

Option Name: maximum.active.watchdogs
Default value: 4

Description:

Specifies the maximum number of active watchdogs at the same time.
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Category: Deploy

~ Device Configuration

v CoreEngine
Kemgel [ Deploy the compiled MicroE) application in a folder in MicroE) application main class project
Watchdog
Deploy
w Feature

Output file: | Browse...

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Description:

Configures the output location where store the MicroEJ Application, the MicroEJ platform libraries and header files.

Group: Configuration

Option(checkbox): Deploy the compiled MicroEJ Application in a folder in MicroEJ Application main class
project

Default value: true
Description:

Deploy the compiled MicroEJ Application in a folder in MicroEJ Application’s main class project.

Option(browse): Output file

Option Name: deploy.copy.filename
Default value: (empty)
Description:

Choose an output file location where copy the compiled MicroEJ Application.
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Category: Feature

e [‘J'ewcc:re Engine Specify Feature options
Kernel
Watchdog
Deploy
~ Feature
Dynamic Download
w Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Description:

Specify Feature options
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Category: Dynamic Download

v Device Dynamic Download
v CoreEngine
Kernel Output Name: |
Watchdog
Deploy Kernel: | F—
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Dynamic Download
Option(text): Output Name

Option Name: feature.output.basename

Default value: application

Option(browse): Kernel

Option Name: kernel.filename

Default value: (empty)

3.3.6 SOAR

SOAR complies with the deterministic class initialization ( <clinit>) order specified in /[BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

An explicit clinit dependency can be declared by creating an XML file with the .clinitdesc extension in the ap-
plication classpath. The file has the following format:

<?xml version='1.0' encoding='UTF-8'?>
<clinit>
(continues on next page)
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(continued from previous page)

<type name="T1" depends="T2"/>
</clinit>

where T1 and T2 are fully qualified names on the form a.b.C. This explicitly forces SOAR to create a dependency
from T1 to T2, and therefore cuts a potentially detected dependency from T2 to T1.

Aclinit map file (ending with extension .clinitmap)is generated beside the SOAR object file. It describes for each
clinit dependency:

+ the typesinvolved
« the kind of dependency

« the stack calls between the two types

3.4 Sandboxed Application

3.4.1 Sandboxed Application Structure

Application Skeleton Creation

The first step to explore a Sandboxed Application structure is to create a new project.

Firstselect File > New > MicroEJ Sandboxed Application Project :

Fillin the application template fields, the Project name field will automatically duplicate in the following fields.

A template project is automatically created and ready to use, this project already contains all folders wherein de-
velopers need to put content:

src/main/java Folder for future sources;
src/main/resources Folder for future resources (images, fonts etc.);
META-INF Sandboxed Application configuration and resources;

module.ivy Ivyinput file, dependencies description for the current project.

Sources Folder

The project source folder ( src/main) contains two subfolders: java and resources. java folder will contain all
*. java files of the project, whereas resources folder will contain elements that the application needs at runtime
like raw resources, images or character fonts.

META-INF Folder

The META-INF folder contains several folders and a manifest file. They are described hereafter.
certificate (folder) Contains certificate information used during the application deployment.

libraries (folder) Contains a list of additional libraries useful to the application and not resolved through the
regular transitive dependency check.

properties (folder) Containsan application.properties file which contains application specific properties
that can be accessed at runtime.
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services (folder) Contains a list of files that describe local services provided by the application. Each file name
represents a service class fully qualified name, and each file contains the fully qualified name of the provided
service implementation.

wpk (folder) Contains a set of applications ( .wpk files) that will be started when the application is executed on
the Simulator.

MANIFEST.MF (file) Containsthe information given at project creation, extra information can be added to this file
to declare the entry points of the application.

module.ivy File

The module.ivy file describes all the libraries required by the application at runtime. The lvy classpath container
lists all the modules that have been automatically resolved from the content of module.ivy . See MicroEJ Module
Manager for more informations about MicroEJ Module Manager.

3.4.2 Application Publication

Build the WPK

When the application is ready for deployment, the last step in MicroEJ Studio is to create the WPK (Wadapps Pack-
age) file that is intended to be published on a MicroEJ Forge instance for end users.

In MicroEJ Studio, right-click on the Sandboxed Application project name and select Build Module.

The WPK build process will display messages in MicroEJ console, ending up the following message:

[echo] project hello published locally with version 0.1.0-RC201907091602
BUILD SUCCESSFUL

Total time: 1 minute 6 seconds

Publish on a MicroEJ Forge Instance

The WPK file produced by the build process is located in a dedicated target~/artifacts folderin the project.

The .wpk fileis ready to be uploaded to a MicroEJ Forge instance. Please consult https://community.microej.com
for more information.

3.4.3 Shared Interfaces
Principle

The Shared Interface mechanism provided by MicroEJ Core Engine is an object communication bus based on plain
Java interfaces where method calls are allowed to cross MicroEJ Sandboxed Applications boundaries. The Shared
Interface mechanism is the cornerstone for designing reliable Service Oriented Architectures on top of MicroEJ.
Communication is based on the sharing of interfaces defining APIs (Contract Oriented Programming).

The basic schema:
« Aprovider application publishes an implementation for a shared interface into a system registry.

+ Auser application retrieves the implementation from the system registry and directly calls the methods de-
fined by the shared interface.
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USER APPLICATION PROVIDER APPLICATION

Shared Interface Call

AA.mm() > mm() {
//code

}

MICROEJ CORE ENGINE

Fig. 15: Shared Interface Call Mechanism

Shared Interface Creation

Creation of a shared interface follows three steps:
« Interface definition,
« Proxy implementation,

+ Interface registration.

Interface Definition

The definition of a shared interface starts by defining a standard Java interface.

package mypackage;

public interface MyInterface(
void foo();

3

To declare an interface as a shared interface, it must be registered in a shared interfaces identification file. A shared
interface identification file is an XML file with the .si suffix with the following format:

<sharedInterfaces>
<sharedInterface name="mypackage.MyInterface"/>
</sharedInterfaces>

Shared interface identification files must be placed at the root of a path of the application classpath. For a MicroEJ
Sandboxed Application project, it is typically placed in src/main/resources folder.
Some restrictions apply to shared interface compared to standard java interfaces:

+ Types for parameters and return values must be transferable types;

« Thrown exceptions must be classes owned by the MicroEJ Firmware.

Transferable Types

In the process of a cross-application method call, parameters and return value of methods declared in a shared
interface must be transferred back and forth between application boundaries.
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USER APPLICATION Shared Interface Transfer [FHMSALCSS AR IREL.

R = AA.mm(P1, P2)

Fig. 16: Shared Interface Parameters Transfer

Shared Interface Types Transfer Rules describes the rules applied depending on the element to be transferred.

Table 1: Shared Interface Types Transfer Rules

Type Owner Instance Rule
Owner

Base type N/A N/A Passing by value. (boolean, byte, short
, char, int, long, double, float)

Any Class, Array or Inter- | Kernel Kernel Passing by reference

face

Any Class, Array or Inter- | Kernel Application Kernel specific or forbidden

face

Array of base types Any Application Clone by copy

Arrays of references Any Application | Clone and transfer rules applied again on
each element

Shared Interface Application Application Passing by indirect reference (Proxy cre-
ation)

Any Class, Array or Inter- | Application Application Forbidden

face

Objects created by an application which class is owned by the Kernel can be transferred to another application
if this has been authorized by the Kernel. The list of eligible types that can be transferred is Kernel specific, so
you have to consult the firmware specification. MicroEJ Evaluation Firmware Example of Transfer Types lists Kernel
types allowed to be transferred through a shared interface call. When an argument transfer is forbidden, the call is
abruptly stopped and a java.lang.IllegalAccessError isthrown by MicroEJ Core Engine.

Table 2: MicroEJ Evaluation Firmware Example of Transfer Types

Type Rule
Clone by copy

java.lang.String

. . Proxy reference creation
java.io.InputStream

Clone by deep copy

java.util.Map<String,String>

Proxy Class Implementation

The Shared Interface mechanism is based on automatic proxy objects created by the underlying MicroEJ Core En-
gine, so that each application can still be dynamically stopped and uninstalled. This offers a reliable way for users
and providers to handle the relationship in case of a broken link.

Once a Java interface has been declared as Shared Interface, a dedicated implementation is required (called the
Proxy class implementation). Its main goal is to perform the remote invocation and provide a reliable implemen-
tation regarding the interface contract even if the remote application fails to fulfill its contract (unexpected excep-
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tions, application killed...). The MicroEJ Core Engine will allocate instances of this class when an implementation
owned by another application is being transferred to this application.

USER APPLICATION PROVIDER APPLICATION

R = AA.mm(P1, P2

Proxy Class

MICROEJ CORE ENGINE

Transfer

Shared Interfaces Binding

Fig. 17: Shared Interfaces Proxy Overview

A proxy class is implemented and executed on the client side, each method of the implemented interface must be
defined according to the following pattern:

package mypackage;
public class MyInterfaceProxy extends Proxy<MyInterface> implements MyInterface {

@0verride
public void foo(){
try {
invoke(); // perform remote invocation
} catch (Throwable e) {
e.printStackTrace();

b
3

Each implemented method of the proxy class is responsible for performing the remote call and catching all errors
from the server side and to provide an appropriate answer to the client application call according to the interface
method specification (contract). Remote invocation methods are defined in the super class ej.kf.Proxy and are
named invokeXXX() where XXX is the kind of return type. As this class is part of the application, the application
developer has the full control on the Proxy implementation and is free to insert additional code such as logging
calls and errors for example.

Table 3: Proxy Remote Invocation Built-in Methods

Invocation Method Usage
void invoke() Remote invocation for a proxy method that returns void
Object invokeRef() Remote invocation for a proxy method that returns a reference

boolean invokeBoolean(), byte invokeByte(), | Remote invocation for a proxy method that returns a base type
char invokeChar(), short invokeShort(), int in-
vokelnt(), long invokeLong(), double invoke-
Double(), float invokeFloat()
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3.5 Virtual Device

3.5.1 Using a Virtual Device for Simulation

The Virtual Device includes the same custom MicroEJ Core, libraries and System Applications as the real device.
The Virtual Device allows developers to run their applications either on the Simulator, or directly on the real device
through local deployment.

The Simulator runs a mockup board support package (BSP Mock) that mimics the hardware functionality. An ap-
plication on the Simulator is run as a Standalone Application.

Before an application is locally deployed on device, MicroEJ Studio ensures that it does not depend on any API that
is unavailable on the device.

YOUR APPLICATION

L

8 ADD-ON LIBRARIES

(@)

<

= FOUNDATION LIBRARIES

)
Graphical Low Level API

w © MEJ S (Abstrac. Layeb

o LLLLRRLE]

o

()

E - -

2 Linux/Windows

\C)‘ Your Lib

YOUR HARDWARE

Fig. 18: MicroEJ Virtual Device Architecture

3.5.2 Runtime Environment

The set of MicroEJ APIs exposed by a Virtual Device (and therefore provided by its associated firwmare) is docu-
mented in Javadoc format in the MicroEJ Resource Center ( Window > Show View > MicroEJ Resource Center

).

3.5. Virtual Device |



MicroEJ Documentation, Revision 4€20bb27

i® MicroE) Resource Center 53
type filter text

4 | 2] Javadoc
[ MICROEJ-DEVELOPER-RUNTIME 1.0

- @2 Online Resources

Fig. 19: MicroEJ Resource Center APIs

3.6 MicroEJ Module Manager

3.6.1 Introduction

Modern electronic device design involves many parts and teams to collaborate to finally obtain a product to be sold
on its market. MicroEJ encourages modular design which involves various stake holders: hardware engineers, UX
designers, graphic designers, drivers/BSP engineers, software engineers, etc.

Modular design is a design technique that emphasizes separating the functionality of an application into inde-
pendent, interchangeable modules. Each module contains everything necessary to execute only one aspect of
the desired functionality. In order to have team members collaborate internally within their team and with other
teams, MicroEJ provides a powerful modular design concept, with smart module dependencies, controlled by the
MicroEJ Module Manager (MMM). MMM frees engineers from the difficult task of computing module dependencies.
Engineers specify the bare minimum description of the module requirements.

The following schema introduces the main concepts detailed in this chapter.
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/ OptlonsJ File J

MICROEJ.SDK
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MMM
v 'l:‘,{ module
(® src/main/java
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v =)\ Module Dependencies module.ivy "}« = [
s edc-1.3.0,jar - C:\Users\user\.micrc Module Dependenaes

(= internal
= src
[#) CHANGELOG.md

Module i) LICENSEtxt Build & Publish Module

Description by module.ivy »  Module Repository
File (] README.md
I 4

Module Project Skeleton

Fig. 20: MMM Overview

MMM is based on the following tools:
« Apache lvy (http://ant.apache.org/ivy) for dependencies resolution and module publication;

« Apache EasyAnt (https://ant.apache.org/easyant/history/trunk/reference.html) for module build from
source code.

3.6.2 Specification

MMM provides a non ambiguous semantic for dependencies resolution. Please consult the MMM specification
available on https://developer.microej.com/packages/documentation/TLT-0831-SPE-MicroEJModuleManager-2.
0-D.pdf.

3.6.3 Module Project Skeleton

In MicroEJ SDK, a new MicroEJ module project is created as following:

+ Select File > New > Project... ,

« Select MicroEJ > MicroEJ Module Project ',

« Fill the module information (project name, module organization, name and revision),
+ Select one of the suggested skeletons depending on the desired module nature,

« Clickon Finish .

11f using MicroEJ SDK versions lower than 5.2.0, please refer to the following section.
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The project is created and a set of files and directories are generated from the selected skeleton.

Note: When an empty Eclipse project already exists or when the skeleton has to be created within an existing
directory, the MicroEJ module is created as following:

« In the Package Explorer, click on the parent project or directory,

« Select File > New > Other... ,

+ Select EasyAnt > EasyAnt Skeleton .

3.6.4 Module Description File

Amodule descriptionfileisan lvy configuration filenamed module. ivy, located at the root of each MicroEJ module
project. It describes the module nature (also called build type) and dependencies to other modules.

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org” xmlns:m="http://ant.apache.org/ivy/extra"
xmlns:ej="https://developer.microej.com” ej:version="2.0.0">
<info organisation="[organisation]” module="[name]" status="integration” revision="[version]">
<ea:build organisation="com.is2t.easyant.buildtypes” module="[buildtype_namel]” revision=
—"[buildtype_version]">
<ea:property name="[buildoption_name]"” value="[buildoption_value]"/>
</ea:build>
</info>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default” visibility="public"/>
<conf name="provided" visibility="public"/>
<conf name="documentation” visibility="public"/>
<conf name="source" visibility="public"/>
<conf name="dist"” visibility="public"/>
<conf name="test"” visibility="private"/>
</configurations>

<publications>
</publications>

<dependencies>
<dependency org="[dep_organisation]” name="[dep_name]” rev="[dep_version]"/>
</dependencies>
</ivy-module>

3.6.5 MicroEJ Module Manager Configuration

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from
MicroEJ Central Repository and to publish built modules to a local folder. The repository configura-
tion is stored in a settings file ( ivysettings.xml ), and the default one is located at $USER_HOME\.
microej\microej-ivysettings-[VERSION].xml

Preferences Page

The MMM preferences page is available at Window > Preferences > MicroEJ > Module Manager .
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& Preferences

type filter text Module Manager - r v
General
Ant Module Repository
C/Ces (1) Settings File: | C\Users\user\.microgj\microej-ivysettings-3.ml ‘
Checkstyle
Help Default | Workspace... | | File System...
Install/Update
Java Import Repository
w Microk) Options
Architectures
Module Manager (2) propery fes: Edit...
Maming Convention Pt
Platforms
Platforms in workspace Remove
Settings
Updates Up
Wirtual Devices D
Mybyn own
Plug-in Development Build Repoci
PMD uild Repaository
Run/Debug 3 [ Use Module repository as Build repository
Senarlint (4) Settings File: | C:\Program Files\MicroEl\MicroE)-SDK-20.0T\rcpl\configuration'org.eclipse.osgi\9\data\repositories\microej-build-repositony\ivysettings.xml Browse...
Team
Termi Export Build Kit
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() Runtime JRE: jre1.8.0_221 v
(7) Max build history size: | 5
< 5 Restore Defaults Apply
® Apply and Close Cancel

Fig. 21: MMM Preferences Page

This page allows to configure the following elements:

1.
2.
3.

Settings File: the file describing how to connect module repositories. See the settings file section.

Options: files declaring MMM options. See the Options section.

Use Module repository as Build repository:thesettings file for connecting the build repositoryin place
of the one bundled in MicroEJ SDK. This option shall not be enabled by default and is reserved for advanced
configuration.

Build repository Settings File:the settings file for connecting the build repository in place of the one
bundled in MicroEJ SDK. This option is automatically initialized the first time MicroEJ SDK is launched. It
shall not be modified by default and is reserved for advanced configuration.

Set verbose mode : to enable advanced debug traces when building a module.
Runtime JRE :the Java Runtime Environment that executes the build process.
Max build history size:the maximum number of previous builds available in Build Module shortcut

list:

3

File Refactor Mavigate Search  Project  Run
cruoiv[@]Jeis-0-a-i@e-

4 Package Explorer 33 | ) Build Selected Module (Ctrl+Alt-C, E)

workspaceRepository -

Edit Source
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Settings File

The settings file is an XML file that describes how MMM connects local or online module repositories. The file format
is described in Apache lvy documentation.

To configure MMM to a custom settings file (usually from an offline repository):

1. Set Settings file toacustom ivysettings.xml settings file',

2. Clickon Apply and Close button

If the workspace is not empty, it is recommended to trigger a full resolution and rebuild all the projects using this
new repository configuration:

1. Clean caches

« In the Package Explorer, right-click on a project;
« Select Ivy > Cleanallcaches .
2. Resolve projects using the new repository

To resolve all the workspace projects, click on the Resolve All button in the toolbar:

'® workspaceRepository -

File Edit Source Refactor Mavigate Searc

A | B4~ (

To only resolve a subset of the workspace projects:

« In the Package Explorer, select the desired projects,
+ Right-click on a project and select lvy > Clean all caches .
3. Trigger Add-On Library processors for automatically generated source code

+ Select Project > Clean... ,
+ Select Clean all projects |,

o Clickon Clean button.

Options

Options can be used to parameterize a module description file or a settings file. Options are declared as key/value
pairsin a standard Java properties file, and are expanded using the ${my_property} notation.

Atypical usage in a settings file is for extracting repository server credentials, such as HTTP Basic access authenti-
cation:

1. Declare options in a properties file
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[E| credentials.properties &

1# User specific credentials
2 artifactory.username=myusername
3 artifactory.password=AKCKLzp2JHRLDyFvmTPMXocXiiU1Cnad7eidUcCO1ERSUdgIrIu24ZTYieXaCwuMaIWykjCD9

4

2. Register this property file to MMM options

Options

Property files: | Sfworkspace_loctest/credentials.properties}

3. Usethis option in a settings file

38
39 <credentials host="artifactory.corp” realm="Artifactory Realm” username="${artifactory.username}” passwd="$§{artifactory.password}” />
4/

Atypical usage in a module description file is for factorizing dependency versions across multiple modules projects:

1. Declare an option in a properties file

=| versions.properties &3

=l
14# Specify the EDC wersion used in this workspace
2 edc.version=1.3.8

pu

2. Register this property file to MMM options

Options

Property files: | S{workspace_loc:test/versions.properties)

3. Use this option in a module description file

22 <dependencies:

23 ol--

24 Use the EDC version defined by MMM configuration

25 -

26 <dependency org="ej.api" name="edc" rev="%{edc.version}" /»
27 </dependencies:

28 ¢/ivy-module:
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3.6.6 Build Kit

The Module Manager build kit is the consistent set of tools and scripts required for building modules.

It is bundled with MicroEJ SDK and can be exported to run in headless mode using the following steps:'

+ Select File > Export > MicroEJ > Module Manager Build Kit ,
+ Choose an empty Target directory ,

+ Clickonthe Finish button.
Once the build kit is fully exported, the directory content shall look like:

v [ = sdlk_5.2.0_build_kit
w [ ant
= lib
microg)-build-repositony.zip

To go further with headless builds, please consult Tool-CommandLineBuild for command line builds, and this tu-
torial to setup MicroEJ modules build in continuous integration environments).

3.6.7 Former MicroEJ SDK Versions

This section describes MMM configuration elements for MicroEJ SDK versions lower than 5.2.0.

New MicroEJ Module Project

The New MicroEJ Module Project wizard is availableat File > New > Project... , EasyAnt > EasyAnt Project

Preferences Pages

MMM Preferences Pages are located in two dedicated pages. The following pictures show the options mapping
using the same options numbers declared in Preferences Page.

lvy Preferences Page

The lvy Preferences Page is available at Window > Preferences > Ivy > Settings .
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® preferences

type filter text Settings le=T 4 - -
General A
Ant [ reload the settings only on demand
C/C++
Checkstyle
Copyright Default | Workspace... | | File System... | Variables...
EasyantdEclipse

(l) Ivy settings path: | CA\Users\user\. microgj\microej-ivysettings-3xml |

Help Ivy user dir: ‘ |
lceTea
Install/Update

Workspace... | | File System... | Variables...

Instant Messaging .
v vy (2) Property files: | S{workspace_loc:easyant-build-component/ivy/ivyDE.properties} Edit
Ad d S{workspace_loc:easyant-build-component/ivy/ivyDE_windows.properties}
vancet
Add
Classpath Container
Security Remove
Settings
Source/Javadoc Map Up
Workspace Resolver
D
XML Editor o
Java
JavaScript
< i > v Restore Defaults Apply

@ Apply and Close Cancel

Easyant Preferences Page

The Easyant Preferences Page is available at Window > Preferences > EasyAnt4Eclipse .

® preferences

type filter text Easyant4Eclipse e T

G 1
Ae: era Set preferences for EasyAntdEclipse.
n

CiCes (5) [[]5et verbose mode
Checkstyle (3) [] Use lvyDE preferences for lvy settings path
Copyright (4) Ivy settings path: | C:\Program Files\MicroEN\MicroE)-SDK-19.05\rep\configuration\org.eclipse.osgi\ 346\0\.cp\repositories\ivysettings.xml Browse..,
Easyant4Eclipse
Help (7) Max build history size: I 5
(6) Runtime JRE jre180.221 v

lceTea
Install/Update
Instant Messaging
v vy
Advanced
Classpath Container
Security
Settings v
< >

® Apply and Close Cancel

Restore Defaults Apply

Export the Build Kit

« Create an empty directory (e.g. mmm_sdk_[version]_build_kit),

+ Locate your SDK installation plugins directory (by default, C:\Program Files\MicroEJ\MicroEJ
SDK-[version]\rcp\plugins on Windows OS),

« Openthefile com.is2t.eclipse.plugin.easyant4e_[version].jar with anarchive manager,
« Extract the directory 1ib to the target directory,

« Openthefile com.is2t.eclipse.plugin.easyant4e.offlinerepo_[version].jar with an archive man-
ager,

+ Navigate to directory repositories,
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« Extractthefilenamed microej-build-repository.zip forMicroEJSDK 5.x or is2t_repo.zip for MicroEJ
SDK 4.1.x to the target directory.

3.7 Module Natures

The following table describes the project skeleton name for most common MicroEJ Module Natures.

Table 4: MicroEJ Module Natures Summary

Module Nature Skeleton Direct Wizard
Name
Add-On Library microej- File > New > MicroEJ Add-On Library Project
javalib
Mock microej-
mock
Module Repository artifact-
repository
Sandboxed Application application | File > New > MicroEJ Sandboxed Application Project
Standalone Application firmware- File > New > MicroEJ Standalone Application Project
singleapp

3.7.1 Module Repository

A module repository is a module that bundles a set of modules in a portable ZIP file. It is a tree structure where
modules organizations and names are mapped to folders.

3.7. Module Natures
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Fig. 22: Example of MicroEJ Module Repository Tree

A module repository takes its input modules from other repositories, usually the MicroEJ Central Repository which
is itself built by MicroEJ Corp. as a module repository.
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A module repository is often called an offline repository as it includes the settings file for a local configuration in
MicroEJ SDK. It can also be imported in MicroEJ Forge.

Create a Repository Project

In MicroEJ SDK, first create a new module project using the artifact-repository skeleton.

« The ivysettings.xml settings file describes how to import the modules of this repository when it is ex-
tracted locally on file system. This file will be packaged at the root of the zip file and does not need to be
modified.

« The module.ivy file describes how to build repository and lists the module dependencies that will be in-
cluded in this repository.

Configure Resolver for Input Modules

MicroEJ Module Manager (MMM) needs to import dependencies to build the module repository. The location
fetched by MMM is defined by a resolver. The resolver is configured with the parameter bar.populate.from.
resolver . The preset value is the resolver provided by default in MicroEJ SDK configuration, which is connected
to MicroEJ Central Repository.

<ea:property name="bar.populate.from.resolver” value="MicroEJChainResolver"/>

The MicroEJChainResolver is a URL resolver  defined in $USER_HOME\ .
microej\microej-ivysettings-[VERSION].xml that pointsto MicroEJ Central Repository.

To ensure the repository will be compliant with the MMM specification, add the following option:

<ea:property name="bar.check.as.v2.module” value="true"/>

There are other advanced options that do not need to be modified by default. These options are described in the
module.ivy generated by the skeleton.

Include Modules

Modules bundled into the module repository must be declared in the dependencies element of the module.ivy
file.

Include a Single Module

To add a module, declare the module dependency using the artifacts configuration:
<dependencies>
<dependency conf="artifacts->*" transitive="false"” org="[module_orgl” name="[module_name]"” rev=

—"[module_version]"” />

<!-- ... other dependencies ... -->
</dependencies>

For example, to add the ej.api.edc libraryversion 1.2.3, write the following line:

<dependency conf="artifacts->x" transitive="false" org="ej.api" name="edc" rev="1.2.3" />
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Note: We recommended to manually describe each dependency of the module repository, in order to keep full
controloftheincluded modules as well asincluded modules versions. Module dependencies can still be transitively
included by setting the dependency attribute transitive to true. In this case, the included module versions are
those that have been resolved when the module was built.

Multiple versions of the same module can be included by declaring each dependency using a different configura-
tion. The artifacts configuration has to be derived with a new name as many times as there are different versions
toinclude.

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="artifacts"” visibility="private"/>
<conf name="artifacts_1" visibility="private"/>
<conf name="artifacts_2" visibility="private"/>

<!-- ... other configurations ... -->
</configurations>

<dependencies>

<dependency conf="artifacts->x" transitive="false"” org="[module_orgl]" name="[module_name]"” rev=
—"[module_version_1]1" />

<dependency conf="artifacts_1->*" transitive="false"” org="[module_org]"” name="[module_namel" rev=
—"[module_version_2]" />

<dependency conf="artifacts_2->*" transitive="false"” org="[module_org]"” name="[module_name]" rev=
—"[module_version_3]1" />

<!-- ... other dependencies ... -->
</dependencies>

Include a Module Repository

To add all the modules already included in an other module repository, declare the module repository dependency
using the repository configuration:

<dependencies>
<dependency conf="repository->*" transitive="false"” org="[repository_orgl" name="[repository_namel]”_
—rev="[repository_version]" />

<!-- ... other dependencies ... -->
</dependencies>

Build the Repository

In the Package Explorer, right-click on the repository project and select Build Module.
The build consists of two steps:

1. Gathers all module dependencies. The whole repository content is created under target~/
mergedArtifactsRepository folder.

2. Checks the repository consistency. For each module, it tries to import it from this repository and fails the
build if at least one of the dependencies cannot be resolved.

The module repository .zip fileisbuiltinthe target~/artifacts/ folder. This file may be published along with
a CHANGELOG.md, LICENSE. txt and README.md.
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Use the Offline Repository

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from MicroEJ
Central Repository.

To configure MicroEJ SDK to import dependencies from a local module repository:
1. Unzip the module repository .zip file to the folder of your choice,

2. Configure MMM settings file using the ivysettings.xml file located at the root of the folder where the repos-
itory has been extracted.

3.8 MicroEJ Classpath

MicroEJ Applications run on a target device and their footprint is optimized to fulfill embedded constraints. The
final execution context is an embedded device that may not even have a file system. Files required by the appli-
cation at runtime are not directly copied to the target device, they are compiled to produce the application binary
code which will be executed by MicroEJ Core Engine.

As a part of the compile-time trimming process, all types not required by the embedded application are eliminated
from the final binary.

MicroEJ Classpath is a developer defined list of all places containing files to be embedded in the final application
binary. MicroEJ Classpath is made up of an ordered list of paths. A path is either a folder or a zip file, called a JAR
file (JAR stands for Java ARchive).

« Application Classpath explains how the MicroEJ Classpath is built from a MicroEJ Application project.

« Classpath Load Model explains how the application contents is loaded from MicroEJ Classpath.

« Classpath Elements specifies the different elements that can be declared in MicroEJ Classpath to describe
the application contents.

3.8.1 Application Classpath

The following schema shows the classpath mapping from a MicroEJ Application project to the MicroEJ Classpath
ordered list of folders and JAR files. The classpath resolution order (left to right) follows the project appearance
order (top to bottom).
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> (03 extrajar —_— }MyApplication/METAfINF/libraries/extra .jar
> [ src-adpgenerated/wadapps/java
v (= META-INF
» [= certificate
v (= libraries
bt extrajar
» [= properties
&' MANIFEST.MF
v [ src
&= main
» [ src-adpgenerated
[%] CHANGELOG.md
= LICENSE.tdt
ko module.ivy
[¥] README.md

Fig. 23: MicroEJ Application Classpath Mapping

3.8.2 Classpath Load Model

A MicroEJ Application classpath is created via the loading of :

+ an entry point type,

« all . [extension].list files declaredin a MicroEJ Classpath.
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The different elements that constitute an application are described in Classpath Elements. They are searched within
MicroEJ Classpath from left to right (the first file found is loaded). Types referenced by previously loaded MicroEJ
Classpath elements are loaded transitively.
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Fig. 24: Classpath Load Principle

3.8.3 Classpath Elements

The MicroEJ Classpath contains the following elements:

« An entrypoint described in section Application Entry Points;

« Typesin .class files, described in section Types;
« Raw resources, described in section Raw Resources;

« Immutables Object data files, described in Section Immutable Objects;

+ Images, Fonts and Native Language Support (NLS) resources, described in Application Resources;

« x.[extension].list files, declaring contents to load. Supported list file extensions and format is specific
to declared application contents and is described in the appropriate section.

At source level, Java types are stored in src/main/java folder of the module project, any other kind of resources
and list files are stored in the src/main/resources folder.

Application Entry Points

MicroEJ Application entry point declaration differs depending on the application kind:

« In case of a MicroEJ Standalone Application, it is a class that contains a public static void
main(String[]) method, declared using the option application.main.class.
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« In case of a MicroEJ Sandboxed Application, it is a class that implements ej.kf.FeatureEntryPoint , de-
clared inthe Application-EntryPoint entryin META-INF/MANIFEST.MF file.

Types
MicroEJ types (classes, interfaces) are compiled from source code ( . java) to classfiles ( .class ). When a type is
loaded, all types dependencies found in the classfile are loaded (transitively).
Atype can be declared as a Required type in order to enable the following usages:
+ to be dynamically loaded from its name (with a call to Class.forName(String) );
« to retrieve its fully qualified name (with a call to Class.getName() ).

A type that is not declared as a Required type may not have its fully qualified name (FQN) embedded. Its FQN can
be retrieved using the stack trace reader tool (see Stack Trace Reader).

Required Types are declared in MicroEJ Classpath using *.types.list files. The file format is a standard Java
properties file, each line listing the fully qualified name of a type. Example:

# The following types are marked as MicroEJ Required Types
com.mycompany .MyImplementation
java.util.Vector

Raw Resources

Raw resources are binary files that need to be embedded by the application so that they may be dynamically re-
trieved with a call to Class.getResourceAsStream(java.io.InputStream) . Raw Resources are declared in Mi-
croEJ Classpath using *.resources.list files. The file format is a standard Java properties file, each line is a
relative / separated name of a file in MicroEJ Classpath to be embedded as a resource. Example:

# The following resource is embedded as a raw resource
com/mycompany/MyResource. txt

Others resources types are supported in MicrokJ Classpath, see Application Resources for more details.

Immutable Objects

Immutables objects are regular read-only objects that can be retrieved with a call to ej.bon.Immutables.
get(String) . Immutables objects are declared in files called immutable objects data files, which format is de-
scribed in the [BON] specification. Immutables objects data files are declared in MicroEJ Classpath using *.
immutables.list files. The file format is a standard Java properties file, each lineis a / separated name of a
relative file in MicroEJ Classpath to be loaded as an Immutable objects data file. Example:

# The following file is loaded as an Immutable objects data files
com/mycompany/MyImmutables.data

System Properties
System Properties are key/value string pairs that can be accessed with a call to System.getProperty(String) .

System properties are declared in MicroEJ Classpath *.properties.list files. The file formatis a standard Java
properties file. Example:
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Listing 1: Example of Contents of a MicroEJ Properties File

# The following property is embedded as a System property
com.mycompany . key=com.mycompany . value
microedition.encoding=I1S0-8859-1

System Properties are resolved at runtime, and all declared keys and values are embedded as intern Strings.

System Properties can also be defined using Applications Options. This can be done by setting the option with a
specific prefix in their name:

« Properties for both the MicroEJ Core Engine and the MicroEJ Simulator : name starts with microej. java.
property.x*

« Properties for the MicroEJ Simulator : name starts with sim. java.property.*
« Properties for the MicroEJ Core Engine : name starts with emb. java.property.*

For example, to define the property myProp with the value theValue, set the following option :
Listing 2: Example of MicroEJ Property Definition in Launch Configura-
tion

microej.java.property.myProp=theValue

Option can also be setinthe VM arguments field of the JRE tab of the launch using the -D option (e.g. -Dmicroej.
java.property.myProp=theValue).

Constants

Note: This feature require [BON] version 1.4 which is available in MicroEJ Runtime starting from MicroEJ Archi-
tecture version 7.11.0.

Constants are key/value string pairs that can be accessed with a call to ej.bon.Constants.get[Type](String),
where Type if one of:

« Boolean,
» Byte,

« Char,

« Class,

« Double,
« Float,

o Int,
 Long,

« Short,

« String.

Constants are declared in MicroEJ Classpath *.constants.list files. Thefile formatis a standard Java properties
file. Example:
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Listing 3: Example of Contents of a BON constants File

# The following property is embedded as a constant
com.mycompany .myconstantkey=com.mycompany.myconstantvalue
Constants are resolved at binary level without having to recompile the sources.
At link time, constants are directly inlined at the place of Constants.get[Type] method calls with no cost.
The String key parameter must be resolved as an inlined String:

« either a String literal "com.mycompany.myconstantkey"”

« ora static final String field resolved as a String constant
The String value is converted to the desired type using conversion rules described by the [BON] API.

A boolean constant declared in an if statement condition can be used to fully remove portions of code. This
feature is similar to C pre-processors #ifdef directive with the difference that this optimization is performed at
binary level without having to recompile the sources.

Listing 4: Example of if code removal using a BON boolean constant

if (Constants.getBoolean("”com.mycompany.myconstantkey”)) {
System.out.println(”this code and the constant string will be fully removed when the constant is.
—resolved to 'false'"”)

}

Note: In Multi-Sandbox environment, constants are processed locally within each context. In particular, constants
defined in the Kernel are not propagated to Sandboxed Applications.

3.9 Application Resources

Application resources are the following Classpath Elements:

» Images
 Fonts

« Native Lanqguage Support

3.9.1 Images

Overview

Images are graphical resources that can be accessed with a call to ej.microui.display.Image.createlmage()
. To be displayed, these images have to be converted from their source format to the display raw format. The
conversion can either be done at :

« build-time (using the image generator tool),
+ run-time (using the relevant decoder library).

Images that must be processed by the image generator tool are declared in MicroEJ Classpath *. images. list files.
The file format is a standard Java properties file, each line representing a / separated resource path relative to the
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MicroEJ classpath root referring to a standard image file (e.g. .png, .Jjpg). The resource may be followed by an
optional parameter (separated by a : ) which defines and/or describes the image output file format (raw format).
When no option is specified, the image is embedded as-is and will be decoded at run-time (although listing files
without format specifier has no impact on the image generator processing, it is advised to specify them in the *.
images.list files anyway, as it makes the run-time processing behavior explicit). Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImagel.png

# The following image is embedded
# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage?2.png:RGB565

# The following image is embedded
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

Output Formats

No Compression

When no output format is set in the images list file, the image is embedded without any conversion / compression.
This allows you to embed the resource as well, in order to keep the source image characteristics (compression, bpp
etc.). This option produces the same result as specifiying an image as a resource in the MicroEJ launcher.

Advantages:

+ Preserves the image characteristics.
Disadvantages:

+ Requires an image runtime decoder;

+ Requires some RAM in which to store the decoded image.

imagel

Display Output Format

This format encodes the image into the exact display memory representation. If the image to encode contains
some transparent pixels, the output file will embed the transparency according to the display’s implementation
capacity. When all pixels are fully opaque, no extra information will be stored in the output file in order to free up
some memory space.

Advantages:
« Drawing an image is very fast;
+ Supports alpha encoding.
Disadvantages:

« No compression: the image size in bytes is proportional to the number of pixels.

imagel:display
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Generic Output Formats

Depending on the target hardware, several generic output formats are available. Some formats may be directly
managed by the BSP display driver. Refer to the platform specification to retrieve the list of natively supported
formats.

Advantages:
+ The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side;
« Drawing an image is very fast when the display driver recognizes the format (with or without transparency);
« Supports or not the alpha encoding: select the most suitable format for the image to encode.
Disadvantages:

+ No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
bits-per-pixel.

Select one the following format to use a generic format:

« ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return c;

3

« RGB888: 24 bits format, 8 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return c & Oxffffff;
}

« ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return 0

| ((c & 0xf000000R) >> 16)

| ((c & 0x00f00000) >> 12)

| ((c & 0x0000f000) >> 8)

| ((c & 0x000000f0) >> 4)

’

}

« ARGBI1555: 16 bits format, 1 bit for transparency, 5 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| (((c & Oxff000000) == Oxff000000) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)

)

3

+ RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat(u32 c){
return 0
| ((c & 0xf80000) >> 8)

(continues on next page)
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(continued from previous page)

| ((c & 0x00fc0) >> 5)
| ((c & 0x0000f8) >> 3)

)

+ A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return oxff - (toGrayscale(c) & 0Oxff);

}

« A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / ox11;

3

+ A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / 0x55;

}

«+ Al: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / oxff;
}

+ C4: 4 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & 0xff) / 0x11;

}

« C2: 2 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & Oxff) / 0x55;

3

+ C1:1bit format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & 0xff) / oxff;
3

« AC44: 4 bits for transparency, 4 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat(u32 c){
return 0
| ((color >> 24) & 0xf0)

(continues on next page)
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| ((toGrayscale(color) & oxff) / ox11)

’

(continued from previous page)

« AC22: 2 bits for transparency, 2 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat (u32 c){
return @
| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & oxff) / 0x55)

’

3

« AC11: 1 bit for transparency, 1 bit with grayscale conversion.

u32 convertARGB8888toRAWFormat (u32 c){
return @
| ((c & 0xff000000) == 0xff000O00 ? 0x2 : 0x0)
| ((toGrayscale(color) & oxff) / oxff)

’

image1:ARGB8888
image2:RGB565
image3:A4

RLE1 Output Format

Theimage engine can display embedded images that are encoded into a compressed format which encodes several
consecutive pixels into one or more 16-bits words. This encoding manages a maximum alpha level of 2 (alpha level

is always assumed to be 2, even if the image is not transparent).

« Several consecutive pixels have the same color (2 words):

- First 16-bit word specifies how many consecutive pixels have the same color;

- Second 16-bit word is the pixels’ color.

« Several consecutive pixels have their own color (1 + n words):

- First 16-bit word specifies how many consecutive pixels have their own color;

- Next 16-bit word is the next pixel color.

« Several consecutive pixels are transparent (1 word):

- 16-bit word specifies how many consecutive pixels are transparent.

Advantages:

« Supports 0 &2 alpha encoding.

« Good compression when several consecutive pixels respect one of the three previous rules.

Disadvantages:

+ Drawing an image is slightly slower than when using Display format.
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imagel:RLE1

3.9.2 Fonts

Overview

Fonts are graphical resources that can be accessed with a call to ej.microui.display.Font.getFont() . To be
displayed, these fonts have to be converted at build-time from their source format to the display raw format by the
font generator tool. Fonts that must be processed by the font generator tool are declared in MicroEJ Classpath *.
fonts.list files. The file format is a standard Java properties file, each line representing a / separated resource
path relative to the MicroEJ classpath root referring to a MicroEJ font file (usually with a .ejf file extension). The
resource may be followed by optional parameters which define :

« some ranges of characters to embed in the final raw file;
« the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depthis 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
# unicode range without transparency
com/mycompany/MyFont2.ejf:latin

# The following font is embedded with all characters
# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2

MicroEJ font files conventionally end with the .ejf suffix and are created using the Font Designer (see Font De-
signer).

Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. Several ranges can be specified, separated by ; . There are two ways to specify a
character range: the custom range and the known range.

Custom Range

Allows the selection of raw Unicode character ranges.
Examples:
o myfont:0x21-0x49 : Embed all characters from 0x21 to 0x49 (included);
o myfont:0x21-0x49,0x55 : Embed all characters from 0x21to 0x49 and character 0x55;

« myfont:0x21-0x49;0x55: Same as previous, but done by declaring two ranges.
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Known Range

A known range is a range defined by the “Unicode Character Database” version 9.0.0 available on https://home.
unicode.org/. Each range is composed of sub ranges that have a unique id.

« myfont:basic_latin:Embed all Basic Latin characters;

« myfont:basic_latin;arabic:Embed all Basic Latin characters, and all Arabic characters.

Transparency

The second parameter is for specifying the font transparency level (1, 2, 4 or 8).
Examples:
« myfont:latin:4:Embed all latin characters with 4 levels of transparency

« myfont::2:Embed all characters with 2 levels of transparency

3.9.3 Native Language Support

Native Language Support (NLS) allows the application to facilitate internationalization. It provides support to ma-
nipulate messages and translate them in different languages. Each message to be internationalized is referenced
by a key, which can be used in the application code instead of using the message directly.

Messages must be defined in PO files in the MicroEJ Classpath of the application. Here is an example:

msgid ""

msgstr ""

"Language: en_US\n"

"Language-Team: English\n"

"MIME-Version: 1.0\n"

"Content-Type: text/plain; charset=UTF-8\n"

msgid "Labell”
msgstr "My label 1"

msgid "Label2”
msgstr "My label 2"

These PO files have to be converted to be usable by the application. In order to let the build system know which PO
files to process, they must be referenced in MicroEJ Classpath *.nls.list files. The file format of these *.nls.
list files is a standard Java properties file. Each line represents the Full Qualified Name of a Java interface that
will be generated and used in the application. Here is an example, let’s call it i18n.nls.list:

com.mycompany .myapp.Labels
com.mycompany . myapp.Messages

For each line, PO files whose name starts with the interface name ( Messages and Labels in the example) are
retrieved from the MicroEJ Classpath and used to generate:

+ aJava interface with the given FQN, containing a field for each msgid of the PO files

+ a NLS binary file containing the translations

So, in the example, the generated interface com.mycompany.myapp.Labels will gather all the translations from
files named Labels*.po and located in the MicroEJ Classpath. PO files are generally suffixed by their locale (
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Labels_en_US.po ) but it is only for convenience since the suffix is not used, the locale is extracted from the PO
file’s metadata.

Once the generation is done, the application can use the Java interfaces to get internationalized messages, for
example:

import com.mycompany.myapp.Labels;
public class MyClass {

String label = Labels.lLabell;

The generation is triggered when building the application or after a change done in any PO or *.nls.1list files.
This allows to always have the Java interfaces up-to-date with the translations and to use them immediately.

The NLS APl module must be added to the module.ivy of the MicroEJ Application project, in order to allow access
to the NLS library.

<dependency org="ej.library.runtime” name="nls" rev="3.0.1"/>

3.10 Development Tools

MicroEJ provides a number of tools to assist with various aspects of development. Some of these tools are run using
MicroEJ Tool configurations, and created using the Run Configurations dialog of the MicroEJ SDK. A configuration
must be created for the tool before it can be used.
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[E] C/C++ Application Target
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@ Launch Group
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Clean intermediate files [Verbose
Filter matched 7 of 12 items i e
./?:. Run Close

Fig. 25: MicroEJ Tool Configuration

The above figure shows a tool configuration being created. In the figure, the MicroEJ Platform has been selected,
but the selection of which tool to run has not yet been made. That selection is made in the Execution Settings...
box. The Configuration tab then contains the options relevant to the selected tool.

3.10.1 Testsuite with JUnit

MicroEJ allows to run unit tests using the standard JUnit API during the build process of a MicroEJ library or a
MicroEJ Application. The MicroEJ testsuite engine runs tests on a target Platform and outputs a JUnit XML report.

Principle

JUnit testing can be enabled when using the microej-javalib (MicroEJ Add-On Library) or the
microej-application (MicroEJ Applications) build type. JUnit test cases processing is automatically enabled
when the following dependency is declared in the module. ivy file of the project.

<dependency conf="test->*" org="ej.library.test” name="junit” rev="1.5.0"/>
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When a new JUnit test case class is created inthe src/test/java folder, a JUnit processor generates MicroEJ com-
pliant classes into a specific source folder named src-adpgenerated/junit/java. These files are automatically
managed and must not be edited manually.

JUnit Compliance
MicroEJ is compliant with a subset of JUnit version 4. MicroEJ JUnit processor supports the following annotations:
@After, @AfterClass, @efore, @BeforeClass, @Ignore, @Test.

Each test case entry point must be declared using the org. junit.Test annotation (@Test before a method dec-
laration). Please refer to JUnit documentation to get details on usage of other annotations.

Setup a Platform for Tests
Before running tests, a target platform must be configured in the MicroEJ workspace. The following steps assume

that a platform has been previously imported into the MicroEJ Platform repository.

Goto Window > Preferences > MicroEJ > Platforms and selectthe desired platform on which to run the
tests.

Press F2 to expand the details.
Select the the platform path and copy it to the clipboard.
Goto Window > Preferences > Ant > Runtime and selectthe Properties tab.

Click on 'Add Property... button and set a new property named target.platform.dir with the platform path
pasted from the clipboard.

Setup a Project with a JUnit Test Case

This section describes how to create a new JUnit Test Case starting from a new MicroEJ library project.

First create anew module project usingthe microej-javalib skeleton. Anew projectnamed mylibrary iscreated
in the workspace.

Right-click on the src/test/java folderand select New > Other... menuitem.

Selectthe Java > JUnit > New JUnit Test Case wizard. Enter a test name and press Finish . A new JUnit
test case class is created with a default failing test case.

Build and Run a JUnit Testsuite

Right-click on the mylibrary project and select Build Module . After the library is built, the testsuite engine
launches available test cases and the build process fails in the console view.

Onthe mylibrary project, right-click and select Refresh .

A target~  folder appears with intermediate build files. The JUnit report is available at
target~\test\xmlI\TEST-test-report.xml.

Double-click on the file to open the JUnit testsuite report.

Modify the test case by replacing
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fail(”"Not yet implemented”);

with

Assert.assertTrue(true);

Right-click again on the mylibrary project and select Build Module . The test is now successfully executed on
the target platform so the MicroEJ Add-On Library is fully built and published without errors.

Double-click on the JUnit testsuite report to see the test has been successfully executed.

Advanced Configurations

Autogenerated Test Classes

The JUnit processor generates test classes into the src-adpgenerated/junit/java folder. This folder contains:

_AllTestClasses.java file Asingle classwith a mainenty pointthat sequentially calls all declared test methods
of all JUnit test case classes.

_AllTests_[TestCase].java files For each JUnit test case class, a class with a main entry point that sequen-
tially calls all declared test methods.

_SingleTest_[TestCase]_[TestMethod].java files For each test method of each JUnit test case class, a class
with a main entry point that calls the test method.

JUnit Test Case to MicroEJ Test Case
The MicroEJ testsuite engine allows to select the classes that will be executed, by setting the following property in
the project module.ivy file.

<ea:property name="test.run.includes.pattern” value="[MicroEJ Test Case Include Pattern]"”/>

Thefollowingline consider all JUnit test methods of the same class as a single MicroEJ test case (default behaviour).
If at least one JUnit test method fails, the whole test case fails in the JUnit report.

<ea:property name="test.run.includes.pattern” value="#x/_AllTests_x%.class"/>

The following line consider each JUnit test method as a dedicated MicroEJ test case. Each test method is viewed
independently in the JUnit report, but this may slow down the testsuite execution because a new deployment is
done for each test method.

<ea:property name="test.run.includes.pattern” value="xx/_SingleTest_x*.class"/>

Run a Single Test Manually

Each test can be run independently as each class contains a main entry point.

In the  src-adpgenerated/junit/java  folder, right-click on the desired autogenerated class (
_SingleTest_[TestCase]_[TestMethod].java)andselect RunAs > MicroEJ Application

The test is executed on the selected Platform and the output result is dumped into the console.
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Testsuite Options

The MicroEJ testsuite engine can be configured with specific options which can be added to the module.ivy file
of the project running the testsuite, within the <ea:build> XML element.

« Application Option Injection

It is possible to inject an Application Option for all the tests, by adding to the original option the microej.
testsuite.properties. prefix:

<ea:property name="microej.testsuite.properties.[application_option_name]” value="[application_
—option_value]"/>

+ Retry Mechanism

A test execution may not be able to produce the success trace for an external reason, for example an unre-
liable harness script that may lose some trace characters or crop the end of the trace. For all these unlikely
reasons, it is possible to configure the number of retries before a test is considered to have failed:

<ea:property name="microej.testsuite.retry.count” value="[nb_of_retries]"/>

By default, when a test has failed, it is not executed again (option value is set to 0 ).

Test Specific Options

The MicroEJ testsuite engine allows to define MicroEJ Launch options specific to each test case. This can be done
by defining a file with the same name as the generated test case file with the .properties extension instead of
the .java extension. The file must be putin the src/test/resources folder and within the same package than
the test case file.

Consultthe Application Launch Options Appendix of the Device Developer’s Guide to get the list of available options
properties.

3.10.2 Font Designer
Principle

The Font Designer module is a graphical tool (Eclipse plugin) that runs within the MicroEJ Workbench used to build
and edit MicroUl fonts. It stores fonts in a platform-independent format.
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Functional Description

font
* ttf

Font
Designer .
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Fig. 26: Font Generation

Font Management

Create a MicroEJ Font

To create a MicroEJ font, follow the steps below:
1. Openthe Eclipse wizard: File > New > Other > MicroEJ > MicroEJ Font .
2. Select a directory and a name.
3. Click Finish.

Once the font is created, a new editor is opened: the MicroEJ Font Designer Editor.

Edit a MicroEJ Font

You can edit your font with the MicroEJ Font Designer Editor (by double-clickingon a *.ejf file or after running
the new MicroEJ Font wizard).

This editor is divided into three main parts:
+ The top left part manages the main font properties.
« The top right part manages the character to embed in your font.

« The bottom part allows you to edit a set of characters or an individual character.

Main Properties

The main font properties are:
« fontsize: height and width (in pixels).
+ baseline (in pixels).

« space character size (in pixels).
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« styles and filters.
« identifiers.

Refer to the following sections for more information about these properties.

Font Height

A font has a fixed height. This height includes the white pixels at the top and at the bottom of each character
simulating line spacing in paragraphs.

N
| [
Al height
L] [ ]

Fig. 27: Font Height

Font Width: Proportional and Monospace Fonts

A monospace font is a font in which all characters have the same width. For example a ‘!’ representation will be
the same width as a ‘w’ (they will be in the same size rectangle of pixels). In a proportional font, a ‘w’ will be wider
thana ‘"

A monospace font usually offers a smaller memory footprint than a proportional font because the Font Designer
does not need to store the size of each character. As a result, this option can be useful if the difference between the
size of the smallest character and the biggest one is small.

Baseline

Characters have a baseline: an imaginary line on top of which the characters seem to stand. Note that characters
can be partly under the line, for example, ‘g’ or ‘}.

| | . - | ] - ] | - ] | | mm = -
| _mE. .___ N L | _IN mEEN n_ L N (NN _HR | .__N

(L1 (L] (] - (L] N . . = E
L] u L L] L] L] L] LLL L] i u N EEEE L] ] _En |
.. W u - ] ] u . .

Fig. 28: The Baseline

Space Character

The Space character (0x20) is a specific character because it has no filled pixels. From the Main Properties Menu
you can fix the space character size in pixels.

Note: When the font is monospace, the space size is equal to the font width.
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Styles and Filters

A MicroUl font holds a style: PLAIN, BOLD, ITALIC, UNDERLINED, and the combinations between BOLD, ITALIC and
UNDERLINED. Font Designer can use one file to describe several MicroUl fonts.

For example, a font file that describes a PLAIN font can also describe an UNDERLINED font because the MicroUl
implementation just has to draw a line under the characters. In this way, from a developer’s point of view, there are
two fonts: a PLAIN font and an UNDERLINED font. From the Font Designer point of view, there are also two fonts,
but they use the same data file. Font Designer adds a tag to describe the UNDERLINED font in the generated font
file.

This tag is a filter. When a file contains one or more filters, MicroUl implementation knows that it has to perform
post processing to obtain a specific MicroUl font from the encoded font.

Alternatively, the user can create two distinct files to describe the two fonts. From the MicroUl application point of
view, there are always two fonts: a PLAIN font and an UNDERLINED font, but no post-processing step is required
(no filter tag).

Examples:

1. Afont file contains the styles PLAIN and UNDERLINED and the filters PLAIN and UNDERLINED. The MicroUl
implementation detects two MicroUl fonts. To draw each font, the PLAIN filter or the UNDERLINED filter is
used accordingly.

2. Afont file contains the styles PLAIN and UNDERLINED and the filter PLAIN. The MicroUl implementation de-
tects two MicroUl fonts. To draw the underlined font, it will not apply the underlining process (the filter UN-
DERLINED is absent). So the MicroUl underlined font will have the same rendering as the MicroUl plain font.

Font Designer features three drop-downs, one for each of BOLD, ITALIC and UNDERLINED. Each drop-down has
three options:

« None - Font Designer will not set this style, nor include a filter for it.
« Built-in - Font Designer will set this style, but not include a filter for it.
+ Dynamic - Font Designer will set this style, and include a filter for it.

If all three drop-downs are set to None, only a plain font is generated.

The number of fonts that will result is shown below the drop-downs.

Identifiers

A number of identifiers can be attached to a MicroUl font. At least one identifier is required to specify the font.
Identifiers are a mechanism for specifying the contents of the font - the set or sets of characters it contains. The
identifier may be a standard identifier (for example, LATIN) or a user-defined identifier. Identifiers are numbers,
but standard identifiers, which are in the range 0 to 80, are typically associated with a handy name. A user-defined
identifier is an identifier with a value of 81 or higher.

Character List

The list of characters can be populated through the import button, which allows you to import characters from
system fonts, images or another MicroEJ font.
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Import from System Font

This page allows you to select the system font to use (left part) and the range of characters. There are predefined
ranges of characters below the font selection, as well as a custom selection picker (for example 0x21 to Oxfe for
Latin characters).

The right part displays the selected characters with the selected font. If the background color of a displayed char-
acter is red, it means that the character is too large for the defined height, or in the case of a monospace font, it
means the character is too high or too wide. You can then adjust the font properties (font size and style) to ensure
that characters will not be truncated.

When your selection is done, click the Finish button to import this selection into your font.

Import from Images

This page allows the loading of images from a directory. The images must be named as follows: 0x[UTF-8].
[extension].

When your selection is done, click the Finish button to import the images into your font.

Character Editor

When a single character is selected in the list, the character editor is opened.
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Fig. 29: Character Editor

You can define specific properties, such as left and right space, or index. You can also draw the character pixel by
pixel - a left-click in the grid draws the pixel, a right-click erases it.

The changes are not saved until you click the Apply button. When changes are applied to a character, the editor
shows that the font has changed, so you can now save it.

The same part of the editor is also used to edit a set of characters selected in the top right list. You can then edit
the common editable properties (left and right space) for all those characters at the same time.

Working With Anti-Aliased Fonts

By default, when characters are imported from a system font, each pixel is either fully opaque or fully transparent.
Fully opaque pixels show as black squares in the character grid in the right-hand part of the character editor; fully
transparent pixels show as white squares.

However, the pixels stored inan ejf file can take one of 256 grayscale values. A fully-transparent pixel has the value
255 (the RGB value for white), and a fully-opaque pixel has the value 0 (the RGB value for black). These grayscale
values are shown in parentheses at the end of the text in the Current alpha field when the mouse cursor hovers over
a pixel in the grid. That field also shows the transparency level of the pixel, as a percentage, where 100% means
fully opaque.

Itis possible to achieve better-looking characters by using a combination of fully-opaque and partially-transparent
pixels. Thistechniqueis called anti-aliasing. Anti-aliased characters can be imported from system fonts by checking
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the anti aliasing box in the import dialog. The ‘&’ character shown in the screenshot above was imported using anti
aliasing, and you can see the various gray levels of the pixels.

When the Font Generator converts an ejf file into the raw format used at runtime, it can create fonts with char-
acters that have 1, 2, 4 or 8 bits-per-pixel (bpp). If the raw font has 8 bpp, then no conversion is necessary and the
characters will render with the same quality as seen in the character editor. However, if the raw font has less than
8 bpp (the default is 1 bpp) any gray pixels in the input file are compressed to fit, and the final rendering will be of
lower quality (but less memory will be required to hold the font).

Itis useful to be able to see the effects of this compression, so the character editor provides radio buttons that allow
the user to preview the characterat 1, 2, 4, or 8 bpp. Furthermore, when 2, 4 or 8 bpp is selected, a slider allows the
user to select the transparency level of the pixels drawn when the left mouse button is clicked in the grid.

Previewing a Font

You can preview your font by pressing the Preview... button, which opens the Preview wizard. In the Preview
wizard, press the Select File button, and select a text file which contains text that you want to see rendered using
your font. Characters that are in the selected text file but not available in the font will be shown as red rectangles.
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Fig. 30: Font Preview
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Removing Unused Characters

In order to reduce the size of a font file, you can reduce the number of characters in your font to be only those char-
acters used by your application. To do this, create a file which contains all the characters used by your application
(for example, concatenating all your NLS files is a good starting point). Then open the Preview wizard as described
above, selecting that file. If you select the check box Delete unused on finish, then those characters that are in the
font but not in the text file will be deleted from the font when you press the Finish button, leaving your font contain-
ing the minimum number of characters. As this font will contain only characters used by a specific application, it is
best to prepare a “complete” font, and then apply this technique to a copy of that font to produce an application
specific cut-down version of the font.

Use a MicroEJ Font

A MicroEJ Font must be converted to a format which is specific to the targeted platform. The Font Generator tool
performs this operation for all fonts specified in the list of fonts configured in the application launch.

Dependencies

No dependency.

Installation

The Font Designer module is already installed in the MicroEJ environment. The module is optional for the platform,
and allows the platform user to create new fonts.

Note: When the platform user already has a MicroEJ environment which provides the Font Designer module,
he/she will able to create a new font even if the platform does not provide the Font Designer module.

In the platform configuration file, check Ul > Font Designer to install the Font Designer module.

Use

Create anew ejf fontfile or open an existing one in order to open the Font Designer plugin.

3.10.3 Stack Trace Reader
Principle

Stack Trace Reader is a MicroEJ tool which reads and decodes the MicroEJ stack traces. When an exception occurs,
the MicroEJ Core Engine prints the stack trace on the standard output System.out. The class names, non required
types (see Types) names and method names obtained are encoded with a MicroEJ internal format. This internal
format prevents the embedding of all class names and method names in the flash, in order to save some memory
space. The Stack Trace Reader tool allows you to decode the stack traces by replacing the internal class names and

method names with their real names. It also retrieves the line number in the MicroEJ Application.
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Functional Description
The Stack Trace Reader reads the debug info from the fully linked ELF file (the ELF file that contains the MicroEJ

Core Engine, the other libraries, the BSP, the OS, and the compiled MicroEJ Application). It prints the decoded stack
trace.

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use

Write a new line to dump the currently executed stack trace on the standard output.
public class MyBackgroundCode implements BackgroundSerwvice {
@override

puhllc void onStart() {
Autoc-generated method stub

S stem.out.println("MyBackgroundCode: Hello World"};
[ new Thrnwahle(j printStackTrace(); |

h
Fig. 31: Code to Dump a Stack Trace

Write a new line to dump the currently executed stack trace on the standard output.

by module.ivy [J] Testjava &3

package com.mycompany;

<

puoblic class Test {

puoblic =tatic void main (String[] args) {
Svetem.out.println("hello world!™);
new Exception(].pIintStackTIaceijd

Fig. 32: Code to Dump a Stack Trace

To be able to decode an application stack trace, the stack trace reader tool requires the application binary file with
debug information (application.fodbg in the output folder). Note that the file which is uploaded on the device
is application.fo (stripped version without debug information).
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= filesystem
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Fig. 33: Application Binary File with Debug Information

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.

MyBackgroundCode: Hello World
Exception
at java.
at java.l
at java.l
at appEn

b968936fb41: 0xc03800e086M: OxcO380bE8: 0xc0380c20@

Fig. 34: Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on RunAs... >
Run Configurations... .

In Execution tab, selectthe Stack Trace Reader tool.
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Fig. 35: Select Stack Trace Reader Tool

tab, browse the previously generated application binary file with debug information (
application.fodbg in case of a Sandboxed Application or application.out in case of a Standalone Applica-

CEX B3~

Mame: Stack Trace Reader

type filter text

[E] C/C++ Application
Ju JUnit
@ Launch Group
i+ [3] Microk) Application
a [Og MicroE) Tool
[ Stack Trace Reader

| Stack Trace Reader |

o Execution | M4 Configuration . =, JRI—j i=| Commorﬂ

Application

Executable filee _.generated.Ba ckgroundSer\.ricesStandanneEpplication.fodbgﬂ ’ Browse... ]

Additional ohject files:

"Trace port” interface for Eclipse

Add

Remove

Connection type: | Censole

Fart: | COMO Baudrate:

Port: | 5555 Address:

Stack trace file: Browse...
Filter matched 7 of 15 items fevert Apply
® Run ] ’ Close

Fig. 36: Stack Trace Reader Tool Configuration (Sandboxed Application)
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Fig. 37: Stack Trace Reader Tool Configuration (Standalone Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.

3 Console 52 | Problems g JUnit
Stack Trace Reader_ [MicroE) Tool] C:\Program Files\Java\jrel B.0_25\bin'javaw.exe (5 avr, 2017 12:44:46)

==============c [ MicroEl Core Engine Trace ] ===============
[INFO] Paste the MicroE]l core engine stack trace here.

Exce

ang.Throwa

= 00 oo

o

Exception in

thread ej.wadapps.app.default
at java.lang.System.getStackTrace(Unknown Source)
at java.lang.Throwable.fillInStackTrace(Throwable.java:79)

at i cowgble . Jgvg:i2s)
at appEntry.MyBackgroundCode.onStart (MyBackgroundCode.java:18) |

Fig. 38: Read the Stack Trace

The stack trace reader can simultaneously decode heterogeneous stack traces with lines owned by different ap-
plications and the firmware. Other debug information files can be appended using the 'Additional object files

option. Lines owned by the firmware can be decoded with the firwmare debug information file (optionally made
available by your firmware provider).
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The following section explains MicroEJ tool options.

Category: Stack Trace Reader

Stack Trace Reader Application

Executable file: Browse...

Additional object files:

Add

Remove

"Trace port” interface for Eclipse

Connection type: | Console ~

COMOD 115200

Browse...

Group: Application
Option(browse): Executable file

Option Name: application.file
Default value: (empty)
Description:

Specify the full path of a full linked elf file.

Option(list): Additional object files

Option Name: additional.application.files

Default value: (empty)

Group: “Trace port” interface for Eclipse

Description:

This group describes the hardware link between the device and the PC.
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Option(combo): Connection type

Option Name: proxy.connection.connection.type
Default value: Console

Available values:

Uart (COM)

Socket

File

Console

Description:

Specify the connection type between the device and PC.

Option(text): Port

Option Name: pcboardconnection.usart.pc.port
Default value: COM0

Description:

Format: port name

Specifies the PC COM port:

Windows - COM1, COM2, ..., COMxn*

Linux- /dev/ttySe, /dev/ttyS1, ..., /dev/ttyS*nx

Option(combo): Baudrate

Option Name: pcboardconnection.usart.pc.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description:

Defines the COM baudrate for PC-Device communication.

Option(text): Port

Option Name: pcboardconnection.socket.port
Default value: 5555

Description:
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IP port.

Option(text): Address

Option Name: pcboardconnection.socket.address
Default value: (empty)
Description:

IP address, on the form A.B.C.D.

Option(browse): Stack trace file

Option Name: pcboardconnection.file.path

Default value: (empty)

3.10.4 Code Coverage Analyzer
Principle

The MicroEJ Simulator features an option to output .cc (Code Coverage) files that represent the use rate of functions
of an application. It traces how the opcodes are really executed.

Functional Description

The Code Coverage Analyzer scans the output .cc files, and outputs an HTML report to ease the analysis of methods
coverage. The HTML report is available in a folder named htmlReport in the same folder as the .cc files.
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Classpath
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Simulator Coverage Coverage
Files

Analyzer
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Fig. 39: Code Coverage Analyzer Process

Dependencies
In order to work properly, the Code Coverage Analyzer should input the .cc files. The .cc files relay the classpath

used during the execution of the Simulator to the Code Coverage Analyzer. Therefore the classpath is considered
to be a dependency of the Code Coverage Analyzer.

Installation

This tool is a built-in platform tool.

Use

A MicroEJ tool is available to launch the Code Coverage Analyzer tool. The tool name is Code Coverage Analyzer.

Two levels of code analysis are provided, the Java level and the bytecode level. Also provided is a view of the fully
or partially covered classes and methods. From the HTML report index, just use hyperlinks to navigate into the
report and source / bytecode level code.
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Category: Code Coverage

Code Coverage

*.cc files folder: Browse...

Classes filter

Includes:

Add...

Edit...

Remove

Excludes:

Add...

Edit...

Remove

Option(browse): *.cc files folder

Option Name: cc.dir
Default value: (empty)
Description:

Specify a folder which contains the cc files to process (*.cc).

Group: Classes filter
Option(list): Includes

Option Name: cc.includes
Default value: (empty)
Description:

List packages and classes to include to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. * : includes all classes which are in package packageA.packageB

packageA.packageB.className : includes the class packageA.packageB.className
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Option(list): Excludes

Option Name: cc.excludes
Default value: (empty)
Description:

List packages and classes to exclude to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. * : excludes all classes which are in package packageA.packageB

packageA.packageB.className : excludes the class packageA.packageB.className

3.10.5 Heap Dumper & Heap Analyzer
Introduction

Heap Dumper is a tool that takes a snapshot of the heap. Generated files (with the .heap extension) are available
on the application output folder. Note that it works only on simulations. It is a built-in platform tool and has no
dependencies.

The Heap Analyzer is a set of tools to help developers understand the contents of the Java heap and find problems
such as memory leaks. For its part, the Heap Analyzer plug-in is able to open dump files. It helps you analyze their
contents thanks to the following features:

« memory leaks detection
« objects instances browse

+ heap usage optimization (using immortal or immutable objects)

The Heap

The heap is a memory area used to hold Java objects created at runtime. Objects persist in the heap until they are
garbage collected. An object becomes eligible for garbage collection when there are no longer any references to it
from other objects.

Heap Dump

A heap dump is an XML file that provides a snapshot of the heap contents at the moment the file is created. It
contains a list of all the instances of both class and array types that exist in the heap. For each instance it records:

« The time at which the instance was created
+ The thread that created it
« The method that created it
For instances of class types, it also records:
« Theclass
+ The values in the instance’s non-static fields

For instances of array types, it also records:
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« The type of the contents of the array

«+ The contents of the array

For each referenced class type it records the values in the static fields of the class.

Heap Analyzer Tools

The Heap Analyzer is an Eclipse plugin that adds three tools to the MicroEJ environment.

Tool name Number of | Purpose
input files
Heap Viewer 1 Shows what instances are in the heap, when they were created,
and attempts to identify problem areas
Progressive 10r more Shows how the number of instances in the heap has changed over
Heap Usage time
Compare 2 Compares two heap dumps, showing which objects were created,

or garbage collected, or have changed values

Heap Dumper

When the Heap Dumper option is activated, the garbage collector process ends by performing a dump file that
represent a snapshot of the heap at this moment. Thus, to generate such dump files, you must explicitly call the
System.gc() method in your code, or wait long enough for garbage collector activation.

The heap dump file contains the list of all instances of both class and array types that exist in the heap. For each

instance it records:

« the time at which the instance was created

« the thread that created it

« the method that created it

For instances of class types, it also records:

« theclass

« the valuesin the instance’s non-static fields

For instances of array types, it also records:

« the type of the contents of the array

« the contents of the array

For each referenced class type, it records the values in the static fields of the class.
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Category: Heap Dumper

Heap Dumper Application

Executable file: Browse...

Resident application files:
Add...
Remove

Memary

Heap memaory file: | Browse...

Output

Heap file name: | application.heap

Group: Application

Option(browse): Executable file

Option Name: application.filename
Default value: (empty)
Description:

Specify the full path of a full linked ELF file.

Option(list): Resident application files

Option Name: additional.application.filenames
Default value: (empty)
Description:

Specify the full path of resident applications .out files linked by the Firmware Linker.

Group: Memory
Option(browse): Heap memory file

Option Name: heap.filename

Default value: (empty)
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Description:

Specify the full path of heap memory dump, in Intel Hex format.

Group: Output
Option(text): Heap file name

Option Name: output.name

Default value: application.heap

Heap Viewer

To open the Heap Viewer tool, select a heap dump XML file in the Package Explorer , right-click on it and select

Open With > Heap Viewer

Alternatively, right-click on it and select Heap Analyzer > Open heap viewer

This will open a Heap Viewer tool window for the selected heap dump' .
The Heap Viewer works in conjunction with two views:

1. The Outline view

2. The Instance Browser view
These views are described below.

The Heap Viewer tool has three tabs, each described below.

Outline View

The Outline view shows a list of all the types in the heap dump, and for each type shows a list of the instances of
that type. When an instance is selected it also shows a list of the instances that refer to that instance. The Outline
view is opened automatically when an Heap Viewer is opened.

! Although this is an Eclipse ‘editor’, it is not possible to edit the contents of the heap dump.
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E Console |[21 Problems [ 0= Outline &3 @ ¥ =0
33 types - 70 instances (from first to last time stamp)

Type name Instances  Referenced instances Method Thread i
. char(] 1 0
@ com.is2t.cldec.s3.DefaultSystemOut 0
» @ com.is2t.test HeapDumpTest 1
PRC) com.isZt.test. HeapDumpTest5TestOhbj 2
<p #99
<p £100
. (@ com.is2t.test.HeapDumpTest$ TestObj2
@ &jbonlmmutables
> @ gj.bonImmutablesFile
. int[]
» L& int(]l]
@ ist.support.lang.Systools

m

@ corm.is2ttest HeapDumpTest.start() : void 3 main
@ com.is2ttest HeapDumpTest.start() : void 5 main

=R = R R R R UV )

D= R -
(=N )

References ’ Type
<&p #98 (C] com.is2ttest. HeapDumpTest

Fig. 40: Outline View

Instance Browser View

The Instance Browser view opens automatically when a type or instance is selected in the Outline view. It has two
modes, selected using the buttons in the top right corner of the view. In ‘Fields’ mode it shows the field values for
the selected type or instance, and where those fields hold references it shows the fields of the referenced instance,
and so on. In ‘Reference’ mode it shows the instances that refer to the selected instance, and the instances that
refer to them, and so on.

El Conzole [3_ Problems EE Cutline LEEE Fields and Reference Hierarchy &2 g]-oe = B
Fields - heap file name: Ch\Users\Jehn\.microgfworkspaces\CM_ARMCC-DEV-1.0.0%HeapDumpT est\ com.isz
Field Type Value
a @ this C com.isZt.test. HeapDumpTest5TestOhbj #100
@ a © int 1
@b O int 0
F I- © int 0

Fig. 41: Instance Browser View - Fields mode
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&l Console (21 Problems EE Cutline T;EE Fields and Reference Hierarchy &2 o[:g =08
References - heap file name : ChUsers'John'umicroefweorkspaces\CM_ARMCC-DEV-1.0.00HeapDumpTest\co
Field Type Value
a @ this C com.isZt.test.HeapDumpTest5TestOhj #100
4 @ testObj C) com.is2t.test.HeapDurmpTest #98
<no references>  <nonex <none:

Fig. 42: Instance Browser View - References mode

Heap Usage Tab

The Heap usage page of the Heap Viewer displays four bar charts. Each chart divides the total time span of the heap
dump (from the time stamp of the earliest instance creation to the time stamp of the latest instance creation) into a
number of periods along the x axis, and shows, by means of a vertical bar, the number of instances created during
the period.

The top-left chart shows the total number of instances created in each period, and is the only chart displayed
when the Heap Viewer is first opened.

When a type or instance is selected in the Outline view the top-right chart is displayed. This chart shows the
number of instances of the selected type created in each time period.

When an instance is selected in the Outline view the bottom-left chart is displayed. This chart shows the
number of instances created in each time period by the thread that created the selected instance.

When an instance is selected in the Outline view the bottom-right chart is displayed. This chart shows the
number of instances created in each time period by the method that created the selected instance.
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[ heap-Oaml 52 =
Instance creation over time, by type, creating thread and creating method Generate graphViz file
Heap usage - Total Instances of type 'com.is2t.test. HeapDumpTest5TestOhy'
Heap usage : 569/569 instance(s) Heap usage: 500/569 instancels)
Instances Instances
489 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp
Created by thread 'main’ Created by method 'com.is2t.test HeapDumpTest.start() « void'
Heap usage: 503/589 instance(s) Heap usage : 500/569 instance(s)
Instances Instances
489 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp

Heap usage | Dominator tree | Leak suspects

Fig. 43: Heap Viewer - Heap Usage Tab

Clicking on the graph area in a chart restricts the Outline view to just the types and instances that were created
during the selected time period. Clicking on a chart but outside of the graph area restores the Outline view to
showing all types and instances” .

The button Generate graphViz file in the top-right corner of the Heap Usage page generates a file compatible with
graphviz (www.graphviz.org).

Dominator Tree Tab

The Dominator tree page of the Heap Viewer allows the user to browse the instance reference tree which contains
the greatest number of instances. This can be useful when investigating a memory leak because this tree is likely
to contain the instances that should have been garbage collected.

The page contains two tree viewers. The top viewer shows the instances that make up the tree, starting with the
root. The left column shows the ids of the instances - initially just the root instance is shown. The Shallow instances
column shows the number of instances directly referenced by the instance, and the Referenced instances column
shows the total number of instances below this point in the tree (all descendants).

2 The Outline can also be restored by selecting the All types and instances option on the drop-down menu at the top of the Outline view.
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The bottom viewer groups the instances that make up the tree either according to their type, the thread that created
them, or the method that created them.

Double-clicking an instance in either viewer opens the Instance Browser view (if not already open) and shows de-
tails of the instance in that view.

[0 heap-0xml 2 =0
?;EE Dominator tree : Instance hierarchy that contains greatest number of instances

Dominator tree instances Type

» [ 298 C] com.is2t.test.HeapDumpTest

4 L

Deorminator tree instances grouped by 1ype, thread or method | Types hd

-
Top consumers Instances

C com.isZt.test.HeapDumpTestSTestObj 500
|= java.lang.Object(]

@ java.utilVector

(@ com.is2t.test.HeapDumpTest

=

Heap usage | Dominator tree | Leak suspects

Fig. 44: Heap Viewer - Dominator Tree Tab

Leak Suspects Tab

The Leak suspects page of the Heap Viewer shows the result of applying heuristics to the relationships between
instances in the heap to identify possible memory leaks.

The page is in three parts.

« The top part lists the suspected types (classes). Suspected types are classes which, based on numbers of
instances and instance creation frequency, may be implicated in a memory leak.

+ The middle part lists accumulation points. An accumulation point is an instance that references a high num-
ber of instances of a type that may be implicated in a memory leak.

« The bottom part lists the instances accumulated at an accumulation point.
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[0 heap-Oaml 22 =0

19 Types suspected

C] com.is2t.test.HeapDumpTestSTestOhbj

Accumulation points

Instance Type
<&y #381 java.lang.Object]]
Accumulated instances

Instance Type it

dp#123 C com.isZt.test. HeapDumpTest5TestOhy

dp 2124 C com.isZt.test.HeapDumpTestSTestObj

G #125 (C] com.is2t.test.HeapDumpTestSTestObj

Gy #126 C] com.is2t.test. HeapDumpTestSTestOhbj

<y #130 C com.isZt.test. HeapDumpTest5TestOhy

dp#131 C com.isZt.test.HeapDumpTestSTestObj

Gp#132 (C] com.is2t.test.HeapDumpTestSTestObj

G #133 C] com.is2t.test. HeapDumpTestSTestOhbj

<y #134 C com.isZt.test. HeapDumpTest5TestOhy

p#135 C com.isZt.test.HeapDumpTestSTestObj i
S P cme e - i -

Heap usage | Dominator tree | Leak suspects

Fig. 45: Heap Viewer - Leak Suspects Tab

Progressive Heap Usage

To open the Progressive Heap Usage tool, select one or more heap dump XML filesin the Package Explorer , right-

click and select Heap Analyzer > Show progressive heap usage

This tool is much simpler than the Heap Viewer described above. It comprises three parts.

+ The top-right part is a line graph showing the total number of instances in the heap over time, based on the
creation times of the instances found in the heap dumps.

« The left part is a pane with three tabs, one showing a list of types in the heap dump, another a list of threads
that created instances in the heap dump, and the third a list of methods that created instances in the heap
dump.

+ The bottom-left is a line graph showing the number of instances in the heap over time restricted to those
instances that match with the selection in the left pane. If a type is selected, the graph shows only instances
of that type; if a thread is selected the graph shows only instances created by that thread; if a method is
selected the graph shows only instances created by that method.
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E”| Progressive Heap Usage %

FProgressive heap usage by type, creating thread and creating method

Types | Threads | Methods|

Mame

char[]

C com.is2t.cldc,s3.DefaultSystem Out
C com.is2t.test.HeapDumpTest

C com.is2t.test. HeapDumpTestSTestObj
C) g.bonImmutables

C) gj.bonImmutablesFile

int[]

int{][]

@ ist.support.lang.Systools

3 ist.support.util EncUS_ASCI

C) ist.suppert.util EncodingConversion
(C] java.io.FileDescriptor

C java.io.FileQutputStream

C java.io.OutputStream

C) java.o. OutputStreamWriter

C) java.ic.Print5stream

C) java.ioWriter

(C] java.lang.Exception

C java.langIndexOutOfBoundsException
@ java.lang.MullPointerException

C) java.lang.Object

m

Type search

Compare Heap Dumps

Heap usage - Total

Instances
570

380

190

39 78 117 156 195 234 273 312 351 390 429 468

Time stamp

Heap usage - Type com.is2t.test HeapDumpTestiTestObj

Instances
501

334

167

3% 78 117 156 195 234 273 312 351 390 429 468
Tirne stamp

Fig. 46: Progressive Heap Usage

The Compare tool compares the contents of two heap dump files. To open the tool select two heap dump XML files
in the Package Explorer, right-click and select Heap Analyzer > Compare

The Compare tool shows the types in the old heap on the left-hand side, and the types in the new heap on the
right-hand side, and marks the differences between them using different colors.

Typesin the old heap dump are colored red if there are one or more instances of this type which are in the old dump
but not in the new dump. The missing instances have been garbage collected.

Types in the new heap dump are colored green if there are one or more instances of this type which are in the new
dump but not in the old dump. These instances were created after the old heap dump was written.

Clicking to the right of the type name unfolds the list to show the instances of the selected type.
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£9 Heap Comparator ©% =0
Show ’AII instances v] Array type C] Class type
[0 Oid heap : heap-0.xm 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
char|] - char[] -
@ com.is2t.cldc.s3.DefaultSystem Out C] com.ist.clde.s3.DefaultSystem Out
(& com.is2ttest.HeapDumpTest (® com.is2ttest HeapDumpTest
(9 com.is2ttest.HeapDumpTestSTestObj (@ com.is2ttest.HeapDumpTestsTestObj
(@ com.is2ttest.HeapDumpTestSTestObj3 {5 com.is2t.test.HeapDumpTestSTestObj2
@ &j.bonlmmutables (@ com.is2t.test.HeapDumpTestSTestObj3
@ gj.benImmutablesFile @ gjbonImmutables
int[] ® gj.bonImmutablesFile
int[]] = int(] E
C] ist.supportlang. Systools 1 int[1[]
(@ ist.support.util EncUS_ASCT (@ ist.suppertlang.Systools
(@ ist.support.util EncodingConversion @ ist.support.util. EncUS_ASCT
(@ java.io.FileDescriptor (@ ist.support.util. EncodingConversion
(@ java.io FileDutputStream (@ java.ioFileDescriptor
(@ java.ic.OutputStream (@ java.ic.FileOutputStream
@ java.o, OutputStreamWiter @ java.o, QutputStream
(& java.io PrintStream — @ java.io.OutputStreamWriter B
(& java.ioWriter (@ java.io.PrintStream
@ java.lang.Exception C] java.ic Writer
@ javalangIndexOutOfBoundsException (@ javalang.Exception
(@ java.lang.MullPointerException @ javalangIndexOutOfBoundsException
(@ javalang.Object @ java.lang.MullPointerException
java.lang.Object[] @ javalang.Object
@ javalang.OutOfMemoryError i java.lang.Object[] i

Fig. 47: Compare Heap Dumps

The combo box at the top of the tool allows the list to be restricted in various ways:

« Allinstances - no restriction.

Garbage collected and new instances - show only the instances that exist in the old heap dump but notin the
new dump, or which exist in the new heap dump but not in the old dump.

Persistent instances - show only those instances that exist in both the old and new dumps.

Persistentinstances with value changed - show only those instances that exist in both the old and new dumps
and have one or more differences in the values of their fields.

Instance Fields Comparison View

The Compare toolworksin conjunction with the Instance Fields Comparison view, which opens automatically when
an instance is selected in the tool.

The view shows the values of the fields of the instance in both the old and new heap dumps, and highlights any
differences between the values.
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£9 Heap Comparator &1

=8
Show ’Persistent instances with value changed vl Array type @ Class type
[0 OId heap : heap-0.xml 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
3 com.ist.testHeapDumpTest (@ com.is?t.test.HeapDumpTest
& com.is?ttestHeapDumpTestSTestObj3 (& com.is?t.test. HeapDumpTestSTestObj3
dp #625 <dp #625
java.ang.Object[] java.lang. Object[]
(& javalang.Thread (& javalang.Thread
@ java.utilVector (@ java.util.Vector
Type com.is2t.test. HeapDumpTestSTestObj3 : 0 instances garbage collected, 0 new instances, 1 persistent instances.
El Console (E_L‘ Problems EE Outline (E Fields and Reference Hierarchy (Eﬁ Instance Fields Comparison 2 =
Fields Type Old value  New value
a @this © com.is2ttest. HeapDumpTestiTestOhbj3 #5625 #6525
@a int 0 0
Gb int 0 3
@c int 0 0

Fig. 48: Instance Fields Comparison view

3.10.6 ELF to Map File Generator

Principle

The ELF to Map generator takes an ELF executable file and generates a MicroEJ compliant .map file. Thus, any ELF
executable file produced by third party linkers can be analyzed and interpreted using the Memory Map Analyzer.

Functional Description

ELF Executable file

Execute
ELF to Map
Tool

Fig. 49: ELF To Map Process
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Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: ELF to Map

ELF to Map Input
ELF file: ‘ | Browse...
Output
Map file: ‘ | Browse...

Group: Input

Option(browse): ELF file

Option Name: input.file

Default value: (empty)

Group: Output

Option(browse): Map file

Option Name: output.file

Default value: (empty)
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3.10.7 Serial to Socket Transmitter
Principle

The MicroEJ serialToSocketTransmitter is a piece of software which transfers all bytes from a serial port to a tcp
client or tcp server.

Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: Serial to Socket

Serial to Socket Serial Options

Port: | COMD Baudrate: | 115200 v

Server Options

Port: | 5555

Group: Serial Options

Option(text): Port

Option Name: serail.to.socket.comm.port
Default value: COM0

Description: Defines the COM port:

Windows - COM1, COM2, ..., COM#n*

Linux- /dev/ttySo, /dev/ttyUSBo, ..., /dev/ttyS*nx, /dev/ttyUSBxnx
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Option(combo): Baudrate

Option Name: serail.to.socket.comm.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description: Defines the COM baudrate.

Group: Server Options
Option(text): Port

Option Name: serail.to.socket.server.port
Default value: 5555

Description: Defines the server IP port.

3.10.8 Memory Map Analyzer
Principle
When a MicroEJ Application is linked with the MicroEJ Workbench, a Memory MAP file is generated. The Memory

Map Analyzer (MMA) is an Eclipse plug-in made for exploring the map file. It displays the memory consumption of
different features in the RAM and ROM.
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Functional Description

MicroEJ
Application

Platform

1. Build the MicroEJ
Application

Map file Executable file

2. Open Memory
Map Analyzer

Fig. 50: Memory Map Analyzer Process

In addition to the executable file, the MicroEJ Platform generates a map file. Double click on this file to open the
Memory Map Analyzer.

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use

The map file is available in the MicroEJ Application project output directory.
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[ Pa. i JgMy. EiTe. iTe. = O | [0 HelloWorldjava &3 =g
= & v 2® * Javall .
. 55} MyHelloWorldSample ; package com.microej.example.hello;
4 4% src/main/java 16% import java.io.Filej[]
4 [ com.microej.example.hello 24
> 47| HelloWorld.java 258
. (™ src/main/resources 26 * Prints the message "Hello World !" an displays MicroE] splash
. 27 */
g fn“ Refe.ranced Libraries 28 public class HelloWorld extends Displayable implements EventHandler{
» [ .settings 29
4 [= commicroej.example.hello.HelloWorld 38 private static final int PADDING TEXT =5;
(&= bon 31 private static final int PADDING BETWEEN IMAGE AND TEXT = 3@;
> B ec ?% . final .
. o fonts ;z private final String[] messages; E -
(= heapDump 35 private Image microejImage;
- (= images L
= logs 378 public static void main(String[] args) {
> (= soar 38 -"?i_crnUI.sturt();
- 39 / new Helloworld().sh H
. (= toolbox -
m 48 try {
SOAR.map & 41 socket s = SSLSocketFactory.getDefoult().createSocket();
SOAR.0 a2 } catch (IOException &) {
> (= filesystem v 43 l Auto-generated catch block
N 44 e.printStackTrace();
[% classpath Z; '
X] project 47 File f = mew File("/s55");

&

Fig. 51: Retrieve Map File

Select an item (or several) to show the memory used by this item(s) on the right. Select “All” to show the memory
used by all items. This special item performs the same action as selecting all items in the list.

[# Pa.. 57 FgMy.. EjTe. = [0 | [0S0ARmap i = B8
< 7 ’ Image 5 Runtime Si
- . ame mage Size untime Size e
“ r" T,,yjrij,:nv:‘o;“;as\fample @ All 1899 KB 51.9 KB =
) L‘“ erc/main/resources . @ ApplicationCode 27KB 0B IMAGE: 49.3 KB /189.9 KB
S @ ApplicationFonts 24.2 KB 0B [ 26.00% ]
» =% Referenced Libraries
. @ Applicationlmages 3.2KB 0B :
g L/ settings > @ Applicationlmmutables 264 B 0B _Ap...l ArplicationSirings l
4= fum.mlcmej.examp\E‘heIIU.HeIIuWurld I 0E 0B
.V,_I/ ben > O ApplicationStrings 189 KB 0B (s
L . @ BSP 600 B 3.7KB
(& fonts . @ ClassesNames 71KB 0B
& heapDump . @ CoreEngine 20KB 7.5KB
© = mages . @ CoreEngineAllocator 08 36.0 KB
£ logs . @ Drivers 56 B 0B
=l ;”Z"bux . @ InstalledFestures 08 64B
E SOARmap > @ LibAddonWadapps 2288 0B
SOARo » & LibFoundationBOMN 856 B 0B
- . @ LibFoundaticnEDC 375KB 486 B
& filesystem . @ LibFoundationFs 01KB 4B
& - . @ LibFoundationkF 100 KB 0B
|%] .classpath . = 5
Project . @ L!hFﬂundat!nanchI 26.7 KB 41KB
- @ LibFoundationNET 26.5 KB 4B
. @ LibFoundationSSL 106 KB 0B

Fig. 52: Consult Full Memory

Select an item in the list, and expand it to see all symbols used by the item. This view is useful in understanding
why a symbol is embedded.
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Fig. 53: Detailed View

3.10.9 Event Tracing
Description

Event Tracing allows to record integer based events for debugging and monitoring purposes without affecting ex-
ecution performance too heavily. Basically, it gives access to Tracer objects that are named and can produce a
limited number of different event types.

Arecord is an event type identified by an eventID and can have a list of values. It can be a single event or a period
of time with a start and an end.

Event Tracing can be accessed from two APIs:

+ A Java API, provided by the Trace APl module. The following dependency must be added to the module.ivy
of the MicroEJ Application project:

<dependency org="ej.api" name="trace" rev="1.1.0"/>

« ACAPI, provided by the Platform header file named LLTRACE_impl.h.
Events are recorded if and only if:

« the MicroEJ Core Engine trace system is enabled,

« and trace recording is started.

To enable the MicroEJ Core Engine trace system, set the Application Option named core. trace.enabled to true
(see also launch configuration).

Then, multiple ways are available to start and stop the trace recording:
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+ by setting the Application Option named core.trace.autostart to true to automatically start at startup
(see also launch configuration),

« using the Java APl methods ej.trace.Tracer.startTrace() and ej.trace.Tracer.stopTrace(),

+ using the C API functions LLTRACE_IMPL_start(void) and LLTRACE_IMPL_stop(void).

Java APl Usage

The detailed Trace APl documentation is available here.

First, you need to instantiate a Tracer object by calling its constructor with two parameters. The first parameter,
name, is a String that will represent the Tracer object group’s name. The second parameter, nbEventTypes,isan
integer representing the maximum number of event types available for the group.

Tracer tracer = new Tracer("MyGroup”, 10);

Then, you can record an event by calling the recordEvent(int eventId) method. The event ID needs to be in
the range 0 to nbEventTypes-1 with nbEventTypes the maximum number of event types set when initializing
the Tracer object. Methods named recordEvent(...) always needs the event ID as the first parameter and can
have up to ten integer parameters as custom values for the event.

To record the end of an event, call the method recordEventEnd(int eventID) . It will trace the duration of an
event previously recorded with one of the recordEvent(int) methods. The recordEventEnd(...) method can
also have another integer parameter for a custom value for the event end. One can use it to trace the returned value
of a method.

The Trace API also provides a String constant Tracer. TRACE_ENABLED_CONSTANT_PROPERTY representing the Con-
stant value of core.trace.enabled option. This constant can be used to remove at build time portions of code
when the trace system is disabled. To do that, just surround tracer record calls with a if statement that checks the
constant’s state. When the constant is set to false, the code inside the if statement will not be embedded with
the application and thus will not impact the performances.

if(Constants.getBoolean(Tracer.TRACE_ENABLED_CONSTANT_PROPERTY)) {
// This code is not embedded if TRACE_ENABLED_CONSTANT_PROPERTY is set to false.
tracer.recordEventEnd(0);

}

Examples:

+ Trace asingle event:

private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();
tracer.recordEvent(0);

}

Standard Output:

VM START
[TRACE] [1] Declare group "Application”
[TRACE] [1] Event 0x0

«+ Trace a method with a start event showing the parameters of the method and an end event showing the
result:
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private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();

int a = 14;
int b = 54;
add(a, b);

}

public static int add(int a, int b) {
tracer.recordEvent(1, a, b);
int result = a + b;
tracer.recordEventEnd(1, result);
return result;

3

Standard Output:

VM START

[TRACE] [1] Declare group "Application”
[TRACE] [1] Event ox1 (14 [@OxE],54 [0x36])
[TRACE] [1] Event End 0x1 (68 [0x44])

Platform Implementation
By default, when enabled, the Trace API displays a message in the standard output for every recordevent(...)
and recordEventEnd(...) method calls.

It does not print a timestamp when displaying the trace message because it can drastically affect execution perfor-
mances. It only prints the ID of the recorded event followed by the values given in parameters.

A Platform can connect its own implementation by overriding the functions defined in the LLTRACE_impl.h file.

MicroEJ provides an implementation for SEGGER SystemView tool. Please contact MicroEJ Support for more infor-
mation about how to integrate this Platform module.

3.11 Advanced Tools

3.11.1 MicroEJ Linker
Overview

MicroEJ Linker is a standard linker that is compliant with the Executable and Linkable File format (ELF).

MicroEJ Linker takes one or several relocatable binary files and generates an image representation using a descrip-
tion file. The process of extracting binary code, positioning blocks and resolving symbols is called linking.

Relocatable object files are generated by SOAR and third-party compilers. An archive file is a container of Relocat-
able object files.

The description file is called a Linker Specific Configuration file (Isc). It describes what shall be embedded, and how
those things shall be organized in the program image. The linker outputs :
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+ An ELF executable file that contains the image and potential debug sections. This file can be directly used by
debuggers or programming tools. It may also be converted into a another format (Intel* hex, Motorola* s19,
rawBinary, etc.) using external tools, such as standard GNU binutils toolchain (objcopy, objdump, etc.).

« Amap file, in XML format, which can be viewed as a database of what has been embedded and resolved by
the linker. It can be easily processed to get a sort of all sizes, call graphs, statistics, etc.

+ The linker is composed with one or more library loaders, according to the platform’s configuration.

ELF Overview

An ELF relocatable file is split into several sections:
« allocation sections representing a part of the program
« control sections describing the binary sections (relocation sections, symbol tables, debug sections, etc.)

An allocation section can hold some image binary bytes (assembler instructions and raw data) or can refer to an
interval of memory which makes sense only at runtime (statics, main stack, heap, etc.). An allocation section is an
atomic block and cannot be split. A section has a name that by convention, represents the kind of data it holds.
For example, .text sections hold binary instructions, .bss sections hold read-write static data, .rodata hold
read-only data, and .data holds read-write data (initialized static data). The name is used in the .lsc file to organize
sections.

A symbol is an entity made of a name and a value. A symbol may be absolute (link-time constant) or relative to a
section: Its value is unknown until MicroEJ Linker has assigned a definitive position to the target section. A symbol
can be local to the relocatable file or global to the system. All global symbol names should be unique in the system
(the name is the key that connects an unresolved symbol reference to a symbol definition). A section may need the
value of symbols to be fully resolved: the address of a function called, address of a static variable, etc.

Linking Process

The linking process can be divided into three main steps:

1. Symbols and sections resolution. Starting from root symbols and root sections, the linker embeds all sec-
tions targeted by symbols and all symbols referred by sections. This process is transitive while new symbols
and/or sections are found. At the end of this step, the linker may stop and output errors (unresolved symbols,
duplicate symbols, unknown or bad input libraries, etc.)

2. Memory positioning. Sections are laid out in memory ranges according to memory layout constraints de-
scribed by the Isc file. Relocations are performed (in other words, symbol values are resolved and section
contents are modified). At the end of this step, the linker may stop and output errors (it could not resolve
constraints, such as not enough memory, etc.)

3. An output ELF executable file and map file are generated.

A partial map file may be generated at the end of step 2. It provides useful information to understand why the link
phase failed. Symbol resolution is the process of connecting a global symbol name to its definition, found in one of
the linker input units. The order the units are passed to the linker may have an impact on symbol resolution. The
rules are:

+ Relocatable object files are loaded without order. Two global symbols defined with the same name result in
an unrecoverable linker error.

« Archive files are loaded on demand. When a global symbol must be resolved, the linker inspects each archive
unit in the order it was passed to the linker. When an archive contains a relocatable object file that declares
the symbol, the object file is extracted and loaded. Then the first rule is applied. It is recommended that you
group object files in archives as much as possible, in order to improve load performances. Moreover, archive
files are the only way to tie with relocatable object files that share the same symbols definitions.
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« Asymbol name is resolved to a weak symbol if - and only if - no global symbol is found with the same name.

Linker Specific Configuration File Specification

Description

A Linker Specific Configuration (Lsc) file contains directives to link input library units. An Isc file is written in an XML
dialect, and its contents can be divided into two principal categories:

« Symbols and sections definitions.

+ Memory layout definitions.

Listing 5: Example of Relocation of Runtime Data from FLASH to RAM

<?xml version="1.0" encoding="UTF-8"7>
LY==
An example of linker specific configuration file
-—>
<lsc name="MyAppInFlash">
<include name="subfile.lscf"/>
<l--
Define symbols with arithmetical and logical expressions
-—=>
<defSymbol name="FlashStart” value="0"/>
<defSymbol name="FlashSize" value="0x10000"/>
<defSymbol name="FlashEnd"” value="FlashStart+FlashSize-1"/>
<l--
Define FLASH memory interval
-=>
<defSection name="FLASH" start="FlashStart"” size="FlashSize"/>

<l--
Some memory layout directives

-—>

<memoryLayout ranges ="FLASH">
<sectionRef name ="x.text"/>
<sectionRef name ="x.data"/>

</memorylLayout>

</1sc>

File Fragments

An Isc file can be physically divided into multiple Isc files, which are called Isc fragments. Lsc fragments may be
loaded directly from the linker path option, or indirectly using the include tagin an Isc file.

Lsc fragments start with the root tag 1scFragment . By convention the lsc fragments file extensionis .1scf . From
here to the end of the document, the expression “the Isc file” denotes the result of the union of all loaded (directly
and indirectly loaded) Isc fragments files.

Symbols and Sections

A new symbol is defined using defSymbol tag. Asymbol has a name and an expression value. All symbols defined
in the lsc file are global symbols.
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A new section is defined using the defSection tag. A section may be used to define a memory interval, or define
a chunk of the final image with the description of the contents of the section.

Memory Layout

A memory layout contains an ordered set of statements describing what shall be embedded. Memory positioning
can be viewed as moving a cursor into intervals, appending referenced sections in the order they appear. A symbol
can be defined as a “floating” item: Its value is the value of the cursor when the symbol definition is encountered.
In the example below, the memory layout sets the FLASH section. First, all sections named . text are embedded.
The matching sections are appended in a undefined order. To reference a specific section, the section shall have a
unique name (for example a reset vector is commonly called .reset or .vector,etc.). Then, the floating symbol
dataStart is set to the absolute address of the virtual cursor right after embedded .text sections. Finally all
sectionsnamed .data are embedded.

A memory layout can be relocated to a memory interval. The positioning works in parallel with the layout ranges,
as if there were two cursors. The address of the section (used to resolve symbols) is the address in the relocated
interval. Floating symbols can refer either to the layout cursor (by default), or to the relocated cursor, using the
relocation attribute. A relocation layout is typically used to embed data in a program image that will be used
at runtime in a read-write memory. Assuming the program image is programmed in a read only memory, one of
the first jobs at runtime, before starting the main program, is to copy the data from read-only memory to RAM,
because the symbols targeting the data have been resolved with the address of the sections in the relocated space.
To perform the copy, the program needs both the start address in FLASH where the data has been put, and the
start address in RAM where the data shall be copied.

Listing 6: Example of Relocation of Runtime Data from FLASH to RAM

<memorylLayout ranges="FLASH"” relocation="RAM" image="true">
<defSymbol name="DataFlashStart” value="."/>
<defSymbol name="DataRamStart” value=" ." relocation="true"/>
<sectionRef name=".data"/>
<defSymbol name="DataFlashLimit” value="."/>

</memorylLayout>

Note: the symbol DataRamStart is defined to the start address where .data sections will be inserted in RAM
memory.

Tags Specification
Here is the complete syntactical and semantical description of all available tags of the . 1sc file.

Table 5: Linker Specific Configuration Tags

Tags Attributes Description

Defines a new section. A floating section only holds a declared size
attribute. A fixed section declares at least one of the start / end at-
tributes. When this tag is empty, the section is a runtime section, and
must define at least one of the start, end or size attributes. When
this tag is not empty (when it holds a binary description), the section
is an image section.

defSection

Continued on next page
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Table 5 - continued from previous page
Tags Attributes Description
name Name of the section. The section name may not be unique. However,
it is recommended that you define a unique name if the section must
be referred separately for memory positioning.

start Optional. Expression defining the absolute start address of the sec-
tion. Must be resolved to a constant after the full load of the Isc file.

end Optional. Expression defining the absolute end address of the section.
Must be resolved to a constant after the full load of the lsc file.

size Optional. Expression defining the size in bytes of the section. Invari-

ant: (end-start)+1=size . Must be resolved to a constant after the
full load of the Isc file.

align Optional. Expression defining the alignment in bytes of the section.
rootSection | Optional. Boolean value. Sets this section as a root section to be em-
bedded even if it is not targeted by any embedded symbol. See also
rootSection tag.

symbolPrefix | Optional. Used in collaboration with symbolTags . Prefix of symbols
embedded in the auto-generated section. See Auto-generated Sec-
tions.

symbolTags Optional. Used in collaboration with symbolPrefix . Comma sepa-
rated list of tags of symbols embedded in the auto-generated section.
See Auto-generated Sections.

Defines a new global symbol. Symbol name must be unique in the
linker context

name Name of the symbol.

type Optional. Type of symbol usage. This may be necessary to set the type
of a symbol when using third party ELF tools. There are three types: -
none : default. No special type of use. - function: symbol describes
a function. - data: symbol describes some data.

value The value "." defines a floating symbol that holds the current cur-
sor position in a memory layout. (This is the only form of this tag that
can be used as a memorylLayout directive) Otherwise value is an ex-
pression. A symbol expression must be resolved to a constant after
memory positioning.

relocation Optional. The only allowed value is true . Indicates that the value
of the symbol takes the address of the current cursor in the memory
layout relocation space. Only allowed on floating symbols.
rootSymbol Optional. Boolean value. Sets this symbol as a root symbol that must
be resolved. See also rootSymbol tag.

weak Optional. Boolean value. Sets this symbol as a weak symbol.
memoryLayout directive. Defines a named group of sections. Group
name may be used in expression macros START, END, SIZE.All mem-
oryLayout directives are allowed within this tag (recursively).

name The name of the group.

Includes an Isc fragment file, semantically the same as if the fragment
contents were defined in place of the include tag.

name Name of the file to include. When the name is relative, the file sepa-
rator is /, and the file is relative to the directory where the current
[sc file or fragment is loaded. When absolute, the name describes a
platform-dependent filename.

Root tag for an .Isc file.

name Name of the Isc file. The ELF executable output will be {name}.out,
and the map file will be {name}.map

defSymbol

group

include

1sc

Continued on next page
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Table 5 - continued from previous page
Tags Attributes Description
1scFragment Root tag for an Isc file fragment. Lsc fragments are loaded from the
linker path option, or included from a master file using the include
tag.
Describes the organization of a set of memory intervals. The memory
layouts are processed in the order in which they are declared in the
file. The same interval may be organized in several layouts. Each lay-
out starts at the value of the cursor the previous layout ended. The fol-
lowing tags are allowed within a memoryLayout directive: defSymbol
(under certain conditions), group, memoryLayoutRef, padding,and
sectionRef .
ranges Exclusive with default. Comma-separated ordered list of fixed sections
to which the layout is applied. Sections represent memory segments.
image Optional. Boolean value. false if notset. If true, the layout de-
scribes a part of the binary image: Only image sections can be embed-
ded. If false, only runtime sections can be embedded.
relocation Optional. Name of the section to which this layout is relocated.
name Exclusive with ranges. Defines a named memoryLayout directive in-
stead of specifying a concrete memory location. May be included in a
parent memoryLayout using memoryLayoutRef.
memorylLayout directive. Provides an extension-point mechanism to
include memoryLayout directives defined outside the current one.
name All directives of memoryLayout defined with the same name are in-
cluded in an undefined order.
memorylLayout directive. Append padding bytes to the current cursor.
Either size or align attributes should be provided.
size Optional. Expression must be resolved to a constant after the full load
of the Isc file. Increment the cursor position with the given size.
align Optional. Expression must be resolved to a constant after the full load
of the Isc file. Move the current cursor position to the next address that
matches the given alignment. Warning: when used with relocation,
the relocation cursor is also aligned. Keep in mind this may increase
the cursor position with a different amount of bytes.
address Optional. Expression must be resolved to a constant after the full load
of the Isc file. Move the current cursor position to the given absolute
address.
fill Optional. Expression must be resolved to a constant after the full load
of the Isc file. Fill padding with the given value (32 bits).
References a section name that must be embedded. This tagis not a
definition. It forces the linker to embed all loaded sections matching
the given name.
name Name of the section to be embedded.
References a symbol that must be resolved. This tagis not a definition.
It forces the linker to resolve the value of the symbol.
name Name of the symbol to be resolved.
Memory layout statement. Embeds all sections matching the given
name starting at the current cursor address.
file Select only sections defined in a linker unit matching the given file
name. Thefile nameis the simple name without any file separator, e.g.
bsp.o or mylink.lsc. Link units may be object files within archive
units.

memorylLayout

memorylLayoutRef

padding

rootSection

rootSymbol

sectionRef

Continued on next page
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Table 5 - continued from previous page

Tags

Attributes

Description

name

Name of the sections to embed. When the name ends with *, all sec-
tions starting with the given name are embedded (name completion),
except sections that are embedded in another sectionRef using the ex-
act name (without completion).

symbol

Optional. Only embeds the section targeted by the given symbol. This
is the only way at link level to embed a specific section whose name is
not unique.

force

Optional. Deprecated. Replaced by the rootSection tag. The only
allowed value is true. By default, for compaction, the linker embeds
only what is needed. Setting this attribute will force the linker to em-
bed all sections that appear in all loaded relocatable files, even sec-
tions that are not targeted by a symbol.

sort

Optional. Specifies that the sections must be sorted in memory. The
value can be: - order : the sections will be in the same order as the
input files - name : the sections are sorted by their file names - unit
: the sections declared in an object file are grouped and sorted in the
order they are declared in the object file

u4

Binary section statement. Describes the four next raw bytes of the
section. Bytes are organized in the endianness of the target ELF ex-
ecutable.

value

Expression must be resolved to a constant after the full load of the lsc
file (32 bits value).

file

Binary section statement. Fills the section with the given expression.
Bytes are organized in the endianness of the target ELF executable.

size

Expression defining the number of bytes to be filled.

value

Expression must be resolved to a constant after the full load of the Isc
file (32 bits value).

Expressions

An attribute expression is a value resulting from the computation of an arithmetical and logical expression. Sup-
ported operators are the same operators supported in the Java language, and follow Java semantics:

« Unaryoperators: + , - , ~ |

« Binaryoperators: + , -, x |/ | % , <<, >>> 0 0>> < 0> <= 0>= == = & | "

&&

« Ternary operator: cond ? ifTrue :

|

« Built-in macros:

ifFalse

START (name) : Get the start address of a section or a group of sections

END(name) : Get the end address of a section or a group of sections

SIZE(name) : Get the size of a section or a group of sections. Equivalent to END(name)-START (name)

TSTAMPH() , TSTAMPL () : Get 32 bits linker time stamp (high/low part of system time in milliseconds)

’

SUM(name, tag) : Get the sum of an auto-generated section (Auto-generated Sections) column. The col-
umn is specified by its tag name.

An operand is either a sub expression, a constant, or a symbol name. Constants may be written in decimal (127) or
hexadecimal form (@x7F ). There are no boolean constants. Constant value © means false, and other constants’

values mean true. Examples of use:
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value="symbol+3"
value="((symbol1*4)-(symbol2*3)"

Note: Ternary expressions can be used to define selective linking because they are the only expressions that may
remain partially unresolved without generating an error. Example:

<defSymbol name="myFunction” value="condition ? symbl : symb2"/>

No error will be thrown if the condition is true and symb1 is defined, or the condition is false and symb2 is
defined, even if the other symbol is undefined.

Auto-generated Sections

The MicroEJ Linker allows you to define sections that are automatically generated with symbol values. This is com-
monly used to generate tables whose contents depends on the linked symbols. Symbols eligible to be embedded
in an auto-generated section are of the form: prefix_tag_suffix.An auto-generated section is viewed as a table
composed of lines and columns that organize symbols sharing the same prefix. On the same column appear sym-
bols that share the same tag. On the same line appear symbols that share the same suffix. Lines are sorted in the
lexical order of the symbol name. The next line defines a section which will embed symbols starting with zeroinit
. Thefirst column refers to symbols starting with zeroinit_start_;the second column refers to symbols starting
with zeroinit_end_.

<defSection
name=".zeroinit"
symbolPrefix="zeroInit"”
symbolTags="start,end"”
/>

Consider there are four defined symbols named zeroinit_start_xxx , zeroinit_end_xxx ,
zeroinit_start_yyy and zeroinit_end_yyy . The generated section is of the form:

0x00: zeroinit_start_xxx
0x04: zeroinit_end_xxx
0x08: zeroinit_start_yyy
0x0C: zeroinit_end_yyy

If there are missing symbols to fill a line of an auto-generated section, an error is thrown.

Execution

MicroEJ Linker can be invoked through an ANT task. The task is installed by inserting the following code in an ANT
script

<taskdef
name="1linker"
classname="com.is2t.linker.GenericLinkerTask"
classpath="[LINKER_CLASSPATH]"

/>

[LINKER_CLASSPATH] is a list of path-separated jar files, including the linker and all architecture-specific library
loaders.

The following code shows a linker ANT task invocation and available options.

3.11. Advanced Tools 144



MicroEJ Documentation, Revision 4€20bb27

<linker
doNotLoadAlreadyDefinedSymbol="[true|false]”
endianness="[little|big|none]”
generateMapFile="[true|false]”
ignoreWrongPositioningForEmptySection="[true|false]”
lsc="[filename]"
linkPath="[path1:...pathN]"
mergeSegmentSections="[true|false]”
noWarning="[true|false]”
outputArchitecture="[tag]l"
outputName="[name]"
stripDebug="[true|false]”
toDir="[outputDirl]”
verboselLevel="[0...9]"

>
<!-- ELF object & archives files using ANT paths / filesets -->
<fileset dir="xxx" includes="x.0">
<fileset file="xxx.a">
<fileset file="xxx.a">
<!-- Properties that will be reported into .map file -->
<property name="myProp"” value="myValue"/>

</linker>
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Table 6: Linker Options Details

Option

Description

doNotLoadAlreadyDefinedSymbol

Silently skip the load of a global symbol if it has already
been loaded before. ( false by default. Only the first
loaded symbol is taken into account (in the order input
files are declared). This option only affects the load se-
mantic for global symbols, and does not modify the se-
mantic for loading weak symbols and local symbols.

Explicitly declare linker endianness [little, big] or

endianness [none] for auto-detection. All input files must declare
the same endianness or an error is thrown.
Generate the .map file ( true by default).
generateMapFile

ignoreWrongPositioningForEmptySection

Silently ignore wrong section positioning for zero size
sections. ( false by default).

Provide a master Iscfile. This optionis mandatory unless

lsc the linkPath option is set.
) Provide a set of directories into which to load link file
linkPath fragments. Directories are separated with a platform-
path separator. This option is mandatory unless the 1sc
option is set.
Silently skip the output of warning messages.
noWarning

mergeSegmentSections

(experimental). Generate a single section per segment.
This may speed up the load of the output executable file
into debuggers or flasher tools. ( false by default).

outputArchitecture

Set the architecture tag for the output ELF file (ELF ma-
chineid).

outputName

Specify the output name of the generated files. By de-
fault, take the name provided in the Isc tag. The output
ELF executable filename will be name.out. The map file-
name will be name.map.

stripDebug

Remove all debug information from the output ELF file.
A stripped output ELF executable holds only the binary
image (no remaining symbols, debug sections, etc.).

toDir

Specify the output directory in which to store generated
files. Output filenames are inthe form: od + separator
+ value of the 1lsc name attribute + suffix.
By default, without this option, files are generated in the
directory from which the linker was launched.

verboselLevel

Print additional messages on the standard output about
linking process.

Error Messages

This section lists MicroEJ Linker error messages.

Table 7: Linker-Specific Configuration Tags

Message ID Description
0 The linker has encountered an unexpected internal error. Please contact the support hot-
line.

Continued on next page
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Table 7 - continued from previous page

1 A library cannot be loaded with this linker. Try verbose to check installed loaders.

2 No sc file provided to the linker.

3 Afile could not be loaded. Check the existence of the file and file access rights.

4 Conflictinginput libraries. Aglobal symbol definition with the same name has already been
loaded from a previous object file.

5 Completion (*) could not be used in association with the force attribute. Must be an exact
name.

6 Arequired section refers to an unknown global symbol. Maybe input libraries are missing.

7 A library loader has encountered an unexpected internal error. Check input library file in-
tegrity.

8 Floating symbols can only be declared inside memorylLayout tags.

9 Invalid value format. For example, the attribute relocation in defSymbol must be a
boolean value.

10 Missing one of the following attributes: address, size, align.

1 Too many attributes that cannot be used in association.

13 Negative padding. Memory layout cursor cannot decrease.

15 Not enough space in the memory layout intervals to append all sections that need to be
embedded. Check the output map file to get more information about what is required as
memory space.

16 A block is referenced but has already been embedded. Most likely a block has been espe-
cially embedded using the force attribute and the symbol attribute.

17 A block that must be embedded has no matching sectionRef statement.

19 An 10 error occurred when trying to dump one of the output files. Check the output direc-
tory option and file access rights.

20 size attribute expected.

21 The computed size does not match the declared size.

22 Sections defined in the Isc file must be unique.

23 One of the memory layout intervals refers to an unknown Isc section.

24 Relocation must be done in one and only one contiguous interval.

25 force and symbol attributes are not allowed together.

26 XML char data not allowed at this position in the Isc file.

27 A section which is a part of the program image must be embedded in an image memory
layout.

28 A section which is not a part of the program image must be embedded in a non-image
memory layout.

29 Expression could not be resolved to a link-time constant. Some symbols are unresolved.

30 Sections used in memory layout ranges must be sections defined in the Isc file.

31 Invalid character encountered when scanning the lsc expression.

32 Arecursive include cycle was detected.

33 An alignment inconsistency was detected in a relocation memory layout. Most likely one
of the start addresses of the memory layout is not aligned on the current alignment.

34 An error occurs in a relocation resolution. In general, the relocation has a value that is out
of range.

35 symbol and sort attributes are not allowed together.

36 Invalid sort attribute value is not one of order, name,or no.

37 Attribute start or end in defSection tagis notallowed when defining a floating section.

38 Autogenerated section can build tables according to symbol names (see Auto-generated
Sections). A symbol is needed to build this section but has not been loaded.

39 Deprecated feature warning. Remains for backward compatibility. It is recommended that
you use the new indicated feature, because this feature may be removed in future linker
releases.

Continued on next page
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Table 7 - continued from previous page
40 Unknown output architecture. Either the architecture ID is invalid, or the library loader has
not been loaded by the linker. Check loaded library loaders using verbose option.
41...43 Reserved.

44 Duplicate group definition. A group name is unique and cannot be defined twice.

45 Invalid endianness. The endianness mnemonic is not one of the expected mnemonics (
little,big,none).

46 Multiple endiannesses detected within loaded input libraries.

47 Reserved.

48 Invalid type mnemonic passed to a defSymbol tag. Must be one of none, function, or
data.

49 Warning. A directory of link path is invalid (skipped).

50 No linker-specific description file could be loaded from the link path. Check that the link
path directories are valid, and that they contain .1sc or .1scf files.

51 Exclusive options (these options cannot be used simultaneously). For example,

-linkFilename and -linkPath are exclusive; either select a master Isc file or a path from
which to load .1scf files.

52 Name given to a memorylLayoutRef ora memoryLayout isinvalid. It must not be empty.

53 A memorylLayoutRef with the same name has already been processed.

54 A memorylLayout must define ranges orthe name attribute.

55 No memory layout found matching the name of the current memoryLayoutRef .

56 Anamed memorylLayout is declared with a relocation directive, but the relocation interval
is incompatible with the relocation interval of the memoryLayout that referenced it.

57 A named memorylLayout has not been referenced. Every declared memorylLayout must
be processed. Anamed memorylLayout must be referenced by a memorylLayoutRef state-
ment.

58 SUM operator expects an auto-generated section.

59 SUM operator tag is unknown for the targetted auto-generated section.

60 SUM operator auto-generated section name is unknown.

61 An option is set for an unknown extension. Most likely the extension has not been set to
the linker classpath.

62 Reserved.

63 ELF unit flags are inconsistent with flags set using the -forceFlags option.

64 Reserved.

65 Reserved.

66 Found an executable object file as input (expected a relocatable object file).

67 Reserved.

68 Reserved.

69 Reserved.

70 Not enough memory to achieve the linking process. Try to increase JVM heap that is run-

ning the linker (e.g. by adding option -Xmx1024M to the JRE command line).

Map File Interpretor

The map file interpretor is a tool that allows you to read, classify and display memory information dumped by
the linker map file. The map file interpretor is a graph-oriented tool. It supports graphs of symbols and allows
standard operations on them (union, intersection, subtract, etc.). It can also dump graphs, compute graph total
sizes, list graph paths, etc.

The map file interpretor uses the standard Java regular expression syntax.

Itis used internally by the graphical Memory Map Analyzer tool.

Commands:
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e createGraph graphName symbolRegExp ... section=regexp

createGraph all section=.*

Recursively create a graph of symbols from root symbols and sections described as regular expressions. For
example, to extract the complete graph of the application:

e createGraphNoRec symbolRegExp ... section=regexp

The above line is similar to the previous statement, but embeds only declared symbols and sections (without
recursive connections).

¢ removeGraph graphName

Removes the graph for memory.

¢ listGraphs

Lists all the created graphs in memory.

¢ listSymbols graphName

Lists all graph symbols.

e listPadding

Lists the padding of the application.

* listSections graphName

Lists all sections targeted by all symbols of the graph.

e inter graphResult g1 ... gn
Creates a graph which is the intersection of g1/\ ... /\gn.
e union graphResult g1 ... gn

Creates a graph which is the union of g1\/ ...\/ gn.

e substract graphResult g1 ... gn

Creates a graph which is the substract of g1\ ... \ gn.

* reportConnections graphName

Prints the graph connections.

e totalImageSize graphName

Prints the image size of the graph.

* totalDynamicSize graphName

Prints the dynamic size of the graph.
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¢ accessPath symbolName

The above line prints one of the paths from a root symbol to this symbol. This is very useful in helping you
understand why a symbol is embedded.

¢ echo arguments

Prints raw text.

¢« exec commandFile

Execute the given commandFile. The path may be absolute or relative from the current command file.

3.11.2 Testsuite Engine
Definition

The MicroEJ Testsuite is an engine made for validating any development project using automatic testing. The Mi-
croEJ Testsuite engine allows the user to test any kind of projects within the configuration of a generic ant file.

Using the MicroEJ Testsuite Ant tasks

Multiple Ant tasks are available in the testsuite-engine provided jar:
+ testsuite allowsthe userto run a given testsuite and to retrieve an XML report document in a JUnit format.

« javaTestsuite isasubtask ofthe testsuite task, used to run aspecialized testsuite for Java (will only run
Java classes).

« htmlReport is atask which will generate an HTML report from a list of JUnit report files.

The testsuite Task

This task have some mandatory attributes to fill:

« outputDir : the output folder of the testsuite. The final report will be generated at [outputDirl/[label]/
[reportName].xml , see the testsuiteReportFileProperty and testsuiteReportDirProperty at-
tributes.

« harnessScript : the harness script must be an Ant script and it is the script which will be called for each test
by the testsuite engine. Itis called with a basedir located at output location of the current test. The testsuite
engine will provide to it some properties giving all the informations to start the test:

- testsuite.test.name: The output name of the current test in the report. Default value is the relative
path of the test. It can be manually set by the user. More details on the output name are available in the
section Specific Custom Properties.

- testsuite.test.path: The current test absolute path in the filesystem.

- testsuite.test.properties: The absolute path to the custom properties of the current test (see the
property customPropertiesExtension)

- testsuite.common.properties: The absolute path to the common properties of all the tests (see the
property commonProperties)

- testsuite.report.dir: The absolute path to the directory of the final report.
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Some attributes are optional, and if not set by the user, a default value will be attributed.

« timeOut: the timein seconds before any test is considerated as unknown. Set it to 0 to disable the time-out.
Will be defaulted as 60.

« verboselLevel : the required level to output messages from the testsuite. Can be one of those values: error,
warning, info, verbose, debug. Will be defaulted as info.

« reportName : the final report name (without extension). Default value is testsuite-report.

« customPropertiesExtension : the extension of the custom properties for each test. For instance, if it is
setto .options, atest named xxx/Testl.class will be associated with xxx/Test1.options . If afile
exists for a test, the property testsuite.test.properties is set with its absolute path and given to the
harnessScript. If the test path references a directory, then the custom properties path is the concatenation
of the test path and the customPropertiesExtension value. By default, custom properties extension is
.properties.

« commonProperties:the properties to apply to every test of the testsuite. Those options might be overridden
by the custom properties of each test. If this option is set and the file exists, the property testsuite.common.
properties is set to the absolute path of the harnessScript file. By default, there is not any common
properties.

« label: the build label. Will be generated as a timestamp by the testsuite if not set.
« productName : the name of the current tested product. Default value is TestSuite.

« jvm: the location of your Java VM to start the testsuite (the harnessScript iscalled asis: [jvm] [...]
-buildfile [harnessScript]). Will be defaulted as your java.home location if the property is set, or to
java.

jvmargs : the arguments to pass to the Java VM started for each test.

« testsuiteReportFileProperty:the name of the Ant property in which is stored the path of the final report.
Default valueis testsuite.report.file and pathis [outputDir]/[label]/[reportName].xml

testsuiteReportDirProperty : the name of the Ant property in which is store the path of the directory of
the final report. Default value is testsuite.report.dir and pathis [outputDir]/[label]

« testsuiteResultProperty : the name of the Ant property in which you want to have the result of the test-
suite (true or false), depending if every tests successfully passed the testsuite or not. Ignored tests do not
affect this result.

Finally, you have to give as nested element the path containing the tests.
+ testPath: containing all the file of the tests which will be launched by the testsuite.

« testIgnoredPath (optional): Any testin the intersection between testIgnoredPath and testPath will be
executed by the testsuite, but will not appear in the JUnit final report. It will still generate a JUnit report for
each test, which will allow the HTML report to let them appears as “ignored” if it is generated. Mostly used
for known bugs which are not considered as failure but still relevant enough to appears on the HTML report.

The javaTestsuite Task

This task extends the testsuite task, specializing the testsuite to only start real Java class. This task will retrieve
the classname of the tests from the classfile and will provide new properties to the harness script:

+ testsuite.test.class: The classname of the current test. The value of the property testsuite.test.
name is also set to the classname of the current test.

o testsuite.test.classpath: The classpath of the current test.
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The htmlReport Task

This task allow the user to transform a given path containing a sample of JUnit reports to an HTML detailled report.
Here is the attributes to fill:

+ Anested fileset containing all the JUnit reports of each test. Take care to exclude the final JUnit report gen-
erated by the testsuite.

« Anested element report

- format : The format of the generated HTML report. Must be noframes or frames. When noframes
format is choosen, a standalone HTML file is generated.

- todir: The output folder of your HTML report.

- The report tagaccepts the nested tag param with name and expression attributes. These tags can
pass XSL parameters to the stylesheet. The built-in stylesheets support the following parameters:

* PRODUCT : the product name that is displayed in the title of the HTML report.
* TITLE :the comment that is displayed in the title of the HTML report.

Note: Tip: Itis advised to set the formatto noframes if your test suite is not a Java testsuite. If the format is set to
frames , with a non-Java MicroEJ Testsuite, the name of the links will not be relevant because of the non-existency
of packages.

Using the Trace Analyzer

This section will shortly explains how to use the Trace Analyzer . The MicroEJ Testsuite comes with an archive
containing the Trace Analyzer which can be used to analyze the output trace of an application. It can be used
from different forms;

« The FileTraceAnalyzer will analyze a file and research for the given tags, failing if the success tag is not
found.

« The SerialTraceAnalyzer will analyze the data from a serial connection.

The TraceAnalyzer Tasks Options

Here is the common options to all TraceAnalyzer tasks:
« successTag: the regular expression which is synonym of success when found (by default . *PASSED. * ).
« failureTag: the regular expression which is synonym of failure when found (by default . *FAILED.x* ).
« verboselevel :intvalue between 0 and 9 to define the verbose level.
« waitingTimeAfterSuccess : waitingtime (in s) after success before closing the stream (by default 5).

« noActivityTimeout : timeout (in s) with no activity on the stream before closing the stream. Set it to 0 to
disable timeout (default value is 0).

+ stopEOFReached : boolean value. Setto true to stop analyzing when input stream EOF is reached. If false
, continue until timeout is reached (by default false).

« onlyPrintableCharacters:booleanvalue. Setto true toonly dump ASCIl printable characters (by default
false).
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The FileTraceAnalyzer Task Options

Here is the specific options of the FileTraceAnalyzer task:

« traceFile: path to the file to analyze.

The SerialTraceAnalyzer Task Options

Here is the specific options of the SerialTraceAnalyzer task:
« port:the comm port to open.
« baudrate: serial baudrate (by default 9600).
+ databits: databits (5/6|7|8) (by default 8).
+ stopBits: stopbits (0|1|3 for (1_5)) (by default 1).

+ parity: none | odd | event (bydefault none).

Appendix

The goal of this section is to explain some tips and tricks that might be useful in your usage of the testsuite engine.

Specific Custom Properties

Some custom properties are specifics and retrieved from the testsuite engine in the custom properties file of a test.

» The testsuite.test.name property is the output name of the current test. Here are the steps to compute
the output name of a test:

- If the custom properties are enabled and a property named testsuite.test.name is find on the cor-
responding file, then the output name of the current test will be set to it.

- Otherwise, if the running MicroEJ Testsuite is a Java testsuite, the output name is set to the class name
of the test.

- Otherwise, from the path containing all the tests, a common prefix will be retrieved. The output name
will be set to the relative path of the current test from this common prefix. If the common prefix equals
the name of the test, then the output name will be set to the name of the test.

- Finally, if multiples tests have the same output name, then the current name will be followed by _XXX
, an underscore and an integer.

« The testsuite.test.timeout property allow the user to redefine the time out for each test. If it is negative
or not an integer, then global timeout defined for the MicroEJ Testsuite is used.

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.
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CHAPTER

FOUR

PLATFORM DEVELOPER GUIDE

4.1 Introduction

4.1.1 Scope

This document explains how the core features of MicroEJ Architecture are accessed, configured and used by the
MicroEJ Platform builder. It describes the process for creating and augmenting a MicroEJ Architecture. This doc-
ument is concise, but attempts to be exact and complete. Semantics of implemented Foundation Libraries are
described in their respective specifications. This document includes an outline of the required low level drivers
(LLAPI) for porting the MicroEJ Architectures to different real-time operating systems (RTOS).

MicroEJ Architecture is state-of-the-art, with embedded MicroEJ runtimes for MCUs. They also provide simulated
runtimes that execute on workstations to allow software development on “virtual hardware.”

4.1.2 Intended Audience

The audience for this document is software engineers who need to understand how to create and configure a Mi-
croEJ Platform using the MicroEJ Platform builder. This document also explains how a MicroEJ Application can
interoperate with C code on the target, and the details of the MicroEJ Architecture modules, including their APIs,
error codes and options.

4.1.3 MicroEJ Architecture Modules Overview

MicroEJ Architecture features the MicroEJ Core Engine: a tiny and fast runtime associated with a Garbage Collector.
It provides four built-in Foundation Libraries :

.+ [BON]
« EDC
. [SNI]
. [sP]

The following figure shows the components involved.
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Fig. 1: MicroEJ Architecture Runtime Modules: Tools, Libraries and APIs

Three APIs allow the device architecture runtime to link with (and port to) external code, such as any kind of RTOS
or legacy C libraries. These three APIs are

+ Simple Native Interface ([SN/])
+ Low Level MicroEJ Core Engine (LLMJVM)
« Low Level Shielded Plug (LLSP)
MicroEJ Architecture features additional Foundation Libraries and modules to extend the kernel:
« serial communication,
« Ul extension (User Interface)
+ networking
« file system
. etc.

Each additional module is optional and selected on demand during the MicroEJ Platform configuration.
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4.2 MicroEJ Platform

4.2.1 Process Overview

This section summarizes the steps required to build a MicroEJ Platform and obtain a binary file to deploy on a
board.

The following figure shows the overall process. The first three steps are performed within the MicroEJ Platform
builder. The remaining steps are performed within the C IDE.

MicroF.J 1. Create a new MlcroE_J Plat_form —
= MicroEJ Platform  =——b Il E1ile])]
configuration project project

'

3. Build the MicroEJ
Platform

2. Select and configure
— additiocnal modules

Architecture

Microf MicroEJ Platform

Application code

l

4. Build the MicroEJ
Application

{

Application
library file

MicroEJ Workbench

CIDE

C application Architecture

code and Board
Support Package

library file

(microejapp.o) (microejruntime.a)

|

5. Build and link the full
application

|

Executable

application

!

6. Program and test the
application on the
board

Fig. 2: Overall Process

1. Step 1 consists in creating a new MicroEJ Platform configuration project. This project describes the MicroEJ
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Platform (MicroEJ architecture, metadata, etc.).

2. Step 2 allows you to select which modules available in MicroEJ Architecture will be installed in the MicroEJ
Platform.

3. Step 3 builds the MicroEJ Platform according to the choices made in steps 1and 2.

4. Step 4 compiles a MicroEJ Application against the MicroEJ Platform in order to obtain an application file to
link in the BSP.

5. Step 5 consists in compiling the BSP and linking it with the MicroEJ Application that was built previously, in
step 4.

6. Step 6 is the final step: Deploy the binary application onto a board.

4.2.2 Concepts

MicroEJ Platform

A MicroEJ Platform includes development tools and a runtime environment.
The runtime environment consists of:

« A MicroEJ Core Engine.

« Some Foundation Libraries.

« Some C libraries.
The development tools are composed of:

« Java APIs to compile MicroEJ Application code.

« Documentation: this guide, library specifications, etc.

+ Tools for development and compilation.

« Launch scripts to run the simulation or build the binary file.

+ Eclipse plugins.

MicroEJ Platform Configuration
A MicroEJ Platform is described by a .platform file. This file is usually called [name].platform,and isstored at
the root of a MicroEJ Platform configuration project called [name]-configuration.

The configuration file is recognized by the MicroEJ Platform builder. The MicroEJ Platform builder offers a visual-
ization with two tabs:
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¥ STM32FT46GDISCO-example-CMThardfp_ARMCCS 23

= O

0 Overview

Platform Properties Platform Content

[General information about this platform., The content of the platform is composed of two parts:

Device: STM3IZFTA6GDISCO €2 Environment: select the architecture,

Name: example ‘¥ Modules: select modules to import in the platform.

fersion: - 72057

Version: 2.1,0-RC201604072057 Platform Configuration

Provider : Microk) Once the content of the platform is chosen, it can be configured.
Vendor URL:

#2| Configuration

Each module can be configured creating a folder with its name along
the .platform file. It could contain:

* an optional [module]. properties file,
* opticnal module specific files and folders.

Meodifying one these files requires to build the platform again,

Build
Generate and test the platform.

X Build Plstform: The new platform is now available and visible in
Available Platforms

Owverview | Content
Fig. 3: MicroEJ Platform Configuration Overview Tab

This tab groups the basic platform information used to identify it: its name, its version, etc. These tags can be
updated at any time.
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Fig. 4: MicroEJ Platform Configuration Content Tab

This tab shows all additional modules (see Modules) which can be installed into the platform in order to augment
its features. The modules are sorted by groups and by functionality. When a module is checked, it will be installed
into the platform during the platform creation.

Modules

The primary mechanism for augmenting the capabilities of a MicroEJ Platform is to add modules to it.

A MicroEJ module is a group of related files (Foundation Libraries, scripts, link files, C libraries, Simulator, tools,
etc.) that together provide all or part of a platform capability. Generally, these files serve a common purpose. For
example, providing an API, or providing a library implementation with its associated tools.

The list of modules is in the second tab of the platform configuration tab. A module may require a configuration
step to be installed into the platform. The Modules Detail view indicates if a configuration file is required.

Low Level API Pattern
Principle

Each time the user must supply C code that connects a platform component to the target, a Low Level APl is defined.
There is a standard pattern for the implementation of these APIs. Each interface has a name and is specified by two
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header files:

« [INTERFACE_NAMET.h specifies the functions that make up the public API of the implementation. In some
cases the user code will never act as a client of the API, and so will never use this file.

o [INTERFACE_NAME]_impl.h specifies the functions that must be coded by the user in the implementation.

The user creates implementations of the interfaces, each captured in a separate C source file. In the simplest form
of this pattern, only one implementation is permitted, as shown in the illustration below.

Low Level API

LLXXX.h LLXXX_implL.h
void LLXXX init(); void LLXXX _TMPL init();
application.c MYIMPL.c
#tinclude "LLXXX.h" #include "LLXXX_impl.h"
Main() { Void LLXXX IMPL init() {

LLXXX_init(); // implementation code
¥ }

Fig. 5: Low Level API Pattern (single implementation)

The following figure shows a concrete example of an LLAPI. The C world (the board support package) has to imple-
ment a send function and must notify the library using a receive function.
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MicroEJ Application

Java communication library (ECOM Comm)

MicroEJ world call LLAPI
LLAPI notify library
LLCOM.h LLCOM_impl.h
void LLCOM dataReceived(..); void LLCOM IMPL sendData(..);
LLAPI
C world call LLAP! implement LLAPI
driver_interrupt.c driver.c
#include "LLCOM.h™ #include "LLCOM_IMPL.h"
IRQ data received(..) { void LLCOM IMPL sendData(..) {
LLCOM_dataReceived(..); // implementation code
1 1
J J

Fig. 6: Low Level APl Example

Multiple Implementations and Instances

When a Low Level API allows multiple implementations, each implementation must have a unique name. At run-
time there may be one or more instances of each implementation, and each instance is represented by a data struc-
ture that holds information about the instance. The address of this structure is the handle to the instance, and that
address is passed as the first parameter of every call to the implementation.

The illustration below shows this form of the pattern, but with only a single instance of a single implementation.
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Low Level API
LLXXX.h LLXXX_implL.h
void LLXXX init(LLXXX* env); void LLXXX TMPL init(LLXXX* env);

/4 /4

MYIMPL.h
#include "LLXXX.h™

typedef struct MYIMPL {
struct LLXXX header;
//specific fields defined here
} MYIMPL;
void MYIMPL_new(MYIMP* env);

application.c MYIMPL.c
#include "MYIMPL.h" #include "MYIMPL.h"
#define LLXXX_ IMPL MYIMPL
MYIMPL instance; #include "LLXXX impl.h"
Main() {
MYIMPL_new(&instance); Void LLXXX_IMPL_init(LLXXX* env) {
LLXXX init(&instance); // implementation code
} 7 } 7

Fig. 7: Low Level API Pattern (multiple implementations/instances)

The #define statementin MYIMPL.c specifies the name given to this implementation.

4.2.3 MicroEJ Platform Creation

This section describes the steps to create a new MicroEJ Platform in MicroEJ SDK, and options to connect it to an
external Board Support Package (BSP) as well as a third-party C toolchain.

MicroEJ SDK must be started on a new empty workspace.

MicroEJ Architecture Import

The first step is to choose and import a MicroEJ Architecture. MicroEJ Architectures for most common microcon-
troller instructions sets and compilers can be downloaded from https://repository.microej.com/architectures/‘_.

MicroEJ Architecture files ends with the . xpf extension, and are classified using the following folder naming con-
vention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]/[VERSION]/[UID]-[VERSION]-[USAGE].xpf

« ISA:instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32,...).
+ TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48).

! MicroEJ Architectures for production can be retrieved from the license server.
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+ VERSION:module version (e.g. 7.12.0).
+ UID:Architecture unique ID (e.g. flopi4G25).
« USAGE = eval forevaluation Architectures, prod for production Architectures.

For example, MicroEJ Architecture versions for Arm® Cortex®-M4 microcontrollers compiled with GNU CC toolchain
is available at https://repository.microej.com/architectures/com/microej/architecture/CM4/CM4hardfp_GCC48/
flopi4G25/.

Once you downloaded a MicroEJ Architecture file, proceed with the following steps to import it in MicroEJ SDK:
« Select File > Import > MicroEJ > Architectures .
« Browse an .xpf file or afolder that contains one or more an . xpf files.

+ Check the |agree and accept the above terms and conditions... box to accept the license.

« Clickon Finish button.

Note: A MicroEJ Architecture can be imported using MicroEJ Module Manager, by adding the following line in a
module description file:

<dependency org="com.microej.architecture.[ISA].[TOOLCHAIN]" name="[UID]" rev="[VERSION]" conf="default
>

<artifact name="[UID]"” m:classifier="[USAGE]" ext="xpf"/>
</dependency>

MicroEJ Platform Configuration

The next step is to create a MicroEJ Platform configuration:

« Select File > New > MicroEJ Platform Project... .

+ Clickon Next button. The Configure Target Architecture page allows to select the MicroEJ Architecture that
contains a minimal MicroEJ Platform and a set of compatible modules targeting a processor architecture and
a compilation toolchain. This environment can be changed later.

- Clickon Browse... button to select one of the installed MicroEJ Architecture.

- Check the Create from a platform reference implementation box to use one of the available imple-

mentation. Uncheck it if you want to provide your own implementation or if no reference implementa-
tion is available.

+ Click on Next button. The Configure platform properties page contains the identification of the
MicroEJ Platform to create. Most fields are mandatory, you should therefore set them. Note that their values
can be modified later on.

+ Click on Finish button. A new project [device]-[name]-[toolchain] is being created containing a
[name].platform file. A Platform description editor shall then open.

« Install Platform Configuration Additions. Files within the content folder have to be copied to
the configuration project folder, by following instructions described at https://github.com/MicroEJ/
PlatformQualificationTools/blob/master/framework/platform/README.rst.

You should get a MicroEJ Platform configuration project that looks like:
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v = mydevice-myplatform-mytoolchain
v = bsp
bsp.properties
w [= dropins
w [ scripts
w [ init-bsp
| initacml
| deploylnBSP.xml
=| deployToclB5PRun.microgjTool
s fulllink.microgjLaunch
fulllink.microgjLaunch.properties
| £ workbenchExtension_launchScriptFramework,jar
¥| .project
| configurationxml
X myplatform.platform

Fig. 8: MicroEJ Platform Configuration Project Skeleton

Groups [ Modules Selection
From the Platform description editor, select the Content tab to access the Platform modules selection. Modules
can be selected/deselected from the Modules frame.

Modules are organized into groups. When a group is selected, by default, all its modules are selected. To view the
modules making up a group, click on the Show/Hide modules icon on the top-right of the frame. This will let you
select/deselect on a per module basis. Note that individual module selection is not recommended.

The description and contents of an item (group or module) are displayed beside the list on item selection.

All the checked modules will be installed in the Platform.
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Fig. 9: MicroEJ Platform Configuration Modules Selection

Modules Customization
Each selected module can be customized by creating a [module] folder named after the module beside the [name].
platform definition. It may contain:

« An optional [module].properties file named after the module name. These properties will be injected in the
execution context prefixed by the module name. Some properties might be needed for the configuration of
some modules. Please refer to the modules documentation for more information.

« Optional module specific files and folders.

Modifying one of these files requires to build the Platform again.

Platform Customization

Platforms can be customized by creating a configuration.xml Ant file beside the [name].platform file. This
Ant script can extend one or several of the extension points available. By default, you should not have to change
the default configuration script.

Here is a template fora configuration.xml Ant file:
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<?xml version="1.0" encoding="UTF-8"?>
<project name="configuration">

<!--
Define "project.dir” property that references the directory
where this file is located.

-—>

<dirname property="project.dir” file="${ant.file.configuration}"/>

</project>

Configuration project (the project which contains the [name].platform file) can contain an optional dropins
folder. The contents of this folder will be copied integrally into the final Platform. This feature allows to add some
additional libraries, tools etc. into the Platform.

The dropins folder organization should respect the final Platform files and folders organization. For instance, the
tools are located in the sub-folder tools. Launch a Platform build without the dropins folder to see how the
Platform files and folders organization is. Then fill the dropins folder with additional features and build again the
Platform to obtain an advanced Platform.

The dropins folder files are kept in priority. If one file has the same path and name as another file already installed
into the Platform, the dropins folder file will be kept.

Modifying one of these files requires to build the Platform again.

BSP Connection

Principle

Using a MicroEJ Platform, the user can compile a MicroEJ Application on that Platform. The result of this compila-
tionisa microejapp.o file.

This file has to be linked with the MicroEJ Platform runtime file (microejruntime.a) and a third-party C project,
called the Board Support Package (BSP) , to obtain the final binary file (MicroEJ Firmware). For more information,
please consult the MicroEJ build process overview.

The BSP connection can be configured by defining 4 folders where the following files are located:
« MicroEJ Application file (microejapp.o).
« MicroEJ Platform runtime file (microejruntime. a, also available in the Platform 1ib folder).
« MicroEJ Platform header files ( . h, also available in the Platform include folder).
« BSP project build script file (build.bat or build.sh).

Once the MicroEJ Application file ( microejapp.o ) is built, the files are then copied to these locations and the
build.bat or build.sh fileis executed to produce the final executable file (application.out).

Note: The final build stage to produce the executable file can be done outside of MicroEJ SDK, and thus the BSP
connection configuration is optional.

BSP connection configuration is only required in the following cases:
« Use MicroEJ SDK to produce the final executable file of a Mono-Sandbox Firmware (recommended).
« Use MicroEJ SDK to run a MicroEJ Testsuite on device.

« Build a Multi-Sandbox Firmware.
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MicroEJ provides a flexible way to configure the BSP connection to target any kind of projects, teams organizations
and company build flows. To achieve this, the BSP connection can be configured either at MicroEJ Platform level
or at MicroEJ Application level (or a mix of both).

The 3 most common integration cases are:
+ Case 1: No BSP connection
The MicroEJ Platform does not know the BSP at all.

BSP connection can be configured when building the MicroEJ Application (absolute locations).

C application

MicroEJ code and Board

. MicroEJ Platform
Application code S

BSP absolute locations

MicroEJ Firmware

Fig. 10: MicroEJ Platform with no BSP connection

This case is recommended when:
- the MicroEJ Firmware is built outside MicroEJ SDK.

- the same MicroEJ Platform is intended to be reused on multiple BSP projects which do not share the
same structure.

« Case 2: Partial BSP connection
The MicroEJ Platform knows how the BSP is structured.

BSP connection is configured when building the MicroEJ Platform (relative locations within the BSP), and the
BSP root location is configured when building the MicroEJ Application (absolute directory).

C application

MicrorJ code and Board

MicroEJ Platform

Application code

Support Package

BSP relativie locations
BSP roofidirectory

MicroEJ Firmware

Fig. 11: MicroEJ Platform with partial BSP connection

This case is recommended when:

- the MicroEJ Platform is used to build one MicroEJ Application on top of one BSP.
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- the Application and BSP are slightly coupled, thus making a change in the BSP just require to build the
firmware again.

« Case 3: Full BSP connection
The MicroEJ Platform includes the BSP.

BSP connection is configured when building MicroEJ Platform (relative locations within the BSP), as well as
the BSP root location (absolute directory). No BSP connection configuration is required when building the
MicroEJ Application.

C application
code and Board
Support Package

Micrord MicroEJ Platform

Application code

BSP relative locations
BSP root directory

MicroEJ Firmware

Fig. 12: MicroEJ Platform with full BSP connection

This case is recommended when:
- the MicroEJ Platform is used to build various MicroEJ Applications.
- the MicrokEJ Platform is validated using MicroEJ testsuites.

- the MicroEJ Platform and BSP are delivered as a single standalone module (same versioning), perhaps
subcontracted to a team or a company outside the application project(s).

Options

BSP connection options can be specified as Platform options or as Application options or a mix of both.

The following table describes Platform options, configured in bsp > bsp.properties file of the Platform config-
uration project.
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Table 1: MicroEJ Platform Options for BSP Connection

Option Description Example
Name
) | The path relative to BSP root.dir where to deploy the Mi- ) )
M1Croejapp croEJ Application file (microejapp.o). MicroEJ/1lib
relative.
dir
The path relative to BSP root.dir where to deploy the Mi-
microejlib eroE Platform runtime file (microejruntime. a). MicroEJ/1lib
relative.
dir
The path relative to BSP root.dir where to deploy the Mi-
microejint ¢roE) Platform headerfiles (*.h). MicrokJ/inc
relative.
dir
] | Thepathrelativeto BSP root.dir whereto execute the BSP . ]
microejsciyiitd script file (build.bat or build.sh). Project/MicrotJ
relative.
dir
The 3rd-party BSP project absolute directory, to be included )
root. to the Platform. c:\\Users\\user\\mybsp onWin-
dir dows systems or /home/user/bsp
on Unix systems.

The following table describes Application options, configured as regular MicroEJ Application Options.

Table 2: MicroEJ Application Options for BSP Connection

Option Name Description

Deploy the MicroEJ Application file (microejapp. o) to the location defined by the Platform
deploy.bsp. (defaults to true when Platform option microejapp.relative.dir isset).
microejapp

Deploy the MicroEJ Platform runtime file ( microejruntime.a ) to the location defined by
deploy.bsp. the Platform (defaults to true when Platform option microejlib.relative.dir is set).
microejlib

Deploy the MicroEJ Platform header files ( *.h ) to the location defined by the Platform (de-
deploy.bsp. faults to true when Platform option microejinc.relative.dir isset).
microejinc

Execute the BSP build script file (build.bat or build.sh) present at the location defined
dgploy ..bsp: by the Platform. (defaults to false and requires microejscript.relative.dir Platform
microejscript | gption to be set).

The 3rd-party BSP project absolute directory. This option is required if at least one the 4
deploé’ -bsp. options described above is set to true and the Platform does not includes the BSP.
root.dir

) Deploy the MicroEJ Application file ( microejapp.o ) to this absolute directory. An empty
deploy.dir. value means no deployment.
microejapp

) Deploy the MicroEJ Platform runtime file (microejruntime.a)to this absolute directory. An
deploy.dir. empty value means no deployment.
microejlib

) Deploy the MicroEJ Platform header files ( *.h ) to this absolute directory. An empty value
deploy.dir. means no deployment.
microejinc

Execute the BSP build scriptfile (build.bat or build.sh) presentin this absolute directory.
deploy.bsp. An empty value means no deployment.
microejscript
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Note: Itisalso possible to configure the BSP root directory using the build option named toolchain.dir,instead
of the application option deploy.bsp.root.dir . This allow to configure a MicroEJ Firmware by specifying both
the Platform (using the target.platform.dir option) and the BSP at build level, without having to modify the
application options files.

For each Platform BSP connection case, here is a summary of the options to set:

No BSP connection, executable file built outside MicroEJ SDK

Platform Options:
[NONE]

Application Options:
[NONE]

No BSP connection, executable file built using MicroEJ SDK

Platform Options:
[NONE]

Application Options:
deploy.dir.microejapp=[absolute_path]
deploy.dir.microejlib=[absolute_path]
deploy.dir.microejinc=[absolute_path]
deploy.bsp.microejscript=[absolute_path]

Partial BSP connection, executable file built outside MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]

Partial BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]
deploy.bsp.microejscript=true

Full BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]
root.dir=[absolute_path]

(continues on next page)
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(continued from previous page)

Application Options:
deploy.bsp.microejscript=true

Build Script File

The BSP build script file is responsible to invoke the third-party C toolchain (compiler and linker) to produce the
final executable file (application.out)

The build script must implement the following specification:
« On Windows operating system, it is a Windows batch file named build.bat.

« On Mac OS X or Linux operating systems, it is a shell script named build.sh, with execution permission
enabled.

« On build error, the script must end with a non zero exit code.
« Onsuccess

- The executable must be copied to the file application.out in the folder from where the script has
been executed.

- The script must end with zero exit code.

Many build script templates are available for most commonly used C toolchains in the Platform Qualification Tools
repository.

Low Level APIs Implementation Files

Some MicroEJ Architecture modules require some additional information about the BSP implementation of Low
Level APIs.

This information must be stored in each module’s configuration folder, in a file named bsp.xml .

This file must start with the node <bsp>. It can contain several lines like this one: <nativeName="A_LLAPI_NAME"
nativeImplementation name="AN_IMPLEMENTATION_NAME"/> where:

o A_LLAPI_NAME refersto a Low Level APl native name. It is specific to the MicroEJ C library which provides the
Low Level API.

+ AN_IMPLEMENTATION_NAME refers to the implementation name of the Low Level APL. It is specific to the BSP;
and more specifically, to the C file which does the link between the MicroEJ C library and the C driver.

Example:

<bsp>
<nativeImplementation name="COMM_DRIVER" nativeName="LLCOMM_BUFFERED_CONNECTION"/>
</bsp>

These files will be converted into an internal format during the MicroEJ Platform build.

MicroEJ Platform Build

To build the MicroEJ Platform, click on the Build Platform link on the Platform configuration Overview tab.
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It will create a MicroEJ Platform in the workspace available for the MicroEJ Application project to run on. The
MicroEJ Platform will be available in: Window > Preferences > MicroEJ > Platformsin workspace .

4.3 MicroEJ Core Engine

The MicroEJ Core Engine (also called the platform engine) and its components represent the core of the platform.
Itis used to compile and execute at runtime the MicroEJ Application code.

4.3.1 Functional Description

The following diagram shows the overall process. The first two steps are performed within the MicroEJ Workbench.
The remaining steps are performed within the C IDE.

MicrorJ MicroEJ Platform

Application code

Build the MicroEJ
Applicaticn
MicroEJ Workbench

CIDE

C application Application Architecture
code and Board library file library file
Support Package {microejapp.o) (microejruntime.a)

Build and link the full
application

Executable

application

Program and test the
application on the board

Fig. 13: MicroEJ Core Engine Flow

1. Step1consists in writing a MicroEJ Application against a set of Foundation Libraries available in the platform.

2. Step 2 consists in compiling the MicroEJ Application code and the required libraries in an ELF library, using
the SOAR.

3. Step 3 consistsin linking the previous ELF file with the MicroEJ Core Engine library and a third-party BSP (OS,
drivers, etc.). This step may require a third-party linker provided by a C toolchain.
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4.3.2 Architecture
The MicroEJ Core Engine and its components have been compiled for one specific CPU architecture and for use
with a specific C compiler.

The architecture of the platform engine is called green thread architecture, it runs in a single RTOS task. Its be-
havior consists in scheduling MicroEJ threads. The scheduler implements a priority preemptive scheduling policy
with round robin for the MicroEJ threads with the same priority. In the following explanations the term “RTOS
task” refers to the tasks scheduled by the underlying OS; and the term “MicroEJ thread” refers to the Java threads
scheduled by the MicroEJ Core Engine.

RTOS Task 1 RTOS Task 2 RTOS Task 3 RTOS Task 4

Fig. 14: A Green Threads Architecture Example

The activity of the platform is defined by the MicroEJ Application. When the MicroEJ Application is blocked (when
all MicroEJ threads are sleeping), the platform sleeps entirely: The RTOS task that runs the platform sleeps.

The platform is responsible for providing the time to the MicroEJ world: the precision is 1 millisecond.

4.3.3 Capabilities

MicroEJ Core Engine defines 3 exclusive capabilities:
« Mono-sandbox : capability to produce a monolithic firmware (default one).

« Multi-Sandbox : capability to produce a extensible firmware on which new applications can be dynamically
installed. See section Multi-Sandbox.

« Tiny application : capability to produce a compacted firmware (optimized for size). See section Tiny applica-
tion.

All MicroEJ Core Engine capabilities may not be available on all architectures. Refer to section Supported MicroEJ
Core Engine Capabilities by Architecture Matrix for more details.
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4.3.4 Implementation

The platform implements the [SNI] specification. It is created and initialized with the C function SNI_createVM
. Then it is started and executed in the current RTOS task by calling SNI_startVM. The function SNI_startVM
returns when the MicroEJ Application exits. The function SNI_destroyVM handles the platform termination.

Thefile LLMJVM_impl.h that comes with the platform defines the API to be implemented. The file LLMJVM.h that
comes with the platform defines platform-specific exit code constants. (See LLMJVM: MicroEJ Core Engine.)

Initialization

The Low Level MicroEJ Core Engine API deals with two objects: the structure that represents the platform, and the

RTOS task that runs the platform. Two callbacks allow engineers to interact with the initialization of both objects:
o LLMJVM_IMPL_initialize: Called once the structure representing the platform is initialized.

o LLMJVM_IMPL _vmTaskStarted : Called when the platform starts its execution. This function is called within
the RTOS task of the platform.

Scheduling

To support the green thread round-robin policy, the platform assumes there is an RTOS timer or some other mecha-
nism that counts (down) and fires a call-back when it reaches a specified value. The platform initializes the timer us-
ingthe LLMJVM_IMPL_scheduleRequest function with one argument: the absolute time at which the timer should
fire. When the timer fires, it must call the LLMIJVM_schedule function, which tells the platform to execute a green
thread context switch (which gives another MicroEJ thread a chance to run).

Idle Mode

When the platform has no activity to execute, it calls the LLMJVM_IMPL_idleVM function, which is assumed to put
the RTOS task of the platform into a sleep state. LLMJVM_IMPL_wakeupVM is called to wake up the platform task.
When the platform task really starts to execute again, it calls the LLMJVM_IMPL _ackWakeup function to acknowledge
the restart of its activity.

Time

The platform defines two times:

« the application time: The difference, measured in milliseconds, between the current time and midnight, Jan-
uary 1,1970, UTC.

« the system time: The time since the start of the device. This time is independent of any user considerations,
and cannot be set.

The platform relies on the following C functions to provide those times to the MicroEJ world:

o LLMJVM_IMPL_getCurrentTime : Depending on the parameter ( true / false) must return the application
time or the system time. This function is called by the MicroEJ method System.currentTimeMillis(). Itis
also used by the platform scheduler, and should be implemented efficiently.

o LLMJVM_IMPL_getTimeNanos : must return the system time in nanoseconds.

o LLMJVM_IMPL_setApplicationTime : must set the difference between the current time and midnight, Jan-
uary 1,1970, UTC.
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Example

The following example shows how to create and launch the MicroEJ Core Engine from the C world. This function (
mjvm_main ) should be called from a dedicated RTOS task.

#include <stdio.h>
#include "mjvm_main.h"
#include "LLMJVM.h"
#include "sni.h"

void mjvm_main(void)

{
void* vm;
int32_t err;
int32_t exitcode;
// create VM
vm = SNI_createVM();
if(vm == NULL)
{
printf("VM initialization error.\n");
}
else
{
printf("VM START\n");
err = SNI_startVM(vm, 0, NULL);
if(err < 0)
{
// Error occurred
if(err == LLMJVM_E_EVAL_LIMIT)
{
printf("Evaluation limits reached.\n");
3
else
{
printf("VM execution error (err = %d).\n", err);
3
}
else
{
// VM execution ends normally
exitcode = SNI_getExitCode(vm);
printf("VM END (exit code = %d)\n", exitcode);
}
// delete VM
SNI_destroyVM(vm);
3
3
Debugging

Theinternal MicroEJ Core Engine function called LLMJVM_dump allows you to dump the state of all MicroEJ threads:
name, priority, stack trace, etc. This function can be called at any time and from an interrupt routine (for instance
from a button interrupt).
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This is an example of a dump:

s WY Dump SESSSsSSssss

2 java threads

Java Thread[3]

name="SYSINpmp"” prio=5 state=WAITING

java/lang/Thread:
at com/is2t/microbsp/microui/natives/NSystemInputPump.@134261800
[0x0800AC32]
at com/is2t/microbsp/microui/io/SystemInputPump.@134265968
[0x0800BC80]
at ej/microui/Pump.@134261696
[0x0800ABCC]
at ej/microui/Pump.@134265872
[0x0800BC24]
at java/lang/Thread.@134273964
[0x0800DBC4]
at java/lang/Thread.@134273784
[0x0800DB04]
at java/lang/Thread.@134273892
[0x0800DB6F ]
Java Thread[2]
name="DISPLpmp" prio=5 state=WAITING

java/lang/Thread:

at java/lang/Object.@134256392
[0x08009719]

at ej/microui/FIFOPump.@134259824
[0x0800A48E]

at ej/microui/io/DisplayPump.134263016
[0x0800BOF8]

at ej/microui/Pump.@134261696
[0x0800ABCC]

at ej/microui/Pump.@134265872
[0x0800BC24]

at ej/microui/io/DisplayPump.@134262868
[0x0800B064]

at java/lang/Thread.@134273964
[0x0800DBC4]

at java/lang/Thread.@134273784
[0x0800DB04]

at java/lang/Thread.@134273892
[0x0800DB6F ]

See Stack Trace Reader for additional info related to working with VM dumps.

4.3.5 Generic Output

The System.err stream is connected to the System.out print stream. See below for how to configure the desti-
nation of these streams.
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4.3.6 Link

Several sections are defined by the MicroEJ Core Engine. Each section must be linked by the third-party linker.

Table 3: Linker Sections

Section name Aim Location Alignment (in bytes)
) Resident applications statics RW 4
.bss.features.installed
Application static RW 8
.bss.soar PP
. Application threads stack blocks RW 8
.bss.vm.stacks. java
TCETEA_HEAP MicroEJ Core Engine internal heap Internal RW | 8
Application hea RW 4
_java_heap pplicatt P
Application immortal hea RW 4
_java_immortals PP P
Application resources RO 16
.rodata.resources
Resident applications code and resources | RO 4
.rodata.soar.features
Shielded Plug data RO 4
_shieldedplug lelded Plug
Ctext soar Application and library code RO 16

Note: Sections ICETEA_HEAP, _java_heap and _java_immortals are zero-initialized at MicroEJ Core Engine
startup.

4.3.7 Dependencies

The MicroEJ Core Engine requires an implementation of its low level APIs in order to run. Refer to the chapter
Implementation for more information.

4.3.8 Installation

The MicroEJ Core Engine and its components are mandatory. In the platform configuration file, check
Multi Applications to install the MicroEJ Core Engine in “Multi-Sandbox” mode. Otherwise, the “Single appli-
cation” mode is installed.

4.3.9 Use

The EDC API Module must be added to the module.ivy of the MicroEJ Application Project. This MicroEJ module is
always required in the build path of a MicroEJ project; and all others libraries depend on it. This library provides a
set of options. Refer to the chapter Application Options which lists all available options.

<dependency org="ej.api” name="edc" rev="1.3.3"/>

The BON API Module must also be added to the module.ivy of the MicroEJ Application project in order to access the
[BON] library.
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<dependency org="ej.api” name="bon" rev="1.4.0"/>

4.4 Multi-Sandbox

4.4.1 Principle
The Multi-Sandbox capability of the MicroEJ Core Engine allows a main application (called Standalone Application)
to install and execute at runtime additional applications (called sandboxed applications).

The MicroEJ Core Engine implements the [KF] specification. A Kernel is a Standalone Application generated on a
Multi-Sandbox-enabled platform. A Feature is a sandboxed application generated against a Kernel.

A sandboxed application may be dynamically downloaded at runtime or integrated at build-time within the exe-
cutable application.

Note that the Multi-Sandbox is a capability of the MicroEJ Core Engine. The MicroEJ Simulator always runs an
application as a Standalone Application.

4.4.2 Functional Description

The Multi-Sandbox process extends the overall process described in the overview of the platform process.

MicroEJ

Application code

4. Build the MicroEJ
Application

MicroEJ Platform

Binary
application

(application fo)

6. Program and test the
application on the
beoard

5. Build and link the full
application

Fig. 15: Multi-Sandbox Process

Once a Kernel has been generated, additional MicroEJ Application code (Feature) can be built against the Kernel
by :

« Creating one launch configuration per feature.

+ Setting the  Settings field in the Execution tab of each feature launch configuration to

Build Dynamic Feature .
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« Settingthe Kernel fieldinthe Configuration tab of each feature launch configuration tothe ... .

using the MicroEJ Application launch named Build Dynamic Feature. The binary application file produced (
application.fo)is compatible only for the Kernel on which it was generated. Generating a new Kernel requires
that you generate the Features again on this Kernel.

The Features built can be deployed in the following ways:

« Downloaded and installed at runtime by software. Refer to the [KF] specification for ej.kf.Kernel install
APls.

« Linked at build-time into the executable application. Features linked this way are then called Installed Fea-
tures. The Kernel should have been generated with options for dimensioning the maximum size (code, data)
for such Installed Features. Features are linked within the Kernel using the Firmware linker tool.

4.4.3 Firmware Linker
A MicroEJ tool is available to link Features as Installed Features within the executable application. The tool name
is Firmware Linker. It takes as input the executable application file and the Feature binary code into which to be

linked. It outputs a new executable application file, including the Installed Feature. This tool can be used to append
multiple Features, by setting as the input file the output file of the previous pass.

4.4.4 Memory Considerations

Multi-Sandbox memory overhead of MicroEJ Core Engine runtime elements are described in the table below.

Table 4: Multi-Sandbox Memory Overhead

Runtime element | Memory | Description
Object RW 4 bytes
Thread RW 24 bytes
Stack Frame RW 8 bytes
Class Type RO 4 bytes
Interface Type RO 8 bytes

4.4.5 Dependencies

o LLKERNEL_impl.h implementation (see LLKERNEL: Multi-Sandbox).

4.4.6 Installation

Multi-Sandbox is an additional module, disabled by default.

To enable Multi-Sandbox of the MicroEJ Core Engine, in the platform configuration file, check Multi Applications

4.4.7 Use

The KF APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow access to
[KF] library.
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<dependency org="ej.api” name="kf" rev="1.4.4"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.

4.5 Tiny application

4.5.1 Principle

The Tiny application capability of the MicroEJ Core Engine allows to build a main application optimized for size.
This capability is suitable for environments requiring a small memory footprint.

4.5.2 Installation

Tiny application is an option disabled by default. To enable Tiny application of the MicroEJ Core Engine, set the
property mjvm.standalone.configuration in configuration.xml file as follows:

<property name="mjvm.standalone.configuration” value="tiny"/>

See section Platform Customization for more info on the configuration.xml file.

4.5.3 Limitations

In addition to general Limitations:

« The maximum application code size (classes and methods) cannot exceed 256KB . This does not include
application resources, immutable objects and internal strings which are not limited.

« The option SOAR > Debug > Embed alltype names has no effect. Only the fully qualified names of
types marked as required types are embedded.

4.6 Native Interface Mechanisms

The MicroEJ Core Engine provides two ways to link MicroEJ Application code with native C code. The two ways are
fully complementary, and can be used at the same time.

4.6.1 Simple Native Interface (SNI)

Principle

[SNI] provides a simple mechanism for implementing native Java methods in the C language.
[SNI] allows you to:
« Call a C function from a Java method.

+ Access an Immortal array in a C function (see the [BON] specification to learn about immortal objects).

[SNI] does not allow you to:
« Access or create a Java object in a C function.

« Access Java static variables in a C function.

4.5, Tiny application 180



MicroEJ Documentation, Revision 4€20bb27

« Call Java methods from a C function.

[SNI] provides some Java APIs to manipulate some data arrays between Java and the native (C) world.

Functional Description

[SNI] defines how to cross the barrier between the Java world and the native world:
« Calla Cfunction from Java.
« Pass parameters to the C function.
+ Return avalue from the C world to the Java world.

« Manipulate (read & write) shared memory both in Java and C : the immortal space.

Java WOFId Java methods C functions Cwo rld

Java C
objects structs
access access

Java Object

Java memory C memory

Array of basetypes

Immortal memory
Fig.16: [SN/] Processing

The above illustration shows both Java and C code accesses to shared objects in the immortal space, while also
accessing their respective memory.
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Example

package example;
import java.io.IOException;

/**

* Abstract class providing a native method to access sensor value.
* This method will be executed out of virtual machine.

*/

public abstract class Sensor {

public static final int ERROR = -1;

public int getValue() throws IOException {
int sensorID = getSensorID();
int value = getSensorValue(sensorlID);
if (value == ERROR) {
throw new IOException("”Unsupported sensor”);

3

return value;

}
protected abstract int getSensorID();

public static native int getSensorValue(int sensorID);

}

class Potentiometer extends Sensor {

protected int getSensorID() {
return Constants.POTENTIOMETER_ID; // POTENTIOMETER_ID is a static final

// File providing an implementation of native method using a C function
#include <sni.h>
#include <potentiometer.h>

#define SENSOR_ERROR (-1)
#define POTENTIOMETER_ID (3)

jint Java_example_Sensor_getSensorValue(jint sensor_id){

if (sensor_id == POTENTIOMETER_ID)
{

return get_potentiometer_value();

}
return SENSOR_ERROR;

Synchronization

A call to a native function uses the same RTOS task as the RTOS task used to run all Java green threads. So during
this call, the MicroEJ Core Engine cannot schedule other Java threads.

[SNI] defines C functions that provide controls for the green threads’ activities:
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o int32_t SNI_suspendCurrentJavaThread(int64_t timeout) : Suspends the execution of the Java thread
thatinitiated the current C call. This function does not block the C execution. The suspension is effective only
at the end of the native method call (when the C call returns). The green thread is suspended until either an
RTOS task calls SNI_resumeJavaThread, or the specified number of milliseconds has elapsed.

e int32_t SNI_getCurrentJavaThreadID(void) : Permits retrieval of the ID of the current Java thread within
the C function (assuming it is a “native Java to C call”). This ID must be given to the SNI_resumeJavaThread
function in order to resume execution of the green thread.

o int32_t SNI_resumeJavaThread(int32_t id) : Resumes the green thread with the given ID. If the thread
is not suspended, the resume stays pending.

T pealy} usalig
7 peaiy} usain
€ pealy3 usalg

SNI_getCurrentJavaThreadID() : 3

awil

SNI_suspendCurrentJavaThread(..)

SNI_resumeJavaThread(3)

The Java Another C
RTOS task RTOS task

Fig. 17: Green Threads and RTOS Task Synchronization

The above illustration shows a green thread (GT3) which has called a native method that executes in C. The C code

suspends the thread after having provisioned its ID (e.g. 3). Another RTOS task may later resume the Java green
thread.

Dependencies

No dependency.

Installation

The [SN/] library is a built-in feature of the platform, so there is no additional dependency to call native code from

Java. In the platform configuration file, check Javato CInterface > SNIAPI to install the additional Java APls
in order to manipulate the data arrays.

Use

The SNI APl module must be added to the module.ivy of the MicroEJ Application project, in order to allow access
to the [SN/] library.
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<dependency org="ej.api” name="sni" rev="1.3.1"/>

4.6.2 Shielded Plug (SP)
Principle

The Shielded Plug [SP] provides data segregation with a clear publish-subscribe API. The data-sharing between
modules uses the concept of shared memory blocks, with introspection. The database is made of blocks: chunks
of RAM.

Module 1 ) Module 2
ShieldedPlug (written in

Database JavaorC)

(written in
JavaorC)

Fig. 18: A Shielded Plug Between Two Application (Java/C) Modules.

Functional Description

The usage of the Shielded Plug (SP) starts with the definition of a database. The implementation of the [SP] for the
MicroEJ Platform uses an XML file description to describe the database; the syntax follows the one proposed by the

[SP] specification.

Once this database is defined, it can be accessed within the MicroEJ Application or the C application. The [SP]
Foundation Library is accessible from the [SP] APl Module. This library contains the classes and methods to read
and write data in the database. See also the Java documentation from the MicroEJ Workbench resources center
(“Javadoc” menu). The C header file sp.h available in the MicrokJ Platform source/MICROJVM/include folder
contains the C functions for accessing the database.

To embed the /SP] database in your binary file, the XML file description must be processed by the [SP] compiler. This
compiler generates a binary file ( .o ) that will be linked to the overall application by the linker. It also generates
two descriptions of the block ID constants, one in Java and one in C. These constants can be used by either the Java
or the C application modules.

Shielded Plug Compiler

A MicroEJ tool is available to launch the [SP] compiler tool. The tool name is Shielded Plug Compiler. It outputs:

« Adescription of the requested resources of the database as a binary file ( . 0 ) that will be linked to the over-
all application by the linker. It is an ELF format description that reserves both the necessary RAM and the
necessary Flash memory for the Shielded Plug database.

« Twodescriptions,onein Javaandonein C, of the block ID constants to be used by either Java or Capplication
modules.
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SPfile SP ShieldedPlug

(-xml) Compiler Database
MicroEJ User
classpath Application
(*.class)

Fig. 19: Shielded Plug Compiler Process Overview

Example

Below is an example of using a database [SP]. The code that publishes the data is written in C, and the code that
receives the data is written in Java. The data is transferred using two memory blocks. TEMP is a scalar value,
THERMOSTAT is a boolean.

Database Description

The database is described as follows:

<shieldedPlug>
<database name="Forecast” id="0" immutable="true" version="1.0.0">
<block id="1" name="TEMP" length="4" maxTasks="1"/>
<block id="2" name="THERMOSTAT" length="4" maxTasks="1"/>
</database>
</shieldedPlug>

Java Code

From the database description we can create an interface.

public interface Forecast {
public static final int ID = 0;
public static final int TEMP = 1;
public static final int THERMOSTAT = 2;

Below is the task that reads the published temperature and controls the thermostat.

public void run(){
ShieldedPlug database = ShieldedPlug.getDatabase(Forecast.ID);
while (isRunning) {
//reading the temperature every 30 seconds
//and update thermostat status
try {
int temp = database.readInt(Forecast.TEMP);
print(temp);
//update the thermostat status
(continues on next page)
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database.writeInt(Forecast.THERMOSTAT, temp>tempLimit ? 0 :

3
catch(EmptyBlockException e){
print("Temperature not available");

}
sleep(30000);

C Code

(continued from previous page)

15

Here is a C header that declares the constants defined in the XML description of the database.

#define Forecast_ID @
#define Forecast_TEMP 1
#define Forecast_THERMOSTAT 2

Below, the code shows the publication of the temperature and thermostat controller task.

void temperaturePublication() {
ShieldedPlug database = SP_getDatabase(Forecast_ID);
int32_t temp = temperature();
SP_write(database, Forecast_TEMP, &temp);

3

void thermostatTask(){
int32_t thermostatOrder;
ShieldedPlug database = SP_getDatabase(Forecast_ID);
while(1){
SP_waitFor(database, Forecast_THERMOSTAT);
SP_read(database, Forecast_THERMOSTAT, &thermostatOrder);
if(thermostatOrder == 0) {
thermostatOFF();
3
else {
thermostatON();

}

Dependencies

« LLSP_impl.h implementation (see LLSP: Shielded Plug).

Installation

The[SP] library and its relative tools are an optional feature of the platform. In the platform configuration file, check
Java to C Interface > Shielded Plug to install the library and its relative tools.
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Use

The Shielded Plug API Module must be added to the module.ivy of the MicroEJ Application project in order to allow
access to the [SP] library.

<dependency org="ej.api"” name="sp" rev="2.0.2"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.

4.6.3 MicroEJ Java H
Principle
This MicroEJ tool is useful for creating the skeleton of a C file, to which some Java native implementation func-

tions will later be written. This tool helps prevent misses of some #include files, and helps ensure that function
signatures are correct.

Functional Description

MicroEJ Java H tool takes as input one or several Java class files (*.class) from directories and / or JAR files. It looks
for Java native methods declared in these class files, and generates a skeleton(s) of the C file(s).

*.class

Fig. 20: MicroEJ Java H Process

Dependencies

No dependency.

Installation

This is an additional tool. In the platform configuration file, check Javato CInterface > MicroEJJavaH to
install the tool.

Use

This chapter explains the MicroEJ tool options.
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4.7 External Resources Loader

4.7.1 Principle

A resource is, for a MicroEJ Application, the contents of a file. This file is known by its path (its relative path from
the MicroEJ Application classpath) and its name. The file may be stored in RAM, flash, or external flash; and it is the
responsibility of the MicroEJ Core Engine and/or the BSP to retrieve and load it.

MicroEJ Platform makes the distinction between two kinds of resources:

« Internal resource: The resource is taken into consideration during the MicroEJ Application build. The SOAR
step loads the resource and copies it into the same C library as the MicroEJ Application. Like the MicroEJ Ap-
plication, the resourceis linked into the CPU address space range (internal device memories, external parallel
memories, etc.).

The available list of internal resources to embed must be specified in the MicroEJ Application launcher (Mi-
croEJ launch). Under the “Resources” tab, select all internal resources to embed in the final binary file.

« External resource: The resource is not taken into consideration by MicroEJ. It is the responsibility of the BSP
project to manage this kind of resource. The resource is often programmed outside the CPU address space
range (storage media like SD card, serial NOR flash, EEPROM, etc.).

The BSP must implement some specific Low Level API (LLAPI) C functions: LLEXT_RES_impl.h. These func-
tions allow the MicroEJ Application to load some external resources.

4.7.2 Functional Description

The External Resources Loader is an optional module. When not installed, only internal resources are available
for the MicroEJ Application. When the External Resources Loader is installed, the MicroEJ Core Engine tries first to
retrieve the expected resource from its available list of internal resources, before asking the BSP to load it (using
LLEXT_RES_impl.h functions).

4.7.3 Implementations

External Resources Loader module provides some Low Level API (LLEXT_RES) to let the BSP manage the external
resources.

Open a Resource

The LLAPI to implement in the BSP are listed in the header file LLEXT_RES_impl.h. First, the framework tries to
open an external resource using the open function. This function receives the resources path as a parameter. This
path is the absolute path of the resource from the MicroEJ Application classpath (the MicroEJ Application source
base directory). For example, when the resource is located here: com.mycompany.myapplication.resource.
MyResource. txt ,the given pathis: com/mycompany/myapplication/resource/MyResource. txt.

Resource Identifier

This open function has to return a unique ID (positive value) for the external resource, or returns an error code
(negative value). This ID will be used by the framework to manipulate the resource (read, seek, close, etc.).

Several resources can be opened at the same time. The BSP does not have to return the same identifier for two
resources living at the same time. However, it can return this ID for a new resource as soon as the old resource is
closed.
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Resource Offset

The BSP must hold an offset for each opened resource. This offset must be updated after each call to read and
seek.

Resource Inside the CPU Address Space Range

An external resource can be programmed inside the CPU address space range. This memory (or a part of memory)
is not managed by the SOAR and so the resources inside are considered as external.

Most of time the content of an external resource must be copied in a memory inside the CPU address space range
in order to be accessible by the MicroEJ algorithms (draw an image etc.). However, when the resource is already
inside the CPU address space range, this copy is useless. The function LLEXT_RES_getBaseAddress must return
a valid CPU memory address in order to avoid this copy. The MicroEJ algorithms are able to target the external
resource bytes without using the other LLEXT_RES APIs such as read, mark etc.

4.7.4 External Resources Folder
The External Resource Loader module provides an option (MicroEJ launcher option) to specify a folder for the ex-
ternal resources. This folder has two roles:

« Itis the output folder used by some extra generators during the MicroEJ Application build. All output files
generated by these tools will be copied into this folder. This makes it easier to retrieve the exhaustive list of
resources to program on the board.

« Thisfolderistakeninto consideration by the Simulatorin order to simulate the availability of these resources.
When the resources are located in another computer folder, the Simulator is not able to load them.

If not specified, this folder is created (if it does not already exist) in the MicroEJ project specified in the MicroEJ
launcher. Its name is externalResources.

4.7.5 Dependencies

o LLEXT_RES_impl.h implementation (see LLEXT RES: External Resources Loader).

4.7.6 Installation

The External Resources Loader is an additional module. In the platform configuration file, check
External Resources Loader to install this module.

4.7.7 Use

The External Resources Loader is automatically used when the MicroEJ Application tries to open an external re-
source.

4.8 Serial Communications

MicroEJ provides some Foundation Libraries to instantiate some communications with external devices. Each com-
munication method has its own library. A global library called ECOM provides support for abstract communication
streams (communication framework only), and a generic devices manager.
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4.8.1 ECOM
Principle

The Embedded COMmunication Foundation Library (ECOM) is a generic communication library with abstract com-
munication stream support (a communication framework only). It allows you to open and use streams on commu-
nication devices such as a COMM port.

Thislibrary also provides a device manager, including a generic device registry and a notification mechanism, which
allows plug&play-based applications.

This library does not provide APIs to manipulate some specific options for each communication method, but it
does provide some generic APIs which abstract the communication method. After the opening step, the MicroEJ
Application can use every communications method (COMM, USB etc.) as generic communication in order to easily
change the communication method if needed.

Functional Description

The diagram below shows the overall process to open a connection on a hardware device.

1. Open a new
connection using the Connection
connection string

Connection

String

2.Open a new input 4. Open a new output
stream on the stream on the
connection connection

InputStream OutputStream

3. Read some data from 5. Write some data to
hardware device hardware device

Fig. 21: ECOM Flow

1. Step 1 consists of opening a connection on a hardware device. The connection kind and its configuration are
fixed by the parameter String connectionString of the method Connection.open.

2. Step 2 consists of opening an InputStream on the connection. This stream allows the MicroEJ Application
to access the “RX” feature of the hardware device.

3. Step 3 consists of using the InputStream APIs to receive in the MicroEJ Application all hardware device data.

4. Step 4 consists of opening an OutputStream on the connection. This stream allows the MicroEJ Application
to access the “TX” feature of the hardware device.

5. Step 5 consists of using the OutputStream APIs to transmit some data from the MicroEJ Application to the
hardware device.

4.8. Serial Communications 190



MicroEJ Documentation, Revision 4€20bb27

Note that steps 2 and 4 may be performed in parallel, and do not depend on each other.

Device Management API

A device is defined by implementing ej.ecom.Device . It is identified by a name and a descriptor ( ej.ecom.
HardwareDescriptor ), which is composed of a set of MicroEJ properties. A device can be registered/unregistered
inthe ej.ecom.DeviceManager.

A device registration listener is defined by implementing ej.ecom.RegistrationListener.When a device is reg-
istered to or unregistered from the device manager, listeners registered for the device type are notified. The notifi-
cation mechanism is done in a dedicated Java thread. The mechanism can be enabled or disabled (see Application
Options).

Dependencies

No dependency.

Installation

ECOM Foundation Library is an additional library. In the platform configuration file, check ' Serial Communication
> ECOM toinstall the library.

Use

The ECOM APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow access
to the ECOM library.

<dependency org="ej.api” name="ecom” rev="1.1.4"/>

This foundation library is always required when developing a MicroEJ Application which communicates with some
external devices. It is automatically embedded as soon as a sub communication library is added in the classpath.

4.8.2 ECOM Comm

Principle

The ECOM Comm Java library provides support for serial communication. ECOM Comm extends ECOM to al-
low stream communication via serial communication ports (typically UARTs). In the MicroEJ Application, the
connection is established using the Connector.open() method. The returned connection is a ej.ecom.io.
CommConnection , and the input and output streams can be used for full duplex communication.

The use of ECOM Comm in a custom platform requires the implementation of an UART driver. There are two differ-
ent modes of communication:

+ In Buffered mode, ECOM Comm manages software FIFO buffers for transmission and reception of data. The
driver copies data between the buffers and the UART device.

« In Custom mode, the buffering of characters is not managed by ECOM Comm. The driver has to manage its
own buffers to make sure no data is lost in serial communications because of buffer overruns.

This ECOM Comm implementation also allows dynamic add or remove of a connection to the pool of available
connections (typically hot-plug of a USB Comm port).
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Functional Description

The ECOM Comm process respects the ECOM process. Please refer to the illustration “ECOM flow”.

Component Architecture

The ECOM Comm C module relies on a native driver to perform actual communication on the serial ports. Each port
can be bound to a different driver implementation, but most of the time, it is possible to use the same implemen-
tation (i.e. same code) for multiple ports. Exceptions are the use of different hardware UART types, or the need for
different behaviors.

Five C header files are provided:
o LLCOMM_impl.h

Defines the set of functions that the driver must implement for the global ECOM comm stack, such as syn-
chronization of accesses to the connections pool.

o LLCOMM_BUFFERED_CONNECTION_impl.h
Defines the set of functions that the driver must implement to provide a Buffered connection
o LLCOMM_BUFFERED_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Buffered connection

e LLCOMM_CUSTOM_CONNECTION_impl.h
Defines the set of functions that the driver must implement to provide a Custom connection
o LLCOMM_CUSTOM_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Custom connection

The ECOM Comm drivers are implemented using standard LLAPI features. The diagram below shows an example
of the objects (both Java and C) that exist to support a Buffered connection.

:ej.ecom.io.CommConnection

Driver Connection
LLCOMM_BUFFERED_CONNECTION_impl.h

-
-

LLCOMM_BUFFERED_CONNECTION.h

Fig. 22: ECOM Comm components

The connection is implemented with three objects' :
« The Java object used by the application; an instance of ej.ecom.io.CommConnection
+ The connection object within the ECOM Comm C module

« The connection object within the driver

! Thisis aconceptual description to aid understanding - the reality is somewhat different, although that is largely invisible to the implementor
of the driver.
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Each driver implementation provides one or more connections. Each connection typically corresponds to a physi-
cal UART.

Comm Port Identifier

Each serial port available for use in ECOM Comm can be identified in three ways:

« An application port number. This identifier is specific to the application, and should be used to identify the
data stream that the port will carry (for example, “debug traces” or “GPS data”).

« Aplatform port number. This is specific to the platform, and may directly identify an hardware device’ .

+ A platform port name. This is mostly used for dynamic connections or on platforms having a file-system
based device mapping.

When the Comm Port is identified by a number, its string identifier is the concatenation of “com” and the number
(e.g. com1l).

Application Port Mapping

The mapping from application port numbers to platform ports is done in the application launch configuration.
This way, the application can refer only to the application port number, and the data stream can be directed to the
matching 1/O port on different versions of the hardware.

Ultimately, the application port number is only visible to the application. The platform identifier will be sent to the
driver.

Opening Sequence

The following flow chart explains Comm Port opening sequence according to the given Comm Port identifier.

Comm Port Identifier yes Aﬁgl‘czgigf yes Open from mapped
is coml[id] ppedic id
platform id
no no
error
Open from name Open from id
success
success success
Connection opened
error error

Connection Error

Unknown Comm Port

Fig. 23: Comm Port Open Sequence

2 Some drivers may reuse the same UART device for different ECOM ports with a hardware multiplexer. Drivers can even treat the platform
port number as a logical id and map the ids to various I/O channels.
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Dynamic Connections

The ECOM Comm stack allows to dynamically add and remove connections from the Driver APl. When a connection
is added, it can be immediately open by the application. When a connection is removed, the connection cannot be
open anymore and java.io.IOException isthrown in threads that are usingit.

In addition, a dynamic connection can be registered and unregistered in ECOM device manager (see Device Manage-
ment API). The registration mechanism is done in dedicated thread. It can be enabled or disabled, see Application

Options.
A removed connection is alive until it is closed by the application and, if enabled, unregistered from ECOM device

manager. A connection is effectively uninstalled (and thus eligible to be reused) only when it is released by the
stack.

The following sequence diagram shows the lifecycle of a dynamic connection with ECOM registration mechanism
enabled.

Hotplug: Task | ‘ Connection | ‘ ECCOM Comm Stackl ‘ Comm Pump: Thread | ‘ DeviceManagerl ‘ Application
T

add

add connection

‘ ‘notify Connection added

v

register Cormm Port

i
i
i
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

e

I I 1 I 1
remov J/ X X X X X
| | |  read() i i i
| remove Connect|on - | X
X X java.io.lCException ) X
| N || ......................... )
! ! notify Connection removed ! !
! ! ' close() ! '
! ! ! I unregister Comm Port_! !
! ! | _ Comm Port unregistered ! !
| 1 released() ' [ '
T I-\ T T T T
Hotplug: Task | ‘ Connection | ‘ ECCOM Comm Stackl ‘ Comm Pump:Thread | ‘ DeviceManagerl ‘ Application |

Fig. 24: Dynamic Connection Lifecycle
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Java API

Opening a connection is done using ej.ecom.io.Connector.open(String name) . The connection string (the
name parameter) must start with “comm:”, followed by the Comm port identifier, and a semicolon-separated list of
options. Options are the baudrate, the parity, the number of bits per character, and the number of stop bits:

« baudrate=n (9600 by default)

« bitsperchar=n where nis in the range 5 to 9 (8 by default)
« stopbits=n where nis 1,2, or 1.5 (1 by default)

« parity=x where x is odd, even or none (none by default)

All of these are optional. Illegal or unrecognized parameters cause an I1legalArgumentException .

Driver API

The ECOM Comm Low Level API is designed to allow multiple implementations (e.g. drivers that support different
UART hardware) and connection instances (see Low Level API Pattern chapter). Each ECOM Comm driver defines a
data structure that holds information about a connection, and functions take an instance of this data structure as
the first parameter.

The name of the implementation must be set at the top of the driver C file, for example’:

#define LLCOMM_BUFFERED_CONNECTION MY_LLCOMM

This defines the name of this implementation of the LLCOMM_BUFFERED_CONNECTION interface to be MY_LLCOMM.

The data structure managed by the implementation must look like this:

typedef struct MY_LLCOMM{
struct LLCOMM_BUFFERED_CONNECTION header;
// extra data goes here

} MY_LLCOMM;

void MY_LLCOMM_new(MY_LLCOMM* env);

In this example the structure contains only the default data, in the header field. Note that the header must be the
first field in the structure. The name of this structure must be the same as the implementation name ( MY_LLCOMM
in this example).

The driver must also declare the “new” function used to initialize connection instances. The name of this function
must be the implementation name with _new appended, and it takes as its sole argument a pointer to an instance
of the connection data structure, as shown above.

The driver needs to implement the functions specified in the LLCOMM_imp1.h file and for each kind of connection,
the LLCOMM_BUFFERED_CONNECTION_impl.h (or LLCOMM_CUSTOM_CONNECTION_impl.h) file.

The driver defines the connections it provides by adding connection objects using LLCOMM_addConnection
Connections can be added to the stack as soon as the LLCOMM_initialize function is called. Connec-
tions added during the call of the LLCOMM_impl_initialize function are static connections. A static con-
nection is registered to the ECOM registry and cannot be removed. When a connection is dynamically added
outside the MicroJVM task context, a suitable reentrant synchronization mechanism must be implemented (see
LLCOMM_IMPL_syncConnectionsEnter and LLCOMM_IMPL_syncConnectionsExit ).

3 The following examples use Buffered connections, but Custom connections follow the same pattern.
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When opening a port from the MicroEJ Application, each connection declared in the connections pool will be asked
about its platform port number (using the getPlatformId method) or its name (using the getName method)
depending on the requested port identifier. The first matching connection is used.

The life of a connection starts with the call to getPlatformId() or getName() method. If the the connection
matches the port identifier, the connection will be initialized, configured and enabled. Notifications and interrupts
are then used to keep the stream of data going. When the connection is closed by the application, interrupts are
disabled and the driver will not receive any more notifications. It is important to remember that the transmit and
receive sides of the connection are separate Java stream objects, thus, they may have a different life cycle and one
side may be closed long before the other.

The Buffered Comm Stream

In Buffered mode, two buffers are allocated by the driver for sending and receiving data. The ECOM Comm C module
will fill the transmit buffer, and get bytes from the receive buffer. There is no flow control.

When the transmit buffer is full, an attempt to write more bytes from the MicroEJ Application will block the Java
thread trying to write, until some characters are sent on the serial line and space in the buffer is available again.

When the receive buffer is full, characters coming from the serial line will be discarded. The driver must allocate a
buffer big enough to avoid this, according to the UART baudrate, the expected amount of data to receive, and the
speed at which the application can handle it.

The Buffered C module manages the characters sent by the application and stores them in the transmit buffer. On
notification of available space in the hardware transmit buffer, it handles removing characters from this buffer and
putting them in the hardware buffer. On the other side, the driver notifies the C module of data availability, and
the C module will get the incoming character. This character is added to the receive buffer and stays there until the
application reads it.

The driver should take care of the following:

« Setting up interrupt handlers on reception of a character, and availability of space in the transmit buffer. The
C module may mask these interrupts when it needs exclusive access to the buffers. If no interrupt is available
from the hardware or underlying software layers, it may be faked using a polling thread that will notify the C
module.

Initialization of the 1/0 pins, clocks, and other things needed to get the UART working.

Configuration of the UART baudrate, character size, flow control and stop bits according to the settings given
by the C module.

Allocation of memory for the transmit and receive buffers.

Getting the state of the hardware: is it running, is there space left in the TX and RX hardware buffers, is it busy
sending or receiving bytes?

The driver is notified on the following events:
+ Opening and closing a connection: the driver must activate the UART and enable interrupts for it.

+ Anew byte is waiting in the transmit buffer and should be copied immediately to the hardware transmit unit.
The C module makes sure the transmit unit is not busy before sending the notification, so it is not needed to
check for that again.

The driver must notify the C module on the following events:

+ Data has arrived that should be added to the receive buffer (using the
LLCOMM_BUFFERED_CONNECTION_dataReceived function)

+ Space available in the transmit buffer (using the LLCOMM_BUFFERED_CONNECTION_transmitBufferReady
function)
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The Custom Comm Stream

In custom mode, the ECOM Comm C module will not do any buffering. Read and write requests from the application
are immediately forwarded to the driver.

Since there is no buffer on the C module side when using this mode, the driver has to define a strategy to store
received bytes that were not handed to the C module yet. This could be a fixed or variable side FIFO, the older
received but unread bytes may be dropped, or a more complex priority arbitration could be set up. On the transmit
side, if the driver does not do any buffering, the Java thread waiting to send something will be blocked and wait
for the UART to send all the data.

In Custom mode flow control (eg. RTS/CTS or XON/XOFF) can be used to notify the device connected to the serial
line and so avoid losing characters.

BSP File

The ECOM Comm C module needs to know, when the MicroEJ Application is built, the name of the implementation.
This mapping is defined in a BSP definition file. The name of this file must be bsp.xml and must be written in the
ECOM comm module configuration folder (near the ecom-comm.xml file). In previous example the bsp.xml file
would contain:

Listing 1: ECOM Comm Driver Declaration (bsp.xml)

<bsp>
<nativeImplementation
name="MY_LLCOMM"
nativeName="LLCOMM_BUFFERED_CONNECTION"
/>
</bsp>

where nativeName is the name of the interface, and name is the name of the implementation.

XML File

The Java platform has to know the maximum number of Comm ports that can be managed by the ECOM Comm
stack. It also has to know each Comm port that can be mapped from an application port number. Such Comm port
is identified by its platform port number and by an optional nickname (The port and its nickname will be visible in
the MicroEJ launcher options, see Application Options ).

A XML file is so required to configure the Java platform. The name of this file must be ecom-comm.xml . It has to be
stored in the module configuration folder (see /nstallation).

This file must start with the node <ecom> and the sub node <comms>. It can contain several time this kind of line:
<comm platformId="A_COMM_PORT_NUMBER" nickname="A_NICKNAME"/> where:
« A_COMM_PORT_NUMBER refers the Comm port the Java platform user will be able to use (see Application Port
Mapping).

« A_NICKNAME is optional. It allows to fix a printable name of the Comm port.

The maxConnections attribute indicates the maximum number of connections allowed, including static and dy-
namic connections. This attribute is optional. By default, it is the number of declared Comm Ports.

Example:
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Listing 2: ECOM Comm Module Configuration (ecom-comm.xml)

<ecom>
<comms maxConnections="20">
<comm platformId="2"/>
<comm platformId="3" nickname="DB9"/>
<comm platformId="5"/>
</comms>
</ecom>

First Comm port holds the port 2, second “3” and last “5”. Only the second Comm port holds a nickname “DB9”.

ECOM Comm Mock
In the simulation environment, no driver is required. The ECOM Comm mock handles communication for all the
serial ports and can redirect each port to one of the following:

« An actual serial port on the host computer: any serial port identified by your operating system can be used.
The baudrate and flow control settings are forwarded to the actual port.

« ATCP socket. You can connect to a socket on the local machine and use netcat or telnet to see the output, or
you can forward the data to a remote device.

« Files. You can redirect the input and output each to a different file. This is useful for sending precomputed
data and looking at the output later on for offline analysis.

When using the socket and file modes, there is no simulation of an UART baudrate or flow control. On a file, data
will always be available for reading and will be written without any delay. On a socket, you can reach the maximal
speed allowed by the network interface.

Dependencies

« ECOM (see Serial Communications).

o LLCOMM_impl.h and LLCOMM_xxx_CONNECTION_impl.h implmentations (see LLCOMM: Serial Communica-
tions).

Installation

ECOM-Comm Java library is an additional library. In the platform configuration file, check ' Serial Communication

> ECOM-COMM to install it. When checked, the xml file "ecom-comm > ecom-comm.xml is required during
platform creation to configure the module (see XML File).

Use

The ECOM Comm APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow
access to the ECOM Comm library.

<dependency org="ej.api"” name="ecom-comm” rev="1.1.4"/>

This Foundation Library is always required when developing a MicroEJ Application which communicates with some
external devices using the serial communication mode.

This library provides a set of options. Refer to the chapter Application Options which lists all available options.
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4.9 Graphics User Interface

4.9.1 Principle

The User Interface Extension features one of the fastest graphical engines, associated with a unique int-based event
management system. It provides [MUI] library implementation. The following diagram depicts the components
involved in its design, along with the provided tools:
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The diagram below shows a simplified view of the components involved in the provisioning of a Java user interface.
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Stacks are the native parts of MicroUl. They connect the MicroUl library to the user-supplied drivers code (coded in
Q).

Drivers for input devices must generate events that are sent, via a MicroUl Event Generator, to the MicroEJ Appli-
cation. An event generator accepts notifications from devices, and generates an event in a standard format that
can be handled by the application. Depending on the MicroUl configuration, there can be several different types of
event generator in the system, and one or more instances of each type. Each instance has an unique id.

Drivers may either interface directly with event generators, or they can send their notifications to a Listener, also
written in C, and the listener passes the notifications to the event generator. This decoupling has two major bene-
fits:

+ The drivers are isolated from the MicroEJ libraries - they can even be existing code.
« The listener can translate the notification; so, for example, a joystick could generate pointer events.

For the MicroEJ Simulator, the platform is supplied with a set of software widgets that generically support a range
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of input devices, such as buttons, joysticks and touchscreens, and output devices such as pixelated displays and
LEDs. With the help of the Front Panel Designer tool that forms part of the MicroEJ Workbench the user must define
a front panel mock-up using these widgets. The user must provide a set of listeners that connects the input widgets
to event generators. The user may choose to simulate events that will ultimately come from a special-purpose
input device using one of the standard input widgets; the listener will do the necessary translation. The user must
also supply, in Java, a display extension that adapts the supplied display widget to the specifics of the hardware
being simulated.

4.9.2 MicroUl
Principle
The MicroUl module defines a low-level Ul framework for embedded devices. This module allows the creation of

basic Human-Machine-Interfaces (HMI), with output on a pixelated screen. For more information, please consult
the [MUI] Specification.

Architecture

MicroUl is not a standalone library. It requires a configuration step and several extensions to drive 1/0 devices
(display, inputs, LEDs, etc.).

m . . . .
) MicroUl library | MicroUl library
(%]
[ 5 .
> E xtension E xtension
= i |
v |
§e)
* = - “
—_ >
g o o a | Front Panel Mock
R o — —_ 1
© a
- |

Platform | Simulator

Fig. 27: MicroUl Elements

At MicroEJ Application startup all MicroUl objects relative to the I/O devices are created and accessible. The follow-
ing MicroUl methods allow you to access these internal objects:

« Display.getDefaultDisplay() : returns the instance of the default display which drives the main LCD
screen.

o Leds.getNumberOfLeds() : returns the numbers of available LEDs.
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First, MicroUl requires a configuration step in order to create these internal objects before the call to the main()
method. The chapter Static Initialization explains how to perform the configuration step.

Note: This configuration step is the same for both embedded and simulation platforms.

The embedded platform requires some additional C libraries to drive the I/0 devices. Each C library is dedicated to
a specific kind of 1/0 device. A specific chapter is available to explain each kind of I/0O device.

Table 5: MicroUl C libraries

I/O devices Extension Name | Chapter
Graphical / pixelated display (LCD screen) Display Display
Inputs (buttons, joystick, touch, pointers etc.) | Input Inputs
LEDs LEDs LEDs

The simulation platform uses a mock which simulates all I/O devices. Refer to the chapter Simulation.

Threads

Principle

The MicroUl implementation for MicroEJ uses internal threads. These threads are created during the MicroUl initial-
ization step, and are started by a call to MicroUI.start() . Refer to the MicroUl specification for more information
aboutinternal threads.

List

+ DisplayPump: Thisthread managesall display events (repaint, show() , etc. Thereisonethread perdisplay.

« InputPump: This thread reads the I/0 devices inputs and dispatches them into the display pump(s).

Memory

The threads are always running. The user has to count them to determine the number of concurrent threads the
MicroEJ Core Engine can run (see Memory options in Application Options).

Exceptions

The threads cannot be stopped with a Java exception: The exceptions are always checked by the framework.

When an exception occurs in a user method called by an internal thread (for instance paint() ), the current
UncaughtExceptionHandler receives the exception. The behavior of the default handler is to print the stack trace.

Transparency

MicroUl provides several policies to use the transparency. These policies depend on several factors, including the
kind of drawing and the LCD pixel rendering format. The main concept is that MicroUl does not allow you to draw
something with a transparency level different from 255 (fully opaque). There are two exceptions: the images and
the fonts.
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Images

Drawing an image (a pre-generated image or an image decoded at runtime) which contains some transparency
levels does not depend on the LCD pixel rendering format. During the image drawing, each pixel is converted into
32 bits by pixel format.

This pixel format contains 8 bits to store the transparency level (alpha). This byte is used to merge the foreground
pixel (image transparent pixel) with the background pixel (LCD buffer opaque pixel). The formula to obtain the pixel
is:

aMult = aFG x aBG) /255

aOut = aFG + aBG — aMult

COut = (CFG x aF G+ CBG * aBG — CBG * aMult)/aOut
where:
« aFGisthe alpha level of the foreground pixel (layer pixel)
+ aBGis the alpha level of the background pixel (working buffer pixel)
+ axx is a color component of a pixel (Red, Green or Blue).

+ aOutis the alpha level of the final pixel

Fonts

A font holds only a transparency level (alpha). This fixed alpha level is defined during the pre-generation of a font
(see Fonts).

+ 1 means 2 levels are managed: fully opaque and fully transparent.

+ 2 means 4 levels are managed: fully opaque, fully transparent and 2 intermediate levels.

« 4 means 16 levels are managed: fully opaque, fully transparent and 14 intermediate levels.

+ 8 means 256 levels are managed: fully opaque, fully transparent and 254 intermediate levels.

Dependencies

« MicroUl initialization step (see Static Initialization).

« MicroUl C libraries (see Architecture).

Installation

The MicroUl library is an additional module. In the platform configuration file, check Ul > MicroUl to install

the library. When checked, the XML file microui > microui.xml is required during platform creation in order
to configure the module. This configuration step is used to extend the MicroUl library. Refer to the chapter Static
Initialization for more information about the MicroUl Initialization step.
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Use

The MicroUl API module must be added to the module.ivy of the MicroEJ Application projectin order to allow access
to the [MicroUl] library:

<dependency org="ej.api” name="microui” rev="2.4.0"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.

4.9.3 Static Initialization
Principle

MicroUl requires a configuration step (also called extension step) to customize itself before MicroEJ Application
startup (see Architecture). This configuration step uses an XML file. In order to save both runtime execution time
and flash memory, the file is processed by the Static MicroUl Initializer tool, avoiding the need to process the XML
configuration file at runtime. The tool generates appropriate initialized objects directly within the MicroUl library,
as well as Java and C constants files for sharing MicroUl event generator IDs.

This XML file (also called the initialization file) defines:

« The MicroUl event generators that will exist in the application in relation to low level drivers that provide data
to these event generators (see /nputs).

« Whether the application has a display; and if so, it provides its logical name.

« Which fonts will be provided to the application.

Functional Description

The Static MicroUl Initializer tool takes as entry point the initialization file which describes the MicroUl library ex-
tension. This tool is automatically launched during the MicroEJ platform build (see /nstallation ).

The Static MicroUl Initializer tool is able to output two files:

« A Java library which extends MicroUl library. This library is automatically added to the MicroEJ Application
classpath when MicroUl API library is fetched. This library is used at MicroUl startup to create all instances
of /O devices (Display, EventGenerator etc.) and contains the fonts described into the configuration file
(these fonts are also called “system fonts”).

Warning: This MicroUl extension library is always generated and MicroUl library cannot run without this exten-
sion.

« ACheaderfile (*.h)file. This H file contains some IDs which are used to make a link between an input device
(buttons, touch) and its MicroUl event generator (see Inputs).

Note: The front panel project does not need a configuration file (like C header file for embedded platform).
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Fig. 28: MicroUl Process

The initialization file root element is <microui> and contains component-specific elements.

<microui>

[ component specific elements ]

</microui>

Display Element

The display component augments the initialization file with:

+ The configuration of the display.

« Fonts that are implicitly embedded within the application (also called system fonts). Applications can also
embed their own fonts.

<display name="DISPLAY"/>

<fonts>

<font file="resources\fonts\myfont.ejf">

<range name="LATIN" sections="0-2"/>
<customrange start="0x21" end="0x3f"/>
</font>

<font file="C:\data\myfont.ejf"/>

</fonts>

Event Generators Element

The event generators component augments the initialization file with:

« the configuration of the predefined MicroUl Event Generator: Command, Buttons, States, Pointer,

Touch

+ the configuration of the generic MicroUl Event Generator
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<eventgenerators>
<!-- Generic Event Generators -->
<eventgenerator name="GENERIC" class="foo.bar.Zork">
<property name="PROP1" value="3"/>
<property name="PROP2" value="aaa"/>
</eventgenerator>

<!-- Predefined Event Generators -->

<command name="COMMANDS" />

<buttons name="BUTTONS" extended="3"/>

<buttons name="JOYSTICK" extended="5"/>

<pointer name="POINTER" width="1200" height="1200"/>
<touch name="TOUCH" display="DISPLAY"/>

<states name="STATES" numbers="NUMBERS" values="VALUES"/>

</eventgenerators>

<array name="NUMBERS">
<elem value="3"/>
<elem value="2"/>
<elem value="5"/>
</array>

<array name="VALUES">
<elem value="2"/>
<elem value="0"/>
<elem value="1"/>
</array>

Example

This common MicroUl initialization file initializes MicroUl with:
« adisplay
+ a Command event generator
« a Buttons event generator which targets n buttons (3 first buttons having extended features)
+ a Buttons event generator which targets the buttons of a joystick
+ a Pointer event generator which targets a touch panel

« a DisplayFont whose path is relative to this file

<microui>
<display name="DISPLAY"/>

<eventgenerators>
<command name="COMMANDS" />
<buttons name="BUTTONS"” extended="3"/>
<buttons name="JOYSTICK" extended="5"/>
<touch name="TOUCH" display="DISPLAY"/>
</eventgenerators>

<fonts>
<font file="resources\fonts\myfont.ejf"/>

(continues on next page)
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(continued from previous page)

</fonts>

</microui>

Dependencies

No dependency.

Installation

The Static Initialization tool is part of the MicroUl module (see MicroU]). Install the MicroUl module to install the
Static Initialization tool and fill all properties in MicroUl module configuration file (which must specify the name of
the initialization file).

Use

The Static MicroUl Initializer tool is automatically launched during the MicroUl module installation.

4.9.4 LEDs

Principle

The LEDs module contains the C part of the MicroUl implementation which manages LED devices. This module is
composed of two elements:

« the C part of the MicroUl LEDs API (a built-in C archive),

« an implementation of a low level API for the LEDs (LLLEDS) which must be provided by the BSP (see LLLEDS:
LEDs).

Implementations

The LEDs module provides only one implementation which exposes some low level APl (LLLEDS) that allow the
BSP to manage the LEDs. This implementation of the MicroUl Leds API provides some low level API. The BSP has
to implement these LLAPI, making the link between the MicroUI C library leds and the BSP LEDs drivers.

The LLAPI to implement are listed in the header file LLLEDS_impl.h . First, in the initialization function, the BSP
must return the available number of LEDs the board provides. The others functions are used to turn the LEDs on
and off.

The LLAPI are the same for the LED which is connected to a GPIO (@ or 1) orviaa PWM. The BSP has the respon-
sibility of interpreting the MicroEJ Application parameter intensity.

Typically, when the LED is connected to a GPI0,the intensity “0” means “OFF,” and all others values “ON.” When
the LED is connected via a PWM, the intensity “0” means “OFF,” and all others values must configure the PWM
signal.

The BSP should be able to return the state of an LED. If it is not able to do so (for example GPIO is not accessiblein
read mode), the returned value may be wrong. The MicroEJ Application may not be able to know the LEDs states.

When there is no LED on the board, a stub implementation of C library is available. This C library must be linked by
the third-party C IDE when the MicroUl module is installed in the MicroEJ Platform.
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Dependencies

« MicroUl module (see MicroUl)

o LLLEDS_impl.h implementation if standard implementation is chosen (see Implementations and LLLEDS:
LEDs).

Installation
LEDs is a sub-part of MicroUl library. When the MicroUl module is installed, the LEDs module must be installed in
order to be able to connect physical LEDs with MicroEJ Platform. If not installed, the stub module will be used.

In the platform configuration file, check Ul > LEDs toinstall LEDs.

Use

The MicroUl LEDs APIs are available in the class ej.microui.led.Leds.

4.9.5 Inputs

Principle

The Inputs module contains the C part of the MicroUl implementation which manages input devices. This module
is composed of two elements:

« the C part of MicroUl input API (a built-in C archive)

« an implementation of a low level API for the input devices (LLINPUT) that must be provided by the BSP (see
LLINPUT: Inputs)

Functional Description
The Inputs module implements the MicroUl int -based event generators’ framework. LLINPUT specifies the low
level API that send events to the Java world.

Each MicroUl Event Generator represents one side of a pair of collaborative components that communicate using
a shared buffer:

« The producer: the C driver connected to the hardware. As a producer, it sends its data into the communica-
tion buffer.

« The consumer: the MicroUl Event Generator . As a consumer, it reads (and removes) the data from the
communication buffer.
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Fig. 29: Drivers and MicroUl Event Generators Communication

The LLINPUT APl allows multiple pairs of <driver - event generator> to use the same buffer, and associates
drivers and event generators using an int ID. The ID used is the event generator ID held within the MicroUl global
registry [MUI]. Apart from sharing the ID used to “connect” one driver’s data to its respective event generator, both
entities are completely decoupled.

A Java green thread, called the InputPump thread, waits for data to be published by drivers into the “input buffer,”
and dispatches to the correct (according to the ID) event generator to read the received data. This “driver-specific-
data” is then transformed into MicroUl events by event generators and sent to objects that listen for input activity.
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Fig. 30: MicroUl Events Framework

Implementation

Theimplementation of the MicroUl Event Generator APIs providessome low level APIs. The BSP hasto implement
these LLAPI, making the link between the MicroUl C library inputs and the BSP input devices drivers.
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The LLAPI to implement are listed in the header file LLINPUT _imp1.h. It allows events to be sent to the MicroUl im-
plementation. The input drivers are allowed to add events directly using the event generator’s unique ID (see Static
Initialization). The drivers are fully dependent on the MicroEJ framework (a driver cannot be developed without
MicroEJ because it uses the header file generated during the MicroUl initialization step).

When there is no input device on the board, a stub implementation of C library is available. This C library must be
linked by the third-party C IDE when the MicroUl module is installed in the MicroEJ Platform.

Generic Event Generators

On the application side, the Ul extension provides an abstract class GenericEventGenerator (package ej.
microui.event)that must beimplemented by clients who want to define their own event generators. Two abstract
methods must be implemented by subclasses:

+ eventReceived: The event generator received an event from a C driver through the low level APl sendEvent
function.

« eventsReceived: The event generator received an event made of several ints.

« setProperty : Handle a generic property (key/value pair) set from the static initialization file (see MicroUl
Static Initializer)

The event generator is responsible for converting incoming data into a MicroUl event and sending the event to its
listener.

Dependencies

« MicroUl module (see MicroUl)

« Static MicroUl initialization step (see section_static_init). This step generates a header file which contains
some unique event generator IDs. These IDs must be used in the BSP to make the link between the input
devices drivers and the MicroUl Event Generators.

« LLINPUT_impl.h implementation (see LLINPUT: Inputs).
Installation
Inputs is a sub-part of the MicroUl library. When the MicroUl module is installed, the Inputs module must be in-

stalled in order to be able to connect physical input devices with MicroEJ Platform. If not installed, the stub module
will be used. In the platform configuration file, check Ul > Inputs toinstall Inputs.

Use

The MicroUl Input APIs are available in the class ej.microui.EventGenerator .

4.9.6 Display
Principle

The Display module contains the C part of the MicroUl implementation which manages graphical displays. This
module is composed of two elements:

« the C part of MicroUl Display API (a built-in C archive)
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« an implementation of a low level API for the displays (LLDISPLAY) that the BSP must provide (see LLDISPLAY:
Display)

Display Configurations

The Display modules provides a number of different configurations. The appropriate configuration should be se-
lected depending on the capabilities of the screen and other related hardware, such as LCD controllers.

The modes can vary in three ways:
« the buffer mode: double-buffer, simple buffer (also known as “direct”)
« the memory layout of the pixels
« pixel format or depth

The supplied configurations offer a limited range of combinations of the options.

Buffer Modes
Overview

When using the double buffering technique, the memory into which the application draws (called graphics buffer
or back buffer) is not the memory used by the screen to refresh it (called frame buffer or display buffer). When
everything has been drawn consistently from the application point of view, the back buffer contents are synchro-
nized with the display buffer. Double buffering avoids flickering and inconsistent rendering: it is well suited to high
quality animations.

For more static display-based applications, and/or to save memory, an alternative configuration is to use only one
buffer, shared by both the application and the screen.

Displays addressed by one of the standard configurations are called generic displays. For these generic displays,
there are three buffer modes: switch, copy and direct. The following flow chart provides a handy guide to selecting
the appropriate buffer mode according to the hardware configuration.
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Implementation

The display module (or stack) does not depend on type of buffer mode. At the end of a drawing, the display stack
callsthe LLAPI LLDISPLAY_IMPL_f1lush to let the implementation to update the LCD data. This function should be
atomicand the implementation has to return the new graphics buffer address (back buffer address). In direct and
copy modes, this address never changes and the implementation has always to return the back buffer address. In
switch mode, the implementation has to return the old LCD frame buffer address.

The next sections describe the work to do for each mode.
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Switch

The switch mode is a double-buffered mode where two buffers in RAM alternately play the role of the back buffer
and the display buffer. The display source is alternatively changed from one buffer to the other.

Switching the source address may be done asynchronously. The synchronize function is called before starting the
next set of draw operations, and must wait until the driver has switched to the new buffer.

Synchronization steps are described below.

Switch Mode Synchronization Steps

« Step 1: Drawing
MicroUl is drawing in buffer 0 (back buffer) and the display is reading its contents from buffer 1 (display
buffer).

MicroUl

draw

read

Display

Step 1: Drawing

« Step 2: Switch
The drawing is done. Set that the next read will be done from buffer 0.
Note that the display “hardware component” asynchronously continues to read data from buffer 1.

MicroUl

read

Display

Step 2 : Switch
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« Step 3: Copy
A copy from the buffer 0 (new display buffer) to the buffer 1 (new back buffer) must be done to keep the

contents of the current drawing. The copy routine must wait until the display has finished the switch, and
start asynchronously by comparison with the MicroUl drawing routine (see next step).

This copy routine can be done in a dedicated RTOS task or in an interrupt routine. The copy should start
after the display “hardware component” has finished a full buffer read to avoid flickering.

Usually a tearing signal from the LCD at the end of the read of the previous buffer (buffer 1) or at the
beginning of the read of the new buffer (buffer 0) throws an interrupt. The interrupt routine starts the copy
using a DMA.

If it is not possible to start an asynchronous copy, the copy must be performed in the MicroUl drawing
routine, at the beginning of the next step.

Note that the copy is partial: only the parts that have changed need to be copied, lowering the CPU load.

MicroUl

copy

read

Display

Step 3: Copy

« Step 4: Synchronisation
Waits until the copy routine has finished the full copy.
If the copy has not been done asynchronously, the copy must start after the display has finished the switch.
Itis a blocking copy because the next drawing operation has to wait until this copy is done.
+ Step 5: Next draw operation
Same behavior as step 1 with buffers reversed.

MicroUl

draw

read

Display

Step 5: Next draw operation
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Copy

The copy mode is a double-buffered mode where the back buffer is in RAM and has a fixed address. To update the
display, data is sent to the display buffer. This can be done either by a memory copy or by sending bytes using a
bus, such as SPl or I2C.

Synchronization steps are described below.

Display Copy Mode

« Step I: Drawing
MicroUl is drawing in the back buffer and the display is reading its content from the display buffer.

MicroUl

draw

read

Display

» Step 2: Copy
The drawing is done. A copy from the back buffer to the display buffer is triggered.

Note that the implementation of the copy operation may be done asynchronously - it is recommended to
wait until the display “hardware component” has finished a full buffer read to avoid flickering. At the
implementation level, the copy may be done by a DMA, a dedicated RTOS task, interrupt, etc.

MicroUl

copy

read

Display

« Step 3: Synchronization
The next drawing operation waits until the copy is complete.
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MicroUl

read

Display

Direct

The direct mode is a single-buffered mode where the same memory area is used for the back buffer and the display
buffer (Seeillustration below). Use of the direct mode is likely to result in “noisy” rendering and flickering, but saves
one buffer in runtime memory.

MicroUl
draw

read
Display

Fig. 32: Display Direct Mode

Byte Layout

This chapter concerns only LCD with a number of bits-per-pixel (BPP) smaller than 8. For this kind of LCD, a byte
contains several pixels and the display module allows to customize how to organize the pixels in a byte.

Two layouts are available:

« line: The byte contains several consecutive pixels on same line. When the end of line is reatched, a padding
is added in order to start a new line with a new byte.

« column: The byte contains several consecutive pixels on same column. When the end of column is reatched,
a padding is added in order to start a new column with a new byte.

When installing the display module, a property bytelayout is required to specify the kind of pixels representation
(see Installation).
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Table 6: Byte Layout: line

BPP [ MSB | \ \ \ | LSB
4 pixel 1 pixel 0

2 pixel 3 pixel 2 pixel 1 pixel 0

1 pixel 7 [ pixel 6 | pixel5 | pixel4 | pixel3 [ pixel2 | pixel1 [ pixel0

Memory Layout

Table 7: Byte Layout: column

BPP | 4 2
MSB | pixel1 | pixel3 | pixel7
pixel 6
pixel2 | pixel 5
pixel 4
pixel 0 | pixel1 | pixel3
pixel 2
pixel 0 | pixel1
LSB pixel 0

For the LCD with a number of bits-per-pixel (BPP) higher or equal to 8, the display module supports the line-by-line
memory organization: pixels are laid out from left to right within a line, starting with the top line. For a display with
16 bits-per-pixel, the pixel at (0,0) is stored at memory address 0, the pixel at (1,0) is stored at address 2, the pixel
at (2,0) is stored at address 4, and so on.

Table 8: Memory Layout for BPP >=8

BPP [ @+0 @+1 @+2 @+3 @+4

32 pixel 0 [7:0] | pixel 0[15:8] | pixel 0[23:16] | pixel 0 [31:24] | pixel1[7:0]
24 pixel 0 [7:0] | pixel 0 [15:8] | pixel 0[23:16] | pixel1[7:0] pixel 1[15:8]
16 pixel 0 [7:0] | pixel 0[15:8] | pixel1[7:0] pixel1[15:8] pixel 2 [7:0]
8 pixel 0 [7:0] | pixel1[7:0] pixel 2 [7:0] pixel 3 [7:0] pixel 4 [7:0]

For the LCD with a number of bits-per-pixel (BPP) lower than 8, the display module supports the both memory
organizations: line by line (pixels are laid out from left to right within a line, starting with the top line) and column
by column (pixels are laid out from top to bottom within a line, starting with the left line). These byte organizations
concern until 8 consecutive pixels (see Byte Layout). When installing the display module, a property memoryLayout
is required to specify the kind of pixels representation (see Installation).

Table 9: Memory Layout ‘line’ for BPP < 8 and byte layout ‘line’

BPP

@+0

@+1

@+2

@+3

@+4

(0,0) to (1,0)

(2,0) to (3,0)

(4,0) to (5,0)

(6,0) to (7,0)

(8,0) to (9,0)

=N D

(0,0) to (3,0)

(4,0) to (7,0)

(8,0) to (11,0)

(12,0) to (15,0)

(16,0) to (19,0)

(0,0) to (7,0)

(8,0 to (15,0)

(16,0) to (23,0)

(24,0) to (31,0)

(32,0) to (39,0)

Table 10: Memory Layout ‘line’ for BPP < 8 and byte layout ‘column’

BPP

@+0

@+1

@+2

@+3

@+4

(0,0) to (0,1)

(1,0) to (1,1)

(2,0) to (2,1)

(3,0) to (3,1)

(4,0) to (4,1)

(0,0) to (0,3)

(1,0) to (1,3)

(2,0) o (2,3)

(3,0) o (3,3)

(4,0) to (4,3)

=N D

(0,0) to (0,7)

(1,0) to (15,7)

(2,0) to (23,7)

(3,0) to (31,7)

(4,0) to (39,7)
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Table 11: Memory Layout ‘column’ for BPP < 8 and byte layout ‘line’

BPP [ @+0 @+1 @+2 @+3 @+4
4 (0,0)to (1,0) | (0,)to (1,1) | (0,2)to (1,2) | (0,3)to (1,3) | (0,4)to (1,4)
2 (0,0)to (3,0) | (0,1)to (3,1) | (0,2)to (3,2) | (0,3)to(3,3) | (0,4)to (3,4)
1 (0,0)to (7,0) | (0,)to (7,1) | (0,2)to (7,2) | (0,3)to (7,3) | (0,4)to (7,4)

Table 12: Memory Layout ‘column’ for BPP < 8 and byte layout ‘column’

BPP [ @+0 @+1 @+2 @+3 @+4

4 (0,0) to (0,1) (0,2) to (0,3) (0,4) to (0,5) (0,6) to (0,7) (0,8) to (0,9)

2 (0,0) to (0,3) | (0,4) to (0,7) (0,8) to (0,11) (0,12) to (0,15) | (0,16) to (0,19)

1 (0,0)to (0,7) | (0,8) to (0,15) | (0,16) to (0,23) | (0,24) to (0,31) | (0,32) to (0,39)
Pixel Structure

The Display module provides pre-built display configurations with standard pixel memory layout. The layout of the
bits within the pixel may be standard (see MicroUl GraphicsContext pixel formats) or driver-specific. When installing
the display module, a property bpp is required to specify the kind of pixel representation (see /nstallation).

When the value is one among this list: ARGB8888 | RGB888 | RGB565 | ARGB1555 | ARGB4444 | C4 | C2 | C1
, the display module considers the LCD pixels representation as standard. According to the chosen format, some
color data can be lost or cropped.

+ ARGB8888: the pixel uses 32 bits-per-pixel (alpha[8], red[8], green[8] and blue[8]).

u32 convertARGB8888toLCDPixel(u32 c){
return c;

3

u32 convertLCDPixeltoARGB8888(u32 c){
return c;

3

« RGB888: the pixel uses 24 bits-per-pixel (alpha[0], red[8], green[8] and blue[8]).

u32 convertARGB8888toLCDPixel(u32 c){
return c & Oxffffff;

3

u32 convertLCDPixeltoARGB8888(u32 c){
return @
| 0xff000000
| ¢

3

« RGB565: the pixel uses 16 bits-per-pixel (alpha[0], red[5], green[6] and blue[5]).

u32 convertARGB8888toLCDPixel(u32 c){
return 0
| ((c & 0xf80000) >> 8)
| ((c & 0x00fco0) >> 5)
| ((c & 0x0000f8) >> 3)

(continues on next page)
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(continued from previous page)

3

u32 convertLCDPixeltoARGB8888(u32 c){
return @
| 9xff000000
| ((c & 0xf800) << 8)
| ((c & 0x07e0) << 5)
| ((c & 0x001f) << 3)

)

3

ARGB1555: the pixel uses 16 bits-per-pixel (alpha[l], red[5], green[5] and blue[5]).

u32 convertARGB8888tolLCDPixel(u32 c){
return 0
| (((c & Oxff00000R0) == Oxff0O000RR) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)

’

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0
| ((c & 0x8000) == 0x8000 ? Oxff000V0Q : 0x00000000)
| ((c & 0x7c00) << 9)
| ((c & 0x03e0) << 6)
| ((c & 0x001f) << 3)

’

}

ARGB4444: the pixel uses 16 bits-per-pixel (alpha[4], red[4], green[4] and blue[4]).

u32 convertARGB8888tolLCDPixel(u32 c){
return 0

| ((c & 0xf00000VR) >> 16)

| ((c & 0x00f00000) >> 12)

| ((c & 0x0000f000) >> 8)

| ((c & 0x000000f0) >> 4)

)

}
u32 convertLCDPixeltoARGB8888(u32 c){
return 0

| ((c & 0xf000) << 16)
| ((c & 0xf000) << 12)
| ((c & 0x0f00) << 12)
| ((c & 0x0f00) << 8)
| ((c & 0x00f0) << 8)
| ((c & 0x00f0) << 4)
| ((c & 0x000f) << 4)
| ((c & 0x000f) << @)

’

3

+ C4: the pixel uses 4 bits-per-pixel (grayscale[4]).
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u32 convertARGB8888tolLCDPixel(u32 c){
return (toGrayscale(c) & 0Oxff) / 0x11;

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xffo00000 | (c * 0x111111);
}

+ C2: the pixel uses 2 bits-per-pixel (grayscale[2]).

u32 convertARGB8888tolLCDPixel(u32 c){
return (toGrayscale(c) & 0xff) / 0x55;

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xffo00000 | (c * 0x555555);
}

« Cl: the pixel uses 1 bit-per-pixel (grayscale[1]).

u32 convertARGB8888toLCDPixel(u32 c){
return (toGrayscale(c) & Oxff) / Oxff;

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xff000000 | (c * Oxffffff);
3

When the value is one among thislist: 1 | 2 | 4 | 8 | 16 | 24 | 32,thedisplay module considers the LCD
pixel representation as generic but not standard. In this case, the driver must implement functions that convert
MicroUl’s standard 32 bits ARGB colors to LCD color representation (see LLDISPLAY: Display). This mode is often
used when the pixel representation is not ARGB or RGB but BGRA or BGR instead. This mode can also be used
when the number of bits for a color component (alpha, red, green or blue) is not standard or when the value does
not represent a color but an index in an LUT.

Antialiasing

Fonts

The antialiasing mode for the fonts concerns only the fonts with more than 1 bit per pixel (see Font Generator).

Background Color

For each pixel to draw, the antialiasing process blends the foreground color with a background color. This back-
ground color is static or dynamic:

« static: The background color is fixed by the MicroEJ Application (GraphicsContext. setBackgroundColor ()

).

« dynamic: The background color is the original color of the destination pixel (a “read pixel” operation is per-
formed for each pixel).

Note that the dynamic mode is slower than the static mode.
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LUT

The display module allows to target LCD which uses a pixel indirection table (LUT). This kind of LCD are considered
as generic but not standard (see Pixel Structure). By consequence, the driver mustimplement functions that convert
MicroUl’s standard 32 bits ARGB colors (see LLDISPLAY: Display) to LCD color representation. For each application
ARGBB8888 color, the display driver has to find the corresponding color in the table. The display module will store
the index of the color in the table instead of using the color itself.

When an application color is not available in the display driver table (LUT), the display driver can try to find the
nearest color or return a default color. First solution is often quite difficult to write and can cost a lot of time at
runtime. That’s why the second solution is preferred. However, a consequence is that the application has only to
use a range of colors provided by the display driver.

MicroUl and the display module uses blending when drawing some texts or anti-aliased shapes. For each
pixel to draw, the display stack blends the current application foreground color with the targeted pixel cur-
rent color or with the current application background color (when enabled). This blending creates some in-
termediate colors which are managed by the display driver. Most of time the default color will be returned
and so the rendering will be wrong. To prevent this use case, the display module offers a specific LLAPI
LLDISPLAY_EXTRA_IMPL_prepareBlendingOfIndexedColors(void* foreground, void* background) . This
APl is only used when a blending is required and when the background color is enabled. Display module calls the
APl just before the blending and gives as parameter the pointers on the both ARGB colors. The display driver should
replace the ARGB colors by the LUT indexes. Then the display module will only use the indexes between the both
indexes. For instance, when the returned indexes are 20 and 27, the display stack will use the indexes 20 to 27,
where all indexes between 20 and 27 target some intermediate colors between the both original ARGB colors.

This solution requires several conditions:
+ Background color is enabled and it is an available color in the LUT.

+ Application can only use foreground colors provided by the LUT. The platform designer should give to the
application developer the available list of colors the LUT manages.

« The LUT must provide a set blending ranges the application can use. Each range can have its own size (dif-
ferent number of colors between two colors). Each range is independent. For instance if the foreground
color RED (0xFFFF0000 ) can be blended with two background colors WHITE (@xFFFFFFFF)and BLACK (
0xFFO00000 ), two ranges must be provided. The both ranges have to contain the same index for the color
RED.

« Application can only use blending ranges provided by the LUT. Otherwise the display driver is not able to find
the range and the default color will be used to perform the blending.

Rendering of dynamic images (images decoded at runtime) may be wrong because the ARGB colors may be
out of LUT range.

Hardware Accelerator

Overview

The display module allows to use an hardware accelerator to perform some drawings: fill a rectangle, draw an im-
age, rotate an image etc. Some optional functions are available in LLDISPLAY_EXTRA.h file (see LLDISPLAY EXTRA:
Display Extra Features). These functions are not automatically call by the display module. The display module must
be configured during the MicroEJ Platform construction specifying which hardware accelerator to use. It uses the
property hardwareAccelerator in display/display.properties file to select a hardware accelerator (see /n-
stallation).

The following table lists the available hardware accelerators supported by MicroEJ, their full names, short names
(used in the next tables) and the hardwareAccelerator property value (see /nstallation).
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Table 13: Hardware Accelerators

Short name | Property
Renesas Graphics Library RGA! RGA rga
Renesas TES Dave/2d Dave2D dave2d
STMicroelectronics Chrom-ART Graphics Accelerator | DMA2D dma2d
Custom Hardware Accelerator Custom custom’

Note: It is possible to target an hardware accelerator which is not supported by MicroEJ yet. Set the property
hardwareAccelerator to custom to force display module to call all drawing functions which can be accelerated.
The LLDISPLAY implementation is able or not to implement a function. If not, the software algorithm will be used.

The available list of supported hardware accelerators is MicroEJ Architecture dependent. For instance, the STMi-
croelectronics Chrom-ART Graphics Accelerator is only available for the MicroEJ Architecture for Cortex-M4 and
Cortex-M7. The Renesas Graphics Library RGA is only available for the MicroEJ Architecture for Cortex-A9. The fol-
lowing table shows in which MicroEJ Architecture an hardware accelerator is available.

Table 14: Hardware Accelerators according MicroEJ Architectures
RGA Dave2D | DMA2D | Custom

ARM Cortex-M0O+ IAR

ARM Cortex-M4 ARMCC

ARM Cortex-M4 GCC

ARM Cortex-M4 IAR

ARM Cortex-M7 ARMCC

Note: Some hardware accelerators may not be available in off-the-self architectures . However they are available
on some specific architectures. Please consult the engineering services page on MicroEJ website.

All hardware accelerators are not available for each number of bits-per-pixel configuration. The following table
illustrates in which display stack according bpp, an hardware accelerator can be used.

" hardware or software implementation
2 see next note
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Table 15: Hardware Accelerators according BPP

RGA Dave2D

DMA2D

Custom

1BPP

al

2 BPP

C2

4BPP

Cc4

8 BPP

16 BPP

RGB565

ARGB1555

ARGB4444

24 BPP

RGB888

32 BPP

ARGB8888

Features and Limits

Each hardware accelerator has a list of features (list of drawings the hardware accelerator can perform) and some
constraints. When the display module is configured to use an hardware accelerator, it takes in consideration these
features and limits. If a drawing is detected by the display module as a drawing to be hardware accelerated, the
LLDISPLAY implementation must configure and use the hardware accelerator to perform the full drawing (not just

a part of drawing).

Note: The custom hardware generator does not have any limit by default. This is the LLDISPLAY implementation

which fixes the limits.

The following table lists the algorithms accelerated by each hardware accelerator.
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Table 16: Hardware Accelerators Algorithms
RGA Dave2D | DMA2D

Fill a rectangle

Draw an image

Scale animage

Rotate an image

Images

The available list of supported image formats is not the same for all hardware accelerators. Furthermore some
hardware accelerators require a custom header before the RAW pixel data, require a padding between each line
etc.. MicroEJ manages these contraints for supported hardware accelerators. For custom hardware accelerator, no
image header can be added and no padding can be set.

The following table illustratres the RAW image formats supported by each hardware accelerator.

Table 17: Hardware Accelerators RAW Image Formats
RGA Dave2D DMA2D

Al

A2
A4

A8

v

al

C2

C4

ACN
AC22
AC44
RGB565

ARGB1555

ARGB4444

RGB888

ARGB8888
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The RAW image given as parameter (in input and/or in output) respects the hardware accelerator specification. For
instance a RAW image with 4BPP must be often aligned on 8 bits, even if its size is odd. The RAW image size given
as parameter is the software size. That means it is the size of the original image.

Example for a A4 image with required alignment on 8 bits:
+ Original image width in pixels (== width in MicroEJ Application): 47
+ Hardware image width in pixels (== line width in pixels in RAW image data): 48
« Width in pixels available in LLDISPLAY ( ((LLDISPLAY_SImage*)src)->width): 48
+ Hardware width in bytes (== line width in bytes in RAW image data): 48 /2 =24

The hardware size may be higher than the software size (like in the example). However the number of pixels to
draw ( ((LLDISPLAY_SDrawImage*)drawing)->src_width ) is always smaller or equal to the software area size.
That means the display module never asks to draw the pixels which are outside the software area. The hardware
size is only useful to be compatible with the hardware accelerator restrictions about memory alignment.

Implementations

The implementation of the MicroUl Display API targets a generic display (see Display Configurations): Switch,
Copy and Direct. It provides some low level API. The BSP has to implement these LLAPI, making the link between
the MicroUl C library display and the BSP display driver. The LLAPI to implement are listed in the header file
LLDISPLAY_impl.h.

When there is no display on the board, a stub implementation of C library is available. This C library must be linked
by the third-party C IDE when MicroUl module is installed in the MicroEJ Platform.

Dependencies

« MicroUl module (see MicroUl)

+ LLDISPLAY_impl.h implementation if standard or custom implementation is chosen (see Implementations
and LLDISPLAY: Display).

Installation

Display is a sub-part of the MicroUl library. When the MicroUl module is installed, the Display module must be
installed in order to be able to connect the physical display with the MicroEJ Platform. If not installed, the stub
module will be used.

In the platform configuration file, check Ul > Display to install the Display module. When checked, the prop-

erties file display > display.properties is required during platform creation to configure the module. This
configuration step is used to choose the kind of implementation (see Implementations).

The properties file must / can contain the following properties:

+ bpp [mandatory]: Defines the number of bits per pixels the display device is using to render a pixel. Expected
value is one among these both list:

Standard formats:

- ARGB8888 : Alpha 8 bits; Red 8 bits; Green 8 bits; Blue 8 bits

3 maximum size <= display width
4 maximum size <= display width
5 maximum size <= display width
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- RGB888: Alpha 0 bit; Red 8 bits; Green 8 bits; Blue 8 bits (fully opaque)

- RGB565 : Alpha 0 bit; Red 5 bits; Green 6 bits; Blue 5 bits (fully opaque)

- ARGB1555 : Alpha 1 bit; Red 5 bits; Green 5 bits; Blue 5 bits (fully opaque or fully transparent)
- ARGB4444 : Alpha 4 bits; Red 4 bits; Green 4 bits; Blue 4 bits

- C4:4bits to encode linear grayscale colors between 0xff000000 and Oxffffffff (fully opaque)
- C2:2 bits to encode linear grayscale colors between 0xff000000 and Oxffffffff (fully opaque)
- C1:1bitto encode grayscale colors 0xff000000 and Oxffffffff (fully opaque)

Custom formats:

32 : until 32 bits to encode Alpha, Red, Green and/or Blue

24 : until 24 bits to encode Alpha, Red, Green and/or Blue

16 : until 16 bits to encode Alpha, Red, Green and/or Blue

8 : until 8 bits to encode Alpha, Red, Green and/or Blue

4 : until 4 bits to encode Alpha, Red, Green and/or Blue

2 : until 2 bits to encode Alpha, Red, Green and/or Blue
- 1:1bitto encode Alpha, Red, Green or Blue
All others values are forbidden (throw a generation error).

« byteLayout [optional, default value is “line”]: Defines the pixels data order in a byte the display device is
using. A byte can contain several pixels when the number of bits-per-pixels (see ‘bpp’ property) is lower than
8. Otherwise this property is useless. Two modes are available: the next bit(s) on same byte can target the
next pixel on same line or on same column. In first case, when the end of line is reatched, the next byte con-
tains the first pixels of next line. In second case, when the end of column is reatched, the next byte contains
the first pixels of next column. In both cases, a new line or a new column restarts with a new byte, even if it
remains some free bits in previous byte.

- line:the next bit(s) on current byte contains the next pixel on same line (x increment)

- column: the next bit(s) on current byte contains the next pixel on same column (y increment)

Note:
- Default value is ‘line’.
- All others modes are forbidden (throw a generation error).

- Whenthe number of bits-per-pixels (see ‘bpp’ property) is higher or equal than 8, this property is useless
and ignored.

memorylLayout [optional, default value is “line”]: Defines the pixels data order in memory the display device
is using. This option concerns only the LCD with a bpp lower than 8 (see ‘bpp’ property). Two modes are
available: when the byte memory address is incremented, the next targeted group of pixels is the next group
on the same line or the next group on same column. In first case, when the end of line is reached, the next
group of pixels is the first group of next line. In second case, when the end of column is reached, the next
group of pixels is the first group of next column.

- line:the next memory address targets the next group of pixels on same line (x increment)

- column: the next memory address targets the next group of pixels on same column (y increment)
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Note:
- Default valueis ‘line’.
- All others modes are forbidden (throw a generation error).

- When the number of bits-per-pixels (see ‘bpp’ property) is higher or equal than 8, this property is useless
and ignored.

Use

The MicroUl Display APIs are available in the class ej.microui.display.Display.

4.9.7 Images

The Image Engine is composed of:

« The “Image Engine Core” module which is able to load and drawing simultaneously some pre-generated
images and some dynamic images.

+ An “Image Generator” module, for converting standard image formats into the display image format before
runtime (pre-generated images).

«+ Aset of “Image Decoder” modules, for converting standard image formats into the display image format at
runtime. Each Image Decoder is an additional module of the main module “Image Engine”.

Image Engine Core

Principle

The Image Engine Core module is a built-in module of the MicroUl module (see MicroUl) for the application side,
and a built-in module of the Display module (see Display) for the C side.

Functional Description

Standard image

{ 0110010
L ] 11001...

Standard image RAW image

Fig. 33: Image Engine Core Principle
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Process overview:

1.

The user specifies the pre-generated images to embed (see Image Generator) and / or the images to embed
as regular resources (see Image Decoder)

The files are embedded as resources with the MicroEJ Application. The files’ data are linked into the FLASH
memory.

When the MicroEJ Application creates a MicroUl Image object, the Image Engine Core loads the image, calling
the right sub Image Engine module (see Image Generator and Image Decoder) to decode the specified image.

When the MicroEJ Application draws this MicroUl Image on the display (or on another image), the decoded
image data is used, and no more decoding is required, so the decoding is done only once.

When the MicroUl Image is no longer needed, it is garbage-collected by the platform; and the Image Engine
Core asks the right sub Image Engine module (see /Image Generator and Image Decoder) to free the image
working area.

External Resources

The Image Engine Core is able to load some images located outside the CPU addresses’ space range. It uses the
External Resource Loader.

When an image is located in such memory, the Image Engine Core copies it into RAM (into the CPU address space
range). Then it calls the right sub Image Engine module (see Image Generator and Image Decoder) to decode the
specified image.

The RAM section used to load the externalimage is automatically freed when the Image Engine Core and its modules
do not need it again.

Dependencies

+ MicroUl module (see MicroUl)

« Display module (see Display)

Installation

Image Engine Core modules are part of the MicroUl module and Display module. Install them in order to be able to
use some images.

Use

The MicroUl image APIs are available in the class ej.microui.display.Image.

Image Generator

Principle

The Image Generator module is an off-board tool that generates image data that is ready to be displayed without
needing additional runtime memory. The two main advantages of this module are:

+ A pre-generated image is already encoded in the format known by the display stack. The image loading is

very fast and does not require any RAM.
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« No extra support is needed (no runtime decoder).

Functional Description

image
*.png

EHE

image raw ||| RAW images stored
"Ipg image||| jn FLASH memory
image

*.bmp

Fig. 34: Image Generator Principle

Process overview (see too Functional Description)

1. The user defines, in a text file, the images to load.

2. The Image Generator outputs a raw file for each image to convert (the raw format is display device-
dependent).

3. The raw files are embedded as (hidden) resources within the MicroEJ Application. The raw files’ data are
linked into the FLASH memory.

4. When the MicroEJ Application creates a MicroUl Image object which targets a pre-generated image, the Im-
age Engine Core has only to create a link from the MicroUl image object to the data in the FLASH memory.
Therefore, the loading is very fast; only the image data from the FLASH memory is used: no copy of the image
data is sent to the RAM first.

5. When the MicroUl Image is no longer needed, it is garbage-collected by the platform, which just deletes the
useless link to the FLASH memory.

Extensions Purpose

The output representation of the images in the same format as the LCD (same pixel representation, see Display Out-
put Format) is dependent on the drivers that run the underlying screen. Indeed, the output raw format is specific to
each display device. The Image Generator tool provided is expandable by extensions, each extension implementing
a dedicated display device layout.

Standard Extension

When the LCD pixels representation is standard (ARGB8888 or RGB565 etc., see Pixel Structure) the image generator
does not need an extension. The formulas of conversions ARGB8388 to RAW formats are the same as described in
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the chapter Pixel Structure.

Generic Extension

When the LCD pixel representation is generic(1 | 2 | 4 | 8 | 16 | 24 | 32,see Pixel Structure) the image
generator requires an extension in order to understand how to convert ARGB pixels into LCD pixel representations.

The Display module provides generic display implementation according the number of bits-per-pixels (1, 2, 4, 8, 16,
24 and 32). The Image Generator tool provides a simple extension to implement in order to target these kinds of
displays: GenericDisplayExtension.’

A method must be implemented in relation to the way the driver has built the layout of the display buffers in mem-
ory: The convertARGBColorToDisplayColor method is used to convert a 32-bits ARGB color into the display pixel
memory representation.

Note: The Image Generator automatically uses the right number of bits to represent a pixel (BPP) and respect the
memory buffer layout using the result of the installation of the Display module.

Create an Extension

Follow the steps below to create an Image Generator extension:
1. First, create a new J2SE project, called (for example) imageGeneratorExtension.

2. In the project’s Java build path (project’s property window, select Java Build Path > Libraries tab),
add the variable IMAGE-GENERATOR-x.vy .

3. Create the package com.is2t.microui.generators.extension.
4. Create a class in the package whose name must be: MicroUIGeneratorExtension.

5. The Java class must implement the extension interface available in the library IMAGE-GENERATOR-x.y (see
previous chapters). Fill the required methods.

The Java project should now look like this:

4 =2 imageGeneratorExtension
a4 [ src
4 f§ com.is2t.microui.generators.extension
- [J] MicroUlGeneratorExtension.java

=] microuiGeneratorExtensionFactory.properties
- B JRE System Library [jre7]
4 =, Referenced Libraries

mgd IMAGE-GENERATOR-1.0 - C:\Users\is2t\.microe]

Fig. 35: Image Generator Extension Project

! Package com.is2t.microej.microui.image
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With a Java class like this:

Listing 3: Image Generator Extension Implementation Example

package com.is2t.microui.generators.extension;
import com.is2t.microej.microui.image.GenericDisplayExtension;
public class MicroUIGeneratorExtensionMyLCD implements GenericDisplayExtension{

public int convertARGBColorToDisplayColor(int color) {
return (char)
((color & 0xf80000) >>> 8) |
((color & 0x00fc00) >>> 5) |
((color & 0x0000f8) >>> 3);

Configuration File

The Image Generator uses a configuration file (also called the “list file”) for describing images that need to be pro-
cessed. The list file is a text file in which each line describes an image to convert. The image is described as a
resource path, and should be available from the application classpath.

Note: The list file must be specified in the MicroEJ Application launcher (see Application Options). However, all
files in application classpath with suffix .images.list are automatically parsed by the Image Generator tool.

Each line can add optional parameters (separated by a ‘:’) which define and/or describe the output file format (raw
format). When no option is specified, the image is converted into the default format.

Note: See /mage Generator to understand the list file grammar.

Below is an example of a list file for the Image Generator:

Listing 4: Image Generator Configuration File Example
imagel

image2:RGB565

The next chapters describe the available output formats.

Generic Output Formats

Several generic output formats are available. Some formats may be directly managed by the display driver. Refers
to the platform specification to retrieve the list of better formats.

Advantages:
« The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side.
« Drawing an image is very fast when the display driver recognizes the format (with or without transparency).

« Supports or not the alpha encoding: select the better format according to the image to encode.
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Disadvantages:

+ No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
bits-per-pixel.

Select one the following format to use a generic format:
« ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

u32 convertARGB8888toRAWFormat(u32 c){
return c;

}

RGB888: 24 bits format, 8 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return c & Oxffffff;
3

« ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return 0

| ((c & 0xf00000VR) >> 16)

| ((c & 0x00f00000) >> 12)

| ((c & 0x0000f000) >> 8)

| ((c & 0x000000f0) >> 4)

)

}

ARGB1555: 16 bits format, 1 bit for transparency, 5 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| (((c & 0xff000000) == Oxff00000Q) ? 0x8000 : @)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)

’

3

+ RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| ((c & 0xf80000) >> 8)
| ((c & 0x00fce0) >> 5)
| ((c & 0x0000f8) >> 3)

3

« A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return Oxff - (toGrayscale(c) & 0xff);
}

+ A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.
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u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & oxff)) / ox11;

3

« A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat(u32 c){
return (Oxff - (toGrayscale(c) & oxff)) / @x55;

}

« Al: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & oxff)) / oxff;

}

« C4: 4 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & 0xff) / 0x11;
3

« C2:2 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & Oxff) / 0x55;

3

+ C1:1bit format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat(u32 c){
return (toGrayscale(c) & oxff) / oxff;

}

« AC44: 4 bits for transparency, 4 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| ((color >> 24) & 0xf0)
| ((toGrayscale(color) & oxff) / ox11)

’

« AC22: 2 bits for transparency, 2 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & oxff) / 0x55)

’

« ACT1: 1 bit for transparency, 1 bit with grayscale conversion.
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u32 convertARGB8888toRAWFormat (u32 c){
return @
| ((c & 0xff00000Q) == OxffO000Q ? Ox2 : 0x0)
| ((toGrayscale(color) & oOxff) / @Oxff)

’

Listing 5: Generic Output Format Examples

image1:ARGB8888
image2:RGB565
image3:A4

Display Output Format

The default embedded image data format provided by the Image Generator tool when using a generic extension is
to encode the image into the exact display memory representation. If the image to encode contains some transpar-
ent pixels, the output file will embed the transparency according to the display’s implementation capacity. When
all pixels are fully opaque, no extra information will be stored in the output file in order to free up some memory
space.

Advantages:
« Drawing an image is very fast.
+ Supports alpha encoding.
Disadvantages:

« No compression: the image size in bytes is proportional to the number of pixels.

Listing 6: Display Output Format Example

imagel:display

RLE1 Output Format

Theimage engine can display embedded images that are encoded into a compressed format which encodes several
consecutive pixels into one or more 16-bits words. This encoding manages a maximum alpha level of 2 (alpha level
is always assumed to be 2, even if the image is not transparent).

« Several consecutive pixels have the same color (2 words).
- First 16-bit word specifies how many consecutive pixels have the same color.
- Second 16-bit word is the pixels’ color.

« Several consecutive pixels have their own color (1+n words).
- First 16-bit word specifies how many consecutive pixels have their own color.
- Next 16-bit word is the next pixel color.

« Several consecutive pixels are transparent (1 word).
- 16-bit word specifies how many consecutive pixels are transparent.

Advantages:
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+ Supports 0 &2 alpha encoding.
« Good compression when several consecutive pixels respect one of the three previous rules.
Disadvantages:

« Drawing an image is slightly slower than when using Display format.

Listing 7: RLE1 Output Format Example

imagel:RLE1

No Compression

When no output format is set in the images list file, the image is embedded without any conversion / compression.
This allows you to embed the resource as well, in order to keep the source image characteristics (compression, bpp
etc.). This option produces the same result as specifying an image as a resource in the MicroEJ launcher.

Advantages:

« Conserves the image characteristics.
Disadvantages:

+ Requires an image runtime decoder.

+ Requires some RAM in which to store the decoded image

Listing 8: Unchanged Image Example
imagel
External Resources

The Image Generator manages two configuration files when the External Resources Loader is enabled. The first con-
figuration file lists the images which will be stored as internal resources with the MicroEJ Application. The second
file lists the images the Image Generator must convert and store in the External Resource Loader output directory.
It is the BSP’s responsibility to load the converted images into an external memory.

Dependencies

+ Image Engine Core module (see /mage Engine Core).

« Display module (see Display): This module gives the characteristics of the graphical display that are usefulin
configuring the Image Generator.

Installation

The Image Generator is an additional module for the MicroUl library. When the MicroUl module is installed, also
install this module in order to be able to target pre-generated images.

In the platform configuration file, check Ul > Image Generator to install the Image Generator module. When
checked, the properties file imageGenerator > imageGenerator.properties is required during platform cre-
ation to configure the module, only when the LCD pixel representation is not standard (see Pixel Structure). This
configuration step is used to identify the extension class name (see Create an Extension).
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Use

The MicroUl Image APIs are available in the class ej.microui.display.Image. There are no specific APIs that use
a pre-generated image. When an image has been pre-processed, the MicroUl Image APIs createImage* will load
the image.

Refer to the chapter Application Options (Libraries > MicroUI > Image ) for more information about specifying
the image configuration file.

Image Decoder

Principle

The Image Engine provides runtime decoders which allow the dynamic loading of images without using the Image
Generator (see /mage Generator). The two main advantages are:

+ The original image is embedded as a resource with the MicroEJ Application.

+ The original image size in bytes is often smaller than a pre-generated image (especially in PNG mode).

Functional Description

image
b \

Standard images stored > |Rraw|[ RAW images stored
in FLASH memory image|||  jn RAM memory

. /
*.bmp

Fig. 36: Image Decoder Principle

Process overview (see too Functional Description)

1. The user specifies the images to embed as regular resources.

2. The original files are embedded as resources with the MicroEJ Application. The original files’ data are linked
into the FLASH memory.

3. When the Image Engine Core calls the decoder to load an image, it transforms the image into a raw format
that is compatible with the display format. It may need some additional RAM to store some working buffers.
At the end of the decoding step, the working buffers are freed: Only the decoded image memory needs to be
retained.

4. When the Image Engine Core calls the decoder to free the image resources, the decoder frees the decoded
image buffer area.
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Internal Decoders

The Ul extension provides two internal Image Decoders modules:

« PNG Decoder: a full PNG decoder that implements the PNG format ( https://www.w3.org/Graphics/PNG ).
Regular, interlaced, indexed (palette) compressions are handled. The RAM used by the decoder is allocated
outside the Java heap.

« BMP Monochrome Decoder: .bmp format files that embed only 1 bit per pixel can be decoded by this decoder.
The RAM used by the decoder to store the decoded image is outside the Java heap.

External Decoders

Some additional decoders can be added. Implement the function LLDISPLAY_EXTRA_IMPL_decodeImage to add
a new decoder (see LLDISPLAY EXTRA: Display Extra Features).

The implementation must respect the following rules:

« Fillsthe LLDISPLAY_SImage structure with the image characteristics: width, height and format.

Note: The output image format might be different than the expected format (given as argument). In this
way, the display module will perform a conversion after the decoding step. During this conversion, an out of
memory error can occur because the final RAW image cannot be allocated.

+ Allocates the RAW image data calling the function LLDISPLAY_UTILS_allocateRawImage . Thisfunction will
allocates the RAW image data space in the display working buffer according the RAW image format and size.

« Decodes the image in the allocated buffer.

« Waiting the end of decoding step before returning.

Dependencies

+ Image Engine Core module (see Image Engine Core)

Installation
The Image Decoders modules are some additional modules to the Display module. The decoders belong to distinct
modules, and either or several may be installed.

In the platform configuration file, check Ul > Image PNG Decoder to install the runtime PNG decoder. Check

Ul > Image BMP Monochrome Decoder to install the runtime BMP monochrom decoder.

Use

The MicroUl Image APIs are available in the class ej.microui.display.Image . There is no specific APl that uses
a runtime image. When an image has not been pre-processed (see /mage Generator), the MicroUl Image APIs
createImagex will load thisimage.
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4.9.8 Fonts

The Font Engine is composed of:

« The “Font Engine Core” module which decodes and prints at application runtime the platform-dependent
fonts files generated by the “Font Generator.”

« A“Font Designer” module: a graphical tool which runs within the MicrokJ Workbench used to build and edit
MicroUl fonts; it stores fonts in a platform-independent format.

« A “Font Generator” module, for converting fonts from the platform-independent format into a platform-
dependent format.

The three modules are complementary: a MicroUl font must be created and edited with the Font Designer before
being integrated as a resource by the Font Generator. Finally the Font Engine Core uses the generated fonts at
runtime.

The Font Designer module and Font Generator module options are the direct consequence of the Font Engine Core
capacities. You must understand the Font Engine Core capacities in order to correctly use the modules.

Font Engine Core
Principle

The Font Engine Core module is a built-in module of the MicroUl module (see MicroUl) for the application side; and
is a built=in module of the Display module (see Display) for the C side.

Functional Description

=

font
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font [ — | font ||| — 3 —  » |RAW
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font in FLASH memory
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s

Fig. 37: Font Generation

Process overview:

1. User uses the Font Designer module to create a new font, and imports characters from system fonts ( *. ttf
files) and / or userimages ( *.png, *.jpg, *.bmp, etc.).

2. Font Designer module saves the font as a MicroEJ Font (*.ejf file).
3. The user defines, in a text file, the fonts to load.

4. The Font Generator outputs a raw file for each font to convert (the raw format is display device-dependent).
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5. The raw files are embedded as (hidden) resources within the MicroEJ Application. The raw files’ data are
linked into the FLASH memory.

6. When the MicroEJ Application creates a MicroUl DisplayFont object which targets a pre-generated image,
the Font Engine Core only has to link from the MicroUI DisplayFont object to the data in the FLASH memory.
Therefore, the loading is very fast; only the font data from the FLASH memory is used: no copy of the image
data is sent to RAM memory first.

7. When the MicroUl DisplayFont is no longer needed, it is garbage-collected by the platform, which just deletes
the useless link to the FLASH memory.

Font Engine
Font Format

The font engine module provides fonts that conform to the Unicode Standard. The .ejf files hold font properties:

« Identifiers: Fonts hold at least one identifier that can be one of the predefined Unicode scripts or a user-
specified identifier. The intention is that an identifier indicates that the font contains a specific set of charac-
ter codes, but this is not enforced.

+ Fontheight and width, in pixels. A font has a fixed height. This height includes the white pixels at the top and
bottom of each character, simulating line spacing in paragraphs. A monospace font is a font where all char-
acters have the same width; for example, a ‘I’ representation has the same width as a ‘w’. In a proportional
font, ‘w’ will be wider than a ‘'. No width is specified for a proportional font.

hei ght

Fig. 38: Font Height

+ Baseline, in pixels. All characters have the same baseline, which is an imaginary line on top of which the
characters seem to stand. Characters can be partly under the line, for example ‘g’ or }. The number of pixels
specified is the number of pixels above the baseline.

Fig. 39: Font baseline

« Space character size, in pixels. For proportional fonts, the Space character ( 0x20 ) is a specific character
because it has no filled pixels, and so its width must be specified. For monospace, the space size is equal to
the font width (and hence the same as all other characters).

« Styles: Afont holds either a combination of these styles: BOLD, ITALIC, UNDERLINED, or is said to be PLAIN.

« Runtime filters: Some fonts may allow the font engine to apply a transformation (in other words, a filter)
on characters before they are displayed in order to provide some visual effect on characters (BOLD, ITALIC,
UNDERLINED). Unless specified, a font allows the font engine to apply any of its filters.
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« When the selected font does not have a graphical representation of the required character, a rectangle is
displayed instead. For proportional fonts, the width is one third of the height of the font.

Fig. 40: Default Character

Font Selection

The font engine implements the [MUI] selection semantics, and also tries to select fonts for which styles are built in,
instead of applying a runtime filter. The font is selected based on the following process:

1. Select fonts that define the specified identifier.

2. Select within the step1 fonts, those whose height is the closest to the specified height.
3. Select within the step2 fonts, those with built-in styles that match the specified styles.
4

. If more than one font is selected by the steps above, select those fonts that have the most built-in styles. If
there is still more than one font, one is selected arbitrarily.

Runtime Transformation: Filters

The user interface extension font engine provides three runtime filters that may apply if the (currently selected)
font allows it. The filters are:
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Table 18: The Three Font Runtime Style Transformations (filters).

Name | Description Rendering sample
HER [ ||
| | [ | [ |
| | [ | || |||
[ | ] | [ | ]| |
| | || || |||
| | [ |

ITALIC | Pixels onupperrows are shifted right. The higher
a pixel is relative to the base line, the more it is

right-shifted.
HEE EEEE
| | [ | HE BER
| | [ | | | | | |
[ | ] | [ 1 [ ] |
| | || | [ | HE
| | [ | | |

BOLD | 1pixelis added to the right of each original pixel.

HEN ]
| | [ | [ | |
| | | | ||
[ [ ] ] [ | [
| | || || ||
| | [ | | [ |
UN- A line is displayed two pixels below the baseline C L L]
DER- | position.
LINED

Multiple filters may apply at the same time, combining their transformations on the displayed characters.

Pixel Transparency

The font engine renders the font according the the value stored for each pixel. If the value is 0, the pixel is not
rendered. If the value is the maximum value (for example the value 3 for 2 bits-per-pixel), the pixel is rendered
using the current foreground color, completely overwriting the current value of the destination pixel. For other
values, the pixel is rendered by blending the selected foreground color with the current color of the destination.

If n is the number of bits-per-pixel, then the maximum value of a pixel (pmax) is 22n - 1. The value of each color
component of the final pixel is equal to:

foreground \* pixelValue / pmax + background \* (pmax - pixelValue) / pmax + adjustment

where adjustment is an adjustment factor specified in the board support package of the platform.

Arabic Support

The font engine manages the ARABIC font specificities: the diacritics and contextual letters. Contrary to the LATIN
fonts, some ARABIC characters can overlap another character. When a character must overlap the previous charac-
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ter in the text, the font engine repositions the X coordinate before rendering the new character (instead of placing
the next character just after the previous one).

To render an Arabic text, the font engine requires several points:

« To determinate if a character has to overlap the previous character, the font engine uses a specific range of
ARABIC characters: from 0xfe70 to oxfefc. All others characters (ARABIC or not) outside this range are
considered classic and no overlap is performed. Note that several ARABIC characters are available outside
this range, but the same characters (same representation) are available inside this range.

« The application strings must use the UTF-8 encoding. Furthermore, in order to force the use of char-
acters in the range 0xfe70 to o0xfefc , the string must be filled with the following syntax: °
\ufee2\ufedc\ufe91\u0020\ufede\ufe92\ufea3d\ufeae\ufee3’;where \uxxxx isthe UTF-8 character en-
coding.

« The application string and its rendering are always performed from left to right. However the string contents
are managed by the application itself, and so can be filled from right to left. To write the text:

pdl e

the string characters must be : “ \ufee2\ufedc\ufe91\u0020\ufe8e\ufe92\ufead\ufeae\ufee3’. The font
engine will first render the character ‘ \ufee2’, then ‘ \ufedc, and so on.

« Each character in the font (in the ejf file) must have a rendering compatible with the character position.
The character will be rendered by the font engine as-is. No support is performed by the font engine to obtain
alinear text.

External Resources

The

Font Engine Coreis able to load some fonts located outside the CPU addresses’ space range. It uses the External

Resource Loader.

When a font is located in such memory, the Font Engine Core copies a very short part of the resource (the font file)

into

a RAM memory (into CPU addresses space range): the font header. This header stays located in RAM during

the full MicroEJ Application time. Then, on MicroEJ Application demand, the Font Engine Core loads some extra

info

rmation from the font into the RAM memory (the font meta data, the font pixels, etc.). This extra information is

automatically unloaded from RAM when the Font Engine Core no longer needs them.

Dependencies

« MicroUl module (see MicroUl)

« Display module (see Display)

Installation

The

Font Engine Core modules are part of the MicroUl module and Display module. You must install them in order

to be able to use some fonts.

Use

The

MicroUl font APIs are available in the class ej.microui.display.Font.
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Font Generator

Principle

The Font Generator module is an off-board tool that generates fonts ready to be displayed without the need for
additional runtime memory. It outputs a raw file for each converted font.

Functional Description

* ejf fonts

RAW fonts stored
in FLASH memory

Fig. 41: Font Generator Principle

Process overview:
1. The user defines, in a text file, the fonts to load.
2. The Font Generator outputs a raw file for each font to convert.

3. Theraw files are embedded as (hidden) resources within the MicroEJ Application. The raw file’s data is linked
into the FLASH memory.

4. When the MicroEJ Application draws text on the display (or on an image), the font data comes directly from
the FLASH memory (the font data is not copied to the RAM memory first).

Pixel Transparency

As mentioned above, each pixel of each characterinan .ejf file has one of 256 different gray-scale values. However
RAW files can have1, 2, 4 or 8 bits-per-pixel (respectively 2, 4,16 or 256 gray-scale values). The required pixel depthiis
defined in the configuration file (see next chapter). The Font Generator compresses the input pixels to the required
depth.

Thefollowing tables illustrates the conversion “grayscale to transparency level”. The grayscale value ‘0x00’ is black
whereas value ‘Oxff’ is white. The transparency level ‘0x0’ is fully transparent whereas level ‘0x1’ (bpp ==1), ‘0x3’
(bpp ==2) or ‘Oxf’ (bpp == 4) is fully opaque.

Table 19: Font 1-BPP RAW Conversion
Grayscale Ranges | Transparency Levels
0x00 to Ox7f 0x1
0x80 to Oxff 0x0
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Table 20: Font 2-BPP RAW Conversion

Grayscale Ranges | Transparency Levels
0x00 to 0x1f 0x3
0x20 to Ox7f 0x2
0x80 to Oxdf 0x1
0xeO0 to Oxff 0x0

Table 21: Font 4-BPP RAW Conversion

Grayscale Ranges | Transparency Levels
0x00 to 0x07 Oxf
0x08 to 0x18 Oxe
0x19 to 0x29 Ooxd
Ox2ato Ox3a Oxc
0x3b to Ox4b Oxb
0x4c to 0x5¢ Oxa
0x5d to Ox6d 0x9
Ox6e to OxT7e 0x8
0x7f to Ox8f ox7
0x90 to Oxa0 0x6
0xal to Oxb1 0x5
0xb2 to Oxc2 0x4
0xc3 to 0xd3 0x3
0xd4 to Oxe4 0x2
0xe5 to 0xf5 0x1
0xf6 to Oxff 0x0

For 8-BPP RAW font, a transparency level is equal to 255 - grayscale value.

Configuration File

The Font Generator uses a configuration file (called the “list file”) for describing fonts that must be processed. The
list file is a basic text file where each line describes a font to convert. The font file is described as a resource path,
and should be available from the application classpath.

Note: The list file must be specified in the MicroEJ Application launcher (see Application Options). However, all
files in application classpath with suffix . fonts.list are automatically parsed by the Font Generator tool.

Each line can have optional parameters (separated by a ‘:’) which define some ranges of characters to embed in the
final raw file, and the required pixel depth. By default, all characters available in the input font file are embedded,
and the pixel depth is 1 (i.e 1 bit-per-pixel).

Note: See Font Generator to understand the list file grammar.

Selecting only a specific set of characters to embed reduces the memory footprint. There are two ways to specify

«,”

a character range: the custom range and the known range. Several ranges can be specified, separated by “;” .

Below is an example of a list file for the Font Generator:
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Listing 9: Fonts Configuration File Example

myfont
myfont1:latin
myfont2:1latin:8
myfont3::4

External Resources

The Font Generator manages two configuration files when the External Resources Loader is enabled. The first con-
figuration file lists the fonts which will be stored as internal resources with the MicroEJ Application. The second file
lists the fonts the Font Generator must convert and store in the External Resource Loader output directory. It is the
BSP’s responsibility to load the converted fonts into an external memory.

Dependencies

« Font Engine Core module (see Font Engine Core)

Installation

The Font Generator module is an additional tool for MicroUl library. When the MicroUl module is installed, install
this module in order to be able to embed some additional fonts with the MicroEJ Application.

If the module is not installed, the platform user will not be able to embed a new font with his/her MicroEJ Appli-
cation. He/she will be only able to use the system fonts specified during the MicroUl initialization step (see Static
Initialization).

In the platform configuration file, check Ul > Font Generator to install the Font Generator module.

Use

In order to be able to embed ready-to-be-displayed fonts, you must activate the fonts conversion feature and spec-
ify the fonts configuration file.

Refer to the chapter Application Options (Libraries > MicroUI > Font ) for more information about specifying
the fonts configuration file.

4.9.9 Simulation
Principle

The graphical user interface uses the Front Panel mock (see Front Panel Mock) and some extensions (widgets) to
simulate the user interactions. Itis the equivalent of the three embedded modules (Display, Inputs and LED) of the
MicroEJ Platform (see MicroUl).

The Front Panel enhances the development environment by allowing User Interface applications to be designed
and tested on the computer rather than on the target device (which may not yet be built). The mock interacts with
the user’s computer in two ways:

« output: LEDs, graphical displays
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« input: buttons, joystick, touch, haptic sensors

Note: This chapter completes the notions described in Front Panel Mock chapter.

Module Dependencies

The Front Panel project requires the dependency ej. tool.frontpanel#widget . This library provides some wid-
gets which have been designed to be compatible with the graphical engine: the MicroUl natives are implemented
in these widgets and the widgets behavior matches with MicroUl implementation.

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org” xmlns:ej="https://developer.microej.com"_
—ej:version="2.0.0">
<info organisation="com.mycompany’

module="examplePanel” status="integration” revision="1.0.0"/>

<configurations defaultconfmapping="default->default;provided->provided”>
<conf name="default” visibility="public” description="Runtime dependencies to other artifacts"/>
<conf name="provided” visibility="public" description="Compile-time dependencies to APIs provided.
—by the platform”/>
</configurations>

<dependencies>
<dependency org="ej.tool.frontpanel” name="widget"” rev="1.0.0"/>
</dependencies>
</ivy-module>

Widget Display

By default, a display area is rectangular. Some displays can have another appearance (for instance: circular). The
front panel is able to simulate that using a filter (see Widget) . This filter defines the pixels inside and outside the
real display area. The filter image must have the same size than display rectangular area. A display pixel at a given
position will be not rendered if the pixel at the same position in mask is fully transparent.

Inputs Extensions

Theinput device widgets (button, joystick, touch etc.) require a listener to know how to react on input events (press,
release, move etc.). The aim of this listener is to generate an event compatible with MicroUl EventGenerator .
Thereby, a button press action can become a MicroUl Buttons press eventora Command event or anything else.

A MicroUl EventGenerator is known by its name. This name is fixed during the MicroUl static initialization (see
Static Initialization). To generate an event to a specific event generator, the widget has to use the event generator
name as identifier.

Afront panel widget can:

« Force the behavior of an input action: the associated MicroUl EventGenerator typeis hardcoded (Buttons
, Pointer etc.), the eventis hardcoded (forinstance: widget button press action may be hardcoded on event
generator Buttons and on the event pressed). Only the event generator name (identifier) should be editable
by the front panel extension project.

+ Propose a default behavior of an input action: contrary to first point, the front panel extension project is able
to change the default behavior. For instance a joystick can simulate a MicroUl Pointer.
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+ Do nothing: the widget requires the front panel extension project to give a listener. This listener will receive all
widgets action (press, release, etc.) and will have to react on it. The action should be converted on a MicroUl
EventGenerator event or might be dropped.

This choice of behavior is widget dependant. Please refer to the widget documentation to have more information
about the chosen behavior.

Heap Simulation
Graphical engine is using two dedicated heaps: for the images and the external fonts. Front panel simulates partly
simulates the heaps usage.

+ Images heap: Front Panel simulates the heap usage when the application is creating a BufferedImage ,
when it loads and decodes an image (PNG, BMP etc.), when it converts an image in MicroEJ format in another
MicroEJ format. However it does not simulate the external image copy in heap.

« External fonts heap: Front Panel does not simulate this heap.
Image Decoders

Front Panel uses its own internal image decoders when the internal image decoders related modules have been
selected (see Internal Decoders).

Front Panel can add some additional decoders like the C-side for the embedded platform (see External Decoders).
However, the exhaustive list of additional decoders is limited (Front Panel is using the Java AWT ImageIO API).
To add an additional decoder, specify the property hardwareImageDecoders.list in front panel configuration
properties file (see Installation) with one or several property values:

Table 22: Front Panel Additional Image Decoders

Type Property value
Graphics Interchange Format (GIF) gif

Joint Photographic Experts Group (JPEG) | jpeg|jpg
Portable Network Graphics (PNG) png

Windows bitmap (BMP) bmp

The decoders list is comma (,) separated. Example:

hardwareImageDecoders.list=jpg, bmp

Dependencies

« MicroUl module (see MicroUl).

« Display module (see Display): This module gives the characteristics of the graphical display that are useful
for configuring the Front Panel.

Installation

Front Panel is an additional module for MicroUl library. When the MicroUl module is installed, install this module
in order to be able to simulate Ul drawings on the Simulator. See Installation to install the module.

The properties file can additional properties:
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[132]

« hardwareImageDecoders.list [optional, defaultvalueis “” (empty)]: Defines the available list of additional
image decoders provided by the hardware. Use comma (‘) to specify several decoders among this list: bmp,
jpg, jpeg, gif, png. If empty or unspecified, no image decoder is added.

Use

Launch a MicroUl application on the Simulator to run the Front Panel.

4.10 Networking

4.10.1 Principle

MicroEJ provides some Foundation Libraries to initiate raw TCP/IP protocol-oriented communications and secure
this communication by using Secure Socket Layer (SSL) or Transport Layer Security (TLS) cryptographic protocols.

The diagram below shows a simplified view of the components involved in the provisioning of a Java network

interface.
MicroEJ Application

Net & SSL libraries

Platform Simulator

Drivers (Board Support Package)
HARDWARE Simulator

. Provided by user . Provided by platform

Fig. 42: Overview

Net and SSL low level parts connects the Net and SSL libraries to the user-supplied drivers code (coded in C).

The MicroEJ Simulator provides all features of Net and SSL libraries. This one takes part of the network settings
stored in the operating system on which the Simulator will be launched.

4.10.2 Network Core Engine
Principle

The Net module defines a low-level network framework for embedded devices. This module allows you to manage
connection (TCP)- or connectionless (UDP)-oriented protocols for client/server networking applications.
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Functional Description

The Net library includes two sub-protocols:

« UDP: a connectionless-oriented protocol that allows communication with the server or client side in a non-
reliable way. No handshake mechanisms, no guarantee on delivery, and no order in packet sending.

« TCP: a connection-oriented protocol that allows communication with the server or client side in a reliable
way. Handshakes mechanism used, bytes ordered, and error checking performed upon delivery.

Dependencies

o LLNET_CHANNEL_impl.h , LLNET_SOCKETCHANNEL _impl.h , LLNET_STREAMSOCKETCHANNEL _impl.h
,  LLNET_DATAGRAMSOCKETCHANNEL_impl.h , LLNET_DNS_impl.h , LLNET_NETWORKADDRESS_impl.h |,
LLNET_NETWORKINTERFACE_impl.h (see LLNET: Network).

Installation

Network is an additional module. In the platform configuration file, check NET to install this module. When
checked, the properties file net > net.properties isrequired during platform creation to configure the module.
This configuration step is used to customize the kind of TCP/IP native stack used and the Domain Name System
(DNS) implementation.

The properties file must / can contain the following properties:
+ stack [optional, default value is “custom”]: Defines the kind of TCP/IP interface used in the C project.

- custom: Select this configuration to make a “from scratch” implementation glue between the C Network
Core Engine and the C project TCP/IP interface.

- bsd: Select this configuration to use a BSD-like library helper to implement the glue between the C Net-
work Core Engine and the C project TCP/IP interface. This property requires that the C project provides
a TCP/IP native stack with a Berkeley Sockets APl and a select mechanism.

« dns [optional, default value is “native”]: Defines the kind of Domain Name System implementation used.

- native: Select this configuration to implement the glue between the C Network Core Engine DNS part
and the C project TCP/IP interface.

- sof't: Select this configuration if you want a software implementation of the DNS part. Only the IPs list
of the DNS server must be provided by the C Network Core Engine glue.

Use

The Net API Module must be added to the module.ivy of the MicroEJ Application project in order to allow access to
the Net library.

<dependency org="ej.api” name="net" rev="1.1.1"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.

4.10.3 SSL
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Principle

SSL (Secure Sockets Layer) library provides APIs to create and establish an encrypted connection between a server
and a client. It implements the standard SSL/TLS (Transport Layer Security) protocol that manages client or server
authentication and encrypted communication. Mutual authentication is supported since SSL APl 2.1.0.

Functional Description

The SSL/TLS process includes two sub-protocols :

« Handshake protocol : consists that a server presents its digital certificate to the client to authenticate the
server’s identity. The authentication process uses public-key encryption to validate the digital certificate
and confirm that a server is in fact the server it claims to be.

+ Record protocol: after the server authentication, the client and the server establish cipher settings to encrypt
the information they exchange. This provides data confidentiality and integrity.

Dependencies

+ Network core module (see Network Core Engine).

o LLNET_SSL_CONTEXT_impl.h and LLNET_SSL_SOCKET_impl.h implementations (see LLNET SSL: SSL).

Installation

SSLis an additional module. In the platform configuration file, check SSL to install the module.

Use

The SSL APl module must be added to the module.ivy of the MicroEJ Application project, in order to allow access
to the SSL library.

<dependency org="ej.api” name="ssl" rev="2.2.0"/>

4.11 File System

4.11.1 Principle

The FS module defines a low-level File System framework for embedded devices. It allows you to manage abstract
files and directories without worrying about the native underlying File System kind.

4.11.2 Functional Description

The MicroEJ Application manages File System elements using File/Directory abstraction. The FS implementation
made for each MicroEJ Platform is responsible for surfacing the native File System specific behavior.

4.11.3 Dependencies

o LLFS_impl.h and LLFS_File_impl.h implementations (see LLFS: File System).
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4.11.4 Installation

FSisan additional module. In the platform configuration file, check FS toinstallit. When checked, the properties
file fs > fs.properties are required during platform creation in order to configure the module.

The properties file must / can contain the following properties:
« fs [optional, default value is “Custom”]: Defines the kind of File System native stack used in the C project.
- Custom: select this configuration to make a specific File System portage.
- FatFS:select this configuration to use FatFS native File System-compliant settings.

« root.dir [optional, for a FatFS File System. Mandatory, for a Custom File System.]: Defines the native File
System root volume (default value is “/” for FatFS).

« user.dir [optional, for a FatFS File System. Mandatory, for a Custom File System.]: Defines the native File
System user directory (default value is “/usr” for FatFS).

« tmp.dir [optional, for a FatFS File System. Mandatory, for a Custom File System.]: Defines the native File
System temporary directory (default value is “/tmp” for FatFS).

« file.separator [optional, for a FatFS File System. Mandatory, for a Custom File System.]: Defines the native
File System file separator (default value is “/” for FatFS).

« path.separator [optional, for a FatFS File System. Mandatory, for a Custom File System.]: Defines the native
File System path separator (default value is “:” for FatFS).

4.11.5 Use

The FS APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow access to
the FS library.

<dependency org="ej.api"” name="fs" rev="2.0.6"/>

4,12 Hardware Abstraction Layer

4.12.1 Principle

The Hardware Abstraction Layer (HAL) library features API that target 10 devices, such as GPIOs, analog to/from
digital converters (ADC / DAC), etc. The API are very basic in order to be as similar as possible to the BSP drivers.

4.12.2 Functional Description

The MicroEJ Application configures and uses some physical GPIOs, using one unique identifier per GPIO. The HAL
implementation made for each MicroEJ Platform has the responsibility of verifying the veracity of the GPIO identi-
fier and the valid GPIO configuration.

Theoretically, a GPIO can be reconfigured at any time. For example a GPIO is configured in OUTPUT first, and later
in ADC entry. However the HAL implementation can forbid the MicroEJ Application from performing this kind of
operation.
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4.12.3 Identifier
Basic Rule

MicroEJ Application manipulates anonymous identifiers used to identify a specific GPIO (port and pin). The iden-
tifiers are fixed by the HAL implementation made for each MicroEJ Platform, and so this implementation is able to
make the link between the MicroEJ Application identifiers and the physical GPIOs.

« A port isavalue between © and n - 1,where n isthe available number of ports.

« A pin isavalue between 0 and m - 1,where m is the maximum number of pins per port.

Generic Rules

Most of time the basic implementation makes the link between the port / pin and the physical GPIO following these
rules:

» The port 0 targets all MCU pins. The first pin of the first MCU port has the ID 0, the second pin has 1 ; the
first pin of the next MCU port has the ID m (where m is the maximum number of pins per port), etc. Examples:

/*m =16 (16 pins max per MCU port) =*/
mcu_pin = application_pin & 0xf;
mcu_port = (application_pin >> 4) + 1;

/* m = 32 (32 pins max per MCU port) */
mcu_pin = application_pin & 0x1f;
mcu_port = (application_pin >> 5) + 1;

« The port from 1 to n (where n is the available number of MCU ports) targets the MCU ports. The first MCU
port hastheID 1,the second hastheID 2, and the last port hastheID n.

« The pinfrom @ to m - 1 (where m is the maximum number of pins per port) targets the port pins. The first
port pin has the ID 0, the second hastheID 1, and the last pinhasthelD m - 1.

The implementation can also normalize virtual and physical board connectors. A physical connector is a connector
available on the board, and which groups several GPIOs. The physical connector is usually called JPn or CNn,
where n is the connector ID. A virtual connector represents one or several physical connectors, and has a name;
for example ARDUINO_DIGITAL .

Using a unique ID to target a virtual connector allows you to make an abstraction between the MicroEJ Application
and the HAL implementation. For exmaple, on a board A, the pin D5 of ARDUINO_DIGITAL port will be connected
to the MCU portA, pin12 (GPIOID= 1, 12). And on board B, it will be connected to the MCU port5, pin@ (GPIO
ID= 5, 0). From the MicroEJ Application point of view, this GPIO hasthe ID 30, 5.

Standard virtual connector IDs are:

ARDUINO_DIGITAL = 30;
ARDUINO_ANALOG = 31;

Finally, the available physical connectors can have a number from 64 to 64 + i - 1,where i isthe available
number of connectors on the board. This allows the application to easily target a GPIO that is available on a physical
connector, without knowing the corresponding MCU port and pin.

JP3 = 64;
IP6 = 65;
JP11 = 66;
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4.12.4 Configuration

A GPIO can be configured in any of five modes:
« Digital input: The MicroEJ Application can read the GPIO state (for example a button state).

« Digitalinput pull-up: The MicroEJ Application can read the GPIO state (for example a button state); the default
GPIO state is driven by a pull-up resistor.

Digital output: The MicroEJ Application can set the GPIO state (for example to drive an LED).

Analog input: The MicroEJ Application can convert some incoming analog data into digital data (ADC). The
returned values are values between @ and n - 1,where n isthe ADC precision.

Analog output: The MicroEJ Application can convert some outgoing digital data into analog data (DAC). The
digital value is a percentage (0 to 100%) of the duty cycle generated on selected GPIO.

4.12.5 Dependencies

o LLHAL_impl.h implementation (see LLHAL: Hardware Abstraction Layer).

4.12.6 Installation

HAL is an additional module. In the platform configuration file, check HAL to install the module.

4.12.7 Use

The HAL API Module must be added to the module.ivy of the MicroEJ Application project in order to allow access to
the ECOM library.

<dependency org="ej.api"” name="hal" rev="1.0.4"/>

4.13 Device Information

4.13.1 Principle

The Device library provides access to the device information. This includes the architecture name and a unique
identifier of the device for this architecture.

4.13.2 Dependencies

o LLDEVICE_impl.h implementation (see LLDEVICE: Device Information).

4.13.3 Installation

Device Information is an additional module. In the platform configuration file, check Device Information toinstall
it. When checked, the property file device > device.properties may be defined during platform creation to
customize the module.

The properties file must / can contain the following properties:
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« architecture [optional, default value is “Virtual Device”]: Defines the value returned by the ej.util.
Device.getArchitecture() method on the Simulator.

« id.length [optional]: Defines the size of the ID returned by the ej.util.Device.getId() method on the
Simulator.

4.13.4 Use

The Device API Module must be added to the module.ivy of the MicroEJ Application project in order to allow access
to the Device library.

<dependency org="ej.api” name="device" rev="1.0.2"/>

4.14 Simulation

4.14.1 Principle

The MicroEJ Platform provides an accurate MicroEJ Simulator that runs on workstations. Applications execute in
an almost identical manner on both the workstation and on target devices. The MicroEJ Simulator features 10
simulation, JDWP debug coupled with Eclipse, accurate Java heap dump, and an accurate Java scheduling policy
(the same as the embedded one).!

4.14.2 Functional Description

In order to simulate external stimuli that come from the native world (that is, “the C world”), the MicroEJ Simulator
has a Hardware In the Loop interface, HIL, which performs the simulation of Java-to-C calls. All Java-to-C calls are
rerouted to an HIL engine. Indeed HIL is a replacement for the [SN/] interface.

1 Only the execution speed is not accurate. The Simulator speed can be set to match the average MicroEJ Platform speed in order to adapt
the Simulator speed to the desktop speed.
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YOUR APPLICATION

ADD-ON LIBRARIES
FOUNDATION LIBRARIES

AALLLILL

MEJ 3) Simulator

HIL API (Socket)
Mock 1 Mock 2 Mock N

Linux [ Windows [ MacOS

WORKSTATION

Fig. 43: The HIL Connects the MicroEJ Simulator to the Workstation.

The “simulated C world” is made of Mocks that simulate native code (such as drivers and any other kind of C li-
braries), so that the MicroEJ Application can behave the same as the device using the MicroEJ Platform.

The MicroEJ Simulator and the HIL are two processes that run in parallel: the communication between them is
through a socket connection. Mocks run inside the process that runs the HIL engine.

).
Simulator Runtime T HIL Engine
MicroEJ Applications Sockat based
HIL API
(Windows / Linux process) (Windows / Linux process)

Fig. 44: A MicroEJ Simulator connected to its HIL Engine via a socket.

4.14.3 Dependencies

No dependency.

4.14.4 Installation

The Simulator is a built-in feature of MicroEJ Platform architecture.

4.14.5 Use

To run an application in the Simulator, create a MicroEJ launch configuration by right-clicking on the main class of
the application, and selecting RunAs > MicroEJ Application .
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This will create a launch configuration configured for the Simulator, and will run it.

4.14.6 Mock

Principle

The HIL engine is a Java standard-based engine that runs Mocks. A Mock is a jar file containing some Java classes
that simulate natives for the Simulator. Mocks allow applications to be run unchanged in the Simulator while still
(apparently) interacting with native code.

Functional Description

As with [SN/], HIL is responsible for finding the method to execute as a replacement for the native Java method
that the MicroEJ Simulator tries to run. Following the [SNI] philosophy, the matching algorithm uses a naming
convention. When a native method is called in the MicroEJ Simulator, it requests that the HIL engine execute it.
The corresponding Mock executes the method and provides the result back to the MicroEJ Simulator.

>
SimJPF HIL Engine
{
Socket based
foo() to execute
Mock
Java code executing
execution foo()
method

l Result from foof)

Fig. 45: The MicroEJ Simulator Executes a Native Java Method foo() .

Example

package example;
import java.io.IOException;

/**

* Abstract class providing a native method to access sensor value.
* This method will be executed out of virtual machine.

*/

public abstract class Sensor {

public static final int ERROR = -1;

public int getValue() throws IOException {
int sensorID = getSensorID();
int value = getSensorValue(sensorlID);
if (value == ERROR) {
(continues on next page)
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(continued from previous page)

throw new IOException("Unsupported sensor”);

b

return value;

}
protected abstract int getSensorID();

public static native int getSensorValue(int sensorID);

}

class Potentiometer extends Sensor {

protected int getSensorID() {
return Constants.POTENTIOMETER_ID; // POTENTIOMETER_ID is a static final

Toimplement the native method getSensorvValue(int sensorID),you need to create a MicroEJ standard project
containing the same Sensor class on the same example package. To do so, open the Eclipse menu File > New
> Project... > Java > Java Project in order to create a MicroEJ standard project.

The following code is the required Sensor class of the created Mock project:

package example;
import java.util.Random;

/**

* Java standard class included in a Mock jar file.

* It implements the native method using a Java method.
*/

public class Sensor {

/**

* Constants

*/

private static final int SENSOR_ERROR = -1;
private static final int POTENTIOMETER_ID = 3;

private static final Random RANDOM = new Random();

/*%

* Implementation of native method "getSensorValue()"

*

* @param sensorID Sensor ID

* @return Simulated sensor value

*/

public static int getSensorValue(int sensorID) {

if( sensorID == POTENTIOMETER_ID ) {

// For the simulation, Mock returns a random value
return RANDOM.nextInt();

}
return SENSOR_ERROR;
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Mocks Design Support

Interface

The MicroEJ Simulator interface is defined by static methods on the Java class com.is2t.hil.NativeInterface.

Array Type Arguments

Both [SNI] and HIL allow arguments that are arrays of base types. By default the contents of an array are NOT sent
over to the Mock. An “empty copy” is sent by the HIL engine, and the contents of the array must be explicitly fetched
by the Mock. The array within the Mock can be modified using a regular assignment. Then to apply these changes
in the MicroEJ Simulator, the modifications must be flushed back. There are two methods provided to support
fetch and flush between the MicroEJ Simulator and the HIL:

+ refreshContent : initializes the array argument from the contents of its MicroEJ Simulator counterpart.

» flushContent : propagates (to the MicroEJ Simulator) the contents of the array that is used within the HIL
engine.

SimJPF — HIL Engine

Nativelnterface.refreshContent()

ot [T ]

Nativelnterface.flushContent()

Fig. 46: An Array and Its Counterpart in the HIL Engine.

Below is a typical usage.

public static void foo(char[] chars, int offset, int length){
NativeInterface ni = HIL.getInstance();
//inside the Mock
ni.refreshContent(chars, offset, length);
chars[offset] = 'A';
ni.flushContent(chars, offset, 1);

Blocking Native Methods

Some native methods block until an event has arrived [SNI]. Such behavior is implemented in native using the
following three functions:

o int32_t SNI_suspendCurrentJavaThread(int64_t timeout)
e int32_t SNI_getCurrentJavaThreadID(void)
e int32_t SNI_resumeJavaThread(int32_t id)

This behavior is implemented in a Mock using the following methods on a lock object:
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o Object.wait(long timeout) : Causesthe current thread to wait until another thread invokes the notify()
method or the notifyAll() method for this object.

« Object.notifyAll() : Wakes up all the threads that are waiting on this object’s monitor.

public static byte[] data = new byte[BUFFER_SIZE];
public static int datalLength = 0;
private static Object lock = new Object();

//Mock native method
public static void waitForData(){
//inside the Mock
//wait until the data is received
synchronized (lock) {
while(datalLength == 0) {
try {
lock.wait(); // equivalent to lock.wait(@)
} catch (InterruptedException e) {
Thread.currentThread().interrupt();
// Use the error code specific to your library
throw new NativeException(-1, "InterruptedException”, e);

}

//Mock data reader thread
public static void notifyDataReception() {
synchronized (lock) {
datalLength = readFromInputStream(data);
lock.notifyAll();

Resource Management

In Java, every class can play the role of a small read-only file system root: The stored files are called “Java resources”
and are accessible using a path as a String.

The MicroEJ Simulator interface allows the retrieval of any resource from the original Java world, using the
getResourceContent method.

public static void bar(byte[] path, int offset, int length) {
NativelInterface ni = HIL.getInstance();
ni.refreshContent(path, offset, length);
String pathStr = new String(path, offset, length);
byte[] data = ni.getResourceContent(pathStr);

Synchronous Terminations

To terminate the whole simulation (MicroEJ Simulator and HIL), use the stop() method.
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public static void windowClosed() {
HIL.getInstance().stop();
3

Dependencies

The HIL Engine APl is automatically provided by the microej-mock project skeleton.

Installation
First create a new module project using the microej-mock skeleton.

v 'l_'—,"f- myrmock
(% src/main/java
-'l*fs sro/main/resources
B\ JRE System Library [JavaSE-1.2]

w i) Referenced Libraries

[ content
v [= lib
g&| HILEngine jar
= SrC

[w] CHANGELOG.md

Once implemented, right-click on the repository project and select Build Module.
Once the module is built, the mock can be installed in a Platform in one of the two ways:

« byaddingthe mock module as a regular Platform module dependency (if your Platform configuration project
contains a module.ivy file),

+ or by manually copying the JAR file [mock_project]\target~\rip\mocks\[mock_name].jar to the Plat-
form configuration mock dropins folder dropins/mocks/dropins/ .

Use

Onceinstalled, a Mock is used automatically by the Simulator when the MicroEJ Application calls a native method
which is implemented into the Mock.

4.14.7 Shielded Plug Mock

General Architecture

The Shielded Plug Mock simulates a Shielded Plug /SP] on desktop computer. This mock can be accessed from the
MicroEJ Simulator, the hardware platform or a Java J2SE application.
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Fig. 47: Shielded Plug Mock General Architecture

Configuration
The mock socket port can be customized for J2SE clients, even though several Shielded Plug mocks with the same
socket port cannot run at the same time. The default socket port is 10082.
The Shielded Plug mock is a standard MicroEJ Application. It can be configured using Java properties:
e sp.connection.address

« sp.connection.port

4.14.8 Front Panel Mock
Principle

A major strength of the MicroEJ environment is that it allows applications to be developed and tested in a Simulator
rather than on the target device, which might not yet be built. To make this possible for devices that controls
operated by the user, the Simulator must connect to a “mock” of the control panel (the “Front Panel”) of the device.
The Front Panel generates a graphical representation of the device, and is displayed in a window on the user’s
development machine when the application is executed in the Simulator.

The Front Panel has been designed to be an implementation of MicroUl library (see Simulation). However it can be
use to show a hardware device, blink a LED, interact with user without using MicroUl library.

Functional Description

1. Creates a new Front Panel project.
2. Creates an image of the required Front Panel. This could be a photograph or a drawing.

3. Defines the contents and layout of the Front Panel by editing an XML file (called an fp file). Full details about
the structure and contents of fp files can be found in chapter Front Panel.
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Creates images to animate the operation of the controls (for example button down image).
Creates Widgets that make the link between the application and the user interactions.

Previews the Front Panel to check the layout of controls and the events they create, etc.

N o s

Exports the Front Panel project into a MicroEJ Platform project.

The Front Panel Project
Creating a Front Panel Project
A Front Panel project is created using the New Front Panel Project wizard. Select:

New > Project... > MicroEJ > Front Panel Project

The wizard will appear:

(™ Create a new Front Panel project L =] 2%
Create a new Front Panel project
Project name must be specified
Project name;
Use default location
Browse...
@jl Finish Cancel

Fig. 48: New Front Panel Project Wizard

Enter the name for the new project.
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Project Contents

v h_—f- examplePanel
B\ JRE System Library [jdk1.8.0_141]
(& zrc/main/java

Bl Module Dependencies module. vy [*]
= lib
= srC

|X| .classpath
|X| .project
byt module.ivy

Fig. 49: Project Contents

A Front Panel project has the following structure and contents:

The src/main/java folder is provided for the definition of Widgets . Itis initially empty. The creation of
these classes will be explained later.

The src/main/resources folder holds thefile or files that define the contents and layout of the Front Panel,
witha . fp extension (the fp file or files), plus images used to create the Front Panel. A newly created project
will have a single fp file with the same name as the project, as shown above. The contents of fp files are
detailed later in this document.

The JRE System Library isreferenced, because a Front Panel project needs to support the writing of Java
forthe Listeners (and DisplayExtensions).

The Modules Dependencies contains the libraries for the Front Panel simulation, the widgets it supports
and the types needed to implement Listeners (and DisplayExtensions).

The 1ib contains a local copy of Modules Dependencies.

Module Dependencies

The Front Panel project is a regular MicroEJ Module project. Its module.ivy file should look like this example:

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org"” xmlns:ej="https://developer.microej.com”_

—ej:version="2.0.0">
<info organisation="com.mycompany"” module="examplePanel” status="integration” revision="1.0.0"/>

<configurations defaultconfmapping="default->default;provided->provided”>

s by

<conf name="default"” visibility="public"” description="Runtime dependencies to other artifacts”/>
<conf name="provided” visibility="public” description="Compile-time dependencies to APIs provided.
the Platform”/>

</configurations>

<dependencies>

<dependency org="ej.tool.frontpanel” name="widget"” rev="1.0.0"/>
(continues on next page)
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(continued from previous page)

</dependencies>
</ivy-module>

Thedependency ej. tool.frontpanel#widget isonly useful for MicroUl application (see Simulation). The depen-
dencies block must be manually updated to depend only on the Front Panel framework. This framework contains
the Front Panel core classes:

<dependencies>
<dependency org="ej.tool.frontpanel” name="framework" rev="1.0.0"/>
</dependencies>

The Front Panel framework does not provide any widgets. Widgets have to be added to simulate user interactions.

Front Panel File

File Content

The Front Panel engine takes an XML file (the . fp file) asinput. It describes the panel using widgets: they simulate
the drivers, sensors and actuators of the real device. The Front Panel engine generates the graphical representa-
tion of the real device, and is displayed in a window on the user’s development machine when the application is
executed in the Simulator.

The following example file describes a simple board with one LED:

<?xml version="1.0"7?>

<frontpanel
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"”
xmlns="https://developer.microej.com”
xsi:schemaLocation="https://developer.microej.com .widget.xsd">

<device name="MyBoard" skin="myboard.png">
<ej.fp.widget.LED x="131" y="127" skin="box_led.png"/>
</device>
</frontpanel>

The device skin mustrefertoa png fileinthe src/main/resources folder. This image is used to render the
background of the Front Panel. The widgets are drawn on top of this background.

The device contains the elements that define the widgets that make up the Front Panel. The name of the widget
element defines the type of widget. The set of valid types is determined by the Front Panel Designer. Every widget
element definesa label , which must be unique for widgets of this type (optional or not), and the x and y coordi-
nates of the position of the widget within the Front Panel (0,0 is top left). There may be other attributes depending
on the type of the widget.

The file and tags specifications are available in chapter Front Panel.

Note: The .fp file grammar has changed since the Ul Pack version 12.0.0 (Front Panel core has been moved
to MicroEJ Architecture 7.11.0). A quick migration guide is available here: open Platform configuration file .
Platform, goto Content tab, click on module Front Panel. The migration guide is available in Details box.
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Editing Front Panel Files

Toedita . fp file, openit using the Eclipse XML editor (right-click on the . fp file, select Open With > XML Editor).
This editor features syntax highlighting and checking, and content-assist based on the schema (XSD file) referenced
in the fp file. This schema is a hidden file within the project’s definitions folder. An incremental builder checks the
contents of the fp file each time it is saved and highlights problems in the Eclipse Problems view, and with markers
on the fp file itself.

Apreview of the Front Panel can be obtained by opening the Front Panel Preview (Window > Show View > Other. ..
> MicroEJ > Front Panel Preview).

The preview is updated each time the . fp file is saved.

A typical working layout is shown below.

1S} examplePanel/sre/main/resources/examplePanel fp - MicraE)® SDK - [m] X

File Edit Source Refactor Mavigate Search Project Run Design Window Help

FmRd B R-DiB-O- B EGES I G DG D [Owick Access] || 5 | &
{2 Pac.. 32|} Wp.. = O % examplePanel.fp 52 = B [E examplePanelfp 2 =8
BE < 1 <?ml version="1.8"?>

<frontpanel

xmlns :xsi="http: /. w3.0rg/2001/ XML Schema-instance” Exa mp|e Device
xmlns="https: //developer.microe]. com”
xsi:schemalocation="https://developer.microej.com .widget.xsd">

<device name="example" skin="example-device.png">
<ej.fp.widget.Button
label="g"
x="53
y="87"
skin="square-normal.png"
pushedskin="square-pressed. png"
/>
<ej.fp.widget.Button

v [22 examplePanel
B JRE System Library [jdk1.

[ sre/main/java
~ [# src/main/resources
@ circle-normal.png
@ circle-pressed.png
@ example-devicepng
x| examplePanelfp

@ square-normal.png
@ square-pressed.png
=\ Module Dependencies m

9
13
15

9
23

& lib label="1"
= sre
o module.vy
skin="circle-normal .png"
pushedskin="circle-pressed. png”
</device>
</frontpanel>
Outputs
Design | Source
& Console 2 ME #tB8-80-=0
FrontPanclPreviewCansole
< >

examplePanel fp - examplePanel/src/main/resources &

Fig. 50: Working Layout Example

Within the XML editor, content-assist is obtained by pressing CTRL + SPACE keys. The editorwilllist all the elements
valid at the cursor position, and insert a template for the selected element.

Multiple Front Panel Files

A Front Panel project can contain multiple .fp files. All fp files are compiled when exporting the Front Panel
project in a Platform (or during Platform build). It is useful to have two or more representation of a board (size,
devices layout, display size etc.). By default the Simulator will chooses the default . fp file declared by the Platform,
or will defaults to a random one. To choose a specific one, set the Application Option frontpanel.file to a Front
Panel simple file name included in the Platform (e.g. mycompany.fp).

Widget
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Description

A widget is a subclass of Front Panel framework class ej.fp.Widget . The library ej.tool.frontpanel#widget
provides a set of widgets which are graphical engine compatible (see Simulation). To create a new widget (or a
subclass of an existing widget), have a look on available widgets in this library.

A widget is recognized by the fp file as soon as its class contains a @WidgetDescription annotation. The anno-
tation contains several @WidgetAttribute . An attribute has got a name and tells if it is an optional attribute of
widget (by default an attribute is mandatory).

This is the description of the widget LED:

@WidgetDescription(attributes = { @WidgetAttribute(name = "x"),
@WidgetAttribute(name = "y"), @WidgetAttribute(name = "skin")3})

As soon as a widget is created (with its description) in Front Panel project, the fp file can use it. Close and reopen
fp file after creating a new widget. In device group, press CTRL + SPACE keys to visualize the available widgets:
the new widget can be added.

<ej.fp.widget.LED x="170" y="753" skin="box_led.png" />
Each attribute requires the set methods in the widget source code. For instance, the widget LED (or its hierarchy)
contains the following methods for sure:

o setX(int),

« setY(int),

o setskin(Image).

The set method parameter’s type fixes the expected value in fp file. If the attribute cannot match the expected
type, an error is throw when editing fp file. Widget master class already provides a set of standard attributes:

« setFilter(Image) : apply a filtering image which allows to crop input area (/nput Device Filters).

« setWidth(int) and setHeight(int) : limits the widget size.
+ setlLabel(String) : specifies an identifier to the widget.
« setOverlay(boolean) : draws widget skin with transparency or not.
« setSkin(Image) : specifies the widget skin.
« setX(int) and setY(int) : specifies widget position.
Notes:
« Widget class does not specify if an attribute is optional or not. It it the responsability to the subclass.

« The label is often used as identifier. It also allows to retrieve a widget calling Device.getDevice().
getWidget(Class<T>, String) . Some widgets are using this identifier as an integer label. It is the re-
sponsability to the widget to fix the signification of the label.

« The widget size is often fixed by the its skin (which is an image). See Widget.finalizeConfiguration()
: it sets the widget size according the skin if the skin has been set; even if methods setWidth() and
setHeight() have been called before.

Runtime

The Front Panel engine parsing the fp file at application runtime. The widget methods are called in two times.
First, engine creates widget by widget:
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1. widget’s constructor: Widget should initialize its own fields which not depend on widget attributes (not val-
orized yet).

2. setXxX() : Widget should check if given attribute value matches the expected behavior (the type has been
already checked by caller). For instance if a width is not negative. On error, implementation can throw an
IllegalArgumentException . These checks must not depend on other attributes because they may have
not already valorized.

3. finalizeConfiguration() : Widget should check the coherence between all attributes: they are now val-
orized.

During these three calls, all widgets are not created yet. And so, by definition, the main device (which is a
widget) not more. By consequence, the implementation must not try to get the instance of device by calling
Device.getDevice() . Furthermore, a widget cannot try to get another widget by calling Device.getDevice().
getWidget(s) . Ifawidget depend on another widget for any reason, the last checks can be performedin start()
method. This method is called when all widgets and main device are created. Call to Device.getDevice() is
allowed.

The method showYourself () isonly useful when visualizing the fp file duringits editing (use Eclipse view Front
Panel Preview). This method is called when clicking on button Outputs.

Example

The following code is a simple widget LED. MicroEJ Application can interact with it using native methods on() and
of f() ofclass ej.fp.widget.LED:

package ej.fp.widget;

import ej.fp.Device;

import ej.fp.Image;

import ej.fp.Widget;

import ej.fp.Widget.WidgetAttribute;
import ej.fp.Widget.WidgetDescription;

/**

* Widget LED declaration. This class must have the same package than

* <code>LED</code> in MicroEJ application. This is required by the simulator to

* retrieve the implementation of native methods.

*/

@WidgetDescription(attributes = { @WidgetAttribute(name = "x"), @WidgetAttribute(name = "y"),
@WidgetAttribute(name = "skin") })

public class LED extends Widget {

boolean on; // false init

/**
* Called by the plugin when clicking on <code>Outputs</code> button from Front
* Panel Preview.
*/
@Override
public void showYourself(boolean appearSwitchedOn) {
update (appearSwitchedOn);
3

VEXS
* Called by framework to render the LED.
*/
(continues on next page)
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(continued from previous page)

@Override

public Image getCurrentSkin() {
// when LED is off, hide its skin returning null
return on ? getSkin() : null;

3

/**

* MicroEJ application native

*/

public static void on() {
update(true);

3

/*%

* MicroEJ application native

*/

public static void off() {
update(false);

3

private static void update(boolean on) {

// retrieve the LED (there is only one LED on device)
LED led = Device.getDevice().getWidget(LED.class);

// update its state
led.on = on;

// ask to repaint it
led.repaint();

Empty Widget

By definition a widget may not contain an attribute. This kind of widget is useful to perform something at Front
Panel startup, for instance to start a thread to pick up data somewhere.

The widget description is @WidgetDescription(attributes = { }).In start() method, a custom behavior
can be performed. In fp file, the widget declaration is <com.mycompany.Init/> (where Init is an example of
widget name).

Input Device Filters

The widgets which simulate the input devices use images (or “skins”) to show their current states (pressed and
released). The user can change the state of the widget by clicking anywhere on the skin: it is the active area. This
active area is, by default, rectangular.

These skins can be associated with an additional image called a filter . Thisimage defines the widget’s active
area. Itis useful when the widget is not rectangular.
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@

skin area

active area

Fig. 51: Active Area

The filter image must have the same size as the skin image. The active area is delimited by the fully opaque pixels.
Every pixel in the filter image which is not fully opaque is considered not part of the active area.

Installation

In the platform configuration file, check Front Panel to install the Front Panel module. When checked, the prop-
erties file frontpanel > frontpanel.properties isrequired during platform creation to configure the module.
This configuration step is used to identify and configure the Front Panel.

The properties file must / can contain the following properties:

« project.name [mandatory]: Defines the name of the Front Panel project (same workspace as the platform
configuration project). If the project name does not exist, a new project will be created.

(34

« fpFile.name [optional, default value is “” (empty)]: Defines the Front Panel file (*.fp) the application has to
use by default when several fp files are available in project.

To test a Front Panel project without rebuilding the platform or without exporting manually the project, add the
Application Option ej.fp.project to a Front Panel Project absolute path (e.g. c:\\mycompany\\myfrontpanel.
fp ). The Simulator will use the specified Front Panel project prior to the one included by the Platform.

Note: This feature works only if the Platform has been built with the Front Panel module enabled.

Warning: This feature is useful to test locally some changes in Front Panel project. The Platform does not
contain the changes until a new Platform is built.

Use

Launch an application on the Simulator to run the Front Panel.

4.14.9 Bluetooth LE Mock

Overview

TorunaMicroEJ Application that uses the Bluetooth LE Foundation Library (ej.api.bluetooth) on MicroEJ Simulator,
a Bluetooth LE mock controller must be set up first:
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BLE Mock

~ommands , results, events)

§ - * BLE

T

Flash + ICIES

. . Bluetooth

environment

Simulator

The Bluetooth LE mock controller is a hardware mock of the Bluetooth LE library. It means the Simulator uses a
real Bluetooth LE device to scan other devices, advertise, discover services, connect, pair, etc... This designenables
testing of apps in a real-world environment.

The Bluetooth LE mock controller implementation is provided for the ESP32-DevKitC board reference. Other im-
plementations or sources can be provided on request.

Requirements

« AESP32-DevKitC board.
« ABluetooth LE mock controller firmware.

+ Atool to flash the firmware like https://www.espressif.com/en/tools-type/flash-download-tools.

Usage

To simulate a Bluetooth LE application, follow these three steps:
+ Set up the controller
+ Set up the network configuration
+ Run the application on the Simulator

If your are facing any issues, check the Troubleshooting section.

Controller Setup

To set up the controller, follow these steps:
+ Plug-in the ESP32-DevKitC board to your computer,
« Find the associated COM port,
+ In the flash tool:

select the chip “ESP32 DownloadTool”

browse for the firmware file

set the offset to 0x000000

set the COM port
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- set the baudrate to 921 600
- start the flash download

With the flash download tool from Espressif, you should end with something similar to this :

W7 ESP32 DOWNLOAD TOOL V3.6.8 - O X

| SPIDownload = HSPIDownload | RFConfig | GPIOConfig | MultiDownload |

~
] B Dcumentsfash.dowrioadt toos 3. \combinetargetin . = [ox00000]
0 Lo |
0 e [
0 = —
0 e ]
0 =
0 o]
0 e 1.
SpiFlashConfig
NOT USE
L CombineBin [[] SpiAutoSet
A0MH SMbit i
OMHz E . [ DoNotChgBin
26.7MH it
: NOT USE | LOCK SETTINGS
20MHz 32Mbit
Qo .
80MHz 64Mbit DETECTED INFO
QouT . flash vendor:
128Mbit 20h : N/A
DO flash deviD:
DOUT 4016h
FASTRD QUAD:32Mbit
crystal:
40 Mhz

Download Panel 1

FINISH AP: 30AEA4DDAS41 STA: 30AEA4DDAS40
BT: 30AEA4DDAS42 ETHERNET: 30AEA4DDAS43

SERK

com: [lcomia vl

BAUD: Igmﬁm I

START ‘ STOP ‘ ERASE ‘

<]

Fig. 52: Bluetooth LE Flash Download Tool Configuration

Network Setup

To configure the network:
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1. Connect your computer to the Wi-Fi network “BLE-Mock-Controller-[hexa device id]” mounted by the con-
troller.

2. Open a browser and connect to http://192.168.4.1/ to access the Wi-Fi setup interface :

Please select a Wi-Fi network Scan (&

MicroEJ_MOBL
MicroE)_Guest
MicroE)_TestWAN

MicroEJ_NTE

.”,@.DI

3. Select the desired network and provide the required information if asked. If an error occurs during the con-
nection, retry this step.

4. In case the device is successfully connected to the desired network, the web page should looks like this:
Connecting to Wi-Fi

network. Please check your
device...

Additionally, the serial output of the device shows connection status.

5. Connectyour computer backto this network: your computer and the controller must be in the same network.

Simulation

Itis possible to run the Simulator as many times as necessary using the same setup. Also, rebooting the controller
will automatically set up the network with the saved configuration.

The IP address of the controller is available in the logs :
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COME 115200 bps, 8M1, no handshake
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Hioka:l=3

119822) wifi

120392) wifi

I
I
I
I
I
I
(1204712 wifi
I

( )
( )
( )
( )
(120372) wifi
(120382) wifi:
( )
( )
( )

Hoka:F=7 5138 182168 4.2

Hoka:F=45133/132.168.4.2
Hoka:F=7 5133 /192.168.4.2

Hoka:F=4 5140 /192 166.4.2
Hoka:l=5 514019216842 202 Accepted fjoin
Hoka:F=7 5140 /192 168.4.2

Stop 5w g

Imac stap hw txg

[ (11737 2) wifi: station: B0:eb:71:25:96:71 leave, AlD =1
II7372) witi 1 0,001 1, ap:1 1, sta:2hbh 255, prof

[EZF32 Wit Driver] M ARMNIMNG] Event 16 received, not treated
I (117 402) wifi: flush g
[ (117 402) wifi:
117402) wifi:
117402) weii:

mode ; sta (30aeaddd:91:10)

pm start, type: 1

cnid1 00001 0, api2hh 265, stac11 0, profl

state: init -> auth (b0)

state: auth -» assoc (0)

state: assoc-» run (10)

cconnected with MicroEJ_TestWak, channel 11
12041 2) weii:

[VBI[0:32ml (121772) event: staip: 192.166.80.33, mask: 255.266.255.0, gw: 192 168.80.1[1B][0m
e].bluetaoth. bluetoothwificontroller INFO: Succestully jained the wifi netwark,

ej.hluetooth. bluetoothwificontroller INFO: Saving credentials...
ej.blustooth.bluetoothwificontraller INFIO: Credentials saw

=1N
ej blustooth bluetoothwificontroller INFO: Starting server a§132 168.80.33 bn port 80

remotecommandserser INFO: Senser listening an port 80

Before running your Bluetooth LE application on the Simulator, in the Run configuration panel, set the simulation
mode to “Controller (over net)” and configure the Bluetooth LE mock settings.
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Fig. 53: Bluetooth LE Mock Configuration
Launchingthe application on the Simulator will restore the controller toits initial state (the BLE adapteris disabled).
Troubleshooting
Network Setup Errors
I can’t find the “BLE-Mock-Controller-[hexa device id]” access point

The signal of this Wi-Fi access point may be weaker than the surrounding access points. Try to reduce the distance
between the controller and your computer; and rescan. If it’s not possible, try using a smartphone instead (only a
browser will be required to set up the network configuration).

I want to override the network configuration

If the Wi-Fi credentials are not valid anymore, the controller restarts the network setup phase. Yet, in case the
credentials are valid but you want to change them, erase the flash and reflash the firmware.

Simulation Errors
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Error during the simulation : mock could not connect to controller

This error means the mock process (Simulator) could not initialize the connection with the controller. Please check
that the device is connected to the network (see logs in the serial port output) and that your computer is in the
same network.

4.15 Limitations

Table 23: Platform Limitations

ltem EVAL DEV
Number of Classes 4000 4000
Number of methods per class 3000 65000
Total number of methods 4000 unlimited
Class / Interface hierarchy depth 127 max 127 max
Number of monitors' per thread 8 max 8 max
Numbers of exception handlers per method 63 max 63 max
Number of fields Base type 65000 65000
References 65000 65000
Number of statics boolean + byte limited 65000
short + char limited 65000
int + float limited 65000
long + double limited 65000
References limited 65000
Method size 65000 65000
Time limit 60 minutes | unlimited
Number of threads 62 62

4,16 Appendices

4.16.1 Appendix A: Low Level API

This chapter describes succinctly the available Low Level API, module by module. The exhaustive documentation
of each LLAPI function is available in the LLAPI header files themselves. The required header files to implement are
automatically copied in the folder include of MicroEJ Platform at platform build time.

LLMJVM: MicroEJ Core Engine
Naming Convention

The Low Level MicroEJ Core Engine API, the LLMIVM API, relies on functions that need to be implemented. The
naming convention for such functions is that their names match the LLMJVM_IMPL_x* pattern.

Header Files

Three C header files are provided:

! No more than n different monitors can be held by one thread at any time.
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« LLMJVM_impl.h
Defines the set of functions that the BSP must implement to launch and schedule the virtual machine
o LLMJVM.h

Defines the set of functions provided by virtual machine that can be called by the BSP when using the virtual
machine

« LLBSP_impl.h

Defines the set of extra functions that the BSP must implement.

LLKERNEL: Multi-Sandbox

Naming Convention

The Low Level Kernel API, the LLKERNEL API, relies on functions that need to be implemented. The naming con-
vention for such functions is that their names match the LLKERNEL_IMPL_* pattern.

Header Files

One C headerfile is provided:
o LLKERNEL_impl.h

Defines the set of functions that the BSP must implement to manage memory allocation of dynamically in-
stalled applications.

LLSP: Shielded Plug

Naming Convention

The Low Level Shielded Plug API, the LLSP API, relies on functions that need to be implemented. The naming
convention for such functions is that their names match the LLSP_IMPL_x* pattern.

Header Files

The implementation of the [SP] for the MicroEJ Platform assumes some support from the underlying RTOS. It is
mainly related to provide some synchronization when reading / writing into Shielded Plug blocks.

o LLSP_IMPL_syncWriteBlockEnter and LLSP_IMPL_syncWriteBlockExit are used as a semaphore by
RTOS tasks. When a task wants to write to a block, it “locks” this block until it has finished to write in it.

» LLSP_IMPL_syncReadBlockEnter and LLSP_IMPL_syncReadBlockExit are used as a semaphore by RTOS
tasks. When a task wants to read a block, it “locks” this block until it is ready to release it.

The [SP] specification provides a mechanism to force a task to wait until new data has been provided to a block.
The implementation relies on functions LLSP_IMPL_wait and LLSP_IMPL_wakeup to block the current task and
to reschedule it.
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LLEXT_RES: External Resources Loader

Principle

This LLAPI allows to use the External Resource Loader. When installed, the External Resource Loader is notified
when the MicroEJ Core Engine is not able to find a resource (an image, a file etc.) in the resources area linked with
the MicroEJ Core Engine.

When a resource is not available, the MicroEJ Core Engine invokes the External Resource Loader in order to load an
unknown resource. The External Resource Loader uses the LLAPI EXT_RES to let the BSP loads or not the expected
resource. The implementation has to be able to load several files in parallel.

Naming Convention

The Low Level API, the LLEXT_RES API, relies on functions that need to be implemented. The naming convention
for such functions is that their names match the LLEXT_RES_IMPL_x pattern.

Header Files

One headerfile is provided:
o LLEXT_RES_impl.h

Defines the set of functions that the BSP must implement to load some external resources.

LLCOMM: Serial Communications

Naming Convention

The Low Level Comm API (LLCOMM), relies on functions that need to be implemented by engineers
in a driver. The names of these functions match the [LCOM_BUFFERED_CONNECTION_IMPL_* or the
[LLCOM_CUSTOM_CONNECTION_IMPL_= pattern.

Header Files

Four C header files are provided:
+ LLCOMM_BUFFERED_CONNECTION_impl.h
Defines the set of functions that the driver must implement to provide a Buffered connection
« LLCOMM_BUFFERED_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Buffered connection

« LLCOMM_CUSTOM_CONNECTION_impl.h
Defines the set of functions that the driver must implement to provide a Custom connection
+ LLCOMM_CUSTOM_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Custom connection
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LLINPUT: Inputs

LLINPUT APIis composed of the following files:
« thefile LLINPUT_impl.h that defines the functions to be implemented

« thefile LLINPUT.h that provides the functions for sending events

Implementation

LLINPUT_IMPL_initialize is the first function called by the input stack, and it may be used to initialize the un-
derlying devices and bind them to event generator IDs.

LLINPUT_IMPL_enterCriticalSection and LLINPUT_IMPL_exitCriticalSection need to provide the stack
with a critical section mechanism for synchronizing devices when sending events to the internal event queue. The
mechanism used to implement the synchronization will depend on the platform configuration (with or without
RTOS), and whether or not events are sent from an interrupt context.

LLINPUT_IMPL_getInitialStateValue allowstheinputstack to getthe current state for devices connected to the
MicroUl States event generator, such as switch selector, coding wheels, etc.

Sending Events

The LLINPUT API provides two generic functions for a C driver to send data to its associated event generator:

« LLINPUT_sendEvent : Sends a 32-bit encoded event to a specific event generator, specified by its ID. If the
input buffer is full, the event is not added, and the function returns 0; otherwise it returns 1.

« LLINPUT_sendEvents : Sends event data to a specific event generator, specified by its ID. If the input buffer
cannot receive the whole data, the event is not added, and the function returns 0; otherwise it returns 1.

Events will be dispatched to the associated event generator that will be responsible for decoding them (see Generic
Event Generators).

The Ul extension provides an implementation for each of MicroUI’s built-in event generators. Each one has dedi-
cated functions that allows a driver to send them structured data without needing to understand the underlying
protocol to encode/decode the data. The following table shows the functions provided to send structured events
to the predefined event generators:
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Table 24: LLINPUT API for predefined event generators

Function name Default event | Comments
generator
kind'
Command Constants are provided that define all stan-
LLINPUT_sendCommandEvent dard MicroUl commands [MUI].
Buttons In the case of chronological sequences (for
LLINPUT _sendButtonPressedEvent example, a RELEASE that may occur only
LLINPUT_sendButtonReleasedEvent after a PRESSED), it is the responsibility of
LLINPUT_sendBut tonRepeatedEvent the driver to ensure the integrity of such se-
quences.
Pointer In the case of chronological sequences (for
LLINPUT _sendPointerPressedEvent example, a RELEASE that may occur only
LLINPUT_sendPointerReleasedEvent after a PRESSED), it is the responsibility of
the driver to ensure the integrity of such se-
LLINPUT_sendPointerMovedEvent quences. Depending on whether a button of
the pointer is pressed while moving, a DRAG
and/or a MOVE MicroUl event is generated.
States The initial value of each state machine
LLINPUT_sendStateEvent (of a States) is retrieved by a call to
LLINPUT_IMPL_getInitialStateValue
that must be implemented by the device. Al-
ternatively, the initial value can be specified
in the XML static configuration.
Pointer In the case of chronological sequences (for
LLINPUT _sendTouchPressedEvent example, a RELEASE that may only occur
LLINPUT_sendTouchReleasedEvent after a PRESSED), it is the responsibility of
LLINPUT_sendTouchMovedEvent the driver to ensure the integrity of such se-
quences. These APIs will generate a DRAG Mi-
croUl eventinstead of a MOVE while they rep-
resent a touch pad over a display.
Event Buffer
The maximum usage of the internal event buffer may be retrieved at runtime using

LLINPUT _getMaxEventsBufferUsage function. This is useful for tuning the size of the buffer.

LLDISPLAY

LLDISPLAY: Display

Principle & Naming Convention

the

Each display stack provides a low level APl in order to connect a display driver. The file LLDISPLAY_impl.h defines
the APl headers to be implemented. For the APIs themselves, the naming convention is that their names match the
*_IMPL_x pattern when the functions need to be implemented.

! The implementation class is a subclass of the MicroUl class of the column.
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Initialization

Each display stack gets initialized the same way:
« First, the function LLDISPLAY_IMPL_initialize is called: It asks its display driver to initialize itself.

« Second, the functions LLDISPLAY_IMPL_getWidth and LLDISPLAY_IMPL_getHeight are called to retrieve
the size of the physical screen.

Working Buffer

The display driver must allocate a runtime memory buffer for creating dynamic images when using MicroUl Image.
createImage() methods that explicitly create mutable images.

The display driver may choose to return an empty buffer. Thus, calling MicroUl Image.createImage() methods
will resultina java.lang.OutOfMemoryError exception.

LLDISPLAY_getWorkingBufferStartAddress returns the buffer start address.
LLDISPLAY_getWorkingBufferEndAddress returns the next address after the buffer (end-start is the buffer
length).

Flush and Synchronization

Function LLDISPLAY_getGraphicsBufferAddress returns the address of the graphics buffer (back buffer) for
the very first drawing. The content of this buffer is flushed to the external display memory by the function
LLDISPLAY_flush . The parameters define the rectangular area of the content which has changed during the last
drawing action, and which must be flushed to the display buffer (dirty area).

LLDISPLAY_synchronize is called before the next drawing after a call to the flush function, in order to avoid flick-
ering on the display device.

LLDISPLAY_EXTRA: Display Extra Features
Principle

An additional low level APl allows you to connect display extra features. Thefiles LLDISPLAY_EXTRA_impl.h define
the API headers to be implemented. For the APIs themselves, the naming convention is that their names match
the *_IMPL_x pattern when the functions must be implemented. These LLAPIs are not required. When they are
not implemented, a default implementation is used (weak function).

Display Characteristics

Function LLDISPLAY_EXTRA_IMPL_isColor directly implements the method from the MicroUl Display class of
the same name. The default implementation always returns LLDISPLAY_EXTRA_OK.

Function LLDISPLAY_EXTRA_IMPL_getNumberOfColors directly implements the method from the MicroUl
Display class of the same name. The default implementation returns a value according to the number of bits
by pixels, without taking into consideration the alpha bit(s).

Function LLDISPLAY_EXTRA_IMPL_isDoubleBuffered directlyimplementsthe method fromthe MicroUl Display
class of the same name. The default implementation returns LLDISPLAY_EXTRA_OK . When LLAPI implementation
targetsa LCD in direct mode, this function must be implemented and return LLDISPLAY_EXTRA_NOT_SUPPORTED
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Contrast

LLDISPLAY_EXTRA_IMPL_setContrast and DISPLAY_EXTRA_IMPL_getContrast are called to set/get the current
display contrast intensity. The default implementations don’t manage the contrast.

BackLight

LLDISPLAY_EXTRA_IMPL_hasBackLight indicates whether the display has backlight capabilities.

LLDISPLAY_EXTRA_IMPL_setBackLight and DISPLAY_EXTRA_IIMPL_getBackLight are called to set/get the cur-
rent display backlight intensity.

LLDISPLAY_EXTRA_IMPL_backlightOn and LLDISPLAY_EXTRA_IMPL_backlightOff enable/disable the backlight.
The default implementations don’t manage the backlight.

Color Conversions

LLDISPLAY_EXTRA_IMPL_convertARGBColorToDisplayColor is called to convert a 32-bit ARGB MicroUl color in
0xAARRGGBB format into the “driver” display color.

LLDISPLAY_EXTRA_IMPL_convertDisplayColorToARGBColor is called to convert a display color to a 32-bit ARGB
MicroUl color.

Drawings
Synchronization

The display stack calls the functions LLDISPLAY_EXTRA_IMPL_enterDrawingMode and
LLDISPLAY_EXTRA_IMPL_exitDrawingMode to enter / leave a critical section. This is useful when some drawings
are performed in C-side using the LLDISPLAY_UTILS AP This function implementation can stay empty when
there is no call from C-side, or when the calls from C-side are performed in the same OS task, rather than in the
MicroEJ Core Engine task. By default these functions do nothing.

LUT

The function LLDISPLAY_EXTRA_IMPL_prepareBlendingOfIndexedColors is called when drawing an image with
indexed color. See LUT to have more information about indexed images.

Hardware Accelerator

Some functions allow you to wuse an hardware accelerator to perform some drawings:
LLDISPLAY_EXTRA_IMPL_fillRect, LLDISPLAY_EXTRA_IMPL_drawImage, LLDISPLAY_EXTRA_IMPL_scaleImage
and LLDISPLAY_EXTRA_IMPL_rotateImage . When called, the LLDISPLAY must perform the drawing (see Hard-
ware Accelerator). Otherwise a call to LLDISPLAY_EXTRA_IMPL _error will be performed with an error code as
parameter (see LLDISPLAY EXTRA). Furthermore, the drawing will be not performed by software.

A drawing may be executed directly during the call of the relative function (synchronous execution), may
be executed by a hardware peripheral like a DMA (asynchronous execution), or may be executed by a ded-
icated OS task (asynchronous execution). When the drawing is synchronous, the function must return
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LLDISPLAY_EXTRA_DRAWING_COMPLETE , which indicates the drawing is complete. When the drawing is asyn-
chronous, the function must return LLDISPLAY_EXTRA_DRAWING_RUNNING, which indicates that the drawing is run-
ning. In this case, the very next drawing (with or without hardware acceleration) will be preceded by a specific call
in order to synchronize the display stack work with the end of hardware drawing. The function used to wait for the
end of drawing is LLDISPLAY_EXTRA_IMPL_waitPreviousDrawing.

The default implementations call the error function.

Structures

The drawing functions are using some struct to specify the drawing to perform. These structures are listed in
LLDISPLAY_EXTRA_drawing.h . Refer to this h file have the exhaustive list of structures and structures elements.

e int32_t LLDISPLAY_EXTRA_IMPL_fillRect(LLDISPLAY_SImagex* dest, int32_t destAddr,
LLDISPLAY_SRectanglex rect, int32_t color)

e int32_t LLDISPLAY_EXTRA_IMPL_drawImage(LLDISPLAY_SImagex* src, int32_t srcAddr,
LLDISPLAY_SImage* dest, int32_t destAddr, LLDISPLAY_SDrawImage* drawing)

o int32_t LLDISPLAY_EXTRA_IMPL_scaleImage(LLDISPLAY_SImagex* src, int32_t srcAddr,
LLDISPLAY_SImage* dest, int32_t destAddr, LLDISPLAY_SScalelmagex drawing)

e int32_t LLDISPLAY_EXTRA_IMPL_rotateImage (LLDISPLAY_SImagex src, int32_t srcAddr,
LLDISPLAY_SImagex dest, int32_t destAddr, LLDISPLAY_SRotatelImage* drawing)

Image Decoders

The API LLDISPLAY_EXTRA_IMPL_decodeImage allows to add some additional image decoders (see External De-
coders). This LLAPI uses some structures as parameter:

int32_t LLDISPLAY_EXTRA_IMPL_decodelImage(int32_t address, int32_t length, int32_t
expected_format, LLDISPLAY_SImage* image, LLDISPLAY_SRawImageData* image_data)

LLDISPLAY_UTILS: Display Utils
Principle

This header file lets some APIs in C-side perform some drawings in the same buffers used by the display stack. This
is very useful for reusing legacy code, performing a specific drawing, etc.

Synchronization

Every drawing performed in C-side must be synchronized with the display stack drawings. The idea is to force the
display stack to wait the end of previous asynchronous drawings before drawing anything else. Use the functions
enterDrawingMode and exitDrawingMode to enter/ leave a critical section.

Buffer Characteristics

A set of functions allow retrieval of several characterics of an image (or the display buffer itself). These func-
tions use a parameter to identify the image: the image Java object hash code ( myImage.hashCode() or
myGraphicsContext.hashCode() )
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Thefunction getBufferAddress returnsthe address of the image data buffer. This buffer can be located in runtime
memory (RAM, SRAM, SDRAM, etc.) or in read-only memory (internal flash, NOR, etc.).

The functions getWidth and getHeight return the size of the image / graphics context.

The function getFormat returns the format of the image / graphics context. The formats list is available in MicroUl
GraphicsContext class.

The functions getClipX1, getClipX2, getClipY1 and getClipY2 return the current clip of the image / graphics
context. The C-side drawing can use the clip limits (this is optional).

Drawings

Aset of functions allows you to use internal display stack functions to draw something on animage (orin the display
buffer itself). These functions use a parameter to identify the image: the image Java object hash code ( myImage.
hashCode() or myGraphicsContext.hashCode() ).

The basic functions drawPixel and readPixel are useful for drawing or reading a pixel. The function blend
allows you to blend two colors and a global alpha.

The C-side can change the current clip of an image / graphics context only in the display stack. The clip is not
updated in MicroUl. Use the function setClip to do this.

A C-side drawing has to update the drawing limits (before or after the drawing itself), using the function
setDrawinglLimits when the drawing is made in the display back buffer. This allows you to update the size of
the dirty area the display stack has to flush. If it is not updated, the C-side drawing (available in back buffer) may
never be flushed to the display graphical memory.

Allocation

When decoding an image with an external image decoder (see External Decoders), the C-side has to allocate a RAW
image in the working buffer. The function LLDISPLAY_UTILS_allocateRawImage takes as parameter a strucutre
which describes the image (size and format) and an output structure where it stores the image allocation data:

int32_t LLDISPLAY_UTILS_allocateRawImage(LLDISPLAY_SImage* image, LLDISPLAY_SRawImageDatax
image_data)

This function can also be used by C-side to allocate a RAW image in the working buffer. Thisimage will not be known
by MicroUl but this image can be used in C-side.

LLLEDS: LEDs
Principle

The LEDs stack provides a Low Level API for connecting LED drivers. The file LLLEDS_impl.h, which comes with
the LEDs stack, defines the API headers to be implemented.

Naming Convention

The Low Level APl relies on functions that must be implemented. The naming convention for such functions is that
their names match the *_IMPL_x pattern.
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Initialization

The first function called is LLLEDS_IMPL_initialize , which allows the driver to initialize all LED devices. This
method must return the number of LEDs available.

Each LED has a unique identifier. The first LED has the ID 0, and the last has the ID NbLEDs - 1.

This Ul extension provides support to efficiently implement the set of methods that interact with the LEDs provided
by a device. Below are the relevant C functions:

LLLEDS_IMPL_getIntensity : Getthe intensity of a specific LED using its ID.
LLLEDS_IMPL_setIntensity : Setthe intensity of an LED usingits ID.

LLNET: Network

Naming Convention

The Low Level API, the LLNET API, relies on functions that need to be implemented. The naming convention for
such functions is that their names match the LLNET_IMPL_x pattern.

Header Files

Several header files are provided:

LLNET_CHANNEL_impl.h

Defines a set of functions that the BSP must implement to initialize the Net native component. It also defines
some configuration operations to setup a network connection.

LLNET_SOCKETCHANNEL_impl.h

Defines a set of functions that the BSP must implement to create, connect and retrieve information on a
network connection.

LLNET_STREAMSOCKETCHANNEL_impl.h

Defines a set of functions that the BSP must implement to do some 1/0 operations on connection oriented
socket (TCP). It also defines function to put a server connection in accepting mode (waiting for a new client
connection).

LLNET_DATAGRAMSOCKETCHANNEL _impl.h

Defines a set of functions that the BSP mustimplement to do some /O operations on connectionless oriented
socket (UDP).

LLNET_DNS_impl.h

Defines a set of functions that the BSP must implement to request host IP address associated to a host name
or to request Domain Name Service (DNS) host IP addresses setup in the underlying system.

LLNET_NETWORKADDRESS_impl.h

Defines a set of functions that the BSP must implement to convert string IP address or retrieve specific IP
addresses (lookup, localhost or loopback IP address).

LLNET_NETWORKINTERFACE_impl.h

Defines a set of functions that the BSP must implement to retrieve information on a network interface (MAC
address, interface link status, etc.).
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LLNET_SSL: SSL

Naming Convention

The Low Level API, the LLNET_SSL API, relies on functions that need to be implemented. The naming convention
for such functions is that their names match the LLNET_SSL_x pattern.

Header Files

Three header files are provided:
o LLNET_SSL_CONTEXT_impl.h

Defines a set of functions that the BSP must implement to create a SSL Context and to load CA (Certificate
Authority) certificates as trusted certificates.

+ LLNET_SSL_SOCKET_impl.h

Defines a set of functions that the BSP must implement to initialize the SSL native components, to create
an underlying SSL Socket and to initiate a SSL session handshake. It also defines some /O operations such
as LLNET_SSL_SOCKET_IMPL_write or LLNET_SSL_SOCKET_IMPL_read used for encrypted data exchange
between the client and the server.

+ LLNET_SSL_X509_CERT_impl.h

Defines a function named LLNET_SSL_X509_CERT_IMPL_parse for certificate parsing. This function checks if
a given certificate is an X.509 digital certificate and returns its encoded format type : Distinguished Encoding
Rules (DER) or Privacy-Enchanced Mail (PEM).

LLFS: File System

Naming Convention

The Low Level File System API (LLFS), relies on functions that need to be implemented by engineersin a driver. The
names of these functions match the LLFS_IMPL_x andthe LLFS_File_IMPL_x pattern.

Header Files

Two C header files are provided:
« LLFS_impl.h

Defines a set of functions that the BSP must implement to initialize the FS native component. It also defines
some functions to manage files, directories and retrieve information about the underlying File System (free
space, total space, etc.).

« LLFS_File_impl.h

Defines a set of functions that the BSP must implement to do some I/O operations on files (open, read, write,
close, etc.).
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LLHAL: Hardware Abstraction Layer

Naming Convention

The Low Level API, the LLHAL API, relies on functions that need to be implemented. The naming convention for
such functions is that their names match the LLHAL_IMPL_x pattern.

Header Files

One headerfile is provided:
o LLHAL_impl.h

Defines the set of functions that the BSP must implement to configure and drive some MCU GPIO.

LLDEVICE: Device Information

Naming Convention

The Low Level Device API (LLDEVICE), relies on functions that need to be implemented by engineers in a driver. The
names of these functions match the LLDEVICE_IMPL_x pattern.

Header Files

One C header file is provided:
+ LLDEVICE_impl.h

Defines a set of functions that the BSP must implement to get the platform architecture name and unique
device identifier.

4.16.2 Appendix B: MicroEJ Foundation Libraries
EDC

Error Messages

When an exception is thrown by the runtime, the error message
Generic:E=<messageld>

isissued, where <messageld> meaningis defined in the next table:

Table 25: Generic Error Messages

Message ID | Description

1 Negative offset.

2 Negative length.

3 Offset + length > object length.

When an exception is thrown by the implementation of the EDC API, the error message

EDC-1.2:E=<messageld>
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isissued, where <messageld> meaningis defined in the next table:

Table 26: EDC Error Messages

Message Description
ID
-4 No native stack found to execute the Java native method.
-3 Maximum stack size for a thread has been reached. Increase the maximum size of the thread stack
parameter.
-2 No Java stack block could be allocated with the given size. Increase the Java stack block size.
-1 The Java stack space is full. Increase the Java stack size or the number of Java stack blocks.
1 A closed stream is being written/read.
2 The operation Reader.mark() is not supported.
3 lock is null in Reader(Object lock).
4 String index is out of range.
5 Argument must be a positive number.
6 Invalid radix used. Must be from Character .MIN_RADIX to Character.MAX_RADIX.
Exit Codes

The RTOS task that runs the MicroEJ runtime may end, especially when the MicroEJ Application calls System.exit
method. By convention, a negative value indicates abnormal termination.

Table 27: MicroEJ Platform exit codes

Message ID | Meaning
0 The MicroEJ Application ended normally.
-1 The SOAR and the MicroEJ Platform are not compatible.
-2 Incompatible link configuration ( 1sc file) with either the SOAR or the MicroEJ Platform.
-3 Evaluation version limitations reached: termination of the application.
-5 Not enough resources to start the very first MicroEJ thread that executes main method.
-12 Maximum number of threads reached.
-13 Fail to start the MicroEJ Platform because the specified MicroEJ heap is too large.
-14 Invalid stack space due to a link placement error.
-15 The application has too many static (the requested static head is too large).
-16 The MicroEJ Core Engine cannot be restarted.
SNI
Error Messages

The following error messages are issued at runtime.

Table 28: [SNI] Run Time Error Messages.

Message ID | Description

-1 Not enough blocks.

-2 Reserved.

-3 Max stack blocks per thread reached.
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KF

Definitions
Feature Definition Files

A Feature is a group of types, resources and [BON] immutables objects defined using two files that shall be in ap-
plication classpath:

» [featureName].kf,a Java properties file. Keys are described in the “Feature definition file properties” table
below.

« [featureName].cert,an X509 certificate file that uniquely identifies the Feature

Table 29: Feature definition file properties

Key Usage Description

entryPoint Mandatory The fully qualified name of the class that implements ej.kf.
FeatureEntryPoint

immutables Optional Semicolon separated list of paths to /BON] immutable files owned by the

Feature. [BON] immutable file is defined by a / separated path relative
to application classpath

resources Optional Semicolon separated list of resource names owned by the Feature. Re-
source name is defined by Class.getResourceAsStream(String)

requiredTypes Optional Comma separated list of fully qualified names of required types. (Types
that may be dynamically loaded using Class. forName() ).

types Optional Comma separated list of fully qualified names of types owned by the Fea-

ture. Awildcard is allowed as terminal character to embed all types start-
ing with the given qualified name (a.b.C,x.y.*)
version Mandatory String version, that can retrieved using ej.kf.Module.getVersion()

Kernel Definition Files

Kernel definition files are mandatory if one or more Feature definition file is loaded and are named kernel.kf
and kernel.cert. kernel.kf must only define the version key. All types, resources and immutables are
automatically owned by the Kernel if not explicitly set to be owned by a Feature.

Kernel API Definition

Kernel types, methods and static fields allowed to be accessed by Features must be declared in kernel.api file.
Kernel API file is an XML file (see example “Kernel API XML Schema” and table “XML elements specification”).

Listing 10: Kernel API XML Schema

<xs:schema xmlns:xs='http://www.w3.0rg/2001/XMLSchema'>
<xs:element name='require'>
<xs:complexType>
<xs:choice minOccurs='0"' maxOccurs='unbounded'>
<xs:element ref='type'/>
<xs:element ref='field'/>
<xs:element ref='method'/>
</xs:choice>
</xs:complexType>
(continues on next page)
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(continued from previous page)

</xs:element>

<xs:element name='type'>
<xs:complexType>
<xs:attribute name='name' type='xs:string' use='required'/>
</xs:complexType>
</xs:element>

<xs:element name='field'>
<xs:complexType>
<xs:attribute name='name' type='xs:string' use='required'/>
</xs:complexType>
</xs:element>

<xs:element name='method'>
<xs:complexType>
<xs:attribute name='name' type='xs:string' use='required'/>
</xs:complexType>
</xs:element>
</xs:schema>

Table 30: XML elements specification

Tag Attributes | Description
require The root element
field Staticfield declaration. Declaring afield as a Kernel APl automatically sets the declaring
type as a Kernel API
name Fully qualified name on the form [type].[fieldName]
method Method or constructor declaration. Declaring a method or a constructor as a Kernel API
automatically sets the declaring type as a Kernel API
name Fully qualified name on the form [type].[methodNamel([typeArgl, ..., typeArgN)

typeReturned . Types are fully qualified names or one of a base type as described by
the Java language (boolean, byte, char, short, int, long, float, double)When
declaring a constructor, methodName is the single type name. When declaring a void
method or a constructor, typeReturned is void

type Type declaration, allowed to be loaded from a Feature using Class. forName()

name Fully qualified name on the form [package].[package].[typeName]

Access Error Codes

When an instruction is executed that will break a [KF] insulation semanticrule,a java.lang.IllegalAccessError
is thrown, with an error code composed of two parts: [sourcel[errorKind].

« source : a single character indicating the kind of Java element on which the access error occurred (Table
“Error codes: source”)

« errorKind: an error number indicating the action on which the access error occurred (Table “Error codes:
kind”)
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Table 31: Error codes: source

Ch aracter | Description

Error thrown when accessing an array

Error thrown when calling a method

Error thrown when accessing an instance field

Error thrown when entering a synchronized block or method
Error thrown when passing a parameter to a method call
Error thrown when returning from a method call

Error thrown when accessing a static field

wlxo o=z —>

Table 32: Error codes: kind

Id | Description

is not owne

1 | Anobject owned by a Feature is being assigned to an object owned by the Kernel, but the current context

d by the Kernel

An object owned by a Feature is being assigned to an object owned by another Feature

An object owned by a Feature is being accessed from a context owned by another Feature

A synchronize on an object owned by the Kernel is executed in a method owned by a Feature

G| bhWN

A call to a feature code occurs while owning a Kernel monitor

Loading Features Dynamically

Features may be statically embedded with the Kernel or dynamically built against a Kernel. To build a Feature
binary file, select Build Dynamic Feature MicroEJ Platform Execution tab. The generated file can be dynamically
loaded by the Kernel runtime using ej.kf.Kernel.load(InputStream) .

ECOM

Error Messages

When an exception is thrown by the implementation of the ECOM API, the error message

ECOM-1.1:E=<mes

isissued, where <

sageld>

messageld> meaning is defined in the next table:

Table 33: ECOM Error Messages

Message ID Description

1 The connection has been closed. No more action can be done on this connection.

2 The connection has already been closed.

3 The connection description is invalid. The connection cannot be opened.

4 The connection stream has already been opened. Only one stream per kind of stream (input or
output stream) can be opened at the same time.

5 Too many connections have been opened at the same time. The platform is not able to open a new
one. Try to close useless connections before trying to open the new connection.

ECOM Comm
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Error Messages

When an exception is thrown by the implementation of the ECOM-COMM API, the error message

ECOM-COMM: E=<me

isissued, where <

ssageld>

messageld> meaning is defined in the next table:

Table 34: ECOM-COMM error messages

Message ID Description

1 The connection descriptor must start with "comm: "

2 Reserved.

3 The Comm port is unknown.

4 The connection descriptor is invalid.

5 The Comm port is already open.

6 The baudrate is unsupported.

7 The number of bits per character is unsupported.

8 The number of stop bits is unsupported.

9 The parity is unsupported.

10 The input stream cannot be opened because native driver is not able to create a RX buffer to
store the incoming data.

1 The output stream cannot be opened because native driver is not able to create a TX buffer to
store the outgoing data.

12 The given connection descriptor option cannot be parsed.

MicroUl

Error Messages

When an exception is thrown by the implementation of the MicroUI API, the exception MicroUIException withthe

error message

MicroUI:E=<mess

ageld>

is issued, where the meaning of <messageld> isdefinedin Table “MicroUl Error Messages”.
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Table 35: MicroUl Error Messages

Message ID Description

1 Deadlock. Cannot wait for an event in the same thread that runs events. Display.
waitForEvent() must not be called in the display pump thread (for example in paint
methods).

3 Out of memory. Not enough memory to allocate the Image ’s buffer. Try to remove ref-
erences on useless images and retry opening the new image, or increase the size of the
MicroUl working buffer.

4 A polygon cannot have more than 16 sides.

5 The platform cannot allocate memory to create a dynamic image.

° Image ’s path is limited to 100 characters.

7 The platform cannot decode this kind of image, because the required runtime image de-
coder is not available in the platform.

8 Another EventGenerator cannot be added into the system pool (max 254).

9 Font’s path is limited to 100 characters.

10 Invalid font path: cannot load this font.

n MicroUl is not started; call MicroUl.start() before using a MicroUl API.

" FIFOPump size must be positive

10 FlyingImage featureis disabled in MicroEJ launch options; cannot use this feature in ap-
plication.

17 Out of memory. There is not enough memory to openanew FlyingImage Trytoincrease
the number of concurrent flying images in the MicroEJ launcher.

19 Font’s path must be relative to the classpath.

20 Unknown event generator class name.

21 The font data cannot be loaded for an unknown reason (font is stored outside the CPU
address space range).

Exceptions

Some other exceptions can be thrown by the MicroUl framework in addition to the generic MicroUIException (see

previous chapter).

Table 36: MicroUl Exceptions

Message ID

Description

OutOfEventsException This exception is thrown when the pump of the internal thread DisplayPump is

full. In this case, no more event (such as repaint, input events etc.) can be
added into it.
Most of time this error occurs when:
« Thereisa userthread which performs too many calls to the method paint
without waiting for the end of the previous drawing.
« Too many input events are pushed from an input driver to the display
pump (for example some touch events).

FS

4.16. Appendices

293



MicroEJ Documentation, Revision 4€20bb27

Error Messages

When an exception is thrown by the implementation of the FS API, the error message
FS:E=<messageld>

is issued, where <messageld> meaning is defined in the next table:

Table 37: File System Error Messages

Message ID | Description

-1 End of File (EOF).

-2 An error occurred during a File System operation.
-3 File System not initialized.

Net

Error Messages

When an exception is thrown by the implementation of the Net AP, the error message
NET-1.1:E=<messageld>

isissued, where <messageld> meaningis defined in the next table:

Table 38: Net Error Messages

Message ID | Description

-2 Permission denied.

-3 Bad socket file descriptor.

-4 Host is down.

-5 Network is down.

-6 Network is unreachable.

-7 Address already in use.

-8 Connection abort.

-9 Invalid argument.

-10 Socket option not available.

-1 Socket not connected.

-12 Unsupported network address family.
-13 Connection refused.

-14 Socket already connected.

-15 Connection reset by peer.

-16 Message size to be sent is too long.
-17 Broken pipe.

-18 Connection timed out.

-19 Not enough free memory.

-20 No route to host.

-21 Unknown host.

-23 Native method not implemented.
-24 The blocking request queue is full, and a new request cannot be added now.
-25 Network not initialized.

-255 Unknown error.
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SSL

Error Messages

When an exception is thrown by the implementation of the SSL API, the error message
SSL-2.0:E=<messageld>

is issued, where <messageId> meaningis defined in the next table:

Table 39: SSL Error Messages

Message ID | Description

-2 Connection reset by the peer.

-3 Connection timed out.

-5 Dispatch blocking request queue is full, and a new request cannot be added now.
-6 Certificate parsing error.

-7 The certificate data size bigger than the immortal buffer used to process certificate.
-8 No trusted certificate found.

-9 Basic constraints check failed: Intermediate certificate is not a CA certificate.
-10 Subject/issuer name chaining error.

-21 Wrong block type for RSA function.

-22 RSA buffer error: Output is too small, or input is too large.
-23 Output buffer is too small, or input is too large.
-24 Certificate Alog|D setting error.

-25 Certificate public-key setting error.

-26 Certificate date validity setting error.

-27 Certificate subject name setting error.

-28 Certificate issuer name setting error.

-29 CA basic constraint setting error.

-30 Extensions setting error.

-31 Invalid ASN version number.

-32 ASN get int error: invalid data.

-33 ASN key init error: invalid input.

-34 Invalid ASN object id.

-35 Not null ASN tag.

-36 ASN parsing error: zero expected.

-37 ASN bit string error: wrong id.

-38 ASN OID error: unknown sum id.

-39 ASN date error: bad size.

-40 ASN date error: current date before.

-4 ASN date error: current date after.

-42 ASN signature error: mismatched OID.

-43 ASN time error: unknown time type.

-44 ASN input error: not enough data.

-45 ASN signature error: confirm failure.

-46 ASN signature error: unsupported hash type.
-47 ASN signature error: unsupported key type.
-48 ASN key init error: invalid input.

-49 ASN NTRU key decode error: invalid input.

-50 X.509 critical extension ignored.

-51 ASN no signer to confirm failure (no CA found).
-52 ASN CRL signature-confirm failure.

Continued on next page
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Table 39 - continued from previous page

Message ID | Description

-53 ASN CRL: no signer to confirm failure.

-54 ASN OCSP signature-confirm failure.

-60 ECC input argument is wrong type.

-61 ECC ASN1 bad key data: invalid input.

-62 ECC curve sum OID unsupported: invalid input.
-63 Bad function argument provided.

-64 Feature not compiled in.

-65 Unicode password too big.

-66 No password provided by user.

-67 AltNames extensions too big.

-70 AES-GCM Authentication check fail.

-n AES-CCM Authentication check fail.

-80 Cavium Init type error.

-81 Bad alignment error, no alloc help.

-82 Bad ECC encrypt state operation.

-83 Bad padding: message wrong length.

-84 Certificate request attributes setting error.
-85 PKCS#T7 error: mismatched OID value.

-86 PKCS#T error: no matching recipient found.
-87 FIPS mode not allowed error.

-88 Name constraint error.

-89 Random Number Generator failed.

-90 FIPS Mode HMAC minimum key length error.
-91 RSA Padding error.

-92 Export public ECC key in ANSI format error: Output length only set.
-93 In Core Integrity check FIPS error.

-94 AES Known Answer Test check FIPS error.
-95 DES3 Known Answer Test check FIPS error.
-96 HMAC Known Answer Test check FIPS error.
-97 RSA Known Answer Test check FIPS error.
-98 DRBG Known Answer Test check FIPS error.
-99 DRBG Continuous Test FIPS error.

-100 AESGCM Known Answer Test check FIPS error.
-101 Process input state error.

-102 Bad index to key rounds.

-103 Out of memory.

-104 Verify problem found on completion.

-105 Verify mac problem.

-106 Parse error on header.

-107 Weird handshake type.

-108 Error state on socket.

-109 Expected data, not there.

-110 Not enough data to complete task.

-m Unknown type in record header.

-1n2 Error during decryption.

-n3 Received alert: fatal error.

-114 Error during encryption.

-116 Need peer’s key.

-n7 Need the private key.

Continued on next page
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Table 39 - continued from previous page

Message ID | Description

-118 Error during RSA private operation.

-119 Server missing DH parameters.

-120 Build message failure.

-121 Client hello not formed correctly.

-122 The peer subject name mismatch.

-123 Non-blocking socket wants data to be read.
-124 Handshake layer not ready yet; complete first.
-125 Premaster secret version mismatch error.
-126 Record layer version error.

-127 Non-blocking socket write buffer full.
-128 Malformed buffer input error.

-129 Verify problem on certificate and check date/time on your device.
-130 Verify problem based on signature.

-131 PSK client identity error.

-132 PSK server hint error.

-133 PSK key callback error.

-134 Record layer length error.

-135 Can’t decode peer key.

-136 The peer sent close notify alert.

-137 Wrong client/server type.

-138 The peer didn’t send the certificate.

-140 NTRU key error.

-141 NTRU DRBG error.

-142 NTRU encrypt error.

-143 NTRU decrypt error.

-150 Bad ECC Curve Type or unsupported.

-151 Bad ECC Curve or unsupported.

-152 Bad ECC Peer Key.

-153 ECC Make Key failure.

-154 ECC Export Key failure.

-155 ECC DHE shared failure.

-157 Not a CA by basic constraint.

-159 Bad Certificate Manager error.

-160 OCSP Certificate revoked.

-161 CRL Certificate revoked.

-162 CRL missing, not loaded.

-165 OCSP needs a URL for lookup.

-166 OCSP Certificate unknown.

-167 OCSP responder lookup fail.

-168 Maximum chain depth exceeded.

-7 Suites pointer error.

-172 No PEM header found.

-173 Out of order message: fatal.

-174 Bad KEY type found.

-175 Sanity check on ciphertext failed.

-176 Receive callback returned more than requested.
-178 Need peer certificate for verification.

-181 Unrecognized host name error.

-182 Unrecognized max fragment length.

Continued on next page
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Table 39 - continued from previous page

Message ID | Description

-183 Key Use digitalSignature not set.

-185 Key Use keyEncipherment not set.

-186 Ext Key Use server/client authentication not set.

-187 Send callback out-of-bounds read error.

-188 Invalid renegotiation.

-189 Peer sent different certificate during SCR.

-190 Finished message received from peer before receiving the Change Cipher message.
-191 Sanity check on message order.

-192 Duplicate handshake message.

-193 Unsupported cipher suite.

-194 Can’t match cipher suite.

-195 Bad certificate type.

-196 Bad file type.

-197 Opening random device error.

-198 Reading random device error.

-199 Windows cryptographic init error.

-200 Windows cryptographic generation error.

-201 No data is waiting to be received from the random device.
-202 Unknown error.

4.16.3 Appendix C: Tools Options and Error Codes
SOAR

When a generic exception is thrown by the SOAR, the error message
SOAR ERROR [M<messageld>] <message>

isissued, where <messageld> and <message> meanings are defined in the next table.

Table 40: SOAR Error Messages.

Message ID Description

0 The SOAR process has encountered some internal limits.

1 Unknown option.

2 An option has an invalid value.

3 A mandatory option is not set.

4 Afilename given in options does not exist .

5 Failed to write the output file (access permissions required for -toDir and -root options).
6 The given file does not exist.

7 I/O error while reading a file.

8 An option value refers to a directory, instead of afile.

9 An option value refers to a file, instead of a directory or a jar file.
10 Invalid entry point class or no main() method.

1 An information file can not be generated in its entirety.

12 Limitations of the evaluation version have been reached.

13 I/O rrror while reading a jar file.

14 10 Error while writing a file.

15 I/O error while reading a jar file: unknown entry size.

16 Not enough memory to load a jar file.

Continued on next page

4.16. Appendices 298



MicroEJ Documentation, Revision 4€20bb27

Table 40 - continued from previous page

Message ID Description

17 The specified SOAR options are exclusive.

18 XML syntax error for some given files.

19 Unsupported float representation.

23 A clinit cycle has been detected. The clinit cycle can be cut either by simplifying the ap-
plication clinit code or by explicitly declaring clinit dependencies. Check the generated .
clinitmap file for more information.

50 Missing code: Java code refers to a method not found in specified classes.

51 Missing code: Java code refers to a class not found in the specified classpath.

52 Wrong class: Java code refers to a field not found in the specified class.

53 Wrong class: A Java classfile refers to a class as an interface.

54 Wrong class: An abstract method is found in a non-abstract class.

55 Wrong class: illegal access to a method, a field or a type.

56 Wrong class: hierarchy inconsistency; an interface cannot be a superclass of a class.

57 Circularity detected in initializion sequence.

58 Option refers twice to the same resource. The first reference is used.

59 Stack inconsistency detected.

60 Constant pool inconsistency detected.

61 Corrupted classfile.

62 Missing native implementation of a native method.

63 Cannot read the specified resource file.

64 The same property name cannot be defined in two different property files.

65 Bad license validity.

66 Classfiles do not contain debug line table information.

67 Same as 51.

150 SOAR limit reached: The specified method uses too many arguments.

151 SOAR limit reached: The specified method uses too many locals.

152 SOAR limit reached: The specified method code is too large.

153 SOAR limit reached: The specified method catches too many exceptions.

154 SOAR limit reached: The specified method defines a stack that is too large.

155 SOAR limit reached: The specified type defines too many methods.

156 SOAR limit reached: Your application defines too many interfaces.

157 SOAR limit reached: The specified type defines too many fields.

158 SOAR limit reached: your application defines too many types.

159 SOAR limit reached: Your application defines too many static fields.

160 SOAR limit reached: The hierarchy depth of the specified type is too high.

161 SOAR limit reached: Your application defines too many bundles.

162 SOAR limit reached: Your application defines too deep interface hierarchies.

163 SOAR limit reached: Your application defines too many cnocrete types.

251 Error in converting an IEE754 float(32) or double(64) to a fixed-point arithmetic number

300 Corrupted class: invalid dup_x1 instruction usage.

301 Corrupted class: invalid dup_x2 instruction usage.

302 Corrupted class:invalid dup_x2 instruction usage.

303 Corrupted class:invalid dup2_x1 instruction usage.

304 Corrupted class:invalid dup2_x1 instruction usage.

305 Corrupted class:invalid dup2_x2 instruction usage.

306 Corrupted class: invalid dup2 instruction usage.

307 Corrupted class:invalid pop2 instruction usage.

308 Corrupted class:invalid swap instruction usage.

309 Corrupted class: Finally blocks must be inlined.

Continued on next page
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Table 40 - continued from previous page

Message ID Description

350 SNI incompatibility: Some specified type should be an array.

351 SNI incompatibility: Some type should define some specified field.

352 SNIincompatibility: The specified field is not compatible with SNI.

353 SNI incompatibility: The specified type must be a class.

354 SNIincompatibility: The specified static field must be defined in the specified type.

355 SNI file error: The data must be an integer.

356 SNl file error : unexpected tag

357 SNIfile error: attributes <name>, <descriptor>, <index>and <size> are expected in the spec-
ified tag.

358 SNI file error : invalid SNI tag value.

359 Error parsing the SNI file.

360 XML Error on parsing the SN file.

361 SNl incompatibility : illegal call to the specified data.

362 No stack found for the specified native group.

363 Invalid SNI method: The argument cannot be an object reference.

364 Invalid SNI method: The array argument must only be a base type array.

365 Invalid SNI method: The return type must be a base type.

366 Invalid SNI method: The method must be static.

Immutable Files Related Error Messages

The following error messages are issued at SOAR time (link phase) and not at runtime.

Table 41: Errors when parsing immutable files at link time.

Message Description
ID
0 Duplicated ID in immutable files. Each immutable object should have a unique ID in the SOAR
image.
1 An immutable file refers to an unknown field of an object.
2 Tried to assign the same object field twice.
3 All immutable object fields should be defined in the immutable file description.
4 The assigned value does not match the expected Java type.
5 An immutable object refers to an unknown ID.
6 The length of the immutable object does not match the length of the assigned object.
7 The type defined in the file doesn’t match the Java expected type.
8 Generic error while parsing an immutable file.
9 Cycle detected in an alias definition.
10 An immutable object is an instance of an abstract class or an interface.
1 Unknown XML attribute in an immutable file.
12 A mandatory XML attribute is missing.
13 The value is not a valid Java literal.
14 Alias already exists.
SNI

The following error messages are issued at SOAR time and not at runtime.
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SP Compiler

Options

Table 42: [SNI] Link Time Error Messages.

Message ID | Description

363 Argument cannot be a reference.

364 Argument can only be from a base type array.
365 Return type must be a base type.

366 Method must be a static method.

Table 43: Shielded Plug Compiler Options.

Option name

Description

-verbose[e. . .e]

Extra messages are printed out to the console according to the number of ‘e’

XML Shielded Plug description file. Multiple files allowed.

-descriptionFile
file
o o Maximum number of task/threads that can wait on a block: a number between 0 and
-waitingTaskLimit . R o
7. -1is for no limit; 8 is for unspecified.
value
When specified, only immutable Shielded Plugs can be compiled.
-immutable P oYy & P
. Output directory. Default is the current directory.
-output dir

-outputName name

Output name for the Shielded Plug layout description. Default is “shielded_plug”.

-endianness name

Either “little” or “big”. Default is “little”.

Output ELF architecture. Only “ELF” architecture is available.

-outputArchitecture
value
) Read/Write header file value.
-rwBlockHeaderSize
value
When specified, generate a C header file with block ID constants.
-genldsC

-cOutputDir dir

Output directory of C header files. Default is the current directory.

-cConstantsPrefix
prefix

C constants name prefix for block IDs.

-genldsJava

When specified, generate Java interfaces file with block ID constants.

-jOutputDir dir

Output directory of Java interfaces files. Default is the current directory.

-jPackage name

The name of the package for Java interfaces.
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Error Messages

NLS Immutables Creator

Table 44: Shielded Plug Compiler Error Messages.
Message ID | Description

Internal limits reached.

Invalid endianness.

Invalid output architecture.

Error while reading / writing files.

Missing a mandatory option.

HlwlN—|O

Table 45: NLS Immutables Creator Errors Messages

ID | Type Description

1 Error Error reading the nls list file : invalid path, input/output error, etc.
2 | Error Error reading the nls list file: The file contents are invalid.
3 | Error Specified class is not an interface.

4 | Error Invalid message ID. Must be greater than or equal to 1.

5 | Error Duplicate ID. Both messages use the same message ID.

6 | Error Specified interface does not exist.

7 | Error Specified message constant is not visible (must be public).
8 | Error Specified message constant is not an integer.

9 | Error No locale file is defined for the specified header.

10 | Error 10 error: Cannot create the output file.

11 | Warning | Missing message value.

12 | Warning | There is a gap (or gaps) in messages constants.

13 | Warning | Specified property does not denote a message.

14 | Warning | Invalid properties header file. File is ignored.

15 | Warning | No message is defined for the specified header.

16 | Warning | Invalid property.

MicroUl Static Initializer

Inputs

The XML file used as input by the MicroUl Static Initialization Tool may contain tags related to the Input component

as described below.

<eventgenerators>

Listing 11: Event Generators Description

<!-- Generic Event Generators -->
<eventgenerator name="GENERIC"” class="foo.bar.Zork">
<property name="PROP1" value="3"/>
<property name="PROP2" value="aaa"/>
</eventgenerator>

<!-- Predefined Event Generators -->
<command name="COMMANDS" />

(continues on next page)
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(continued from previous page)

<buttons name="BUTTONS" extended="3"/>

<buttons name="JOYSTICK"” extended="5"/>

<pointer name="POINTER" width="1200" height="1200"/>
<touch name="TOUCH" display="DISPLAY"/>

<states name="STATES" numbers="NUMBERS" values="VALUES"/>

</eventgenerators>

<array name="NUMBERS">
<elem value="3"/>
<elem value="2"/>
<elem value="5"/>

</array>

<array name="VALUES">
<elem value="2"/>
<elem value="0"/>
<elem value="1"/>

</array>
Table 46: Event Generators Static Definition
Tag Attributes | Description
The list of event generators.
eventgenerators
priority | Optional. An integer value. Defines the internal display thread priority. De-
fault value is 5.
Describes a generic event generator. See also Generic Event Generators.
eventgenerator -
name The logical name.
class The event generator class (must extend the ej.microui.event.generator.
GenericEventGenerator class). This class must be available in the MicroEJ
Application classpath.
listener | Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified the listener is the default display.
A generic event generator property. The generic event generator will receive
property - .
this property at startup, via the method setProperty.
name The property key.
value The property value.
The default event generator Command .
command -
name The logical name.
listener | Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified, then the listener is the default display.
The default event generator Buttons.
buttons -
name The logical name.
extended | Optional. Anintegervalue. Defines the number of buttons which support the
MicroUl extended features (elapsed time, click and double-click).
listener | Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified, then the listener is the default display.
. The default event generator Pointer .
pointer -
name The logical name.
width An integer value. Defines the pointer area width.
height An integer value. Defines the pointer area heigth.

Continued on next page
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Table 46 - continued from previous page
Tag Attributes | Description
extended | Optional. An integer value. Defines the number of pointer buttons (right
click, left click, etc.) which support the MicroUl extended features (elapsed
time, click and double-click).
listener | Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified, then the listener is the default display.
The default event generator Touch.
name The logical name.
display Logical name of the Display with which the touch is associated.
listener | Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified, then the listener is the default display.
An event generator that manages a group of state machines. The state of a
machine is changed by sending an event using LLINPUT _sendStateEvent.
name The logical name.
numbers The logical name of the array which defines the number of state machines
for this States generator, and their range of state values. The IDs of the state
machines start at 0. The number of state machines managed by the States
generator is equal to the size of the numbers array, and the value of each
entry in the array is the number of different values supported for that state
machine. State machine values for state machine i can be in the range 0 to
numbers[i]-1.
values Optional. The logical name of the array which defines the initial state values
of the state machines for this States generator. The values array must be
the same size as the numbers array. If initial state values are specified using
a values array, thenthe LLINPUT_IMPL_getInitialStateValue function
is not called; otherwise that function is used to establish the initial values'
listener | Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified, then the listener is the default display.
An array of values.
name The logical name.
Avalue.
value An integer value.

touch

states

array

elem

Display

The display component augments the static initialization file with:
+ The configuration of each display.

« Fonts that are implicitly embedded within the application (also called system fonts). Applications can also
embed their own fonts.

<display name="DISPLAY"/>

<fonts>
<font file="resources\fonts\myfont.ejf">
<range name="LATIN” sections="0-2"/>
<customrange start="0x21" end="0x3f"/>
</font>
(continues on next page)

! Exception: When using MicroEJ Platform, where there is no equivalent to the LLINPUT_IMPL_getInitialStateValue function. If no
values array is provided, and the MicroEJ Platform is being used, all state machines take 0 as their initial state value.
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(continued from previous page)

<font file="C:\data\myfont.ejf"/>

</fonts>

Table 47: Display Static Initialization XML Tags Definition

Tag

Attributes

Description

The display element describes one display.

display

name

The logical name of the display.

priority

Optional. An integer value. Defines the internal display thread priority. De-
fault value is 5.

default

true or false. Defines this display to be the default display. By default the
very first display described in the XML file is the default display.

fonts

The list of system fonts. The system fonts are available for all displays.

font

A system font.

file

The font file path. The path may be absolute or relative to the XML file.

range

Afont generic range.

name

The generic range name (LATIN, HAN, etc.)

sections

Optional. Defines one or several sub parts of the generic range.
“1”: add only part 1 of the range

“1-5”: add parts1to 5

“1,5”: add parts1and 5

These combinations are allowed:

“1,5,6-8” add parts 1,5, and 6 through 8

By default, all range parts are embedded.

customrange

A font-specific range.

start

UTF16 value of the very first character to embed.

end

UTF16 value of the very last character to embed.

Font Generator

Configuration File

ConfigFile
Line
FontPath
Ranges

Range
CustomRangelList
CustomRange
KnownRange
SubRangelist
SubRange
Identifier
Number
Number16
Number10@
Digit16

::= Line [ 'EOL' Line J*

::= FontPath [ ':' [ Ranges 1 [ ':' BitsPerPixel ] ]
::= Identifier [ '/' Identifier Jx

::= Range [ ';' Range J*

::= CustomRangelList | KnownRange

::= CustomRange [ ',' CustomRange Jx

::= Number | Number '-

Number

::= Name [ SubRangelList ]?

::= "(' SubRange [ ',' SubRange Jx ')'
::= Number | Number - Number

c:= 'a-zA-Z_$' [ 'a-zA-Z_$0-9' Ix

::= Number16 | Number1@

::= 'ox' [ Digitl6 ]+

::= [ Digitle J+

::= 'a-fA-Fo-9'

(continues on next page)
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Digitl10@
BitsPerPixel

Custom Range

1nn
<
©

Allows the selection of raw Unicode character ranges.

Examples:

o myfont:0x21-0x49 : Embed all characters from 0x21 to 0x49 (included).

(continued from previous page)

« myfont:0x21-0x49,0x55 : Embed all characters from 0x21 to 0x49 and character 0x55

« myfont:0x21-0x49;0x55: Same as previous, but done by declaring two ranges.

Known Range

A known range is a range available in the following table.

Examples:

« myfont:basic_latin:Embed all Basic Latin characters.

« myfont:basic_latin;arabic: Embed all Basic Latin characters, and all Arabic characters.

The following table describes the available list of ranges and sub-ranges (processed from the “Unicode Character
Database” version 9.0.0 available on the official unicode website https://www.unicode.org).

Table 48: Ranges

Name Tag Start End

Basic Latin basic_latin 0x0 ox7f

Latin-1 Supplement latin-1_supplement 0x80 Oxff

Latin Extended-A latin_extended-a 0x100 ox17f
Latin Extended-B latin_extended-b 0x180 0x24f
IPA Extensions ipa_extensions 0x250 | Ox2af
Spacing Modifier Letters spacing_modifier_letters 0x2b0 | Ox2ff
Combining Diacritical Marks combining_diacritical_marks 0x300 | Ox36f
Greek and Coptic greek_and_coptic 0x370 0ox3ff
Cyrillic cyrillic 0x400 | Ox4ff
Cyrillic Supplement cyrillic_supplement 0x500 | Ox52f
Armenian armenian 0x530 0x58f
Hebrew hebrew 0x590 | Ox5ff
Arabic arabic 0x600 | Oxo6ff
Syriac syriac 0x700 | OxT74f
Arabic Supplement arabic_supplement 0x750 | Ox77f
Thaana thaana 0x780 | Ox7bf
NKo nko 0x7c0 | OxT7ff
Samaritan samaritan 0x800 | 0x83f
Mandaic mandaic 0x840 | 0x85f
Arabic Extended-A arabic_extended-a 0x8a0 | Oxsff
Devanagari devanagari 0x900 | 0x97f
Bengali bengali 0x980 | Oxoff

Continued on next page
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Table 48 - continued from previous page

Name Tag Start End
Gurmukhi gurmukhi 0xa00 | OxaTf
Gujarati gujarati 0xa80 | Oxaff
Oriya oriya 0xb00 | Oxb7f
Tamil tamil 0xb80 | Oxbff
Telugu telugu 0xc00 | Oxc7f
Kannada kannada 0xc80 | Oxcff
Malayalam malayalam 0xd00 | Oxd7f
Sinhala sinhala 0xd80 | Oxdff
Thai thai 0xe00 | Oxe7f
Lao lao 0xe80 | Oxeff
Tibetan tibetan 0xf00 | Oxfff
Myanmar myanmar 0x1000 | 0x109f
Georgian georgian 0x10a0 | Ox10ff
Hangul Jamo hangul_jamo 0x1100 | Ox11ff
Ethiopic ethiopic 0x1200 | 0x137f
Ethiopic Supplement ethiopic_supplement 0x1380 | 0x139f
Cherokee cherokee 0x13a0 | Ox13ff
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics 0x1400 | Ox167f
Ogham ogham 0x1680 | 0x169f
Runic runic 0x16a0 | Ox16ff
Tagalog tagalog 0x1700 | ox171f
Hanunoo hanunoo 0x1720 | 0x173f
Buhid buhid 0x1740 | 0x175f
Tagbanwa tagbanwa 0x1760 | Ox177f
Khmer khmer 0x1780 | Ox17ff
Mongolian mongolian 0x1800 | 0x18af
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics_extended| 0x18b0 | 0x18ff
Extended

Limbu limbu 0x1900 | 0x194f
Tai Le tai_le 0x1950 | 0x197f
New Tai Lue new_tai_lue 0x1980 | 0Ox19df
Khmer Symbols khmer_symbols 0x19e0 | 0x19ff
Buginese buginese 0x1a00 | Oxlaif
Tai Tham tai_tham 0x1a20 | Oxlaaf
Combining Diacritical Marks Extended | combining_diacritical_marks_extended Ox1ab0 | Oxlaff
Balinese balinese 0x1b00 | Ox1b7f
Sundanese sundanese 0x1b80 | Ox1bbf
Batak batak 0x1bc0O | Ox1bff
Lepcha lepcha 0x1c00 | Oxl1c4f
Ol Chiki ol_chiki 0x1c50 | Ox1c7f
Cyrillic Extended-C cyrillic_extended-c 0x1c80 | Ox1c8f
Sundanese Supplement sundanese_supplement 0x1ccO | Oxlccf
Vedic Extensions vedic_extensions Ox1cd0 | Oxicff
Phonetic Extensions phonetic_extensions 0x1d00 | ox1d7f
Phonetic Extensions Supplement phonetic_extensions_supplement 0x1d80 | Ox1dbf
Combining Diacritical Marks Supple- | combining_diacritical_marks_supplement 0x1dcO | ox1dff
ment

Latin Extended Additional latin_extended_additional 0x1e00 | Oxleff
Greek Extended greek_extended 0x1f00 | Oxi1fff

Continued on next page
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Table 48 - continued from previous page

Name Tag Start End
General Punctuation general_punctuation 0x2000 | Ox206f
Superscripts and Subscripts superscripts_and_subscripts 0x2070 | 0x209f
Currency Symbols currency_symbols 0x20a0 | 0x20cf
Combining Diacritical Marks for Sym- | combining_diacritical_marks_for_symbols 0x20d0 | 0x20ff
bols

Letterlike Symbols letterlike_symbols 0x2100 | 0x214f
Number Forms number_forms 0x2150 | 0x218f
Arrows arrows 0x2190 | Ox21ff
Mathematical Operators mathematical_operators 0x2200 | 0x22ff
Miscellaneous Technical miscellaneous_technical 0x2300 | Ox23ff
Control Pictures control_pictures 0x2400 | 0x243f
Optical Character Recognition optical_character_recognition 0x2440 | 0x245f
Enclosed Alphanumerics enclosed_alphanumerics 0x2460 | 0x24ff
Box Drawing box_drawing 0x2500 | 0x257f
Block Elements block_elements 0x2580 | 0x259f
Geometric Shapes geometric_shapes 0x25a0 | 0x25ff
Miscellaneous Symbols miscellaneous_symbols 0x2600 | Ox26ff
Dingbats dingbats 0x2700 | 0x27bf
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-a 0x27c0 | Ox27ef
Symbols-A

Supplemental Arrows-A supplemental_arrows-a 0x27f0 | Ox27ff
Braille Patterns braille_patterns 0x2800 | Ox28ff
Supplemental Arrows-B supplemental_arrows-b 0x2900 | 0x297f
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-b 0x2980 | 0Ox29ff
Symbols-B

Supplemental Mathematical Opera- | supplemental_mathematical_operators 0x2a00 | Ox2aff
tors

Miscellaneous Symbols and Arrows miscellaneous_symbols_and_arrows 0x2b00 | 0x2bff
Glagolitic glagolitic 0x2c00 | 0x2c5f
Latin Extended-C latin_extended-c 0x2c60 | Ox2cTf
Coptic coptic 0x2c80 | Ox2cff
Georgian Supplement georgian_supplement 0x2d00 | 0x2d2f
Tifinagh tifinagh 0x2d30 | ox2d7f
Ethiopic Extended ethiopic_extended 0x2d80 | 0x2ddf
Cyrillic Extended-A cyrillic_extended-a 0x2de0 | Ox2dff
Supplemental Punctuation supplemental_punctuation 0x2e00 | Ox2eT7f
CJK Radicals Supplement cjk_radicals_supplement 0x2e80 | Ox2eff
Kangxi Radicals kangxi_radicals 0x2f00 | ox2fdf
Ideographic Description Characters ideographic_description_characters 0x2ff0 | Ox2fff
CJK Symbols and Punctuation cjk_symbols_and_punctuation 0x3000 | 0x303f
Hiragana hiragana 0x3040 | 0x309f
Katakana katakana 0x30a0 | 0x30ff
Bopomofo bopomofo 0x3100 | 0x312f
Hangul Compatibility Jamo hangul_compatibility_jamo 0x3130 | 0x318f
Kanbun kanbun 0x3190 | 0x319f
Bopomofo Extended bopomofo_extended 0x31a0 | 0x31bf
CJK Strokes cjk_strokes 0x31c0 | Ox3lef
Katakana Phonetic Extensions katakana_phonetic_extensions 0x31f0 | Ox31ff
Enclosed CJK Letters and Months enclosed_cjk_letters_and_months 0x3200 | Ox32ff

Continued on next page
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Table 48 - continued from previous page

Name Tag Start End
CJK Compatibility cjk_compatibility 0x3300 | 0x33ff
CJK Unified Ideographs Extension A cjk_unified_ideographs_extension_a 0x3400 | Ox4dbf
Yijing Hexagram Symbols yijing_hexagram_symbols 0x4dcO | ox4dff
CJK Unified Ideographs cjk_unified_ideographs 0x4e00 | Oxofff
Yi Syllables yi_syllables 0xa000 | Oxa48f
Yi Radicals yi_radicals 0xa490 | Oxa4cf
Lisu lisu 0xa4d0 | Oxa4ff
Vai vai 0xa500 | Oxa63f
Cyrillic Extended-B cyrillic_extended-b 0xa640 | 0xa69f
Bamum bamum Oxa6al | Oxa6ff
Modifier Tone Letters modifier_tone_letters 0xa700 | OxaTif
Latin Extended-D latin_extended-d 0xa720 | OxaTff
Syloti Nagri syloti_nagri 0xa800 | 0xa82f
Common Indic Number Forms common_indic_number_forms 0xa830 | 0xa83f
Phags-pa phags-pa 0xa840 | 0xa87f
Saurashtra saurashtra 0xa880 | Oxa8df
Devanagari Extended devanagari_extended Oxa8e0 | OxaS8ff
Kayah Li kayah_li 0xa900 | 0xa92f
Rejang rejang 0xa930 | 0xa95f
Hangul Jamo Extended-A hangul_jamo_extended-a 0xa960 | 0xa97f
Javanese javanese 0xa980 | 0xa9df
Myanmar Extended-B myanmar_extended-b 0xa9%e0 | Oxaoff
Cham cham 0xaa00 | Oxaa5f
Myanmar Extended-A myanmar_extended-a 0xaa60 | Oxaa7f
Tai Viet tai_viet 0xaa80 | Oxaadf
Meetei Mayek Extensions meetei_mayek_extensions Oxaae0 | Oxaaff
Ethiopic Extended-A ethiopic_extended-a Oxab00 | Oxab2f
Latin Extended-E latin_extended-e 0xab30 | Oxabé6f
Cherokee Supplement cherokee_supplement 0xab70 | Oxabbf
Meetei Mayek meetei_mayek OxabcO | Oxabff
Hangul Syllables hangul_syllables Oxac00 | Oxd7af
Hangul Jamo Extended-B hangul_jamo_extended-b 0xd7b0 | Oxd7ff
High Surrogates high_surrogates 0xd800 | Oxdb7f
High Private Use Surrogates high_private_use_surrogates 0xdb80 | Oxdbff
Low Surrogates low_surrogates 0xdc00 | Oxdfff
Private Use Area private_use_area 0xe000 | Oxf8ff
CJK Compeatibility Ideographs cjk_compatibility_ideographs 0xf900 | Oxfaff
Alphabetic Presentation Forms alphabetic_presentation_forms 0xfb00 | Oxfb4f
Arabic Presentation Forms-A arabic_presentation_forms-a 0xfb50 | Oxfdff
Variation Selectors variation_selectors 0xfe00 | OxfeoOf
Vertical Forms vertical_forms Oxfe10 | Oxfelf
Combining Half Marks combining_half_marks 0xfe20 | Oxfe2f
CJK Compatibility Forms cjk_compatibility_forms 0xfe30 | Oxfe4f
Small Form Variants small_form_variants 0xfe50 | Oxfe6f
Arabic Presentation Forms-B arabic_presentation_forms-b 0xfe70 | Oxfeff
Halfwidth and Fullwidth Forms halfwidth_and_fullwidth_forms 0xffo0 | Oxffef
Specials specials Oxfff0 | Oxffff
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Error Messages
Table 49: Static Font Generator Error Messages
ID | Type Description
0 Error The static font generator has encountered an unexpected internal error.
1 Error The Fonts list file has not been specified.
2 Error The static font generator cannot create the final, raw file.
3 Error The static font generator cannot read the fonts list file.
4 | Warning The static font generator has found no font to generate.
5 Error The static font generator cannot load the fonts list file.
6 Warning The specified font path is invalid: The font will be not converted.
7 Warning There are too many arguments on a line: The current entry is ignored.
8 Error The static font generator has encountered an unexpected internal error.
9 Error The static font generator has encountered an unexpected internal error.
10 | Warning The specified entry is invalid: The current entry is ignored.
11 | Warning The specified entry does not contain a list of characters: The current entry is ignored.
12 | Warning The specified entry does not contain a list of identifiers: The current entry is ignored.
13 | Warning The specified entry is an invalid width: The current entry is ignored.
14 | Warning The specified entry is an invalid height: the current entry is ignored.
15 | Warning The specified entry does not contain the characters’ addresses: The current entry is
ignored.
16 | Warning The specified entry does not contain the characters’ bitmaps: The current entry is ignored.
17 | Warning The specified entry bits-per-pixel value is invalid: The current entry is ignored.
18 | Warning The specified range is invalid: The current entry is ignored.
19 | Error There are too many identifiers. The output RAW format cannot store all identifiers.
20 | Error The font’s name is too long. The output RAW format cannot store all name characters.

Image Generator

Configuration File

ConfigFile

Line

ImagePath
ImageOption
Identifier

Letter

LetterOrDigit

::= Line [ '"EOL' Line J*

::= ImagePath [ ':' ImageOption J]*
= Identifier [ '/' Identifier 1x
= [*:]*
= Letter [ LetterOrDigit 1*
= 'a-zA-Z_$'
= 'a-zA-7Z_$0-9'
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Error Messages
Table 50: Static Image Generator Error Messages
ID | Type Description
0 | Error The static image generator has encountered an unexpected internal error.
1 Error The images list file has not been specified.
2 | Error The static image generator cannot create the final, raw file.
3 | Error The static image generator cannot read the images list file. Make sure the system allows

reading of this file.

Warning The static image generator has found no image to generate.

Error The static image generator cannot load the images list file.

Warning There are too many or too few options for the desired format.

Error A static image generator extension class is unknown.

4
5
6 | Warning The specified image path is invalid: The image will be not converted.
7
8
9

Error The static image generator has encountered an unexpected internal error.

10 | Warning The specified output format is unknown: The image will be not converted.

11 | Warning The specified format is not managed by the static image generator: The image will be not
converted.

12 | Warning The specified alpha level is invalid: The image will be not converted.

13 | Warning The specified alpha level is not compatible with the specified format: The image will be not
converted.

14 | Warning A specified attribute is undefined for the specified format.

Front Panel

FP File

XML Schema

<?xml version="1.0"7>

<frontpanel
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance”
xmlns="https://developer.microej.com”
xsi:schemaLocation="https://developer.microej.com .widget.xsd">

<device name="example"” skin="example-device.png">
<ej.fp.widget.[type]l x="22" y="51" [widget-attributes]/>
<ej.fp.widget.[type]l x="30" y="125" [widget-attributes]/>
<l-- ... -=>
</device>
</frontpanel>
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File Specification

Table 51: FP File Specification

Tag Attributes Description
The root element.
frontpanel - T
Invariant tag
xmlns:xsi -
Invariant tag?
xmlns -
Invariant tag®
xsi:schemalLocation -
) The device’s root element.
device — -
The device’s logical name.
name
" Refers to a PNG file which defines the device background.
SK1n
. fo. widget Defines the widget to use. Refer to the widget documentation.
€J.Tp.widget. xxx All widget should provide this identifier. Sometimes it is used
label as string, sometimes as integer
The widget x-coordinate.
X
The widget y-coordinate.
y

LLDISPLAY_EXTRA

Error Messages

Display module calls the function LLDISPLAY_EXTRA_IMPL_error when the LLDISPLAY implementation has to
perform a drawing but does not.

Table 52: LLDISPLAY_EXTRA Error Messages

ID | Description

-10 | Acallto LLDISPLAY_EXTRA_IMPL_fillRect has been performed but the implementation has not per-
formed the drawing.

-1 | Acallto LLDISPLAY_EXTRA_IMPL_drawImage has been performed but the implementation has not per-
formed the drawing.

-12 | Acallto LLDISPLAY_EXTRA_IMPL _scalelImage has been performed but the implementation has not per-
formed the drawing.

-13 | Acall to LLDISPLAY_EXTRA_IMPL_rotateImage has been performed but the implementation has not
performed the drawing.

HIL Engine

Below are the HIL Engine options:

T Mustbe ” http://www.w3.0rg/2001/XMLSchema-instance ”
2 Must be ” https://developer.microej.com”
3 Must be " https://developer.microej.com .widget.xsd”
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Table 53: HIL Engine Options

Option name

Description

-verbosele....e]

Extra messages are printed out to the console (add extra e to get more messages).

-ip <address>

MicroEJ Simulator connection IP address (A.B.C.D). By default, set to localhost.

-port <port>

MicroEJ Simulator connection port. By default, set to 8001.

-connectTimeout
<timeout>

timeout in s for MicroEJ Simulator connections. By default, set to 10 seconds.

-excludes
<name[sep]name>

Types that will be excluded from the HIL Engine class resolution provided mocks. By

default, no types are excluded.

-mocks
<name[sep]name>

Mocks are either . jar fileor .class files.

Heap Dumping

XML Schema

Below is the XML schema for heap dumps.

Table 54: XML Schema for Heap Dumps

<!--
Schema

-=>

</xs:element>

<?xml version='1.0' encoding="'UTF-8'?>

Copyright 2012 IS2T. All rights reserved.

IS2T PROPRIETARY/CONFIDENTIAL. Use is subject to license terms.

<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema">
<!-- root element
<xs:element name="heap">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element ref="class"/>
<xs:element ref="object"/>
<xs:element ref="array"/>
<xs:element ref="stringlLiteral”/>
</xs:choice>
</xs:complexType>

: heap -->

Continued on next page
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Table 54 - continued from previous page

<!-- class element -->
<xs:element name="class">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element ref="field"/>
</xs:choice>
<xs:attribute name="name" type="xs:string” use = "required"/>
<xs:attribute name="id" type="xs:string"” use = "required"/>
<xs:attribute name="superclass" type="xs:string"/>
</xs:complexType>
</xs:element>

<!-- object element-->
<xs:element name="object">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element ref="field"/>
</xs:choice>

<xs:attribute name="id" type="xs:string"” use = "required"/>
<xs:attribute name="class" type="xs:string"” use = "required"/>
<xs:attribute name="createdAt"” type="xs:string” use = "optional”/>
<xs:attribute name="createdInThread" type="xs:string"” use = "optional”/>
<xs:attribute name="createdInMethod” type="xs:string"/>

<xs:attribute name="tag" type="xs:string"” use = "required"”/>

</xs:complexType>
</xs:element>

<!-- array element-->
<xs:element name="array" type = "arrayTypeWithAttribute"/>
<!-- stringLiteral element-->

<xs:element name="stringlLiteral”>
<xs:complexType>
<Xs:sequence>
<xs:element minOccurs ="4" maxOccurs="4" ref="field "/>
</xs:sequence>
<xs:attribute name="id" type="xs:string"” use = "required"/>
<xs:attribute name="class" type="xs:string" use = "required"/>
</xs:complexType>
</xs:element>

Continued on next page
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Table 54 - continued from previous page

<!-- field element : child of class, object and stringLiteral-->
<xs:element name="field">
<xs:complexType>

<xs:attribute name="name" type="xs:string” use = "required"/>
<xs:attribute name="id" type="xs:string"” use = "optional”/>

<xs:attribute name="value" type="xs:string"” use = "optional”/>
<xs:attribute name="type" type="xs:string” use = "optional”/>

</xs:complexType>
</xs:element>

<xs:simpleType name = "arrayType">
<xs:list itemType="xs:integer"/>
</xs:simpleType>

<!-- complex type "arrayTypeWithAttribute"”. type of array element-->
<xs:complexType name = "arrayTypeWithAttribute">
<xs:simpleContent>
<xs:extension base="arrayType">

<xs:attribute name="id" type="xs:string"” use = "required"/>
<xs:attribute name="class" type="xs:string"” use = "required"/>
<xs:attribute name="createdAt"” type="xs:string"” use = "optional”/>
<xs:attribute name="createdInThread” type="xs:string"” use = "optional”/>
<xs:attribute name="createdInMethod” type="xs:string"” use = "optional”/>
<xs:attribute name="length"” type="xs:string” use = "required"/>
<xs:attribute name="elementsType"” type="xs:string” use = "optional”/>
<xs:attribute name="type" type="xs:string" use = "optional"/>

</xs:extension>
</xs:simpleContent>
</xs:complexType>

</xs:schema>

File Specification

Types referenced in heap dumps are represented in the internal classfile format (/nternal classfile Format for Types).
Fully qualified names are names separated by the / separator (For example, a/b/C).
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Listing 12: Internal classfile Format for Types

Type = <BaseType> | <ClassType> | <ArrayType>

BaseType: B(byte), C(char), D(double), F(float), I(int), J(long), S(short), Z(boolean),
ClassType: L<ClassName>;

ArrayType: [<Type>

Tags used in the heap dumps are described in the table below.

Table 55: Tag Descriptions

Tags Attributes Description
The root element.
heap
class Element that references a Java class.
ame Class type (<ClassType>)
id Unique identifier of the class.
Identifier of the superclass of this class.
superclass
bect Element that references a Java object.
obJjec id Unique identifier of this object.
Fully qualified name of the class of this object.
class
Element that references a Java array.
array . - = -
id Unique identifier of this array.
Full lified fthecl f thi .
class ully qualified name of the class of this array
T f the el ts of thi .
elementsType ype of the elements of this array
Jength Array length.
trineliteral Element that references a java.lang.String literal.
stringLitera id Unique identifier of this object.
Id of java.lang.String class.
class
_ Element that references the field of an object or a class.
field Name of this field
name :
id Object or Array identifier, if it holds a reference.
type Type of this field, if it holds a base type.
Value of this field, if it holds a base type.
value

4.16.4 Appendix D: Architectures MCU / Compiler
Principle

The MicroEJ C libraries have been built for a specific processor (a specific MCU architecture) with a specific C com-
piler. The third-party linker must make sure to link C libraries compatible with the MicroEJ C libraries. This chapter
details the compiler version, flags and options used to build MicroEJ C libraries for each processor.

Some processors include an optional floating point unit (FPU). This FPU is single precision (32 bits) and is compli-
ant with IEEE 754 standard. It can be disabled when not in use, thus reducing power consumption. There are two
steps to use the FPU in an application. The first step is to tell the compiler and the linker that the microcontroller
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has an FPU available so that they will produce compatible binary code. The second step is to enable the FPU during
execution. This is done by writing to CPAR in the SystemInit() function. Even if there is an FPU in the proces-
sor, the linker may still need to use runtime library functions to deal with advanced operations. A program may
also define calculation functions with floating numbers, either as parameters or return values. There are several
Application Binary Interfaces (ABI) to handle floating point calculations. Hence, most compilers provide options to
select one of these ABIs. This will affect how parameters are passed between caller functions and callee functions,
and whether the FPU is used or not. There are three ABIs:

« Soft ABI without FPU hardware. Values are passed via integer registers.

«+ Soft ABlwith FPU hardware. The FPU is accessed directly for simple operations, but when a function is called,
the integer registers are used.

« Hard ABI. The FPU is accessed directly for simple operations, and FPU-specific registers are used when a
function is called, for both parameters and the return value.

It is important to note that code compiled with a particular ABI might not be compatible with code compiled with
another ABI. MicroEJ modules, including the MicroEJ Core Engine, use the hard ABI.

Supported MicroEJ Core Engine Capabilities by Architecture Matrix

The following table lists the supported MicroEJ Core Engine capabilities by MicroEJ Architectures.

Table 56: Supported MicroEJ Core Engine Capabilities by MicroEJ Ar-
chitecture Matrix

MicroEJ Core Engine Architectures Capabilities
MCU Compiler Single application | Tiny application | Multi applications
ARM Cortex-MO GCC YES YES NO
ARM Cortex-M4 IAR Embedded Workbench | YES YES YES
for ARM
ARM Cortex-M4 GCC YES NO YES
ARM Cortex-M4 Keil uVision YES NO YES
ARM Cortex-M7 IAR Embedded Workbench | YES NO YES
for ARM
ARM Cortex-M7 GCC YES NO YES
ARM Cortex-M7 Keil uVision YES NO YES
ESP32 ESP-IDF YES NO YES
ARM Cortex-M0O
Table 57: ARM Cortex-M0 Compilers
Compiler Version Flags and Options Module
GCC 4.8 flopinG22
-mabi=aapcs -mcpu=cortex-m@ -mlittle-endian -mthumb
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ARM Cortex-M4

Table 58: ARM Cortex-M4 Compilers

Compiler Version Flags and Options Module

Keil  uVi- | 5.18.0.0 flopi4A20

sion --cpu Cortex-M4.fp --apcs=/hardfp --fpmode=ieee_no_fenv

GCC 4.8 flopi4G25
-mabi=aapcs -mcpu=cortex-m4 -mlittle-endian
-mfpu=fpv4-sp-d16 -mfloat-abi=hard -mthumb

IAR  Em- | 8.32.1.18631 flopi4l35

bedded --cpu Cortex-M4F --fpu VFPv4_sp

Work-

bench for

ARM

Note: Since MicroEJ 4.0, Cortex-M4 architectures are compiled using hardfp convention call.

ARM Cortex-M7
Table 59: ARM Cortex-M7 Compilers

Compiler Version Flags and Options Module

Keil uVi- | 5.18.0.0 flopi7A21

sion --cpu Cortex-M7.fp.sp --apcs=/hardfp
--fpmode=ieee_no_fenv

GCC 4.8 flopi7G26
-mabi=aapcs -mcpu=cortex-m7 -mlittle-endian
-mfpu=fpv5-sp-d16 -mfloat-abi=hard -mthumbb

IAR  Em- | 8.32.1.18631 flopi7136

bedded --cpu Cortex-M7 --fpu VFPv5_sp

Work-

bench for

ARM
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ESP32
Table 60: Espressif ESP32 Compilers
Compiler| Version | Flagsand Options Module | Module Version
Name
GCC 5.2.0 simikoul | Any
(ESP- (crosstool- “Mlongealls
IDF) ng-
1.22.0-
80-
g6c4433a
GCC 5.2.0 simikou2| Up to 7.13.0 (in-
(ESP- (crosstoo__—mlongcalls -mfix-esp32-psram-cache-issue cluded)
IDF) ng-
1.22.0-
80-
g6c4433a
GCC 5.2.0 simikou2
(ESP- (Crosstoo__—mlongcalls -mfix-esp32-psram-cache-issue 7.13.71 or higher
IDF) ng-
1.22.0-
96-
£2852398

IAR Linker Specific Options

This section lists options that must be passed to IAR linker for correctly linking the MicroEJ object file (microejapp.
o) generated by the SOAR.

--no_range_reservations

MicroEJ SOAR generates ELF absolute symbols to define some link-time options (0 based values). By default, IAR
linker allocates a 1 byte section on the fly, which may cause silent sections placement side effects or a section
overlap error when multiple symbols are generated with the same absolute value:

Error[Lp023]: absolute placement (in [0x00000000-0x000000db]) overlaps with absolute symbol
C...]

The option --no_range_reservations tells IAR linker to manage an absolute symbol as described by the ELF
specification.

--diag_suppress=Lp029

MicroEJ SOAR generates internal veneers that may be interpreted asillegal code by IAR linker, causing the following
error:

Error[Lp029]: instruction validation failure in section "C:\xxx\microejapp.o[.text.
__icetea__virtual___Txxx#1126]": nested IT blocks. Code in wrong mode?

The option --diag_suppress=Lp029 tells IAR linker to ignore instructions validation errors.
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CHAPTER

FIVE

KERNEL DEVELOPER GUIDE

5.1 Overview

5.1.1 Introduction

The Kernel Developer’s Guide describes how to create a MicroEJ Multi-Sandbox Firmware, i.e. a firmware that can
be extended (statically or dynamically) to run and control the execution of new applications (called Sandboxed
Applications).

The intended audience of this document are java developers and system architects who plan to design and build
their own firmware.

Here is a non-exhaustive list of the activities to be done by Multi-Sandbox Firmware Developers:
+ Defining a list of APIs that will be exposed to applications
« Managing lifecycles of applications (deciding when to install, start, stop and uninstall them)
« Integrating applications (called resident applications)
+ Defining and applying permissions on system resources (rules & policies)
« Managing connectivity
« Controlling and monitoring resources

This document takes as prerequisite that a MicroEJ Platform is available for the target device (see Platform De-
veloper Guide). This document also assumes that the reader is familiar with the development and deployment of
MicroEJ Applications (see Application Developer Guide) and specifics of developing Sandboxed Applications (see
Sandboxed Application).

5.1.2 Terms and Definitions

A Resident Application is a Sandboxed Application that is linked into a Multi-Sandbox Firmware.

A Multi-Sandbox Platform is a Platform with the Multi Sandbox capability of the MicroEJ Core Engine enabled (see
the chapter Multi-Sandbox of the Platform Developer Guide). A Multi-Sandbox Firmware can only be built with a
Multi-Sandbox Platform.

A Mono-Sandbox Firmware is produced by building and linking a Standalone Application with a Platform.

A Virtual Device is the Multi-Sandbox Firmware counterpart for developing a Sandboxed Application in MicroEJ
Studio. It provides the firmware functional simulation part. Usually it also provides a mean to directly deploy a
Sandboxed Application on the target device running a Multi-Sandbox Firmware (this is called Local Deployment).
In case of dynamic application deployment, the Virtual Device must be published on MicroEJ Forge instance in
order to execute an internal batch applications build for this device.
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5.1.3 Overall Architecture
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Fig. 1: Firmware Boundary Overview
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Add-on Libraries II Applications II

Kernel Custom Kernel APls Virtual Device II
Code Tools

MicroEJ SDK

[

Firmware Binary ] [ Firmware Package ] [ Virtual Device ]
( (

(to be installed on device) to be imported in a MicroEJ Store) to be imported in MicroEl Studio)

Fig. 2: Firmware Input and Output Artifacts

Firmware Implementation Libraries

Firmware implementations must cover the following topics:

The firmware’s kernel entry point implementation, that deals with configuring the different policies, regis-
tering kernel services and converters, and starting applications.

The storage infrastructure implementation: mapping the Storage service on an actual data storage imple-
mentation. There are multiple implementations of the data storage, provided in different artifacts that will
be detailed in dedicated sections.

The applications management infrastructure: how application code is stored in memory and how the lifecy-
cle of the code is implemented. Again, this has multiple alternative implementations, and the right module
must be selected at build time to cover the specific firmware needs.

The simulation support: how the Virtual Device implementation reflects the firmware implementation, with
the help of specific artifacts.

The Kernel API definition: not all the classes and methods used to implement the firmware’s kernel are actu-
ally exposed to the applications. There are some artifacts available that expose some of the libraries to the
applications, these ones can be picked when the firmware is assembled.

The Kernel types conversion and other KF-related utilities: Kernel types instances owned by one application
can be transferred to another application through a Shared Interface. For that to be possible, a conversion
proxy must be registered for this kernel type.

Tools libraries: tools that plug into MicroEJ Studio or SDK, extending them with feature that are specific to
the firmware, like deployment of an application, a management console, ...

System Applications: pre-built applications that can be embedded as resident apps into a firmware. Some of
them are user-land counter parts of the Kernel, implementing the application lifecycle for the firmware’s ap-
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plication framework (e.g. the Wadapps Framework). These “Kernel System Applications” rely on a dedicated
set of interfaces to interact with the Kernel, this interface being defined in a dedicated module.
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5.1.4 Firmware Build Flow
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Fig. 3: Firmware Build Flow (Kernel + Resident Applications)
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5.1.5 Virtual Device Build Flow

The Virtual Device is automatically built at the same time than the firmware when using the
build-firmware-multiapp build type (see Headless Build). The Virtual Device builder performs the follow-
ing steps:

« Remove the embedded part of the platform (compiler, linker and runtime).

« Append Add-On Libraries and Resident Applications into the runtime classpath. (See /vy Configurations) for
specifying the dependencies).

« Turn the Platform (MicroEJ SDK) license to Virtual Device (MicroEJ Studio) license so that it can be freely
distributed.

« Generate the Runtime Environment from the Kernel APlIs.

[ Add-on Libraries ] [ Kernel APls ]

Virtual Device Build Application 1 ]
(build-firmware-multiapp)

Platf
[ ( ot ) ] l ¢ Application N ]

Simulator + Libs .
Validate

© Build Module

!

[ Virtual Device ]

Fig. 4: Virtual Device Build Flow

5.2 Kernel & Features Specification

Kernel & Features semantic (KF) allows an application code to be split between multiples parts: the main applica-
tion, called the Kernel and zero or more sandboxed applications called Features.

The Kernel part is mandatory and is assumed to be reliable, trusted and cannot be modified. If there is only one
application, i.e only one main entry point that the system starts with, then this application is considered as the
Kernel and called a Standalone Application. Even if there are more applications in the platform, there is still only
one entry point. This entry point is the Kernel. Applications (downloaded or preinstalled) are “code extensions”
(called “Features”), that are called by the Kernel. These Features are fully controlled by the Kernel: they can be
installed, started, stopped and uninstalled at any time independently of the system state (particularily, a Feature
never depends on an other Feature to be stopped).

The complete [KF] specification is available at http://www.e-s-r.net/download/specification/ESR-SPE-0020-KF-1.
4-F.pdf
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5.3 Getting Started

5.3.1 Online Getting Started

The MicroEJ Multi-Sandbox Firmware Getting Started is available on MicroEJ GitHub repository, at https://github.
com/MicroEJ/Example-MinimalMultiAppFirmware.

Thefile README.md provides a step by step guide to produce a minimal firmware on an evaluation board on which
new applications can be dynamically deployed through a serial or a TCP/IP connection.

5.3.2 Create an Empty Firmware from Scratch
Create a new Firmware Project

First create a new module project using the build-firmware-multiapp skeleton.

Project configuration

Configure your Easylnt project.

Project name : | myfirmware

Organization : | My crg

Madule : | myrmodule

Revision: | 0.1.0

Skeleton : |Ecum.i.sZt.easl.rant.skel.etu-ns#fi.rmwa.re-mul‘ti.a.p-p:+

9 skeleton(s) found.

A new project is generated into the workspace:
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[& Package Explorer 2 e Type Hierarchy = O
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+ & myfmard
a [ src/mainfjava
4 B myorg
« 4] Main.java
4 [P src/main/resources
|=| kernel.cert
[;f' kernel kf
> By vy moduledvy [*]
4 (= build
|=| common.properties
= dropins
v = SIC
[#] CHAMGELOG.md
[E] LICENSE.bet
by module.ivy
README.md

Setup a Platform

Before building the firmware, a target platform must be configured. The easiest way to do it is to copy a platform
file into the myfirmware > dropins folder. Such file usually ends with . jpf . For other ways to setup the input
platform to build a firmware see Change the Platform used to Build the Firmware and the Virtual Device.

Build the Firmware

In the Package Explorer, right-click on the firmware project and select Build Module . The build of the Firmware
and Virtual Device may take several minutes. When the build is succeed, the folder myfirmware > target~ >
artifacts contains the firmware output artifacts (see Firmware Input and Output Artifacts) :

mymodule.out : The Firmware Binary to be programmed on device.
mymodule.kpk : The Firmware Package to be imported in a MicroEJ Forge instance.
mymodule.vde : The Virtual Device to be imported in MicroEJ Studio.

mymodule-workingEnv.zip : This file contains all files produced by the build phasis (intermediate, debug
and report files).
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5.3.3 MicroEJ Demo VEE Flavors

This set of APIs is proposed as examples of industrial or commercial typical products APIs.

What is a MicroEJ Demo Runtime Environment?

A MicroEJ Runtime Environment defines a set of MicroEJ APIs exposed to a MicroEJ Sandboxed Application. Here
are the default runtimes provided for evaluation by MicroEJ. Any runtime can be customized with MicroEJ SDK for

a specific product.

MicroEJ Demo Run- | EDC/B- COMP/WADARARS LEDS/BUTTOMST/CONNECTHESE. | HAL | ECOM/CO
time Environment ON/KF CROUI/MWT

MicroEJ-Developer (©) © (©) © © © | ®
MicroEJ-Ul ® ® ® ® ©®© | ©
MicroEJ-Headless © © O] (©) [OIKO)
MicroEJ-BLE ® ® ® ©) O] ®© | © o

You can find below what are the different APIs included in the Runtime Environment:

API Purpose

EDC Core APIs for the execution.

B-ON Memory Usage control and Sequences start-up.

KF Required by the implementation of Shared Interfaces, an inter-application com-
munication process.

COMP or COMPONENTS Lightweight Services Framework.

WADAPPS Wadapps Application Framework.

MICROUI/MWT Main Ul library for MicroEJ and the Widgets framework based on MicroUl.

LEDS or MICROUI-LEDS

Ul library specific to LEDs.

BUTTONS or MICROUI- | Ul library specfic to buttons.
BUTTONS

NET Socket (TCP/UDP) library.

CONNECT or CONNECTIV- | Network connectivity detection library.
ITY

SSL Secure Socket Layer.

BLE Bluetooth Low Energy support.

HAL GPIO Access (digital and analog)

ECOM Device access framework.

COMM or ECOM-COMM

Serial ports support for the ECOM.

What is a MicroEJ Demo Flavor?

A MicroEJ Demo Flavor is a composition of a set of runtime services, resident applications and a given MicroEJ
Runtime Environment. Any flavor can be customized with MicroEJ SDK for a specific product.
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MicroEJ MicroEJ Runtime | Services Resident Apps Ul Resident Apps
Demo Environment
Flavor
Man- App- CommandServerNTP | About Ap- | Forge
age- Metadata- Socket pList | Connect
ment Storage
Green MicroEJ- © © © (©)
Developer
Blue MicroEJ- ©® © © © ® (@)
Developer
Red MicroEJ-Ul (@) ® ©®© | ©
Purple MicroEJ-Headless | @ (©) ©® ©)
Black MicroE J-BLE ® ® ® ® ®

You can find below what are the different System Apps included in the Flavor:

System Apps Purpose

Management Contains the implementation of Wadapps framework services, required by all VEE.

App-Metadata- Stores some Applications Metadata (icons, descriptions) so that it can be locally used by a

Storage MicroEJ Companion.

CommandServer-| Allows the deployment of MicroEJ Applications through a local network connection.

Socket

NTP Synchronizes the time of the device.

About Displays version information about the VEE.

AppList An application browser, can be used to start, stop or uninstall the applications, or display
their descriptions and version information.

Forge Connect Displays a desktop that allows the management of MicroEJ Applications using a connection
to MICROEJ FORGE.

Settings Displays the VEE parameters and settings.

5.4 Build Firmware

Prerequisite of this chapter: minimum understanding of MicroEJ Module Manager.

5.4. Build Firmware
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5.4.1 Workspace Build
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5.4.2 Headless Build
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5.4.3 Runtime Environment

A Firmware define a runtime environment which is the set of classes, methods and fields all applications are al-
lowed to use. In most of the cases the runtime environment is an aggregation of several kernel APIs built with
module project build-runtime-api skeleton.

<info organisation="myorg"” module="mymodule" status="integration"

revision="1.0.0">
<ea:build organisation="com.is2t.easyant.buildtypes” module="build-runtime-api” revision="2.+">
<ea:plugin org="com.is2t.easyant.plugins” module="clean-artifacts” revision="2.+" />
<ea:property name="clean.artifacts.max.keep” value="2" />
<ea:property name="runtime.api.name” value="RUNTIME"/>
<ea:property name="runtime.api.version” value="1.0"/>
</ea:build>

</info>

The runtime.api.name property define the name of the runtime environment (it is required by the build type) ,
and the runtime.api.version property define it version. If the property runtime.api.version is not provided
the build type computes it using the revision of the ivy module.

<dependencies>

<dependency org="com.microej.kernelapi” name="edc" rev="[1.0.4-RC0,1.0.5-RCO[" transitive="false"/>

<dependency org="com.microej.kernelapi” name="kf" rev="[2.0.1-RC0,2.0.2-RCO[" transitive="false"/>
<dependency org="com.microej.kernelapi” name="bon" rev="[1.0.4-RC0,1.0.5-RCO[" transitive="false"/>
<dependency org="com.microej.kernelapi” name="wadapps"” rev="[1.2.2-RC0,1.2.3-RCO[" transitive="false
ey
<dependency org="com.microej.kernelapi” name="components"” rev="[1.2.2-RC0,1.2.3-RCO[" transitive=
—"false"/>
</dependencies>

This runtime environment aggregate all classes, methods and fields defined by edc, kf, bon,wadapps, components
kernel APIs.

The documentation of a runtime environment is packaged into the Virtual Device as HTML javadoc ( Help >

MicroEJ Resource Center > Javadoc ).

Specify the Runtime Environment of the Firmware

While building a firmware, two ways exist to specify the runtime environment:

« Byusingone or moreivy dependencies of kernel APT artifacts. In this case we must set properties runtime.
api.name and runtime.api.version.

+ By using the ivy dependency runtimeapi module.

5.4.4 Resident Applications
A MicroEJ Sandboxed Application can be dynamically installed from a MicroEJ Forge instance or can be directly
linked into the Firmware binary at built-time. In this case, it is called a Resident Application.
The user can specify the Resident Applications in two different ways:
« Set the property build-systemapps.dropins.dir to afolder with contains all the resident applications.

+ Add ivy dependencyy on each resident application:
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<dependency org="com.microej.app.wadapps” name="management"
rev="[2.2.2-RC0,3.0.0-RCO[" conf="systemapp->application”/>

All Resident Applications are also available for the Virtual Device, if a resident application should only be available
for the Firmware, use an ivy dependency with the ivy configuration systemapp-fw instead of systemapp, like:

<dependency org="com.microej.app.wadapps” name="management" rev="[2.2.2-RC0,3.0.0-RCO[" conf="systemapp-
—fw->application”/>
5.4.5 Advanced

MicroEJ Firmware module.ivy

The following section describes module description file ( module.ivy ) generated by the
build-firmware-multiapp skeleton.

lvy info

<info organisation="org"” module="module"” status="integration”
revision="1.0.0">
<ea:build organisation="com.is2t.easyant.buildtypes” module="build-firmware-multiapp” revision="2.+
'—)“/>
<ea:property name="application.main.class” value="org.Main" />
<ea:property name="runtime.api.name” value="RUNTIME" />
<ea:property name="runtime.api.version” value="0.1.0" />
</info>

The property application.main.class is set to the fully qualified name of the main java class. The firmware
generated from the skeleton defines its own runtime environment by using ivy dependencies on several kernel
APT instead of relying on a runtime environment module. As consequence, the runtime.api.name and runtime.
api.version properties are specified in the firmware project itself.

lvy Configurations

The build-firmware-multiapp build type requires the following configurations, used to specify the different kind
of firmware inputs (see Firmware Input and Output Artifacts) as lvy dependencies.

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default” visibility="public"/>
<conf name="provided" visibility="public"/>
<conf name="platform” visibility="public"/>
<conf name="vdruntime"” visibility="public"/>
<conf name="kernelapi” visibility="private"/>
<conf name="systemapp” visibility="private"/>
<conf name="systemapp-fw" visibility="private"/>
</configurations>

The following table lists the different configuration mapping usage where a dependency line is declared:

n n n

<dependency org="..." name="..." rev="..." conf="[Configuration Mapping]"/>
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Table 1: Configurations Mapping for build-firmware-multiapp Build

Type

Configuration Mapping

Dependency Kind

Usage

provided->provided

Foundation Library (
JAR)

Expected to be provided by the platform. (e.g. ej.api.
* module)

default->default

Add-On Library ( JAR
)

Embedded in the firmware only, not in the Virtual De-
vice

vdruntime->default

Add-On Library ( JAR
)

Embedded in the Virtual Device only, not in the
firmware

default->default;
vdruntime->default

Add-On Library ( JAR
)

Embedded in both the firmware and the Virtual Device

platform->platformDev

Platform ( JPF)

Platform dependency used to build the firmware and
the Virtual Device. There are other ways to select the
platform (see Change the Platform used to Build the
Firmware and the Virtual Device)

kernelapi->default

Runtime  Environ-

ment ( JAR)

See Runtime Environment

systemapp->application

Application (WPK)

Linked into both the firmware and the Virtual Device as
resident application. There are other ways to select res-
ident applications (see Resident Applications)

systemapp-fw->application

Application (WPK)

Linked into the firmware only as resident application.

Example of minimal firmware dependencies.

The following example firmware contains one system app (management ), and defines an APl that contains all types,

methods, and fields from edc, kf,wadapps, components.

<dependencies>

<dependency org="ej.api" name="edc" rev="[1.2.0-RC0,2.0.0-RCO[" conf="provided” />

<dependency org="ej.api" name="kf" rev="[1.4.0-RC0,2.0.0-RCO[" conf="provided” />

<dependency org="ej.library.wadapps” name="framework"” rev="[1.0.0-RC0,2.0.0-RCO[" />

<dependency org="com.microej.library.wadapps.kernel” name="common-impl” rev="[3.0.0-RC0,4.0.0-RCO["_

o>

<dependency org="com.microej.library.wadapps” name="admin-kf-default” rev="[1.2.0-RC0,2.0.0-RCO[" />
<!-- Runtime API (set of Kernel API files) -->
<dependency org="com.microej.kernelapi” name="edc" rev="[1.0.0-RC0,2.0.0-RCO[" conf="kernelapi->

—default"/>

<dependency org="com.microej.kernelapi” name="kf" rev="[2.0.0-RC0,3.0.0-RCO[" conf="kernelapi->

—default”/>

<dependency org="com.microej.kernelapi” name="wadapps"” rev="[1.0.0-RC0,2.0.0-RCO[" conf="kernelapi->

—default”/>

<dependency org="com.microej.kernelapi” name="components"” rev="[1.0.0-RC0,2.0.0-RCO[" conf=

—"kernelapi->default"”/>
<!-- System apps -->

<dependency org="com.microej.app.wadapps” name="management"
rev="[2.2.2-RC0,3.0.0-RCO[" conf="systemapp->application”/>

</dependencies>

Change the set of Properties used to Build a Firmware

The build use the file build/common.properties to configure the build process.
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Change the Platform used to Build the Firmware and the Virtual Device

To build a firmware and a Virtual Device a platform must be specified. Four different ways are possible to do so:

« Use an vy dependency.

<dependency org="myorg"” name="myname" rev="1.0.0" conf="platform->platformDev"” transitive="false"/
>

« Copy/Paste a platform file into the folder defined by the property platform-loader.target.platform.
dropins (by default it valueis dropins).

« Setthe property platform-loader.target.platform.file.

<ea:property name="platform-loader.target.platform.file"” value="/path-to-a-platform-file/" />

+ Setthe property platform-loader.target.platform.dir.

<ea:property name="platform-loader.target.platform.dir” value="/path-to-a-platform-folder/" />

Build only a Firmware

Set the property skip.build.virtual.device

<ea:property name="skip.build.virtual.device” value="SET" />

Build only a Virtual Device

Set the property virtual.device.sim.only

<ea:property name="virtual.device.sim.only"” value="SET" />

Build only a Virtual Device with a pre-existing Firmware

Copy/Paste the .kpk file into the folder dropins

5.5 Writing Kernel APIs

This section lists different ways to help to write kernel.api files.

5.5.1 Default Kernel APIs Derivation
MicroEJ provides predefined kernel API files for the most common libraries provided by a Kernel. These files are
packaged as MicroEJ modules under the com/microej/kernelapi organisation.

The packaged file kernel.api can be extracted from the JAR file and edited in order to keep only desired types,
methods and fields.
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5.5.2 Build a Kernel API Module

« First create a new module project using the microej-kernelapi skeleton.

« Create the kernel.api fileintothe src folder.

+ Right-click on the project and select Build Module .

5.5.3 Kernel APl Generator

MicroEJ Kernel API Generator is a tool that help to generate a kernel.api file based on a Java classpath.

In MicroEJ SDK, create a new MicroEJ Tool launch, Run > Run Configurations > MicroEJ Tool , choose your

Platform, select Kernel APl Generator forthe Settings options, and don’t forget to set the output folder.

Create. manage. and run configurations

»

CExX| 8-

Mame: | Wy Kernel AP

‘ type filter text

C/C++ Application
Ju JUnit
= Launch Group
3] MicroEJ Application
4 [g MicrokE) Tool
D& My Kernel API

Filter matched & of 13 items

4 Execution . Il Configuratio

rq = JRE} 5= Qommorq

Target

Execution

Settings: | Kernel APl Generator

v

Kemnel AP Generator.

Options

Output folder: | S{workspace_loc}/kemelapi

| | Browse... |

Clean intermediate files

[[]verbose

Apply

©)

‘ | Close |

Define the classpath to use in the Configuration tab, and Press Run . A kernel.api file is generated in the

output folder and it contains all classes, methods and fields found in the given classpath.
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Category: Kernel APl Generator

Kernel AP| Generator Classpath

Add Jar...

Add Class Folder...

Remove

Types Filters

Includes Patterns: ‘ “=i*class ‘

Excludes Patterns: | ‘

Group: Classpath
Option(list):

Option Name: kernel.api.generator.classpath

Default value: (empty)

Group: Types Filters
Option(text): Includes Patterns

Option Name: kernel.api.generator.includes.patterns
Default value: **/*.class

Description: Comma separated list of ANT Patterns for types to include.

Option(text): Excludes Patterns

Option Name: kernel.api.generator.excludes.patterns
Default value: (empty)

Description: Comma separated list of ANT Patterns for types to exclude.
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5.6 Communication between Features

Features can communicate together through the use of shared interfaces. The mechanism is described in Chapter
Shared Interfaces of the Application Developer’s Guide.

5.6.1 Kernel Type Converters

The shared interface mechanism allows to transfer an object instance of a Kernel type from one Feature to an other.
To do that, the Kernel must register a new converter (See AP/ Documentation Kernel.addConverter() method).

5.7 APl Documentation

The full APl documentation of the Kernel & Features Foundation Library is available in MicroEJ SDK ( Help >

MicroEJ Resource Center > Javadoc > KF [version] ).

5.8 Multi-Sandbox Enabled Libraries

A multi-Sandbox enabled library is a foundation or Add-On Library which can be embedded into the kernel and
exposed as API. MicroEJ Foundation Libraries provided in MicroEJ SDK are already multi-Sandbox enabled. A state-
less library - i.e. a library that does not contain any method modifying an internal global state - is multi-Sandbox
enabled by default.

This section details the multi-Sandbox semantic that have been added to MicroEJ Foundation Libraries in order to
be multi-Sandbox enabled.

5.8.1 MicroUl

Physical Display Ownership
The physical display is owned by only one context at a time (the Kernel or one Feature). The following cases may
trigger a physical display owner switch:

« during a call to ej.microui.display.Displayable.show() : after the successful permission check, it is
assigned to the context owner.

« duringacallto ej.microui.display.Display.callSerially(java.lang.Runnable) : after the successful
permission check it is assigned to owner of the Runnable instance.

The physical display switch performs the following actions:

« Ifa Displayable instance is currently shown on the Display,the method Displayable.becomeHidden()
is called.

« All pending events (input events, display flushes, call serially runnable instances) are removed from the dis-
play event serializer

« System Event Generators handlers are reset to their default ej.microui.util.EventHandler instance.
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Automatically Reclaimed Resources

Instances of ej.microui.display.Image, ej.microui.display.Font are automatically reclaimed when a Fea-
ture is stopped.

5.8.2 ECOM

The ej.ecom.DeviceManager registry allows to share devices across Features. Instances of ej.ecom.Device that
are registered with a shared interface type are made accessible through a Proxy to all other Features that embed
the same shared interface (or an upper one of the hierarchy).

5.8.3 ECOM-COMM

Instances of ej.ecom.io.CommConnection are automatically reclaimed when a Feature is stopped.

5.8.4 FS

Instances of java.io.FileInputStream, java.io.FileOutputStream are automatically reclaimed when a Fea-
ture is stopped.

5.8.5 NET

Instances of java.net.Socket, java.net.ServerSocket, java.net.DatagramSocket are automatically re-
claimed when a Feature is stopped.

5.8.6 SSL

Instances of javax.net.ssl.SSLSocket are automatically reclaimed when a Feature is stopped.

5.9 Setup a KF Testsuite

A KF testsuite can be executed when building a Foundation Library or an Add-On library, and usually extends the
tests written for the default library testsuite to verify the behavior of this library when its APIs are exposed by a
Kernel.

A KF testsuite is composed of a set of KF tests, each KF test itself is a minimal MicroEJ Multi-Sandbox Firmware
composed of a Kernel and zero or more Features.

5.9.1 Enable the Testsuite

In an existing library project:
« Createthe src/test/projects directory,

+ Editthe module.ivy and insert the following line within the <ea:build> XML element:

<ea:plugin organisation="com.is2t.easyant.plugins” module="microej-kf-testsuite” revision="+" />
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5.9.2 Add a KF Test

A KF test is a structured directory placed in the src/test/projects directory.
« Create a new directory for the KF test
« Within this directory, create the sub-projects:
- Create a new module project for the Kernel using the microej-javalib skeleton,
- Create a new module project for the Feature using the application skeleton,
- Create a new module project for the Firmware using the firmware-multiapp skeleton.

The names of the project directories are free, however MicroEJ suggests the following naming convention, assum-
ing the KF test directory is [TestName] :

« [TestName]-kernel forthe Kernel project,
+ [TestName]-app[1..N] for Feature projects,
o [TestName]-firmware forthe Firmware project.

The KF Testsuite structure shall be similar to the following figure:
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v '_._'—‘,,J- KfProject
(= src/main/java
i src/main/resources
(B sroftest/java
B sroftest/resources
Bl vy module.ivy [*]
[= internal
W = src
i=> main
w = test
w [= projects
w = FirstTest
w [= FirstTest-app1
= META-IMF
= src
CHANGELOG.md

|=| LICEMSE txt
by module.ivy
README.md
[ FirstTest-app2
w [ FirstTest-firmware
[= build
= dropins
= =rc
CHAMGELOG.md
|=| LICEMSE txt
by module.ivy
README.md
w = FirstTest-kernel
= internal
= src
CHAMGELOG.md
|=| LICEMSE txt
by module.ivy
README.md
= SecondTest
= ThirdTest
[= src-adpgenerated
CHAMGELOG.md
|=| LICEMSE txt
by moduledvy
[#

README.md
Fig. 6: KF Testsuite Overall Structure

All the projects will be built automatically in the right order based on their dependencies.
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5.9.3 KF Testsuite Options

It is possible to configure the same options defined by Testsuite Options for the KF testsuite, by using the prefix
microej.kf.testsuite.properties instead of microej.testsuite.properties.
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CHAPTER

SIX

TUTORIALS

6.1 Understand How to Build a MicroEJ Firmware and its Dependencies

A MicroEJ Firmware is built from several input resources and tools. Each component has dependencies and re-

quirements that must be carefully respected in order to build a firmware.

This document describes the components, their dependencies and the process involved in the build of a MicroEJ

Firmware.

Good knowledge of the MicroEJ Glossary is required.

6.1.1 The Components

As depicted in the following image, several resources and tools are used to build a MicroEJ Firmware.

8 Developer Setup

MicroEJ SDK IDE

MicroEJ Repository

MicroEJ Architecture

SDK Workspace

Platform Projects

Java Projects
MicroEJ Module

EL ET-( ¢
(MMM)

C Toolchain

MicroEJ
Firmware

Import required
MicroEJ Architecture & Packs

\H] MicroEJ Resources

s ™\
MicroEJ Architecture

Foundation Libraries

Import platform in workspace

\. /
s ™

BSP C Drivers

Import Java application in workspace

Import offline repository (optional)

Platform
Configuration

MicroEJ Application

Offline Repository

Update Module Settings

MicrokEJ
Central
Repository
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MicroEJ Architecture (.xpf, .xpfp)
A MicroEJ Architecture contains the runtime port to a target instruction set (ISA) and a C compiler (CC) and MicroEJ
Foundation Libraries.
The MicroEJ Architectures are distributed into two formats:
+ EVAL: evaluation license with runtime limitations (explained in SDK developer guide).
« PROD: production license (only MicroEJ sales & Customer Care team distribute this version).

The supported MicroEJ Architectures are listed here https://developer.microej.com/
mej32-embedded-runtime-architectures/#arch

The MicroEJ Architecture is either provided from:
« For EVAL license only: the MicroEJ Repository at https://repository.microej.com/architectures/

« For PROD license only: SDK license site https://license.microej.com/ (  MyProduct >

Download additional products  will list the downloads available). See Production Licenses for help
with PROD license.

« MicroEJ sales or customer care team if the requested architecture is not listed as available.

See MicroEJ Architecture Import for a description on how to import a MicroEJ Architecture.

MicroEJ Platform Source (.zip)

This package includes:
« a CBoard Support Package (BSP) with C drivers and an optional RTOS
« a MEJ32 Architecture
« the abstraction layers implementation of the platform architecture and foundations libraries
+ the MicroEJ Simulator and its associated MicroEJ Mocks
The platform .zip files contain:
« <platform>-configuration : The configuration of the MicroEJ Platform
o <platform>-bsp: The C code for the board-specific files (drivers).
« <platform>-fp: Front panel mockup for the simulator.

See MicroEJ Platform Creation to learn how to create a MicroEJ Platform using a MicroEJ Platform Source project.

Depending on the project’s requirements, the MicroEJ Platform can be connected in various ways to the BSP; see
BSP Connection for more information on how to do it.

MicroEJ Application

A MicroEJ Application is a Java project that can be configured (in the Run configurations... properties):
1. to either run on:
« asimulator (computer desktop),
« adevice (actual embedded hardware).

2. to setup:
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« memory (example: Java heap, Java stack),
« foundation libraries,

» etc.

To run on a device, the application is compiled and optimized for a specific MicroEJ Platform. It generates a
microejapp.o (native object code) linked with the <platform>-bsp project.

To import an existing MicroEJ Application as a zipped project in the SDK:
« Goto File > Import... > General > ExistingProjectsinto Workspace > Select archivefile >
Browse... .
« Select the zip of the project (e.g. x.zip).
« And select Finish import.

See Create a MicroEJ Standalone Application for more information on how to create, configure, and develop a Mi-
croEJ Application.

C Toolchain (GCC, KEIL, IAR, ...)
Used to compile and link the following files into the final firmware (binary, hex, elf, ... that will be programmed on
the hardware):

« the microejapp.o (application),

« the microejruntime.lib or microejruntime.a (platform),

« the BSP Cfiles (drivers).

Module Repository

A Module Repository provides the modules required to build MicroEJ Platforms and MicroEJ Applications.

« The MicroEJ Central Repository is an online repository of software modules (libraries, tools, etc.), see https:
//repository.microej.com/. This repository can also be used as an offline repository, see https://developer.
microej.com/central-repository/.

« (Optional) It can be extended with an offline repository ( .zip ) that can be imported in the workspace (see
Use the Offline Repository):

See Module Repository for more information.

Dependencies Between Components

+ A MicroEJ Architecture targets a specific instruction set (ISA) and a specific C compiler (CC).

- The Ctoolchain used for the MicroEJ Architecture must be the same as the one used to compile and link
the BSP project and the MicroEJ Firmware.

+ A MicroEJ Platform consists of the aggregation of both a MicroEJ Architecture and a BSP with a C toolchain.
- Changing either the MicroEJ Architecture or the C toolchain results in a change of the MicroEJ Platform.
« A MicroEJ Application is independent of the MicroEJ Architecture.

- It can run on any MicroEJ Platform as long the platform provides the required APIs.
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- To run a MicroEJ Application on a new device, create a new MicroEJ Platform for this device with the
exact same features. The MicroEJ Application will not require any change.

6.1.2 How to Build

The process to build a MicroEJ Firmware is two-fold:
1. Build a MicroEJ Platform
2. Build a MicroEJ Application

The MicroEJ Application is compiled against the MicroEJ Platform to produce the MicroEJ Firmware deployed on
the target device.

Note: The MicroEJ Application also runs onto the MicroEJ Simulator using the mocks provided by the MicroEJ
Platform.

Build a MicroEJ Platform

The next schema presents the components and process to build a MicroEJ Platform.

Foundation Libraries Foundation Libraries Mockups

S D
Foundation Libraries
Abstraction Layer

H

MicroEJ Architecture
{MEJ32 Core + Built-in Foundation
Libraries + Simulator + Mockups)

Java Java/C

l (java, .list, resources) l (.java, .c)

Platform Configuration

Java Compiler Java/C Compiler
l (.xml, .properties) (.a, .jar, .h) l (-jar) l (.exe, jar) (.h, .c)

MicroEJ SDK (Platform Builder)

MicroEJ Platform

MEJ32 Core Simulator +

Java Mockups Scripts +
Foundation Tooling +
Libraries Documentation

@ MEJ3?
LAAARRAA)

Build a MicroEJ Firmware
The next schema presents the steps to build a MicroEJ Mono-Sandbox Firmware (previously known as MicroEJ
Single-app Firmware). The steps are:

1. Build the MicroEJ Application into a microejapp.o using MicroEJ SDK

2. Compile the BSP C sourcesinto .o usingthe C toolchain

3. the BSP ( .0) and the MicroEJ Application (microejapp.o ) and the MicroEJ Platform (microejruntime.a)
are linked by the Ctoolchain to produce afinal ELF or binary called MicroEJ Firmware (e.g. application.out

).
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C Code 6
BSP code C Libraries

NEVEIRSIELES

MicroEJ Platform Add-on Libraries

Abstraction Layer Legacy C Libraries
+ MicroEJ Startup

l (.h, .c) @
C Compiler

MicroEJ SDK (App Builder)

(microejruntime.a, microejapp.o)

ELF Linker

3 Firmware
MEJ32 Core
LALALANL

Java BSP code
Application Ccode

See BSP Connection for more information on how to connect the MicroEJ Platform to the BSP.

Dependencies Between Processes

+ Rebuild the MicroEJ Platform:
- When the MicroEJ Architecture ( . xpf ) changes.
- When a MicroEJ Foundation Library ( . xpfp ) changes.
- When a Foundation Library changes, either when
* The public API( . java or .h)changes.
* The front-panel or mock implementation ( . java ) changes.
+ Rebuild of the MicroEJ Platform is not required:
- When the implementation ( . c ) of a Foundation Library changes.
- When the BSP ( .c) changes.
- When the MicroEJ Application changes.
+ Rebuild MicroEJ Application:
- When it changes.
- When the MicroEJ Platform changes.
+ Rebuild the BSP:
- When it changes.
- When the MicroEJ Platform changes.

 Rebuild the MicroEJ Firmware:
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- When the MicroEJ Application (microejapp.o) changes.
- When the BSP ( x.0) changes.

- When the MicroEJ Platform (microejruntime.a) changes.

6.1.3 Get Support

If any questions, feel free to contact our support team with the following information (the table below is an exam-
ple):

Delivery Name

MicroEJ SDK Distribution 20.07 / Version 5.2.0 (see Determine the MicroEJ Studio/SDK
Version)

MEJ32 XPF ARM Cortex-M4 / |IAR DEV

Platform 1.0.0

Application 1.2.4

Module Repository https://repository.microej.com/packages/repository/2.5.0/microej-5_
0-2.5.0.zip

C compiler IAR 8.40.1

6.2 Create a MicroEJ Platform for a Custom Device

6.2.1 Introduction

A MicroEJ Architecture is a software package that includes the MicroEJ Runtime port to a specific target Instruction
Set Architecture (ISA) and C compiler. It contains a set of libraries, tools and C header files. The MicroEJ Architec-
tures are provided by MicroEJ SDK.

A MicroEJ Platform is a MicroEJ Architecture port for a custom device. It contains the MicroEJ configuration and
the BSP (C source files).

MicroEJ Corp. provides MicroEJ Evaluation Architectures at https://repository.microej.com/architectures/, and
MicroEJ Platform demo projects for various evaluation boards at https://repository.microej.com/index.php?
resource=JPF.

We recommend reading the MicroEJ Firmware section to get an overview of MicroEJ Firmware build flow.

The following document assumes the reader is familiar with the Platform Developer Guide.

Each MicroEJ Platform is specific to:
« a MicroEJ Architecture (MCU ISA and C compiler)
« an optional RTOS (e.g. FreeRTOS - note: the MicroEJ OS can run bare metal)

+ adevice: the OSbring up code thatis device specific (e.g. the MCU specific code/IO/RAM/Clock/Middleware...
configurations)

In this document we will address the following items:
+ MicroEJ Platform Configuration project (in MicroEJ SDK)
« MicroEJ Simulator (in MicroEJ SDK)
« Platform BSP (in a C IDE/Compiler like GCC/KEIL/IAR)
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The MicroEJ Platform relies on C drivers (aka low level LL drivers) for each of the platform feature. These drivers are
implemented in the platform BSP project. This project is edited in the C compiler IDE/dev environment (e.g. KEIL,
GCC, IAR). E.g. the MicroUl library LED feature will require a LLLEDS. c thatimplements the native on/off IO drive.

The following sections explain how to create a MicroEJ Platform for a custom device starting from an existing Mi-
croEJ Platform project whether it is configured for the same MCU/RTOS/C Compiler or not.

In the following, we assume that the new device hardware is validated and at least a trace output is available. It is
also a good idea to run basic hardware tests like:

« Internal and external flash programming and verification
« RAM 8/16/32 -bit read/write operations (internal and external if any)
« EEMBC Coremark benchmark to verify the CPU/buses/memory/compiler configuration

+ See the Platform Qualification Tools used to qualify MicroEJ Platforms.

6.2.2 A MicroEJ Platform Project is already available for the same MCU/RTOS/C Compiler

This is the fastest way: the MicroEJ Platform is usually provided for a silicon vendor evaluation board. Import this
platform in MicroEJ SDK.

As the MCU, RTOS and compiler are the same, only the device specific code needs to be changed (external RAM,
external oscillator, communication interfaces).

Platform

In MicroEJ SDK

« modifythe .platform fromthe MicroEJ Platform (xxx-configuration project)to matchthe device features
and its associated configuration (e.g. UI->Display ).

Mame

[] Multi Applications
[] Serial Communication
~ [m] Ul

Display
Font Designer
Font Generator
Front Panel
Image BMP Monochrome Decoder
Image Generator
Image PNG Decoder
Inputs
[] LEDs
MicroUl

More details on available modules can be found in the Platform Developer Guide.

BSP

Required actions:

« modify the BSP C project to match the device specification
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- edit the scatter file/link options
- edit the compilation options

« create/review/change the platform Low Level C drivers. They must match the device components and the
MCU 10 pin assignment

Note: Anumberof LLx.h files are referenced from the project. Implement the function prototypes declared
there so that the JVM can delegate the relevant operations to the provided BSP C functions.

Simulator

In MicroEJ SDK

« modify the existing Simulator front panel xxx-fp project

6.2.3 A MicroEJ Platform Project is not available for the same MCU/RTOS/C Compiler

Look for an available MicroEJ Platform that will match in order of priority:
« same MCU part number
« same RTOS
« same C compiler
At this point, consider either to modify the closest MicroEJ Platform
+ In MicroEJ SDK: modify the platform configuration.
« in the CIDE: start from an empty project that match with the MCU.
Or to start from scratch a new MicroEJ Platform

« In MicroEJ SDK: create the MicroEJ Platform and refer to the selected MicroEJ Platform as a model forimple-
mentation. (refer to MicroEJ Platform Configuration)

« in the CIDE: start from an empty project and implement the drivers of each of the LL drivers API.
Make sure to link with:
- the microejruntime.a thatrunsthe JVM for the MCU Architecture

- the microejapp.o that contains the compiled Java application

MCU

The MCU specific code can be found:
» inthe C project IDE properties
« inthe linker file
+ the 10 configuration

« in the low level driver (these drivers are usually provided by the silicon vendor)
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RTOS

The LL driver is named LLMJVM_RTOS.c/.h . Modify this file to match the selected RTOS.

C Compiler

The BSP project is provided for a specific compiler (that matches the selected platform architecture). Start a new
project with the compiler IDE that includes the LL drivers and start the MicroEJ Platform in the main() function.

6.2.4 Platform Validation

Use the Platform Qualification Tools to qualify the MicroEJ Platform built.

6.2.5 Further Assistance Needed

Please note that porting MicroEJ to a new device is also something that is part of our engineering services. Consider
contacting sales@microej.com to request a quote.

6.3 Create a MicroEJ Firmware From Scratch

This tutorial explains how to create a MicroEJ Firmware from scratch. It goes trough the typical steps followed by
a Firmware developer integrating MicroEJ with a C Board Support Package (BSP) for a target device.

In this tutorial, the target device is a a Luminary Micro Stellaris. Though this device is no longer available on the
market, it has two advantages:

« The QEMU PC System emulator can emulate the device.
+ FreeRTOS provides an official Demo BSP.
Consequently, no board is required to follow this tutorial. Everything is emulated on the developer’s PC.

Thetutorial should take 1hour to complete (excluding the installation time of MicroEJ SDK and Windows Subsystem
Linux (WSL)).

6.3.1 Intended Audience

The audience for this document is Firmware engineers who want to understand how MicroEJ is integrated to a C
Board Support Package.

In addition, this tutorial should be of interest to all developers wishing to familiarize themselves with the low level
components of a MicrokEJ Firmware such as: MicroEJ Architecture, MicroEJ Platform, Low Level APl and BSP connec-
tion.

6.3.2 Introduction

The following steps are usually followed when starting a new project:
1. Pick a target device (that meets the requirements of the project).
2. Setup a RTOS and a toolchain that support the target device.
3. Adapt the RTOS port if needed.
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. Install a MicroEJ Architecture that matches the target device/RTOS/toolchain.

4
5. Setup a new MicroEJ Platform connected to the Board Support Package (BSP).
6. Implement Low Level API.

T

. Validate the resulting MicroEJ Platform with the Platform Qualification Tools (PQT).

8. Develop the MicroEJ Application.

This tutorial describes step by step how to go from the FreeRTOS BSP to a MicroEJ Application that runs on the
MicroEJ Platform and prints the classic "Hello, World!".

In this tutorial:
+ The target device is a Luminary Micro Stellaris which is emulated by QEMU (QEMU Stellaris boards).
« The RTOS is FreeRTOS and the toolchain is GNU CC fo ARM.

All modifications to FreeRTOS BSP made for this tutorial are available at https://github.com/MicroEJ/FreeRTOS/
tree/tuto-microej-firmware-from-scratch.

Note: The implementation of the Low Level API and their validation with the Platform Qualification Tools (PQT)
will be the topic of another tutorial.

6.3.3 Prerequisites

MicroEJ SDK version 5.1.0 or higher (distribution 19.05). Can be downloaded from https://developer.microej.
com/ (direct link)

« Windows 10 with Windows Subsystem for Linux (WSL). See the installation guide.
« A Linux distribution installed on WSL (Tested on Ubuntu 19.10 eoan and Ubuntu 20.04 focal).

Note: In WSL, use the command 1sb_release -a to print the current Ubuntu version.

A code editor such as Visual Studio Code is also recommended to edit BSP files.

6.3.4 Overview
The next sections describe step by step how to build a MicroEJ Firmware that runs a HelloWorld MicroEJ Application
on the emulated device.
The steps to follow are:
1. Setup the development environment (assuming the prerequisites are satisfied).
2. Getarunning BSP
3. Build the MicroEJ Platform
4, Create the HelloWorld MicroEJ Application
5. Implement the minimum Low Level API to run the application

This tutorial goes through trials and errors every Firmware developers may encounter. It provides a solution after
each error rather than providing the full solution in one go.

6.3. Create a MicroEJ Firmware From Scratch 356


https://github.com/microej/PlatformQualificationTools
https://www.qemu.org/docs/master/system/arm/stellaris.html
https://github.com/MicroEJ/FreeRTOS/tree/tuto-microej-firmware-from-scratch
https://github.com/MicroEJ/FreeRTOS/tree/tuto-microej-firmware-from-scratch
https://github.com/microej/PlatformQualificationTools
https://developer.microej.com/
https://developer.microej.com/
https://repository.microej.com/packages/SDK/19.05/MicroEJ-SDK-Installer-Win64-19.05.exe
https://docs.microsoft.com/en-us/windows/wsl/install-win10

MicroEJ Documentation, Revision 4€20bb27

6.3.5 Setup the Development Environment

This section assumes the prerequisites have been properly installed.

In WSL:

1.
2.

Update apt’s cache: sudo apt-get update

Install gemu-system-arm and GNU CC toolchain for ARM: sudo apt-get install -y gemu-system-arm
gcc-arm-none-eabi build-essential subversion

The rest of this tutorial will use the folder src/tuto-from-scratch/ in the Windows home folder.

Create the folder: mkdir -p /mnt/c/Users/${USER}/src/tuto-from-scratch (the -p option ensures all
the directories are created).

Go into the folder: cd /mnt/c/Users/${USER}/src/tuto-from-scratch/

Clone FreeRTOS and its submodules: git clone -b V10.3.1 --recursive https://github.com/
FreeRTOS/FreeRT0S.git (this may takes some time)

Note: Use the right-click to paste from the Windows clipboard into WSL console. The right-click is also used to
copy from the WSL console into the Windows clipboard.

6.3.6 Get Running BSP

This section presents how to get running BSP based on FreeRTOS that boots on the target device.

1.
2.

Go into the target device sub-project: cd FreeRTOS/FreeRT0S/Demo/CORTEX_LM3S811_GCC
Build the project: make

Ignoring the warnings, the following error appears during the link:

cC hw_include/osram96x16.c

LD gcc/RTOSDemo. axf

arm-none-eabi-1d: section .text.startup LMA [0000000000002b24,0000000000002c8f] overlaps section .
—data LMA [0000000000002b24,0000000000002b27]

make: *** [makedefs:191: gcc/RTOSDemo.axf] Error 1

Insert the following fixes in the linker script file named standalone.ld (thanks to http://roboticravings.
blogspot.com/2018/07/freertos-on-cortex-m3-with-gemu.html).

Note: WSL can start the editor Visual Studio Code. type code . in WSL. . represents the current directory
in Unix.

diff --git a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/standalone.ld b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/
—standalone.1ld

index 8ee3fe2f8..b771ff834 100644
--- a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/standalone.1d
+++ b/FreeRT0S/Demo/CORTEX_LM3S811_GCC/standalone.1ld
@@ -42,7 +42,15 @@ SECTIONS
_etext = .;
} > FLASH

(continues on next page)
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.data : AT (ADDR(.text) + SIZEOF(.text))

.ARM.exidx :

{
*(.ARM. exidx*)
*(.gnu.linkonce.armexidx.x)

(continued from previous page)

+ + + + 4+ + + o+ +

{

.data :

} > FLASH

_begin_data

_data =

L

AT ( _begin_data )

L

*(vtable)

Thisisthe outputofthe git diff command. Lines startingwitha - should be removed. Lines starting with
a + should be added.

Note:

CORTEX_LM3S811_GCC directory:

The patch(1) can be used to apply the patch. Assuming WSL shell is in FreeRTOS/Demo/

1. Install dos2unix utility: sudo apt install dos2unix

2. Convert all files to unix line-ending: find -type f -exec dos2unix {} \;

3. Copy the content of the code block in a file named linker.patch (every lines of the code block must
be copied in thefile).

4. Apply the patch: patch -1 -p4 < linker.patch.

Itis also possible to paste the diff directly into the console:

1. In WSL, invoke patch -1 -p4.The command starts, waiting for input on stdin (the standard input).

. Copy the diff and paste itin WSL

2
3. Press enter
4

. Press Ctrl-d Ctrl-d (pressthe Control key +the letter d twice).

3. Run the build again: make

4. Run the emulator with the generated kernel: gemu-system-arm -M 1m3s811evb -nographic -kernel
gcc/RTOSDemo.bin

The following error appears and then nothing:

$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:

error:
error:
error:
error:
error:
error:
error:
error:
error:
error:
error:
error:
error:

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

0x80
oxe3
0x80
oxe3
0x80
Oxe3
0x80
oxe3
0x80
oxe3
0x80
Oxe3
0x80
(continues on next page)
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$sd0303:
$sd0303:
$sd0303:
$sd0303:
$sd0303:

error:
error:
error:
error:
error:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

oxe3
0x80

oxe3
0x80

Oxe3

(continued from previous page)

5. Press Ctrl-a x (press Control +the letter a, release, press x ) to the end the QEMU session. The session
ends with QEMU: Terminated.

Note: The errors can be safely ignored. They occur because the OLED controller emulated receive incorrect
commands.

At this point, the target device is successfully booted with the FreeRTOS kernel.

6.3.7 FreeRTOS Hello World

This section describes how to configure the BSP to print text on the QEMU console.

The datasheet of the target device (LM3S811 datasheet) describes how to use the UART device and an example
implementation for QEMU is available here).

The following code implements the putchar(3) and puts(3) functions:

#define UARTOBASE ((volatile intx) 0x4000C000)

int putchar (int c){
(*UARTOBASE) = c;

return c;

3

int puts(const char *s) {
while (xs) {
putchar(*s);

S+t

’

}

return putchar('\n');

And here is the patch that implements both functions and prints Hello World.

diff --git a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/main.c b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
index 107517c00. .3ea4c23a4 100644
--- a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/main.c
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
@@ -134,9 +134,25 @@ SemaphoreHandle_t xButtonSemaphore;
QueueHandle_t xPrintQueue;

+#define UARTOBASE ((volatile intx) 0x4000C000)

+

+int putchar (int c){

+  (%UARTOBASE) = c;

+ return c;

+}

(continues on next page)
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+

+int puts(const

+ while (*s)

+ putchar
+ S++;

+ 3

+ return putc

+}

int main( void

{

+ puts(”"Hello, World! puts function is working.");

/* Configure the clocks, UART and GPIO. */

prvSetupHard

char xs) {
{
(*s);

har('\n");

)

ware();

(continued from previous page)

Rebuild and run the newly generated kernel: make && qgemu-system-arm -M 1m3s811evb -nographic -kernel

gcc/RTOSDemo. bin (press Ctrl-a x tointerrupt the emulator).

make: Nothing to be done for 'all'.

Hello, World! puts function is working.
Unknown command:

$sd0303: error:
ssd@303: error:
ssd@303: error:
$sd0303: error:
ssd@303: error:
ssd@303: error:
$sd0@303: error:
ssd@303: error:
ssd@303: error:
$sd0303: error:
ssd@303: error:
ssd@303: error:
$sd0303: error:
ssd@303: error:
ssd@303: error:
$sd0303: error:
ssd@303: error:
ssd@303: error:
QEMU: Terminated

With this two functions implemented, printf(3) isalso available.

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

Unknown command:

Unexpected byte

0x80
oxe3
0x80
Oxe3
0x80
oxe3
0x80
Oxe3
0x80
Oxe3
0x80
Oxe3
0x80
oxe3
0x80
oxe3
0x80
Oxe3

diff --git a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/main.c b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
index 76440e60e..f24007597 100644

--- a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/main.c
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
@@ -149,9 +149,11 @@ int puts(const char #*s) {

return p

+#include <stdio
+
int main( void

{

= puts(”"Hello, World! puts function is working.");

utchar('\n");

.h>

)

(continues on next page)
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(continued from previous page)

+ printf("Hello, World! printf function is working.\n");

/* Configure the clocks, UART and GPIO. */
prvSetupHardware();

At this point, the character output on the UART is implemented in the FreeRTOS BSP. The next step is to create the
MicroEJ Platform and MicroEJ Application.

6.3.8 Create a MicroEJ Platform

This section describes how to create and configure a MicroEJ Platform compatible with the FreeRTOS BSP and GCC
toolchain.

+ A MicroEJ Architecture is a software package that includes the MicroEJ Runtime port to a specific target In-
struction Set Architecture (ISA) and C compiler. It contains a set of libraries, tools and C header files. The
MicroEJ Architectures are provided by MicroEJ SDK.

+ A MicroEJ Platform is a port of a MicroEJ Architecture for a custom device. It contains the MicroEJ configura-
tion and the BSP (C source files).

When selecting a MicroEJ Architecture, special care must be taken to ensure the compatibility between the
toolchain used in the BSP and the toolchain used to build the MicroEJ Core Engine included in the MicroEJ Ar-
chitecture.

The list of MicroEJ Architectures supported is listed at https://docs.microej.com/en/latest/
PlatformDeveloperGuide/appendix/toolchain.html.  MicroEJ Evaluation Architectures provided by MicroEJ
Corp. can be downloaded from MicroEJ Architectures Repository.

There is no CM3 in MicroEJ Architectures Repository and the Arm® Cortex®-M3 MCU is not mentioned in the ca-
pabilities matrix. This means that the MicroEJ Architectures for Arm® Cortex®-M3 MCUs are no longer distributed
for evaluation. Download the latest MicroEJ Architecture for Arm® Cortex®-MO instead (the Arm® architectures are
binary upward compatible from Arm®v6-M (Cortex®-MO0) to Arm®v7-M (Cortex®-M3)).

Import the MicroEJ Architecture

This step describes how to import a MicroEJ Architecture.

1. Start MicroEJ SDK on an empty workspace. For example, create an empty folder workspace next to the
FreeRTOS git folder and select it.

2. Keep the default MicroEJ Repository

3. Download the latest MicroEJ Architecture for Arm® Cortex®-MO instead: https://repository.microej.com/
architectures/com/microej/architecture/CM0/CM0_GCC48/flopi0G22/7.11.0/flopi0G22-7.11.0-eval.xpf

4. Import the MicroEJ Architecture in MicrokJ SDK
1. File > Import > MicroEJ > Architectures

2. select the MicroEJ Architecture file downloaded

3. Accept the license and click on Finish
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Target:
Mame Verzion Select All
, 7
f,'a ARM Cortex-P0 GCC EVAL 7110 Deselect All
MICROE) LICEMSE AGREEMEMNT P
PREAMELE

THIS SOFTWARE LICEMSE AGREEMEMNT (THE « AGREEMENT ») APPLIES TO PRODUCTS LICENSEL
On purchase of any Licensed Product from 152T or an 52T Partner or an (52T Distributor, the rel:
THE LICEMSEE, AS A USER OF THE LICEMSED PRODUCTS REFERRED TO ABOVE AMD ON THE REL
1 DEFINITIOMNS

< >

[]| agree and accept the above terms and conditions and | want to install the copyrighted Software

'i?;' < Back Mext = Cancel

Install an Evaluation License

This step describes how to create and activate an Evaluation License for the MicroEJ Architecture previously im-
ported.

1. Selectthe Window > Preferences > MicroEJ > Architectures menu .

. Click on the architectures and press Get UID .
. Copy the UID. It will be needed when requesting a license.

2

3

4. Go to https://license.microej.com.

5. Clickon Create a new account link.
6

. Create an account with a valid email address. A confirmation email will be sent a few minutes after. Click on
the confirmation link in the email and login with the account.

7. Clickon Activate a License .
8. Set Product P/N: to 9PEVNLDBU6IJ .
9. Set UID: tothe UID generated before.
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10. Click on Activate .

+ Thelicenseis beingactivated. An activation mail should be received in less than 5 minutes. If not, please
contact support@microej.com.

» Once received by email, save the attached zip file that contains the activation key.

11. Go back to Microej SDK.
12. Selectthe Window > Preferences > MicroEJ menu.

13. Press Add... .
14. Browse the previously downloaded activation key archive file.

15. Press OK . Anew license is successfully installed.

16. Goto Architectures sub-menu and check that all architectures are now activated (green check).

17. Microej SDK is successfully activated.
& Preferences O x

| Architectures 4 s
Checkstyle ~
EasyantdEclipse
Help Target:
Install/Update
hvy
lava

v MicrokE)

Architectures
Marning Conventicr

Add or remove Architectures,

MName Yersion Lic... Select All

- 7 o
1€k ARM Cortex-M0D GCC EVAL 1.0 Deselect All

Import...

Uninstall
Platforms

Platforms in worksp Get UID
Settings
Updates
Yirtual Devices
Mlylyn
Plug-in Development
PMD
Run/Debug
Sonarlint
Team
Terminal
Validation

AML w
Restore Defaults Apply

|:'3;‘| Apply and Close Cancel

Create the MicroEJ Platform

This step describes how to create a new MicroEJ Platform using the MicroEJ Architecture previously imported.

1. Select File > New > MicroEJ Platform Project .

6.3. Create a MicroEJ Firmware From Scratch 363


mailto:support@microej.com

MicroEJ Documentation, Revision 4€20bb27

2. Ensure the Architecture selected isthe MicroEJ Architecture previously imported.
3. Ensurethe Create from a platform reference implementation box is unchecked.

4, Clickon Next button.
5. Fill the fields:
o Set Device: to 1m3s811evh

o Set Name: to Tuto

el‘ workspace - Im3s811evb-Tuto-CMO_GCC48/ Tuto.platform - MicroE)® SDK
File Edit Mavigate S5earch Project Bun Window Help

milhd AP HE-O-L-W GBS S
[# Package Explorer £3 Type Hierarchy =] % =

w =% Im3s811evb-Tuto-CMO_GCC48
Q Tuto.platform

Gl hlvtn YDy
= 0 X Im3s811evb-Tuto-CMO_GCC48 2

{3 Overview

Platform Properties
General information about this Platform.

Device: Im3s811evb

|
Name: | Tuto |
Version: [ 1.0.0 |
Provider: | author |
Vendor URL: | |

Setup the MicroEJ Platform

This step describes how to configure the MicroEJ Platform previously created.

The Platform Configuration Additions provide a flexible way to configure the BSP connection between the Mi-
croEJ Platform and MicroEJ Application to the BSP. In this tutorial, the Partial BSP connection is used. That is,
the MicroEJ SDK will output all MicroEJ files (C headers, MicroEJ Application microejapp.o , MicroEJ Runtime
microejruntime.a,...)inalocation known by the BSP. The BSP is configured to compile and link with those files.

For this tutorial, that means that the final binary is produced by invoking make in the FreeRTOS BSP.

1. Install the Platform Configuration Additions by copying all the files within the content folderin the MicroEJ

Platform folder.

Eln workspace - Im3s81Tevb-Tute-CMO_GCC4E/Tuto.platform - MicroEl ® SDK
File Edit Source Refactor Mavigate Search Project Bun  Window Help

N mi R P BR-PHE-O- QLW OISO S

&
[# Package Explorer 52 Te Type Hierarchy = i
w = Im3s81evb-Tuto-CMO_GCC42

= bsp

[= dropins

£ configurationxml
X Tuto.platform
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Note: The content directory contains files that must be installed in a MicroEJ Platform configuration direc-
tory (the directory that contains the .platform file). It can be automatically downloaded using the following
command line:

svn checkout https://github.com/MicroEJ/PlatformQualificationTools/trunk/framework/platform/
—content [path_to_platform_configuration_directory]

2. Editthefile bsp/bsp.properties as follow:

# Specify the MicroEJ Application file ('microejapp.o') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejapp.relative.dir=microej/lib

# Specify the MicroEJ Platform runtime file ('microejruntime.a') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejlib.relative.dir=microej/lib

# Specify MicroEJ Platform header files ('x.h') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejinc.relative.dir=microej/inc

3. Openthe .platform fileandclickon Build Platform. The MicroEJ Platform will appear in the workspace.

@- warkspace - Im3s811evb-Tute-CMO_GCCAE/ Tute.platform - MicroEl ® SDE
File Edit Source Refactor Mavigate Search  Project Bun Window Help

A W B- P H-O-QR-FE- BB VL
[ Package Explorer &2 Tg Type Hierarchy =
v = Im3s811evb-Tute-CMO_GCC43

v = bsp
|= bsp.properties
[= dropins

@ configuration.xml
£ Tuto.platform
2 Im3s811evb-Tute-CMO_GCC48-1.0.0

At this point, the MicroEJ Platform is ready to be used to build MicroEJ Applications.

6.3.9 Create MicroEJ Application HelloWorld

1. Select File > New > MicroEJ Standalone Application Project .

2. Setthe nameto HelloWorld andclickon Finish
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& New MicroEJ Standalone Application Project O >

Create a Standalone Application project —

Enter project name and configure your application.

Project:
Project name : | HEIIDWDrId|

Application:

Publication :

Organization : | Com.mycompany |

Module: | HelloWorld |

Revision: | 0.1.0 |

3. Runtheapplication in Simulator to ensureitis working properly. Right-click on HelloWorld project> Run as
> MicroEJ Application
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@L workspace - MicroBl ® SDK
File Edit 5curce Refactor Mavigate Search Project RBun Window Help

03~

[ Package Explorer 53 Tg Type Hierarchy

DiFE-O0-" QU HO-IC - EIR KD
BES Y= O

v’f\::l(::lv -

= HelloWorld
=% Im3s811evl
= Im3s811evl

X G

L E

G

Mew

Go Into

Open in New Window
Open Type Hierarchy

Show In

Copy

Copy Qualified Mame
Paste

Delete

Build Path
Source

Refactor

Import...
Export...

Refresh
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The following message appears in the console:

& Conscle i3 Problems

Microl
platform/refresh:

platform/project:

microej/clean:

[delete] Deleting director

BUILD SUCCESSFUL
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[ Initialization Stage ] ===============
[ Launching on Simulator ] ===============

SUCCESS

6.3.10 Configure BSP Connection in MicroEJ Application

This step describes how to configure the BSP connection for the HelloWorld MicroEJ Application and how to build
the MicroEJ Application that will run on the target device.

For a MicroEJ Application, the BSP connection is configured in the PROJECT-NAME /build/common.properties file.

1. Create afile HelloWorld/build/emb.properties with the following content:

core.memory.immortal.size=0

core.memory. javaheap.size=1024

core.memory.threads.pool.size=4

core.memory.threads.size=1

core.memory.thread.max.size=4

deploy.bsp.microejapp=true

deploy.bsp.microejlib=true

deploy.bsp.microejinc=true

deploy.bsp.root.dir=[absolute_path] to FreeRTOS\\FreeRTOS\\Demo\\CORTEX_LM3S811_GCC

Note: Assuming the WSL current directory is FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S811_GCC , use the
following command to find the deploy.bsp.root.dir path with proper escaping:

pwd | sed -e 's|/mnt/c/|C:\\\\|"' -e 's|/[\\\\]|g'

2. Open Run > Run configurations...

3. Select the HelloWorld launcher configuration

6.3. Create a MicroEJ Firmware From Scratch 368



MicroEJ Documentation, Revision 4€20bb27

& Run Configurations X
Create, manage, and run configurations @
OB X | }:9 M Name: | HelloWorld Main |
| type filter text 3] Main . Executionw it Configuration] B JRE} B Sourca li=| Qommon}
[©] C/C++ Application Project
Ju JUnit
HelloWorld Bi
= Launch Group (Deprecated) | croter | ‘ L ‘
w 11 MicroE) Application i
3] HelloWorld Main -
g MicroEl Tool | com.mycempany.Main | ‘ Select Main type... ‘
Revert Appl
Filter matched 6 of 12 itermns e BEY
@ Run | | Close
4. Select Execution tab.
5. Change the execution mode from Execute on Simulator to Execute on Device .
6. Add thefile build/emb.properties to the options files
& Run Configurations X
Create, manage, and run configurations @
OB X | 2 Name: ‘ HelleWorld Main |
|typef\|ter text 7] Main | s Execution it Configuratiorﬂ B JRE} Be Source} H Common}
[E] C/C++ Application Target ~
Ju JUnit
Platfi : | Im3s811evb-Tuto-CMO_GCCA4S (1.0.0 Ei
= Launch Group (Deprecated) atrorm | m evb-lute = ( ) || rowse ‘
~ [0 MicroE Application Execution
m_ LEli¥ridINin () Execute on Simulator (®) Execute on Device
[ig MicreE] Tool
Core Engine Mode: |Defau|'t V|
Settings: | Default - Settings: |Bui|d & Deploy V|
The application is g ted, linked and deployed.
Options
Output folder | ${project_loc:HelloWorld} | | Browse... ‘
Clean intermediate files [ Verbose
Options Files
${project_loc:HelloWarld}/build/emb.properties Add..
Lln e
Revert Appl
Filter matched 6 of 12 items o R
® Run | ‘ Close
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7. Clickon Run

=============== [ Initialization Stage ] ===============

Platform connected to BSP location 'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_
—[.M3S811_GCC' using application option 'deploy.bsp.root.dir'

=============== [ Launching SOAR ]
== [ Launching Link ]
=============== [ Deployment ] ===============

MicroEJ files for the 3rd-party BSP project are generated to 'C:\Users\user\src\tuto-from-
—scratch\workspace\HelloWorld\com.mycompany.Main\platform'.

The MicroEJ application (microejapp.o) has been deployed to: 'C:\Users\user\src\tuto-from-
—scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S811_GCC\microej\lib"'.

The MicroEJ platform library (microejruntime.a) has been deployed to: 'C:\Users\user\src\tuto-from-
—scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S811_GCC\microej\lib"'.

The MicrokEJ platform header files (*.h) have been deployed to: 'C:\Users\user\src\tuto-from-
—scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S811_GCC\microej\inc"'.

=============== [ Completed Successfully ] ===============

SUCCESS

At this point, the HelloWorld MicroEJ Application is built and deployed in the FreeRTOS BSP.

6.3.11 MicroEJ and FreeRTOS Integration

This section describes how to finalize the integration between MicroEJ and FreeRTOS to get a working firmware
that runs the HelloWorld MicroEJ Application built previously.

In the previous section, when the MicrokEJ Application was built, several files were added to a new folder named
microej/.

$ pwd

/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S811_GCC

$ tree microej/

microej/

— inc

— BESTFIT_ALLOCATOR.h

— BESTFIT_ALLOCATOR_impl.h

— LLBSP_impl.h

— LLMJVM.h

— LLMJVM_MONITOR_impl.h

— LLMJVM_impl.h

— LLTRACE_impl.h

— MJVM_MONITOR.h

— MJVM_MONITOR_types.h

— intern
BESTFIT_ALLOCATOR.h
BESTFIT_ALLOCATOR_impl.h
LLBSP_impl.h
LLMIVM. h
LLMIVM_impl.h
trace_intern.h

— sni.h

L— trace.h

L— 1lib

|: microejapp.o
microejruntime.a

(continues on next page)
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(continued from previous page)
3 directories, 19 files

« The microej/lib folder contains the HelloWorld MicroEJ Application object file (microejapp.o ) and the
MicroEJ Runtime. The final binary must be linked with these two files.

« The microej/inc foldercontains several C header files used to expose MicroEJ Low Level APIs. The functions
defined in files ending with the _impl.h suffix should be implemented by the BSP.

To summarize, the following steps remain to complete the integration between MicroEJ and the FreeRTOS BSP:
« Implement minimal Low Level APIs
+ Invoke the MicroEJ Core Engine

+ Build and link the firmware with the MicroEJ Runtime and MicroEJ Application

Minimal Low Level APIs

The purpose of this tutorial is to demonstrate how to develop a minimal MicroEJ Architecture, it is not to develop a
complete MicroEJ Architecture. Therefore this tutorial implements only the required functions and provides stub
implementation for unused features. For example, the following implementation does not support scheduling.

The two headers that must be implemented are LLBSP_impl.h and LLMJVM_impl.h.
1. In the BSP, create a folder named microej/src (nexttothe microej/lib and microej/inc folders).

2. Implement LLBSP_impl.h in LLBSP.c:

Listing 1: microej/src/LLBSP.c

#include "LLBSP_impl.h"

extern void _etext(void);
uint8_t LLBSP_IMPL_isInReadOnlyMemory(void* ptr)
{

return ptr < &_etext;

3

/*%

* Writes the character <code>c</code>, cast to an unsigned char, to stdout stream.

* This function is used by the default implementation of the Java <code>System.out</code>.
*/

void LLBSP_IMPL_putchar(int32_t c)

{
putchar(c);

}
« The implementation of LLBSP_IMPL_putchar reuses the putchar implemented previously.

« The rodata section is defined in the linker script standalone.1ld. The flash memory starts at 0 and
the end of the section is stored in the _etex symbol.

3. Implement LLMJVM_impl.h in LLMJVM_stub.c (all functions are stubbed with a dummy implementation):
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Listing 2: microej/src/LLMJVM_stub.c
#include "LLMJVM_impl.h"

int32_t LLMJVM_IMPL_initialize()

{
return LLMJVM_OK;
}
int32_t LLMJVM_IMPL_vmTaskStarted()
{
return LLMJVM_OK;
}
int32_t LLMJVM_IMPL_scheduleRequest(int64_t absoluteTime)
{
return LLMJVM_OK;
}
int32_t LLMJVM_IMPL_idleVM()
{
return LLMJVM_OK;
}
int32_t LLMJVM_IMPL_wakeupVM()
{
return LLMJVM_OK;
}
int32_t LLMJVM_IMPL_ackWakeup()
{
return LLMJVM_OK;
}
int32_t LLMJVM_IMPL_getCurrentTaskID()
{
return (int32_t) 123456;
}
void LLMJVM_IMPL_setApplicationTime(int64_t t)
{
}
int64_t LLMJVM_IMPL_getCurrentTime(uint8_t system)
{
return 0;
}
int64_t LLMJVM_IMPL_getTimeNanos()
{
return 0;
}

int32_t LLMJVM_IMPL_shutdown(void)

{
return LLMJVM_OK;

(continues on next page)
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(continued from previous page)

The microej folder in the BSP has the following structure:

$ pwd

/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S811_GCC

$ tree microej/

microej/

— inc

— BESTFIT_ALLOCATOR.h

— BESTFIT_ALLOCATOR_impl.h

— LLBSP_impl.h

— LLMJVM.h

— LLMJVM_MONITOR_impl.h

— LLMJVM_impl.h

— LLTRACE_impl.h

— MJVM_MONITOR.h

— MJVM_MONITOR_types.h

— intern
BESTFIT_ALLOCATOR.h
BESTFIT_ALLOCATOR_impl.h
LLBSP_impl.h
LLMJIVM. h
LLMIVM_impl.h
trace_intern.h

— sni.h

L— trace.h

— 1lib

I: microejapp.o

microejruntime.a

L— src
LLBSP.c
LLMIVM_stub.c

4 directories, 21 files

Invoke MicroEJ Core Engine

The MicroEJ Core Engine is created and initialized with the C function SNI_createVM. Then it is started and ex-
ecuted in the current RTOS task by calling SNI_startVM. The function SNI_startVM returns when the MicroEJ
Application exits. Both functions are declared in the C header sni.h.

diff --git a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/main.c b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
index d5728f976..644710120 100644
--- a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/main.c
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
@@ -150,11 +150,14 @@ int puts(const char *s) {
3

#include <stdio.h>
+#include "sni.h"

int main( void )
{
printf("Hello, World! printf function is working.\n");

(continues on next page)
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+ SNI_startVM(SNI_createVM(), @, NULL);
+

/* Configure the clocks, UART and GPIO. */
prvSetupHardware();

Build and Link the Firmware with the MicroEJ Runtime and MicroEJ Application

To build and link the firmware with the MicroEJ Runtime and MicroEJ Application, the BSP port must be modified
to:

1. Use the MicroEJ header files in folder microej/inc

2. Use the source files folder microej/src that contains the Low Level APl implementation LLBSP.c and
LLMJVM_stub.c

3. Compile and link LLBSP.o and LLMJVM_stub.o

4, Link with MicroEJ Application ( microej/lib/microejapp.o ) and MicroEJ Runtime ( microej/lib/
microejruntime.a)

The following patch updates the BSP port Makefile to doit:

index 814cc6f7e..bbcad47b3 100644

--- a/FreeRT0S/Demo/CORTEX_LM3S811_GCC/Makefile
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/Makefile

@@ -29,8 +29,10 @@ RTOS_SOURCE_DIR=../../Source
DEMO_SOURCE_DIR=. ./Common/Minimal

CFLAGS+=-I hw_include -I . -I ${RTOS_SOURCE_DIR}/include -I ${RTOS_SOURCE_DIR}/portable/GCC/ARM_CM3 -I.
<. ./Common/include -D GCC_ARMCM3_LM3S102 -D inline=
+CFLAGS+= -I microej/inc

VPATH=${RTOS_SOURCE_DIR}: ${RTOS_SOURCE_DIR}/portable/MemMang: ${RTOS_SOURCE_DIR}/portable/GCC/ARM_CM3:$
<»{DEMO_SOURCE_DIR}:init:hw_include
+VPATH+= microej/src

0BJS=${COMPILER}/main.o \
${COMPILER}/list.0  \
@@ -44,9 +46,12 @@ OBJS=${COMPILER}/main.o \

${COMPILER}/semtest.o \
${COMPILER}/0osram96x16.0

+0BJS+= ${COMPILER}/LLBSP.o ${COMPILER}/LLMJVM_stub.o
+

INIT_OBJS= ${COMPILER}/startup.o

LIBS= hw_include/libdriver.a
+LIBS+= microej/lib/microejruntime.a microej/lib/microejapp.o

Then build the firmware with make . The following error occurs at link time.

cC microej/src/LLMIVM_stub.c
LD gcc/RTOSDemo . axf

— -
. arm-none-eabi-1d: error: microej/lib/microejruntime.a(sni_vm_startup_
—greenthread.o) uses VFP register arguments, gcc/RTOSDemo.axf does not

(continues on next page)

6.3. Create a MicroEJ Firmware From Scratch 374



MicroEJ Documentation, Revision 4€20bb27

(continued from previous page)
arm-none-eabi-1d: failed to merge target specific data of file microej/lib/microejruntime.a(sni_vm_
—startup_greenthread.o)
arm-none-eabi-1d: gcc/RTOSDemo.axf section ‘ICETEA_HEAP' will not fit in region “SRAM'
arm-none-eabi-1d: region ‘SRAM' overflowed by 4016 bytes
microej/lib/microejapp.o: In function ‘_java_internStrings_end':

The RAM requirements of the BSP (with printf), FreeRTOS, the MicroEJ Application and MicroEJ Runtime do not fit
in the 8k of SRAM. It is possible to link within 8k of RAM by customizing a MicroEJ Tiny Application on a baremetal
device (without a RTOS) but this is not the purpose of this tutorial.

Instead, this tutorial will switch to another device, the Luminary Micro Stellaris LM3S6965EVB. This device is almost
identical as the LM3S811EVB but it has 256k of flash memory and 64k of SRAM. Updating the values in the linker
script standalone. 1d is sufficient to create a valid BSP port for this device.

Instead of continuing to work with the LM3S811 port, create a copy, named CORTEX_LM3S6965_GCC:

$ cd ..

$ pwd
/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo
$ cp -r CORTEX_LM3S811_GCC/ CORTEX_LM3S6965_GCC

$ cd CORTEX_LM3S6965_GCC

The BSP path defined by the property deploy.bsp.root.dir inthe MicroEJ Application must be updated as well.
The rest of the tutorial assumes that everything is done in the CORTEX_LM3S6965_GCC folder.

Then update the linker script standlone.ld:

diff --git a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/standalone.ld b/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/
—standalone.1ld

index b771ff834..e3719ea30 100644

--- a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/standalone.1d

+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.1d

@@ -28,8 +28,8 @@

MEMORY

{

- FLASH (rx) : ORIGIN = 0x00000000, LENGTH = 64K

- SRAM (rwx) : ORIGIN = 0x20000000, LENGTH = 8K
FLASH (rx) : ORIGIN = 0x00000000, LENGTH = 256K
SRAM (rwx) : ORIGIN = 0x20000000, LENGTH = 64K

}

SECTIONS

The new command to run the firmware with QEMU is: gemu-system-arm -M 1m3s6965evb -nographic -kernel
gcc/RTOSDemo.bin.

Rebuild the firmware with make . The following error occurs:

CcC microej/src/LLMIVM_stub.c

LD gcc/RTOSDemo . axf o
— microej/lib/microejapp.o: In function ‘_java_internStrings_end':
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.soar+@x1b3e):_
—undefined reference to ‘ist_mowana_vm_GenericNativesPool___com_1is2t_1vm_1support_1lang_
—1SupportNumber_1lparselLong'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.soar+@xl1cea):._
—undefined reference to ‘ist_mowana_vm_GenericNativesPool___com_Tis2t_Tvm_Tsupport_1la@ghtinues on next page)
H1SupportNumber 1toStr1ngLongNat1ve C \Users\user\src\tuto-from-

\
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C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.soar+0x1f2a):_
—undefined reference to ‘ist_mowana_vm_GenericNativesPool___java_1lang_1System_lgetMethodClass'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.soar+@xl1e3e):._
—undefined reference to ‘ist_mowana_vm_GenericNativesPool___com_1is2t_1vm_1support_1lang_1Systools_
—lappen

. skip ...
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.soar+0x31d6):_
—undefined reference to ‘ist_mowana_vm_GenericNativesPool___java_1llang_1System_linitializeProperties'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.soar+@x37b6):
—undefined reference to ‘ist_mowana_vm_GenericNativesPool___java_1lang_1Thread_1storeException'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.soar+@x37c8):._
—undefined reference to ‘ist_microjvm_NativesPool___java_llang_1Thread_lexecClinit'
microej/lib/microejapp.o: In function ‘__icetea__getSingleton__com_is2t_microjvm_mowana_VMTask':
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.text.__icetea__
—getSingleton__com_is2t_microjvm_mowana_VMTask+@xc): undefined reference to ‘com_is2t_microjvm_mowana_
—VMTask___getSingleton'
microej/lib/microejapp.o: In function

. skip ...
microej/lib/microejapp.o: In function ‘TRACE_record_event_u32x3_ptr'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.rodata.TRACE_
—record_event_u32x3_ptr+0x0): undefined reference to ‘TRACE_default_stub'
microej/lib/microejapp.o: In function ‘TRACE_record_event_u32x4_ptr'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o: (.rodata.TRACE_
—record_event_u32x4_ptr+0x0): undefined reference to ‘TRACE_default_stub'
microej/lib/microejapp.o:C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.
—Main\SOAR.o: (.rodata.TRACE_record_event_u32x5_ptr+0x0): more undefined references to ‘TRACE_default_
—stub' follow
make: *x* [makedefs:196: gcc/RTOSDemo.axf] Error 1

N

__icetea__getSingleton__com_is2t_microjvm_IGreenThreadMicroJvm':

This error occurs because microejruntime.a referstosymbolsin microejapp.o butisdeclared afterin the linker
command line. By default, the GNU LD linker does not search unresolved symbols into archive files loaded previ-
ously (see man 1d for a description of the start-group option). To solve this issue, either invert the declaration
of LIBS (put microejapp.o first) or guard the libraries declaration with --start-group and --end-group in
makedefs . This tutorial uses the later.

diff --git a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/makedefs b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
index 1a8f4dab5..66b482804 100644
--- a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/makedef's
+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedef's
@@ -196,13 +196,13 @@ ifeq (${COMPILER}, gcc)
echo ${LD} -T ${SCATTER_${notdir ${@:.axf=}}} \
--entry ${ENTRY_${notdir ${@:.axf=3}3}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \
- ${LDFLAGS} -0 ${@} ${"} \
- "${LIBC}' '${LIBGCC}'; \
${LDFLAGS} -o ${@} --start-group ${"} \
"${LIBC}"' '${LIBGCC}' --end-group; \
fi
@${LD} -T ${SCATTER_${notdir ${@:.axf=3}}} \
--entry ${ENTRY_${notdir ${@:.axf=}3}} \
${LDFLAGSgcc_${notdir ${@:.axf=}3}} \
= ${LDFLAGS} -0 ${@} ${"} \
- "${LIBC}' '${LIBGCC}'
${LDFLAGS} -o ${@} --start-group ${"} \
"${LIBC}"' '${LIBGCC}' --end-group
@${OBJCOPY} -0 binary ${@} ${@:.axf=.bin}
(continues on next page)
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endif

Rebuild with make . The following error occurs:

LD gcc/RTOSDemo . axf
microej/lib/microejruntime.a(VMCOREMicroJvm__131.0): In function ‘VMCOREMicroJvm__1131____1_11046":
_131.c:(.text.VMCOREMicroJvm__1131____1_11046+0x20): undefined reference to ‘fmodf'

microej/lib/microejruntime.a(VMCOREMicroJvm__131.0): In function ‘VMCOREMicroJvm__1131____1_11045":
_131.c:(.text.VMCOREMicroJvm__1131 1_11045+0x2c): undefined reference to ‘fmod'

1

microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___cos':
Math.c: (.text.iceTea_lang_Math___cos+@x2a): undefined reference to ‘cos'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___sin':
Math.c: (.text.iceTea_lang_Math___sin+@x2a): undefined reference to ‘sin'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___tan':
Math.c: (.text.iceTea_lang_Math___tan+0x2a): undefined reference to ‘tan'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___acos__D':
Math.c: (.text.iceTea_lang_Math___acos__D+0x18): undefined reference to ‘acos’
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___acos(void)':
Math.c: (.text.iceTea_lang_Math___acos__F+0x12): undefined reference to ‘acosf"
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___asin':
Math.c: (.text.iceTea_lang_Math___asin+0x18): undefined reference to ‘asin'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___atan':
Math.c: (.text.iceTea_lang_Math___atan+0x2): undefined reference to ‘atan'’
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___atan2':
Math.c: (.text.iceTea_lang_Math___atan2+0x2): undefined reference to ‘atan2'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___log':
Math.c: (.text.iceTea_lang_Math___log+0x2): undefined reference to ‘log'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math_(...)(long long, =*)':
Math.c: (.text.iceTea_lang_Math___exp+0x2): undefined reference to ‘exp'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math_(char,...)(int, long)':
Math.c: (.text.iceTea_lang_Math___ceil+@x2): undefined reference to ‘ceil’
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function ‘iceTea_lang_Math___floor":

. skip ...

This error occurs because the Math library is missing. The rule for linking the firmware is defined in the file makedef's
. Replicating how the libc is managed, the following patch finds the 1ibm.a library and add it at link time:

diff --git a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
index 66b482804..801812829 100644

--- a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/makedefs

+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedef's
@@ -102,6 +102,11 @@ LIBGCC=${shell ${CC} -mthumb -march=armv6t2 -print-libgcc-file-name}

#

LIBC=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libc.a}

+#

+# Get the location of libm.a from the GCC front-end.

+#

+LIBM=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=1libm.a}

+

#

# The command for extracting images from the linked executables.

#

@@ -197,12 +202,12 @@ ifeq (${COMPILER}, gcc)
--entry ${ENTRY_${notdir ${@:.axf=}3}3} \
${LDFLAGSgcc_${notdir ${@:.axf=}3}} \

(continues on next page)
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(continued from previous page)
${LDFLAGS} -o ${@} --start-group ${"} \
= "${LIBC}" '${LIBGCC}' --end-group; \
+ "${LIBM}" '${LIBC}' '${LIBGCC}' --end-group; \
fi
@${LD} -T ${SCATTER_${notdir ${@:.axf=3}}} \
--entry ${ENTRY_${notdir ${@:.axf=}3}} \
${LDFLAGSgcc_${notdir ${@:.axf=}3}} \
${LDFLAGS} -o ${@} --start-group ${"} \
= "${LIBC}"' '${LIBGCC}' --end-group
+ "${LIBM}" '${LIBC}' '${LIBGCC}' --end-group;
@${OBJCOPY} -0 binary ${@} ${@:.axf=.bin}
endif

Rebuild with make . The following error occurs:

cC microej/src/LLMIVM_stub.c

LD gcc/RTOSDemo . axf
/usr/lib/gcc/arm-none-eabi/6.3.1/../../../arm-none-eabi/lib/thumb/libc.a(lib_a-sbrkr.o): In function ‘_
—sbrk_r':
/build/newlib-jo3xW1/newlib-2.4.0.20160527/build/arm-none-eabi/thumb/newlib/libc/reent/../../7../7../../..
—/newlib/libc/reent/sbrkr.c:58: undefined reference to ‘_sbrk'
make: *x* [makedefs:196: gcc/RTOSDemo.axf] Error 1

Instead of implementing a stub _sbrk function, this tutorial uses the 1ibnosys.a which provides stub implemen-
tation for various functions.

diff --git a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/makedefs b/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/makedefs
index 801812829..9de8150a5 100644

--- a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/makedefs

+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
@@ -107,6 +107,11 @@ LIBC=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libc.a}

#

LIBM=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libm.a}

+#
+# Get the location of libnosys.a from the GCC front-end.
+#
+LIBNOSYS=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=1libnosys.a}
+
#
# The command for extracting images from the linked executables.
#
@e -202,12 +207,12 @@ ifeq (${COMPILER}, gcc)
-—entry ${ENTRY_${notdir ${@:.axf=3}}3} \
${LDFLAGSgcc_${notdir ${@:.axf=}3}} \
${LDFLAGS} -o ${@} --start-group ${"} \
= "${LIBM}" '${LIBC}' '${LIBGCC}' --end-group; \
+ "${LIBNOSYS}' '${LIBM}' '${LIBC}' '${LIBGCC}' --end-group; \
fi
@${LD} -T ${SCATTER_${notdir ${@:.axf=3}}} \
-—entry ${ENTRY_${notdir ${@:.axf=}3}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \
${LDFLAGS} -o ${@} --start-group ${"} \
- "${LIBM}' '${LIBC}' '${LIBGCC}' --end-group;
+ "${LIBNOSYS}"' '${LIBM}' "${LIBC}' '${LIBGCC}' --end-group;
@${OBJCOPY} -0 binary ${@} ${@:.axf=.bin}
endif
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Rebuild with make . The following error occurs:

cC microej/src/LLMIVM_stub.c

LD gcc/RTOSDemo . axf
/usr/lib/gcc/arm-none-eabi/6.3.1/../../../arm-none-eabi/lib/thumb/libnosys.a(sbrk.o): In function ‘_sbrk
/build/newlib-jo3xW1/newlib-2.4.0.20160527/build/arm-none-eabi/thumb/libgloss/libnosys/../../7../../../
—libgloss/libnosys/sbrk.c:21: undefined reference to ‘end’

make: *x* [makedefs:201: gcc/RTOSDemo.axf] Error 1

The _sbrk implementation needs the end symbol to be defined. Looking at the implementation, the end symbol
corresponds to the beginning of the C heap. This tutorial uses the end of the .bss segment as the beginning of the
C heap.

diff --git a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.ld b/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/
—standalone.1ld
index e3719ea30..e86294b5f 100644
--- a/FreeRT0S/Demo/CORTEX_LM3S6965_GCC/standalone.1ld
+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.1d
@@ -64,5 +64,6 @@ SECTIONS

*(.bss)

* (COMMON)

_ebss = .;
+ end = .;

} > SRAM

Then rebuild with make . There should be no error. Finally, run the firmware in QEMU with the following command:
gemu-system-arm -M 1m3s6965evb -nographic -kernel gcc/RTOSDemo.bin
Hello, World! printf function is working.

Hello World!
QEMU: Terminated // press Ctrl-a x to end the QEMU session

The first Hello, World! isfromthe main.c and the second one from the MicroEJ Application.
To make this more obvious:

1. Update the MicroEJ Application to print Hello World! This is my first MicroEJ Application

1S workspace - fsrefmainfjava/com/mycompany/Mainjava - MicroE) & SDK
File Edit Source Refactor Navigate Search Project Run Window Help
Himg B A-PiE-O- G- WGBS IPAREM Y-
[# Package Explorer 52 2% T = 8 [ Manjava 2
v [ HelloWorld 28 Javal]
v (& srmainfjava 7 package com.mycompany;
v [ commycompany 5 e
p 9
1] Mainjava * Generated by the build-firmware-singleapp-skeleton.<br/>
i src/main/resources 11 Please keep it in sync with the property 'application.main.class’ defined in module.ivy
B vy module.ivy [1] 2 /

& build 13 public class Main {
(= com.mycompany.Main
o s
CHANGELOG.md
= LICENSE.txt
foy moduleivy
[5 README.md
(& Im3s81Tevb-Tuto-CMD_GCCAS
2 Im3s81Tevb-Tuto-CMO_GCCA-1.0.0

simple main.
args

comnand line arguments.
public static void main(String[] args) {

.println("Hello World! This is my first MicroEd Application®); //SNON-NLS-13
H

=i

2. Rebuild the MicroEJ Application
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@- workspace - HelloWerld/src/main/java/com/mycompany/Main.java - MicroEl ® 50Dk
File Edit 5Scurce Refactor Mavigate Search Project Bun Window Help

N B Q- PO Q-G BB
% Package Explorer 53 Type Hierarchy | Run HelloWorld Main I e ¥ = 8

v 12 HelloWorld
~ (® sro/main/java

v i com.mycompany
1] Mainjava

iﬁ% src/main/resources

B vy module.ivy [*]

= build

= com.mycempany.Main

= sre

[%] CHANGELOG.md

|=| LICEMSE. txt

by moduleivy

[#] README.md
= Im3sB11evb-Tuto-CMO_GCC48
& Im3s811evb-Tuto-CMO_GCC48-1.0.0

On success, the following message appears in the console:

=============== [ Initialization Stage ji==========c=————x

Platform connected to BSP location 'C:\Users\user\src\tuto-from-
—scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC' using application option 'deploy.bsp.root.
—dir'.

== == [ Launching Link 1]

MicroEJ files for the 3rd-party BSP project are generated to 'C:\Users\user\src\tuto-from-
—scratch\workspace\HelloWorld\com.mycompany.Main\platform'.

The MicroEJ application (microejapp.o) has been deployed to: 'C:\Users\user\src\tuto-from-
—scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\lib".

The MicroEJ platform library (microejruntime.a) has been deployed to: 'C:\Users\user\src\tuto-
—from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\lib".

The MicroEJ platform header files (*.h) have been deployed to: 'C:\Users\user\src\tuto-from-
—scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\inc".

=============== [ Completed Successfully ] ===============

SUCCESS

3. Then rebuild and run the firmware:
$ make && gemu-system-arm -M 1m3s6965evb -nographic -kernel gcc/RTOSDemo.bin

LD gcc/RTOSDemo . axf
Hello, World! printf function is working.
Hello World! This is my first MicroEJ Application
QEMU: Terminated
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Congratulations!
At this point of the tutorial:
« The MicroEJ Platform is connected to the BSP (BSP partial connection).
« The MicroEJ Application is deployed within a known location of the BSP (in microej/ folder).
+ The FreeRTOS LM3S6965 port:
- provides the minimal Low Level API to run the MicroEJ Application
- compiles and links FreeRTOS with the MicroEJ Application and MicroEJ Runtime
- runson QEMU
The next steps recommended are:
« Complete the implementation of the Low Level APIs (implement all functions in LLMJVM_impl.h).

« Validate the implementation with the PQT Core.

6.4 Setup an Automated Build using Jenkins and Artifactory

This tutorial explains how to setup an environment for automating MicroEJ Module build and deployment using
Jenkins and JFrog Artifactory.

Such environment setup facilitates continuous integration (Cl) and continuous delivery (CD), which improves pro-
ductivity across your development ecosystem, by automatically:

« building modules when source code changes
+ saving build results

« reproducing builds

« archiving binary modules

The tutorial should take 2 hours to complete.

6.4.1 Intended Audience

The audience for this document is engineers who are in charge of integrating MicroEJ Module Manager (MMM) to
their continuous integration environment.

In addition, this tutorial should be of interest to all developers wishing to understand how MicroEJ works with
headless module builds.

For those who are only interested by command line module build, consider using the CommandLineBuild tool.

6.4.2 Introduction

The overall build and deployment flow of a module can be summarized as follows:
1. Some event triggers the build process (i.e module source changed, user action, scheduled routine, etc.)
2. The module source code is retrieved from the Source Control System
3. The module dependencies are imported from the Repository Manager
4

. The Automation Server then proceeds to building the module
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5. If the build is successful, the module binary is deployed to the Repository Manager

Automation Server

Build Trigger 4|— Load Source Code Build with MMM Deploy Binary

@ Jenkins

mport module

Clone d . Publish module
ependencies
@ Software Developers Source Control Repository Manager
Q g 4 Module Repositories
h
g Push = :/ . < :/ JFrog
MICROE 0 W Qi OW” ~ ARTIFAGTORY

6.4.3 Prerequisites

« MicroEJ SDK 4.1.5 or higher.

« Git 2.x installed, with Git executable in path. We recommend installing Git Bash if your operating system is
Windows (https://git-for-windows.github.io/).

« Apache Ant 1.9.x installed (https://ant.apache.org/bindownload.cgi).
+ Java Development Kit (JDK) 1.8.x.
This tutorial was tested with Jenkins 2.235.3 and Artifactory 6.20.1.

6.4.4 Overview

The next sections describe step by step how to setup the build environment and build your first MicroEJ module.
The steps to follow are:
1. Install and setup MicroEJ build tools, Jenkins and Artifactory
2. Create a Jenkins job template for MMM builds
3. Create a simple MicroEJ module (Hello World)
4. Create a new Jenkins job for the Hello World module
5. Build the module
For the purposes of simplifying the steps, this tutorial will be performed locally on a single machine.
Artifactory will host MicroEJ modules, divided in 3 repositories:

« microej-module-repository : repository initialized with pre-built MicroEJ modules, a mirror of the Central
Repository
« microej-build-repository : repository initialized with build scripts and tools exported from MicroEJ SDK

+ libs-snapshot-local : repository where will be published custom modules
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6.4.5 Install the Build Tools

This section assumes the prerequisites have been properly installed.

1. Locate your JDK installation directory (typically something like C:\Program Files\Java\jdk1.8.
0_[version] on Windows).

2. Set the environment variable JAVA_HOME to point to the bin directory (for example C:\Program
Files\Java\jdk1.8.0_[version]\bin).

3. Set the environment variable JRE_HOME to point to the jre directory (for example C:\Program
Files\Java\jdk1.8.0_[version]\jre).

4. Download the pre-configured settings file by cloning the following git repository:

git clone --recursive https://github.com/MicroEJ/Tool-CommandLineBuild.git

5. Create a directory named buildKit inthe Tool-CommandLineBuild directory.

6. Exportthe MicroEJ build kit from your MicroEJ SDK version to the buildKit directory, by following the steps
described here.

7. Set the environment variable MICROEJ_BUILD_TOOLS_HOME to point to the Tool-CommandLineBuild direc-
tory

Note: At this point, the content of the directory Tool-CommandLineBuild should look like the following:

Tool-CommandLineBuild

— buildKit
ant
L— 1ib
ant jar
ant launcher. jar
microej- bu11d repository.zip (or is2t_repo.zip)
— easyant
— .
— ivy
t: ivysettings-artifactory.xml

6.4.6 Get a Module Repository

A Module Repository is a portable ZIP file that bundles a set of modules for extending the MicroEJ development
environment. Please consult the Module Repository section for more information.

In the following, we will use the MicroEJ Central Repository, which is the Module Repository used by MicroEJ SDK to
fetch dependencies when starting an empty workspace. It bundles Foundation Library APIs and numerous Add-On
Libraries.

Next step is to download a local copy of this repository:

1. Visit the Central Repository on the MicroEJ Developer website.

2. Navigate to the Working Offline section.

3. Clickonthe offline repository link. This will download the Central Repository as a ZIP file.
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6.4.7 Setup Artifactory

Install and Start Artifactory

1. Download Artifactory here: https://api.bintray.com/content/jfrog/artifactory/jfrog-artifactory-oss-\protect\
T1\textdollarlatest.zip;bt_package=jfrog-artifactory-oss-zip.

2. Unzip downloaded archive, then navigate to bin directory (by default artifactory-oss-[version]/bin).

3. Run artifactory.bat or artifactory.sh depending on your operating system. After initialization, the
terminal should print the message Artifactory successfully started . In case an error occurs, check that
JAVA_HOME and JRE_HOME environment variables are correct.

4. Go to http://localhost:8081/.

5. Login to Artifactory for the first time using the default admin account (Username: admin , Password:
password ).

6. Onthe Welcome wizard, setthe administrator password, then click Next ,

7. Configure proxy server (if any) then click Next , or click Skip .
8. On Create Repositories page, select Maven then clickon Create .

9. Clickon Finish .

Artifactory is up and running.

Configure Artifactory

For demonstration purposes we will allow anonymous users to deploy modules in the repositories.

1. Goto Admin > Security > Security Configuration .
2. Inthe General Security Settings section, check Allow Anonymous Access . Click Save .
3. Goto Admin > Security > Permissions .

4. Clickon Anything entry (do not check the line), then goto Users tab, clickon Anonymous and check
Deploy/Cache permission. Click Save and finish .
Next steps will involve uploading large files, so we have to augment the file upload maximum size accordingly:
1. Goto Admin > General Configuration .

2. Inthe General Settings section, change the value of File Upload Max Size (MB) to 1024 then click on

Save .

Configure Repositories

First step is to configure to pre-defined repository for the future snapshot modules built.

1. Goto Admin > Repositories > Local .

2. Clickon libs-snapshot-local repository,then check Handle Releases anduncheck Handle Snapshots

. Click Save and finish .
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Next step is to create the repositories that will hold the MicroEJ modules.

1. Goto Admin > Repositories > Local .

2. Clickon New ,andselect Maven .

3. Set Repository Key field to microej-module-repository,then uncheck Handle Snapshots . Click on

Save and finish .

4. Clickon New ,andselect Maven .

5. Set Repository Key field to microej-build-repository , then uncheck Handle Snapshots . Click on
Save and finish .

6. Make these two repositories accessible by default:

1. Goto Admin > Security > Permissions .
2. Clickon Anything entry (do not check the line)

3. On the Resources tab, drag repositories microej-module-repository and

microej-build-repository fromthe Available repositories areatothe Included Repositories
area.

4, Clickon Save & Finish .

0 Available Repositories 5 Included Repositories

Name Name
& jcenter
@ libs-release-local
&2 libs-snapshot-local
@ microej-build-repository

% microej-module-repository

Import MicroEJ Repositories

In this section, we will import MicroEJ repositories into Artifactory repositories to make them available to the build
server.

1. Goto Admin > Import&Export > Repositories .
2. Scrollto the Import Repository from Zip section.

3. Import the MicroEJ Module Repository:
1. As Target Local Repository , select microej-module-repository inthe list.
2. As  Repository Zip File , select MicroEJ module repository zip file ( microej-[MicroEJ

version]-[version].zip ) that you downloaded earlier (please refer to section Get a Module
Repository).
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3. Click Upload . At the end of upload, click on Import . Upload and import may take some time.
4. Import the MicroEJ Build Repository:

1. As Target Local Repository , select microej-build-repository in the list.

2. As Repository Zip File , select MicroEJ Build Repository zip file ( microej-build-repository.

zip or is2t_repo.zip)thatyou exported from MicroEJ SDK earlier (please refer to section Install
the Build Tools).

3. Click Upload . At the end of upload, click on Import . Upload and import may take some time.

Artifactory is now hosting all required MicroEJ modules. Go to Artifacts and check that repositories
microej-module-repository and microej-build-repository docontain modulesasshown inthefigure below.

& microej-build-repository

[jl

License/MicroE]_LicenseAgreement_Studio/1.4-C

[:I

ant-contribfant-contrib/1.0b3

[:I

befcyberelf/nanoxml/lite/2.2.3

[:I

classworlds/classworlds/1.1-alpha-2

[jl

Com

[:I

commons-cli/fcommons-clif1.2

[:I

commons-codec/commons-codec/1.9

[:I

commons-ig/commons-io

[jl

commons-lang/commeons-lang/2.6

[:I

commons-logging/commons-logging

[:I

commons-vfs/commons-vfs/1.0

[:I

domdj/dom4j/1.6.1

&2 microej-module-repository
£ com
E gj
& googlecloud/iotcore
& org
ivysettings.xml
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6.4.8 Setup Jenkins

Install Jenkins

1. Download Jenkins WAR (Web Archive) here: http://mirrors.jenkins.io/war-stable/latest/jenkins.war

2. Open a terminal and type the following command: java -jar [path/to/downloaded/jenkinswarl/
jenkins.war . Afterinitialization, the terminal will print out Jenkins is fully up and running .

3. Goto http://localhost:8080/.

4. To unlock Jenkins, copy/paste the generated password that has been written in the terminal log. Click on
Continue .

5. Select option Install suggested plugins and wait for plugin installation.
6. Fillinthe Create First Admin User form. Click Save and continue .

7. Clickon Save and finish ,thenon Start using Jenkins .

Configure Jenkins

First step is to configure JDK and Ant installations:
1. Goto Manage Jenkins > Global Tool Configuration .

2. Add JDK installation:
1. Scrollto JDK section.

2. Clickon AddJDK .
3. Set Name to JDK [jdk_version] (forexample JDK 1.8).

4. Uncheck Install automatically .

5. Set JAVA_HOME to path/to/jdk[jdk_version] (forexample C:\Program Files\Java\jdk1.
8.0_[version] on Windows).

3. Add Ant installation:

1. Scrollto Ant section.

2. Clickon AddAnt .

3. Set Name to Ant 1.9.

4. Uncheck Install automatically .

5. Set ANT_HOME to path/to/apache-ant-1.9.[version].

4, Clickon Save .

Create a Job Template

1. Go to Jenkins dashboard.

2. Clickon Newitem to create ajob template.
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3. Setitemnameto Template - MMM from Git.
4. Select Freestyle project .
5. Clickon Ok .

In General tab:

1. Check This project is parametrized andadd String parameter named easyant.module.dir with default
value to $WORKSPACE/TO_REPLACE . This will later point to the module sources.

In Source Code Management tab:
1. Select Git source control:

2. Set Repository URL valueto TO_REPLACE,
3. Set Branch Specifier valueto origin/master,

4. In Additional Behaviours , click on Add , select Advanced sub-modules behaviors , then check
Recursively update submodules .

In Build tab:
1. Add build step Invoke Ant :
« As Antversion ,select Ant 1.9.

« Set Targets tovalue -1ib ${MICROEJ_BUILD_TOOLS_HOME}/buildKit/ant/1lib.

« In Advanced , set Build file tovalue $MICROEJ_BUILD_TOOLS_HOME/easyant/build-module.
ant.

« In Advanced ,expand Properties textfield then add the following Ant properties:

personalBuild=false

jenkins.build.id=$BUILD_ID

jenkins.node.name=$NODE_NAME
user.ivysettings.file=$MICROEJ_BUILD_TOOLS_HOME/ivy/ivysettings-artifactory.xml
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Invoke Ant 0
Ant Version Ant 1.9 ~
ErgEE -lib ${MICROEJ_BUILD_TOOLS_HOME}/buildKit/ant/lib v o
Build File SMICROEJ_BUILD_TOOLS_HOME/easyant/build-module.ant v o
Properties personalBuild=false e

jenkins.build.id=%BUILD_ID

jenkins.node.name=SNODE_NAME

user.ivysettings.file=S$MICROEJ_BUILD_TOOLS_HOME/ivy/ivysettings-artifactory.xml
Java Options 7]

Finally, clickon Save .

6.4.9 Build a new Module using Jenkins

Since your environment is now setup, it is time to build your first module from Jenkins and check it has been pub-
lished to Artifactory. Let’s build an “Hello World” Sandboxed Application project.

Create a new MicroEJ Module

In this example, we will create a very simple module using the Sandbox Application buildtype (build-application
) that we’ll push to a Git repository.

Note: For demonstration purposes, we’ll create a new project and share it on a local Git bare repository. You can
adapt the following sections to use an existing MicroEJ project and your own Git repository.

1. Start MicroEJ SDK.
2. Goto File > New > MicroEJ Sandboxed Application Project .

3. Fillin the template fields, set Project name to com.example.hello-world.
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Create a Sandboxed Application project —

Enter project name and configure your application.

Project:

Project name : | com.example.hello-world |
Application:

ID: | helloworld |

Printable name: | Hello World |

Description : | A simple Hello Werld |

Publication :

Organization : | com.example |
Module : | hello-world |
Revision : 10,10 |

@
|

4, Click Finish . This will create the project files and structure.

5. Right-click on source folder src/main/java and select New > Package . Setaname to the package and

click Finish .

6. Right-click on the new package and select New > Class . Set a name to the class and check public
static void main(String[] args),thenclick Finish .

{8 Package Ex.. 32 |f2 TypeHiera.. = B  [J] Mainjava &2

% - 1 package com.example.hello;
v 2 com.examplehello-world :
b= ! ple.hella-worl -
v {® src/main/java 4 * Main class of the project.
v [ com.examplehello 5 *
1] Mainjava 6 public class Main {
W src/main/resources 7
- ) - g /%%
=i Medule Dependencies moduleivy [] 9 * Entry point of the project.
[ src-adpgenerated/wadapps/java 8 *
= META-INF 1 * [@param args
= src 2 * Some arguments.
= src-adpgenerated i *;:1_ tati id in(string[] ) 1
= public static void main(String[] args
& EI;;I:I;SEELOG.md 5 System.out.println("Hello World!™); //SNON-NL5-13
E ot 6 }
fp module.ivy 17
[#] README.md 18 }

6.4. Setup an Automated Build using Jenkins and Artifactory 390



MicroEJ Documentation, Revision 4€20bb27

7. Locate the project files

1. Inthe Package Explorer view, right-click on the project then click on ' Properties .

2. Select Resource menu.

3. Click on the arrow button on line Location to show the project in the system explorer.

b S
type filter text Resource A4 r v
Resource
; Path: Jcom.examplehello-world
Builders .
Checkstyle Type: Project =
Git Location: \com.example.hello-world',__ (== __,'

lumr e

8. Open aterminal from this directory and type the following commands:

git init --bare ~/hello_world.git

git init

git remote add origin ~/hello_world.git
git add com.example.hello-world

git commit -m "Add Hello World application”
git push --set-upstream origin master

Note: For more details about MicroEJ Applications development, refer to the Application Developer Guide.

Create a New Jenkins Job

Start by creating a new job, from the job template, for building our application.
1. Go to Jenkins dashboard.
2. Clickon New ltem .
3. Setitem nameto Hello World.
4. In Copyfrom field,type Template - MMM from Git (autocomplete enabled).

5. Validate with Ok button.

The job configuration page opens, let’s replace all the TO_REPLACE placeholders from the job template with correct
values:

1. In General tab,set easyant.module.dir tovalue $WORKSPACE/com.example.hello-world.

This project is parameterized (7]
String Parameter (7]
Name easyant.module.dir )
Default Value = SWORKSPACE/com.example.hello-world 0

2. In Source Code Management , edit Repository URL to ~/hello_world.git.
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Source Code Management

O None
® Git
Repaositories 0
Repository URL | ~/hello_world.git e
Credentials _none - |¥% =Add ~
Advanced...
Add Repository
Branches to build “
Branch Specifier (blank for 'any’) | origin/master @

Add Branch

3. Clickon Save .

Build the “Hello World” Application

Let’s run the job!

In Jenkins’ Hello World dashboard, click on Build with Parameters , then click on Build .

Note: You can check the build progress by clicking on the build progress bar and showing the Console Output .

At the end of the build, the module is published to http://localhost:8081/artifactory/list/libs-snapshot-local/com/
example/hello-world/.

Congratulations!
At this point of the tutorial:
« Artifactory is hosting your module builds and MicroEJ modules.

« Jenkins automates the build process using MicroEJ Module Manager.

The next steps recommended are:

« Adapt Jenkins/Artifactory configuration to your ecosystem and development flow.

6.4.10 Appendix

This section discusses some of the customization options.

Customize Jenkins

Jenkins jobs are highly configurable, following options and values are recommended by MicroEJ, but they can be
customized at your convenience.

In General tab:

1. Check Discard old builds and set Max # of builds to keep valueto 15.

2. Clickon Advanced button, and check Block build when upstream project is building .
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In Build triggers tab:

1. Check PollSCM , and set a CRON-like value (for example H/30 * * x * to poll SCM for changes every 30
minutes).

In Post-build actions tab:

1. Add post-build action Publish JUnit test result report :

2. Set TestreportXMLs to #**/target~/test/xml/**/test-report.xml, #*%/target~/test/xml/*x*/
*Test.xml.

3. Check Retain long standard output/error .

4, Check Do not fail the build on empty test results

Add a Self-Signed Certificate

In case your Artifactory instance uses a self-signed SSL certificate, you might fall into this error when fetching de-
pendencies:

HttpClientHandler: sun.security.validator.ValidatorException: PKIX path building failed: sun.security.
—provider.certpath.SunCertPathBuilderException: unable to find valid certification path to requested.
—target url=[artifactory address]

The authority has to be added to the trust store of the JRE/JDK that is running Artifactory. Here is a way to do it:
1. Install Keystore Explorer.

2. Start Keystore Explorer, and open file [JDK home]/jre/lib/security/cacerts with the password
changeit . You may not have the right to modify this file. Edit rights if needed before opening it.

3. Clickon Tools ,then Import Trusted Certificate .

4, Select your certificate.

5. Savethe cacerts file.

6.5 Improve the Quality of Java Code

This tutorial describes some rules and tools aimed at improving the quality of a Java code to simplify its mainte-
nance. It makes up a minimum consistent set of rules which can be applied in any situation, especially on embed-
ded systems where performance and low memory footprint matter.

6.5.1 Intended Audience

The audience for this document is engineers who are developing any kind of Java code (application or library).

6.5.2 Readable Code

This section describes rules to get a readable code, in order to facilitate:
« the maintenance of an existing code with multiple developers contributions (e.g. merge conflicts, reviews).

« the landing to a new code base when the same rules are applied across different modules and components.
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Naming Convention

Naming of Java elements (package, class, method, field and local) follows the Camel Case convention.
+ Package names are written fully in lower case (no underscore).
+ Package names are singular (e.g. ej.animal instead of ej.animals).
+ Class names are written in upper camel case.
« Method and instance field names are written in lower camel case.
« Static field names are written in lower camel case.
« Constant names are written in fully upper case with underscore as word separator.
« Enum constant names are written in fully upper case with underscores as word separators.
« Local (and parameter) names are written in lower camel case.

« When a name contains an acronym, capitalize only the first letter of the acronym (e.g. for a local with the
HTTP acronym, use myHttpContext instead of myHTTPContext ).

Itis also recommended to use full words instead of abbreviations (e.g. MyProxyReference instead of MyProxyRef

).
Visibility
Here is a list of the usage of each Java element visibility:
e public:API.
« protected: API for subclasses.
+ package : component intern API (collaboration inside a package).
« private:internal structure, cache, lazy, etc.

By default, all instance fields must be private.

Package visibility can be used by writing the comment /xdefault*/ in place of the modifier.

Javadoc

Javadoc comments convention is based on the official documentation.

Note: Javadocis written in HTML format and doesn’t accept XHTML format: tags must not be closed. For example,
use only a <p> between two paragraphs.

Here is a list of the rules to follow when writing Javadoc:
« AlLAPIs (see Visibility) must have a full Javadoc (classes, methods, and fields).
+ Add a dot at the end of all phrases.
« Add @since tagwhen introducing a new API.
+ Do not hesitate to use links to help the user to navigate in the API ( @see, @link).
+ Usethe @code tagin the following cases:

- For keywords (e.g. {@code null} or {@code true}).
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- For names and types (e.g. {@code x} or {@code Integer}).
- For code example (e.g. {@code new Integer(Integer.parselnt(s))}).
Here is a list of additional rules for methods:
« The first sentence starts with the third person (as if there is This method before).
« All parameters and returned values must be described.
+ Putas much as possible information in the description, keep @param and @return minimal.
« Start @param with a lower case and usually with the or a.
« Start @return with a lower case as if the sentence starts with Returns.

+ Avoid naming parameters anywhere other than in @param. If the parameter is renamed afterward, the com-
ment is not changed automatically. Prefer using the given xxx.

Code Style and Formatting

MicroEJ defines a formatting profile for .java files, which is automatically set up when creating a new Module
Project Skeleton.

Note: MicroEJ SDK automatically applies formatting when a . java file is saved. It is also possible to manually
apply formatting on specific files:

« In Package Explorer,select the desired files, folders or projects,

« thengoto Source > Format . The processed files must not have any warning or error.

Here is the list of formatting rules included in this profile:
« Indentation is done with 1 tab.

+ Braces are mandatory with if, else, for, do,and while statements, even when the body is empty or
contains only a single statement.

« Braces follow the Kernighan and Ritchie style (Egyptian brackets) described below:
- No line break before the opening brace.
- Line break after the opening brace.
- Line break before the closing brace.

- Line break after the closing brace, only if that brace terminates a statement or terminates the body of a
method, constructor, or named class. For example, there is no line break after the brace if it is followed
by else ora comma.

+ One statement per line.
« Let the formatter automatically wraps your code when a statement needs to be wrapped.
Here is a list of additional formatting rules that are not automatically applied:

+ Class and member modifiers, when present, must appear in the order recommended by the Java Language
Specification: public protected private abstract default static final transient volatile
synchronized native strictfp.

« Avoid committing commented code (other than to explain an optimization).

« All methods of an interface are public. There is no need to specify the visibility (easier to read).
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+ The parts of a class or interface declaration must appear in the order suggested by the Code Convention for
the Java Programming Language:

Class (static) fields. First, the public class fields, then the protected, then package level (no access mod-
ifier), and then the private.

Instance fields. First, the public class fields, then the protected, then package level (no access modifier),
and then the private.

Constructors

Methods

Note: Most of these rules are checked by Code Analysis with SonarQube™.

6.5.3 Best Practices

This section describes rules made of best practices and well-known restrictions of the Java Programming Language
and more generally Object Oriented paradigm.

Common Pitfalls

« Object.equals(Object) and Object.hashCode() methods must be overridden in pairs. See Equals and Hash-
code.

+ Do not assign fields in field declaration but in the constructor.
+ Do not use non-final method inside the constructor.

« Do not overburden the constructor with logic.

+ Do not directly store an array given by parameter.

« Do not directly return an internal array.

« Save object reference from a field to a local before using it (see Local Extraction).

Simplify Maintenance

« Extract constants instead of using magic numbers.

« Use parenthesis for complex operation series; it simplifies the understanding of operator priorities.
« Write short lines. This can be achieved by extracting locals (see Local Extraction).

« Use a limited number of parameters in methods (or perhaps a new type is needed).

+ Create small methods with little complexity. When a method gets too complex, it should be split.

+ Use + operator only for single-line string concatenation. Use an explicit StringBuilder otherwise.

« Use component-oriented architecture to separate concerns. If a class is intended to be instantiated using
Class.newlnstance(), add a default constructor (without parameters).
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Basic Optimizations

« Avoid explicitly initializing fields to @ or null, because they are zero-initialized by the runtime. A //VM_DONE

comment can be written to understand the optimization.

+ The switch/case statements are generated by the Java compiler in two ways depending on the cases density.

Prefer declaring consecutive cases (table_switch) for performance (0(1) ) and slightly smaller code memory
footprint instead of lookup_switch (0(log N) ).

« Avoid using built-in thread safe types (Vector, Hashtable, StringBuffer, etc.). Usually synchronization has to

be done at a higher level.

+ Avoid serializing/deserializing data from byte arrays using manual bitwise operations, use ByteArray utility

methods instead.

Local Extraction

Local extraction consists of storing the result of an expression before using it, for example:

Object myLocale = this.myField;
if (myLocale != null) {
myLocale.myMethod();

}

Itimproves the Java code in many ways:

« self documentation: gives a name to a computed result.

«+ performance and memory footprint: avoids repeated access to same elements and extract loop invariants.

« thread safety: helps to avoid synchronization issues or falling into unwanted race conditions.

code pattern detection: helps automated tools such as Null Analysis.

Equals and Hashcode

The purpose of these methods is to uniquely and consistently identify objects. The most common use of these
methods is to compare instances in collections (list or set elements, map keys, etc.).

The Object.equals(Object) method implements an equivalence relation (defined in the Javadoc) with the following
properties:

It is reflexive: for any reference value x, x.equals(x) mustreturn true.

It is symmetric: for any reference values xandy, x.equals(y) mustreturn true ifandonlyif y.equals(x)
returns true.

It is transitive: for any reference values x, y, and z, if x.equals(y) returns true and y.equals(z) returns
true,then x.equals(z) mustreturn true.

It is consistent: for any reference values x and y, multiple invocations of x.equals(y) consistently return
true or consistently return false, provided no information used in equals comparisons on the object is
modified.

For any non-null reference value x, x.equals(null) mustreturn false.

Avoid overriding the equals(Object) method in a subclass of a class that already overrides it; it could break the
contract above. See Effective Java book by Joshua Bloch for more information.

If the equals(Object) method is implemented, the hashCode() method must also be implemented. The
hashCode () method follows these rules (defined in the Javadoc):
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+ It must consistently return the same integer when invoked several times.

« Iftwo objects are equal according to the equals(Object) method, then calling the hashCode () method on
each of the two objects must produce the same integer result.

« In the same way, it should return distinct integers for distinct objects.
The equals(Object) method is written that way:

« Compare the argument with this using the == operator. If both are equals, return true . This test is for
performance purposes, so it is optional and may be removed if the object has a few fields.

« Use an instanceof to check if the argument has the correct type. If not, return false . This check also
validates that the argument is not null.

+ Cast the argument to the correct type.

For each field, check if that field is equal to the same field in the casted argument. Return true if all fields
are equal, false otherwise.

@Override
public boolean equals(Object o) {
if (o == this) {
return true;

}
if (!(o instanceof MyClass)) {
return false;

}
MyClass other = (MyClass)o;
return fieldl == other.fieldl &&
(field2 == null ? other.field2 == null : field2.equals(other.field2));

3
The Object.hashCode() method is written that way:
« Choose a prime number.
« Create a result local, whatever the value (usually the prime number).

« For each field, multiply the previous result with the prime plus the hash code of the field and store it as the
result.

+ Return the result.
Depending on its type, the hash code of a field is:
« Boolean: (f 2 0 : 1).
« Byte, char, short, int: (int) f).
e Long: (int)(f » (f >>> 32)).
o Float: Float.floatToIntBits(f).
« Double: Double.doubleToLongBits(f) andthe same as fora long.
« Object: (f == null ? @ : f.hashCode()).
« Array: add the hash codes of all its elements (depending on their type).

private static final int PRIME = 31;

@Override
public int hashCode() {
(continues on next page)
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(continued from previous page)

int result = PRIME;

result = PRIME * result + field1l;

result = PRIME * result + (field2 == null ? 0 : field2.hashCode());
return result;

6.5.4 Related Tools

This section points to tools aimed at helping to improve code quality.

Unit Testing

Here is a list of rules when writing tests (see Testsuite with JUnit):

« Prefer black-box tests (with a maximum coverage).
+ Hereis the test packages naming convention:
- Suffix package with .test for black-box tests.

- Use the same package for white-box tests (allow to use classes with package visibility).

Code Analysis with SonarQube™

SonarQube is an open source platform for continuous inspection of code quality. SonarQube offers reports on
duplicated code, coding standards, unit tests, code coverage, code complexity, potential bugs, comments, and
architecture.

To setit up onyour MicroEJ application project, please refer to this documentation. It describes the following steps:
« How to run a SonarQube server locally.
+ How to run an analysis using a dedicated script.

« How to run an analysis during a module build.

6.6 Optimize the Memory Footprint of an Application

This tutorial explains how to analyze the memory footprint of an application and provides a set of common rules
aimed at optimizing both ROM and RAM footprint.

6.6.1 Intended Audience

The audience for this document is Java engineers and Firmware integrators who are going to execute a MicroEJ
Application on a memory-constrained device.
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6.6.2 Introduction

Usually, the application development is already started when the developer starts thinking about its memory foot-
print. Before jumping into code optimizations, it is recommended to list every area of improvement and estimate
for each area how much memory can be saved and how much effort it requires.

Without performing the memory analysis first, the developer might start working on a minor optimization that
takes a lot of effort for little improvements. In contrast, he could work on a major optimization, allowing faster and
bigger improvements. Moreover, each optimization described hereafter may allow significant memory savings for
an application while it may not be relevant for another application.

6.6.3 How to Analyze the Footprint of an Application
This section explains the process of analyzing the footprint of a MicroEJ Application and the tools used during the
analysis.
Suggested footprint analysis process:
1. Build the MicroEJ Application
. Analyze SOAR.map with the Memory Map Analyzer

2

3. Analyze soar/x.xml with an XML editor

4. Link the MicroEJ Application with the BSP

5. Analyze the map file generated by the third-party linker with a text editor
Footprint analysis tools:

» The Memory Map Analyzer allows to analyze the memory consumption of different features in the RAM and
ROM.

« The Heap Dumper & Heap Analyzer allow to understand the contents of the Java heap and find problems such
as memory leaks.

« The Dependency Discoverer allows to analyze a piece of code to detect all its dependencies.

How to Analyze the Files Generated by the MicroEJ Linker

The MicroEJ Application linker generates files useful for footprint analysis, such as the SOAR map file and the SOAR
information file. To understand how to read these files, please refer to the Build Output Files documentation.

How to Analyze a Map File Generated by a Third-Party Linker

A <firmware>.map file is generated by the C toolchain after linking the MicroEJ Application with the BSP. This
section explains how a map file generated by GCC is structured and how to browse it. The structure is not the same
on every compiler, but it is often similar.

File Structure

This file is composed of 5 parts:

« Archive member included to satisfy reference by file.Each entry contains two lines. The first line
contains the referenced archive file location and the compilation unit. The second line contains the compi-
lation unit referencing the archive and the symbol called.
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« Allocating common symbols. Each entry containsthe name of a globalvariable, its size, and the compilation
unit where it is defined.

» Discarded input sections. Each entry contains the name and the size of a section that has not been
embedded in the firmware.

« Memory Configuration. Each entry contains the name of a memory, its address, its size, and its attributes.

o Linker script and memory map. Each entry contains a line with the name and compilation unit of a section
and one line per symbol defined in this section. Each of these lines contains the name, the address, and the
size of the symbol.

Finding the Size of a Section or Symbol

For example, to know the thread stacks’ size, search for the .bss.vm.stacks. java sectioninthe Linker script
and memory map part. The size associated with the compilation unit is the size used by the thread stacks.

The following snippet shows that the .bss.vm.stacks. java section takes 0x800 bytes.

.bss.vm.stacks. java

0x20014070 0x800 ..\..\..\..\..\..\..\.microej\CM4hardfp_
—»GCC48\application\microejapp.o

0x20014070 __icetea___6bss_6vm_6stacks_6java$$Base

0x20014870 __icetea___6bss_6vm_6stacks_6java$sLimit

See Core Engine Link documentation for more information on MicroEJ Core Engine sections.

6.6.4 How to Reduce the Image Size of an Application

Generic coding rules can be found in the following tutorial: Improve the Quality of Java Code.

This section provides additional coding rules and good practices to reduce the image size (ROM) of an application.

Application Resources
Resources such as images and fonts take a lot of memory. For every .1ist file, make sure that it does not embed
any unused resource.

Only resources declared ina .1list file will be embedded. Other resources available in the application classpath
will not be embedded and will not have an impact on the application footprint.

Fonts
Default Font

By default, in a MicroEJ Platform configuration project, a so-called system font is declared in the microui.xml file.

When generating the MicroEJ Platform, this file is copied from the configuration project to the actual MicroEJ Plat-
form project. It will later be converted to binary format and linked with your MicroEJ Application, even if you use
fonts different from the system font.

Therefore, you can comment the system font from the microui.xml file to reduce the ROM footprint of your Mi-
croEJ Application if this one does not rely on the system font. Note that you will need to rebuild the MicroEJ Plat-
form and then the application to benefit from the footprint reduction.
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See the Display Element section of the Static Initialization documentation for more information on system fonts.

Character Ranges

When creating a font, you can reduce the list of characters embedded in the font at several development stages:
+ On font creation: see the Removing Unused Characters section of Font Designer documentation.

+ On application build: see the Fonts section of MicroEJ Classpath documentation.

Pixel Transparency

You can also make sure that the BPP encoding used to achieve transparency for your fonts do not exceed the fol-
lowing values:

« The pixel depth of your display device.
+ The required alpha level for a good rendering of your font in the application.

See the Fonts section of MicroEJ Classpath documentation for more information on how to achieve that.

External Storage

To save storage on internal flash, you can access fonts from an external storage device.

See the External Resources section of the Font Generator documentation for more information on how to achieve
that.

Internationalization Data
Implementation

MicroEJ provides the Native Language Support (NLS) library to handle internationalization.

See https://github.com/MicroEJ/Example-NLS for an example of the use of the NLS library.

External Storage

The default NLS implementation fetches text resources from internal flash, but you can replace it with your own
implementation to fetch them from another location.

See External Resources Loader documentation for additional information on external resources management.

Compression

The default NLS implementation relies on text resources that are not compressed, but you can use your own en-
coding to load them from compressed resources.
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Images
Encoding

If you are tight on ROM but have enough RAM and CPU power to decode PNG images on the fly, consider storing
yourimages as PNG resources. If you are in the opposite configuration (lots of ROM, but little RAM and CPU power),
consider storing your images in raw format.

See Image Generator documentation for more information on how to achieve that.

Color Depth (BPP)

Make sure to use images with a color depth not exceeding the one of your display to avoid the following issues:
« Waste of memory.

« Differences between the rendering on the target device and the original image resource.

External Storage

To save storage on internal flash, the application can access the images from an external storage device.

See External Resources Loader documentation for more information on how to achieve that.

Application Code

The following application code guidelines are recommended in order to minimize the size of the application:
+ Check libraries versions and changelogs regularly. Latest versions may be more optimized.
+ Avoid manipulating String objects:
- For example, prefer using integers to represent IDs.

- Avoid overriding Object.toString() for debugging purposes. This method will always be embedded even
if it is not called explicitly.

- Avoid using Logger or System.out.println() , use the trace library instead. The logging library uses
strings, while the trace library only uses integer-based error codes.

- Avoid using the string concatenation operator ( + ), use an explicit StringBuilder instead. The code gen-
erated by the + operator is not optimal and is bigger than when using manual StringBuilder opera-
tions.

« Avoid manipulating wrappers such as Integer and Long objects, use primitive types instead. Such objects
have to be allocated in Java heap memory and require additional code for boxing and unboxing.

« Avoid using the service library, use singletons or Constants.getClass() instead. The service library requires
embedding class reflection methods and the type names of both interfaces and implementations.

+ Avoid using the Java Collections Framework. This OpenJDK standard library has not been designed for mem-
ory constrained devices.

- Useraw arrays instead of List objects. The ArrayTools class provides utility methods for common array
operations.

- Use PackedMap objects instead of Map objects. It provides similar APIs and features with lower Java
heap usage.
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« Useej.bon.Timerinstead of deprecated java.util.Timer.When both class are used, almost all the code is
embedded twice.

+ Use BON constants in the following cases if possible:

- when writing debug code or optional code, use the if (Constants.getBoolean()) { ... } pattern.
That way, the optional code will not be embedded in the production firmware if the constant is set to
false.

- replacethe use of System Properties by BON constants when both keys and values are known at compile-
time. System Properties should be reserved for runtime lookup. Each property requires embedding its
key and its value as intern strings.

+ Check for useless or duplicate synchronization operations in call stacks, in order reduce the usage of
synchronized statements. Each statement generates additional code to acquire and release the monitor.

« Avoid declaring exit statements ( break , continue, throw or return)thatjump outofa synchronized
block. At each exit point, additional code is generated to release the monitor properly.

+ Avoid declaring exit statements ( break , continue, throw or return)thatjumpoutofa try/finally
block. At each exit point, the code of the finally blockis generated (duplicated). This also applies on every
try-with-resources blocksincea finally block is generated to close the resource properly.

« Avoid overriding Object.equals(Object) and Object.hashCode(), use == operator instead if it is sufficient. The
correct implementation of these methods requires significant code.

+ Avoid calling equals() and hashCode() methods directly on Object references. Otherwise, the method
of every embedded class which overrides the method will be embedded.

« Avoid creating inlined anonymous objects (such as new Runnable() { ... } objects), implement the
interface in a existing class instead. Indeed, a new class is created for each inlined object. Moreover, each
enclosed final variable is added as a field of this anonymous class.

+ Replace constant arrays and objects initialization in static final fields by immutables objects. Indeed,
initializing objects dynamically generates code which takes significant ROM and requires execution time.

« Check if some features available in software libraries are not already provided by the device hardware. For
example, avoid using java.util.Calendar (full Gregorian calendar implementation) if the application only re-
quires basic date manipulation provided by the internal real-time clock (RTC).

MicroEJ Platform Configuration

The following configuration guidelines are recommended in order to minimize the size of the application:

+ Check MicroEJ Architecture and Packs versions and changelogs regularly. Latest versions may be more opti-
mized.

« Configure the Platform to use the tiny capability of the MicroEJ Core Engine. It reduces application code size
by ~20%, provided that the application code size is lower than 256KB (resources excluded).

« Disable unnecessary modulesin the .platform file. For example, disable the Image PNG Decoder module
if the application does not load PNG images at runtime.

« Don’t embed unnecessary pixel conversion algorithms. This can save up to ~8KB of code size but it requires
knowing the format of the resources used in the application.

« Select yourembedded C compilation toolchain with care, prefer one which will allow low ROM footprint with
optimal performance. Check the compiler options:

- Check documentation for available optimization options ( -0Os on GCC). These options can also be over-
ridden per source file.
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- Separate each function and data resource in a dedicated section ( -ffunction-sections
-fdata-sections on GCC).

+ Check the linker optimization options. The linker command line can be found in the project settings, and it
may be printed during link.

- Only embed necessary sections (--gc-sections option on GCC/LD).

- Some functions, such as the printf function, can be configured to only implement a subset of the pub-
lic API (for example, remove -u _printf_float option on GCC/LD to disable printing floating point
values).

+ In the map file generated by the third-party linker, check that every embedded function is necessary. For
example, hardware timers or HAL components may be initialized in the BSP but not used in the application.
Also, debug functions such as SystemView may be disconnected when building the production firmware.

Application Configuration

The following application configuration guidelines are recommended in order to minimize the size of the applica-
tion:

« Disable class names generation by setting the soar.generate.classnames optionto false. Class names
are only required when using Java reflection. In such case, the name of a specific class will be embedded
only if is explicitly required. See Stripping Class Names from an Application section for more information.

+ Remove UTF-8 encoding support by setting the cldc.encoding.utf8.included optionto false. The
default encoding ( 1S0-8859-1) is enough for most applications.

« Remove SecurityManager checks by setting the com.microej.library.edc.securitymanager.enabled
optionto false. This feature is only useful for Multi-Sandbox firmwares.

For more information on how to set an option, please refer to the Defining an Option section.

Stripping Class Names from an Application
By default, when a Java class is used, its name is embedded too. A class is used when one of its methods is called,
for example. Embedding the name of every class is convenient when starting a new MicroEJ Application, but it is

rarely necessary and takes a lot of ROM. This section explains how to embed only the required class names of an
application.

Removing All Class Names

First, the default behavior is inverted by defining the Application option soar.generate.classnames to false.

For more information on how to set an option, please refer to the Defining an Option section.

Listing Required Class Names

Some class names may be required by an application to work properly. These class names must be explicitly spec-
ifiedina *.types.list file.

The code of the application must be checked for all uses of the Class.forName(), Class.getName() and
Class.getSimpleName() methods. For each of these method calls, if the class name if absolutely required and can
not be known at compile-time, add ittoa *. types.list file. Otherwise, remove the use of the class name.

The following sections illustrates this on concrete use cases.
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Case of Service Library

The ej.service.ServiceLoader class of the service library is a dependency injection facility. It can be used to dynam-
ically retrieve the implementation of a service.

The assignment between a service APl and its implementation is done in *.properties.list files. Both the ser-
vice class name and the implementation class name must be embedded (i.e.,added ina . types.list file).

For example:

# example.properties.list
com.example.MyService=com.example.MyServiceImpl

# example.types.list
com.example.MyService
com.example.MyServiceImpl

Case of Properties Loading

Some properties may be loaded by using the name of a class to determine the full name of the property. For exam-
ple:

n

Integer.getInteger(MyClass.class.getName() + ".myproperty");

In this case, it can be replaced with the actual string. For example:

Integer.getInteger(”com.example.MyClass.myproperty"”);

Case of Logger and Other Debugging Facilities

Logging mechanisms usually display the name of the classes in traces. It is not necessary to embed these class
names. The Stack Trace Reader can decipher the output.

6.6.5 How to Reduce the Runtime Size of an Application

You can find generic coding rules in the following tutorial: Improve the Quality of Java Code.

This section provides additional coding rules and good practices in order to reduce the runtime size (RAM) of an
application.

Application Code

The following application code guidelines are recommended in order to minimize the size of the application:

« Avoid using the default constructor of collection objects, use constructors that allow to set the initial capacity.
For example, use the ArrayList(int initialCapacity) constructor instead of the default one which will allocate
space for ten elements.

+ Adjust the type of int fields (32 bits) according to the expected range of values being stored ( by te for 8 bits
signed integers, short for 16 bits signed integers, char for 16 bits unsigned integers).
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+ When designing a generic and reusable component, allow the user to configure the size of any buffer allo-
cated internally (either at runtime using a constructor parameter, or globally using a BON constant). That
way, the user can select the optimal buffer size depending on his use-case and avoid wasting memory.

Avoid allocatingimmortal arrays to call native methods, use regular arrays instead. Immortal arrays are never
reclaimed and they are not necessary anymore when calling a native method.

« Reduce the maximum number of parallel threads. Each thread require a dedicated internal structure and VM
stack blocks.

- Avoid creating threads on the fly for asynchronous execution, use shared thread instances instead
(Timer, Executor, MicroUl.callSerially(Runnable), ...).

+ When designing Graphics User Interface:

- Avoid creating mutable images (Bufferedimage instances) to draw in them and render them later, render
graphics directly on the display instead. Mutable images require allocating a lot of memory from the
images heap.

- Make sure that your Widget hierarchy is as flat as possible (avoid any unnecessary Container). Deep
widget hierarchies take more memory and can reduce performance.

MicroEJ Platform Configuration

The following configuration guidelines are recommended in order to minimize the runtime size of the application:

+ Check the size of the stack of each RTOS task. For example, 1.0KB may be enough for the MicroJVM task but
it can be increased to allow deep native calls. See Debugging Stack Overflows section for more information.

+ Check the size of the heap allocated by the RTOS (for example, configTOTAL_HEAP_SIZE for FreeRTOS).

« Check that the size of the back buffer matches the size of the display. Use a partial buffer if the back buffer
does not fit in the RAM.

Debugging Stack Overflows

If the size you allocate for a given RTOS task is too small, a stack overflow will occur. To be aware of stack overflows,
proceed with the following steps when using FreeRTOS:

1. Enable the stack overflow check in FreeRTOS.h:

#define configCHECK_FOR_STACK_OVERFLOW 1

2. Define the hook function in any file of your project (main.c for example):
void vApplicationStackOverflowHook(TaskHandle_t xTask, signed char xpcTaskName) { }
3. Add a new breakpoint inside this function

4. When a stack overflow occurs, the execution will stop at this breakpoint

For further information, please refer to the FreeRTOS documentation.

Application Configuration

The following application configuration guidelines are recommended in order to minimize the size of the applica-
tion.

For more information on how to set an option, please refer to the Defining an Option documentation.
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Java Heap and Immortals Heap

« Configure the immortals heap option to be as small as possible. You can get the minimum value by calling
Immortals.freeMemory() after the creation of all the immortal objects.

+ Configure the Java heap option to fit the needs of the application. You can get the maximum heap usage
by calling Runtime.freeMemory() after System.gc() at different moments in the application’s lifecycle. The
profiling library can be used for this.

Thread Stacks

« Configure the maximum number of threads option. This number can be known accurately by counting in the
code how many Thread and Timer objects may run concurrently. You can call Thread.getAllStackTraces()
or Thread.activeCount() to know what threads are running at a given moment.

« Configure the number of allocated thread stack blocks option. This can be done empirically by starting with a
low number of blocks and increasing this number as long as the application throws a StackOverflowError

« Configure the maximum number of blocks per thread option. The best choice is to set it to the number of
blocks required by the most greedy thread. Another acceptable option is to set it to the same value as the
total number of allocated blocks.

« Configure the maximum number of monitors per thread option. This number can be known accurately by
counting the number of concurrent synchronized blocks. This can also be done empirically by starting
with a low number of monitors and increasing this number as long as no exception occurs. Either way, it is
recommended to set a slightly higher value than calculated.

VM Dump

The LLMIVM_dump() function declared in LLMJVM.h may be called to print information on alive threads such as
their current and maximum stack block usage. This function may be called from the application by exposingitin a
native function. See Debugging section for usage.

More specifically, the Peak java threads count value printedinthe dump can be used to configure the maximum
number of threads. The max_java_stack and current_java_stack values printed for each thread can be used
to configure the number of stack blocks.

MicroUl Images Heap

+ Configure the images heap to be as small as possible. You can compute the optimal size empirically. It can
also be calculated accurately by adding the size of every image that may be stored in the images heap at
a given moment. One way of doing this is to inspect every occurrence of Bufferedimage() allocations and
Resourcelmage usage of loadImage() methods.

6.7 Explore Data Serialization Formats

This tutorial highlights some data serialization formats that are provided on MicroEJ Central Repository and their
usage through basic code samples.
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6.7.1 Intended Audience

The audience for this document is Application engineers who want to implement data serialization. In addition,
this tutorial should be of interest to software architects who are looking for a suitable data format for their use case.

6.7.2 XML

XML (EXtensible Markup Language) is used to describe data and text. It allows flexible development of user-defined
document types. The format is robust, non-proprietary, persistent and is verifiable for storage and transmission.
To parse this data format, the XML Pull parser KXm|Parser from the Java community has been integrated to MicroEJ
Central Repository.

XML Parser Use In MicroEJ SDK

The XML APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow access to
the KXML library.

<dependency org="org.kxml2" name="kxml2" rev="2.3.2"/>

Example Of Use

An example available at https://github.com/MicroEJ/Example-XML. It presents how to use XML data exchange for
your MicroEJ Application. It also details how to use the KXml[Parser module.

The example parses a short poem written in XML and prints the result on the standard output. The project can run
on any MicroEJ Platform (no external dependencies).

<?xml version="1.0" encoding="UTF-8"?>
<poem xmlns="http://www.megginson.com/ns/exp/poetry">
<title>Roses are Red</title>
<1>Roses are red,</1>
<1>Violets are blue;</1>
<1>Sugar is sweet,</1>
<1>And I love you.</1>
</poem>

Running the ReadPoem Java application should print the following trace :

[ Initialization Stage ] ===============
[ Launching on Simulator ] ===============

Roses are red,
Violets are blue;
Sugar is sweet,
And I love you.

SUCCESS

Running MyXmlPullApp gives more details on the XML parsing and should print this trace :
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parser implementation class is class org.kxml2.io.KXmlParser
Parsing simple sample XML

Start document

Start element: {http://www.megginson.com/ns/exp/poetry}poem

Characters: "\n"

Start element: {http://www.megginson.com/ns/exp/poetry}title
Characters: "Roses are Red”

End element: {http://www.megginson.com/ns/exp/poetry}title
Characters: "\n"

Start element: {http://www.megginson.com/ns/exp/poetry}1l
Characters: "Roses are red,”

End element: {http://www.megginson.com/ns/exp/poetry}1l
Characters: "\n"

Start element: {http://www.megginson.com/ns/exp/poetry}1l
Characters: "Violets are blue;"

End element: {http://www.megginson.com/ns/exp/poetry}1l
Characters: "\n"

Start element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "Sugar is sweet,”

End element: {http://www.megginson.com/ns/exp/poetry}1l
Characters: "\n"

Start element: {http://www.megginson.com/ns/exp/poetry}1l
Characters: "And I love you."

End element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "\n"

End element: {http://www.megginson.com/ns/exp/poetry}poem
S e e e e e [ Completed Successfully ] S e e e e =S

SUCCESS

6.7.3 JSON
As described on the JSON official site, JSON (JavaScript Object Notation) is a lightweight data-interchange format.
Itis widely used in many applications such as:

+ as a mean of data serialization for lightweight web services such as REST

« for server interrogation in Ajax to build dynamic webpages

» oreven databases.

JSON is easily readable by humans compared to XML. To parse this data format, several JSON parsers are available
on the official JSON page, such as JSON ME, which has been integrated to MicroEJ Central Repository.

JSON Parser Use In MicroEJ SDK

The JSON API Module must be added to the module.ivy of the MicroEJ Application project in order to allow access
to the JSON library.

<dependency org="org.json.me"” name="json" rev="1.3.0"/>

Theinstantiation and use of the parser is pretty straightforward. First you need to get the JSON contentasa String
,andthen createa org. json.me.JSONObject instance with the string. If the string content is a valid JSON content,
you should have an workable JSONObject to browse.
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Example Of Use

In the following example we will parse this JSON file that represents a simple abstraction of a file menu:

{

"menu”: {
"id": "file",
"value”: "File",
"popup”: {
"menuitem”: [
{"value”: "New", "onclick”: "CreateNewDoc()"},
{"value"”: "Open"”, "onclick": "OpenDoc()"},
{"value”: "Close”, "onclick”: "CloseDoc()"}
1
3
}

First, we need to include this file in our project by adding it to the src/main/resources folder and creating a
.resources.list properties file to declare this resource for our application to be able to retrieve it (see Raw Re-
sources for more details).

v B src/main/java
v B com.microgj.examples,json
4] MyJSONExample.java
v B sro/main/resources
w HL resources

=| json.resources.list

[iE] [ie

MEnU.jsan

This .resources.list file (here named json.resources.list)should contain the path to our JSON file as such

resources/menu. json

The example below will parse the file, browse the resulting data structure (org. json.me.JSONObject ) and print
the value of the menuitem JSON array.

package com.microej.examples.json;

import java.io.DatalInputStream;
import java.io.IOException;

import org.json.me.JSONArray;
import org.json.me.JSONException;
import org.json.me.JSONObject;

VEXS

This example uses the org.json.me parser provided by json.org to parse and
browse a JSON content.

*
*
*
* The JSON content is simple abstraction of a file menu as provided here:
* http://www. json.org/example.html

*

*

The example then tries to list all the 'menuitem's available in the popup

(continues on next page)
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(continued from previous page)

* menu. It is assumed the user knows the menu JSON file structure.
*

*/
public class MyJSONExample {

public static void main(String[] args) {
// get back an input stream from the resource that represents the JSON
// content
DataInputStream dis = new DatalnputStream(
MyJSONExample.class.getResourceAsStream(”/resources/menu. json"));
byte[] bytes = null;

try {

// assume the available returns the whole content of the resource
bytes = new byte[dis.available()1];

dis.readFully(bytes);
} catch (IOException el) {
// something went wrong

el.printStackTrace();
return;

try {
// create the data structure to exploit the content
// the string is created assuming default encoding

JSONObject jsono = new JSONObject(new String(bytes));

// get the JSONObject named "menu” from the root JSONObject
JSONObject o = jsono.getJSONObject("menu”);

0 = 0.getJSONObject ("popup”);
JSONArray a = o.getJSONArray("menuitem”);

System.out.println("The menuitem content of popup menu is:");
System.out.println(a.toString());

} catch (JSONException e) {
// a getJSONObject() or a getJSONArray() failed
// or the parsing failed
e.printStackTrace();

The execution of this example on the MicroEJ Simulator should print the following trace:

=============== [ Initialization Stage ]| e

(continues on next page)
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(continued from previous page)
=============== [ Launching Simulator ] ===============
The menuitem content of popup menu is:
[{"value":"New","onclick”:"CreateNewDoc()"},{"value":"Open
—"onclick":"CloseDoc()"}]
=============== [ Completed Successfully ] ===============

non

,"onclick”:"OpenDoc()"},{"value"”:"Close",

SUCCESS
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